Click within the Contents listing below to go directly to a section or page.

Preface ....................................................................................................................................................... 10
  About This Manual .................................................................................................................................... 10
  Additional Resources ................................................................................................................................ 11
  Training File Details ................................................................................................................................. 11
  Getting Help ................................................................................................................................................ 12

Section 1–System Setup ................................................................................................................................. 13

Chapter 1: Getting Started with Cornerstone* Setup ................................................................................. 14
  Introduction ................................................................................................................................................ 14
  Designating a Cornerstone Administrator ................................................................................................. 14
  Setting Security ......................................................................................................................................... 14
  Backing Up Your Cornerstone Data ............................................................................................................ 14
  Viewing Current User Information: Exclusive Use .................................................................................... 14
  Changing IDs ............................................................................................................................................... 15
  Setting Up a Signature Capture Device .................................................................................................... 16

Chapter 2: Setting Up Cornerstone* Controls .............................................................................................. 18
  Overview ................................................................................................................................................... 18
  Updating Controls ...................................................................................................................................... 18
  Deleting Unused Controls ......................................................................................................................... 18
  User Defined Prompts ............................................................................................................................... 18
  Classifications .......................................................................................................................................... 20
  Patient Colors .......................................................................................................................................... 22
  Reasons for Visit ....................................................................................................................................... 22
  Patient Sexes ............................................................................................................................................ 24
  Payment Types ........................................................................................................................................... 25
  Credit and Debit Payment Types ............................................................................................................... 26
  Credit Codes ............................................................................................................................................ 28
  Taxes ......................................................................................................................................................... 29
  Discounts ................................................................................................................................................... 30
  Billing Messages ....................................................................................................................................... 30
  Estimate Messages ................................................................................................................................... 31
  Invoice Types .......................................................................................................................................... 32
  Units of Measure ..................................................................................................................................... 32
  Price Change Reasons ............................................................................................................................... 33
  Controlled Substance Export List ............................................................................................................ 33
  Controlled Substance Reasons ................................................................................................................ 35
  Problem List ............................................................................................................................................. 36
  Initial Setup Reports ................................................................................................................................. 37

Chapter 3: Setting Up Lists and Information ............................................................................................... 40
  Overview ................................................................................................................................................... 40
  Updating List Items ................................................................................................................................. 40
  Deleting Unused List Items ....................................................................................................................... 40
  Practice Information ................................................................................................................................. 41
Chapter 5: Setting Staff Defaults ................................................................. 150
  Overview................................................................................................. 150
  Accessing Staff Defaults ....................................................................... 150
  Staff Defaults for Patient Clipboard ...................................................... 150
  Staff Defaults for the Toolbar Display .................................................... 151
  Staff Defaults for Miscellaneous Settings ............................................. 152
  Staff Defaults for Inventory ................................................................... 153
  Staff Defaults for Favorite Document Templates ................................... 154

Chapter 6: Setting Cornerstone* Imaging Defaults ........................................ 155
  Overview................................................................................................. 155
  Image Archiving Defaults ..................................................................... 155
  Modality Layout Defaults ..................................................................... 156
  Image Email Defaults ........................................................................... 158
  Cornerstone Imaging Defaults ............................................................... 160
  Image Keywords Defaults ..................................................................... 161
  Telemedicine Provider Defaults ............................................................ 162

Section 3–Items and Inventory Setup ............................................................ 164

Chapter 7: Getting Started with Cornerstone* Inventory Setup .................. 165
  Overview................................................................................................. 165
  Inventory Setup–Single or Multiple Location ......................................... 165
  Setting Up Your List of Vendors ............................................................. 167
  Setting Up Internal Cost Centers ........................................................... 169
  Setting Up Inventory Adjustment Reasons ........................................... 170

Chapter 8: Setting Up a Single Location Inventory System .......................... 171
  Overview................................................................................................. 171
  Setting Up Locations for Single Location Inventory ................................ 172

Chapter 9: Setting Up a Multiple Location Inventory System .................... 174
  Overview................................................................................................. 174
  Location Groups, Locations, and Location Types .................................. 175
  Setting Up Location Types .................................................................... 176
  Setting Up Location Groups ................................................................. 177
  Setting Up Locations for Multiple Location Inventory .......................... 178

Chapter 10: Setting Up Your Invoice Items .................................................. 180
  Overview................................................................................................. 180
  Inventory Calculations .......................................................................... 180
  Setting Up Invoice Item Classifications and Subclasses .......................... 182
  The Invoice Item List ............................................................................ 184
  Setting Up Invoice Item Information .................................................... 186
  Inactivating Invoice Items ..................................................................... 190
  Deleting Invoice Items .......................................................................... 190
Section 5–Pet Health Management Setup ................................................................. 296

Chapter 15: Setting Up Physical Exam and Pet Health Report Card ......................... 297
Overview .................................................................................................................. 297
Creating Your Own System Templates .................................................................... 297
Creating and Updating Observation Text .............................................................. 298

Chapter 16: Setting Up Vital Signs/Weight .............................................................. 301
The Default Vital Sign List ....................................................................................... 301
About the Vital Sign List ......................................................................................... 302
Vital Sign Types ...................................................................................................... 303
Setting Up the Vital Sign List for Your Practice .................................................... 305
Editing the Weight Vital Sign .................................................................................. 309
Setting the Vital Signs Display Order ..................................................................... 310
Copying a Vital Sign from the Vital Sign List ....................................................... 311
Deleting a Vital Sign from the Vital Sign List ....................................................... 311

Chapter 17: Setting Up Medical Notes and Correspondence .................................. 312
Overview .................................................................................................................. 312
Template Types ...................................................................................................... 312
Getting Ready Checklist ......................................................................................... 316
Cornerstone Editor–Template Setup/Update Window .......................................... 317
Page Setup and Formatting Tools .......................................................................... 321
Document Template Setup Tools ......................................................................... 323
Cornerstone Editor Features and Limitations in Text-Only Mode ....................... 334
Customizing the Default Setup Document Template ........................................... 335
Designating the Text-Only Template to Use for Adding Quick Text Medical Notes .. 337
Creating a New Document Template for Medical Notes or Correspondence ........ 338
Importing a Document Template ......................................................................... 340
Creating a Copy of an Existing Document Template .......................................... 340
Using “Save As” to Save an Existing Template as a Different Template Type ...... 341
Showing Correspondence with Medical Notes in History ................................... 341
Converting Medical Note Templates .................................................................... 342
Inactivating a Document Template ...................................................................... 345
Setting Up a Special Action to Associate a Document Template with an Invoice Item .. 345
Customizing Document Templates for PetDetect* Collars .................................. 346
Customizing Document Templates for ID Cards .................................................. 347
LifeLearn® ClientEd Online™ Integration with Cornerstone ............................... 349
Loading LifeLearn® CD Documents in Cornerstone ........................................... 349

Chapter 18: Setting Up Classic Medical Notes ....................................................... 351
Overview .................................................................................................................. 351
About Classic Medical Note Templates ............................................................... 351
Creating a New Classic Medical Note Template .................................................. 352
Creating a New Classic Medical Note Template Based on an Existing Template .. 355
Chapter 27: Using Cornerstone Performance Tracker ..........................................................441
Overview........................................................................................................................................................441
Tracking Performance ........................................................................................................................................441

Chapter 28: Using the Backup Verification Assistant ...........................................................446
Overview........................................................................................................................................................446
How the Backup Verification Assistant Works .............................................................................................446
Enabling the Backup Verification Assistant in Cornerstone ...........................................................................447
Viewing the Backup Verification Assistant ......................................................................................................447

Chapter 29: Purging Data from Cornerstone* ........................................................................448
Overview........................................................................................................................................................448
Options for Purging Data from Cornerstone .................................................................................................448
Purging Clients and Patients ...............................................................................................................................449
Purging Patients ................................................................................................................................................451
Purging Specific Types of Client or Patient Information ...............................................................................452
Purging Patient Reminders ...............................................................................................................................454
Purging Inventory Records ...............................................................................................................................455

Chapter 30: Using the Time Clock ...........................................................................................456
Overview........................................................................................................................................................456
Time Clock Toolbar Buttons .............................................................................................................................456
Setting Up Security ........................................................................................................................................456
Setting Up Staff Members ...............................................................................................................................456
The Timesheet ................................................................................................................................................457
Clocking In and Out .......................................................................................................................................457
Recording Absences .....................................................................................................................................458
Changing Previously Recorded Times ............................................................................................................459
Entering Hours Using the Edit Times Dialog Box ...........................................................................................459
Printing Attendance Reports ...........................................................................................................................460

Chapter 31: Setting Up the Mobile Computing Module .........................................................462
Overview........................................................................................................................................................462
Mobile Computing Functionality—Mobile Computer vs. Main System ......................................................462
Setting Up the Mobile Computing Module .....................................................................................................463
Setting Mobile Computing Defaults ...............................................................................................................463
Copying Images to a Mobile Computer ..........................................................................................................465
Viewing the Mobile Computer List ...............................................................................................................465
Deleting a Mobile Computer ............................................................................................................................466
Generating a Mobile Computing Checkout Report ............................................................................................466
About This Manual

This manual provides setup and system configuration information for your IDEXX Cornerstone* Practice Management System. This information is intended for the person designated as the Cornerstone Administrator and any other staff members responsible for setting up and maintaining the Cornerstone system at your practice. This manual provides information on:

- Setting up your Cornerstone system
- Setting up Cornerstone defaults
- Setting up items and inventory
- Setting up scheduling and patient visit functions
- Setting up pet health management functions
- Completing End of Period processing tasks
- Other management tools and tasks

How to Use This Manual

This manual takes advantage of the searching and linking tools available within Adobe® Reader® PDF (Portable Document Format) files. Use the following tools to search and navigate within this manual:

- **Bookmarks panel**—The Bookmarks panel acts as an always-visible linked Table of Contents, available on the left side of the document window.

- **Clickable TOC**—This Contents section provides direct links to each page—just click the page/chapter/section text in the Contents listing to go to that page.

- **Find toolbar**—Select Edit > Find in Adobe Reader and use the Find toolbar to do a quick search for a word or phrase in the current PDF.

- **Search window**—Select Edit > Search in Adobe Reader and use the Search window to look for words in the current PDF or in multiple PDFs or to use advanced search options.
Additional Resources

The following resources are available for additional help with your Cornerstone software:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Recommended Use</th>
<th>Location</th>
</tr>
</thead>
</table>
| Cornerstone User’s Manual             | Find reference information and procedural steps for using Cornerstone to perform daily tasks | • Icon installed on your desktop  
• **Start > Programs > Cornerstone > Manuals**  
**Note:** In Windows® 8, you can find the Cornerstone folder on the Apps screen.  
• [idexx.com/cornerstoneresources](http://idexx.com/cornerstoneresources) |
| Cornerstone Help System               | Find window-specific information and procedural steps for setting up your Cornerstone system and performing daily tasks | • Press F1 on any Cornerstone window or dialog box  
• On the Cornerstone menu, select **Help > Contents** |
| Cornerstone Tutorial Training Files & Print-Based Courses | Work with the Cornerstone Tutorial Training Files data to complete exercises that mimic everyday tasks in your practice without jeopardizing the integrity of your real medical records | • **Start > Programs > Cornerstone > Training Files**  
• **Start > Programs > Cornerstone > Training Files–Print Based Courses**  
**Note:** In Windows® 8, you can find the Cornerstone folder on the Apps screen. |
| IDEXX Learning Center                 | Access online courses, webinars, video snippets, tutorials, and podcasts      | • [idexxlearningcenter.com](http://idexxlearningcenter.com) |

Training File Details

In the training files (including the Cornerstone Assistant training files), functionality is limited for some Cornerstone 8.3 features which ordinarily communicate with systems outside of Cornerstone:

- **Pet Health Network® Pro**—You can see and use Pet Health Network Pro features like the share button and the IDEXX Message Center alerts for appointment requests; however, these actions won’t be reflected on pethealthnetworkpro.com or petly.com.

- **Inventory Ordering using IDEXX SmartOrder® with MWI® Veterinary Supply**—Although you can’t use IDEXX SmartOrder, you can view the windows used for working with this feature. Also, Purchase Order 1000 in the training files shows an example of a purchase order created using IDEXX SmartOrder.

- **IDEXX Faxing Service**—Although you can’t send faxes from the training files with the IDEXX Faxing Service, this feature is very close to the new email feature that is usable in the training files. Also, completed faxes are shown on the Communications Log in the training files.

- **Antech Diagnostics® Module**—A training version of this module is not available in the training files. However, training is included when you purchase the Antech module or upgrade from the previous version of the module.
• **Lifelearn® ClientEd™ Online**—You can set up and synchronize Cornerstone with LifeLearn ClientEd Online documents only from your live Cornerstone database.

• **VetConnect® PLUS**—You can view VetConnect PLUS information for the following patients:
  - Zeke—Patient ID 15329 (Feline)
  - Blake—Patient ID 3679K-1 (Canine)
  - Twister—Patient ID 120Q-1 (Canine)

• **Electronic signature capture for the integrated payment solution with XCharge®**—In the training files, you can view XCharge features except the ability to capture electronic signatures.

• **Activation**—You cannot activate or set up any of the above features from the training files; you can do that only from your live Cornerstone database. Also, in the configuration windows for a multi-location single database environment, the training files do not allow you to apply primary settings to a secondary practice.

**Getting Help**

If you have a problem or question that you cannot find the answer to in the Cornerstone Help system or documentation, the following support options are available:

- Visit our online support center at [cornerstonehelp.com](http://cornerstonehelp.com).
- Email Cornerstone Support at [cornerstone@idexx.com](mailto:cornerstone@idexx.com).
- Call Cornerstone Support at **1-800-695-2877**.
Section 1–System Setup

Chapter 1: Getting Started with Cornerstone* Setup
Chapter 2: Setting Up Cornerstone* Controls
Chapter 3: Setting Up Lists and Information
Chapter 1: Getting Started with Cornerstone* Setup

Introduction
Because the IDEXX Cornerstone* Practice Management System is a flexible tool, you decide how to set up Cornerstone software to work effectively in your practice’s environment. If you don’t have a detailed plan now, you can start with general settings and add more detailed settings later. You can always add and modify settings as your practice changes. Remember, however, that the more customized settings and preferences you set up in your system now, the less likely you’ll have to make changes in client, patient, staff, and invoice item information later.

Designating a Cornerstone Administrator
Before you can begin to set up and customize your Cornerstone system to meet the needs of your practice, you must set up staff information and security for at least one staff member, ideally the designated Cornerstone Administrator or system manager. This staff member needs access to all dialog boxes/windows and reports.

Setting Security
Due to its confidential nature, specific security setup instructions are not provided in this manual. To set up security for each staff member, select Security Setup on the File menu and follow the Staff Security Guide you received separately when you purchased your Cornerstone software.

Tip: When setting up security, remember that if the dialog box name or report is selected, the staff member can access it.

Backing Up Your Cornerstone Data
There are a number of ways that data can be backed up, and your procedure may vary from that of another practice. Please refer to the instructions from your trainer or contact Cornerstone Support at 1-800-695-2877 for documentation and instructions specific to your computer system and needs.

IMPORTANT: We strongly recommend backing up your Cornerstone files daily.

Backup Tips
- Close all of the programs on the taskbar to ensure a proper backup.
- If you use tapes, replace them every 12 to 18 months.
- Keep tapes and CDs stored away from extreme cold and heat.
- Store the backups off the premises every night.
- Store tapes in the upright position to avoid creating slack.
- Keep tapes away from magnetic fields.

Note: If your practice uses one of the supported backup software packages, you can set up Cornerstone to automatically verify your backup. See “Chapter 28: Using the Backup Verification Assistant” beginning on page 446 for more information.

Viewing Current User Information: Exclusive Use
If you are running Cornerstone on a network, it is important to be the only user logged into Cornerstone when performing a mass mark up and when purging data.
To check which computers are logged into Cornerstone at any time, open the User Information dialog box.

**To view computers logged into Cornerstone:**
1. On the **File** menu, select **User Information**. The User Information dialog box displays a list of the computers currently logged into Cornerstone.

![User Information dialog box](image)

2. Click **OK** to close the dialog box.

**Changing IDs**

If you need to change a client ID, patient ID, or invoice item ID, you can do this using the Change IDs tool.

**IMPORTANT:** We strongly advise making a backup of your database before changing IDs.

**Before You Begin**
- Identify which client, patient, or invoice item IDs to change. Verify that the IDs you want to change to are not being used.
- Back up your Cornerstone database.

**To change an ID:**
1. On the **Tools** menu, select **Change ID**. The Change IDs dialog box appears.

![Change IDs dialog box](image)

2. From the **Type** drop-down list, select **Client ID**, **Invoice Item ID**, or **Patient ID**.

3. In the first available row in the **Current ID** column, type the ID or press F2 to search for and select the client, patient, or invoice item ID that you want to change. The name of the client, patient, or invoice item is displayed.
4. In the **New ID** column, type the new ID you want to use for this client, patient, or invoice item.  
   **Note:** You can change an ID only to a currently unused ID.

5. To change additional IDs (of the same type of ID), in the next available row, repeat steps 3 and 4.

6. Click **OK** to process the ID change. When you are prompted to confirm the change, click **Yes**.
   When the IDs have been processed, a message appears to notify you of the number of changes. The checkered flag indicates that the ID change was successful.

**Setting Up a Signature Capture Device**

Signature capture devices, such as signature pads and clipboards, allow you to collect, store, and include electronic signatures on documents. Compatible signature pads and clipboards can be used with your Cornerstone software to:

- Collect staff members’ signatures and store them in your software for later use.
- Allow staff members and clients to sign documents electronically.
- Capture electronic signatures when you are using the integrated third-payment solution. For more information, see “XCharge® Card Payment Processing Software” on page 26.

You can store electronic signatures on documents in patient history. Once a document that includes an electronic client signature is saved, you cannot change the document.

**Supported Signature Capture Devices**

The following signature capture devices are supported in Cornerstone:

- Topaz® ClipGem®
- Topaz SignatureGem® (SigGem)
- Topaz SigLite®

In addition, you can use a supported tablet PC to capture an electronic signature.

For information on purchasing a signature capture device or tablet PC, call IDEXX Practice Solutions at 1-888-224-4408.

**Note:** If a signature capture device will be used on a thin-client workstation, the device may need to be connected to an AnywhereUSB® device, depending on the type of signature capture device being used.

**To set up your system to use a signature capture device:**

1. On the **Tools** menu, select **Signature Capture Device**. The Signature Capture Device dialog box appears.

![Signature Capture Device dialog box]
2. Select **SigLite LCD**, **ClipGen**, or **None**, and then enter the port number.
3. Click **Test Connection** to test the device’s connection to Cornerstone.
4. Click **OK**.
Chapter 2: Setting Up Cornerstone* Controls

Overview
Controls allow you to set up your IDEXX Cornerstone* Practice Management System so that customized options (such as those for classifications, colors, reason for visit, billing messages, and units of measure) you use every day are available from predefined drop-down lists and other fields throughout the program.

When setting up Controls menu options in Cornerstone, you can:

- Activate or deactivate the status of specific settings (such as prompts, taxes, and discounts).
- Activate or deactivate specific settings that cause alerts (such as classifications and credit codes).
- Change descriptions to customize them to your practice’s needs and make them more meaningful.

Note: Cornerstone defaults are a subset of Cornerstone controls. Defaults are covered in “Chapter 4: Setting Practice and Workstation Defaults” beginning on page 83.

Updating Controls

To update items set up through the Controls menu:

1. On the Controls menu, select the type of control you want to change.
2. From the list of settings, select the setting to modify, and then click Update. The corresponding dialog box appears.
3. Update the description or other options, as applicable.
4. Click OK to save your changes.

Deleting Unused Controls

You can delete any item in a Controls menu list if the item is not linked to a patient or client record. Deleting items you’ll never use saves you time when you select information in dialog boxes.

If a controls item is being used for a client, patient, staff, invoice item, census, or other record, you cannot deleted it.

To delete items set up through the Controls menu:

1. On the Controls menu, select the type of control you want to delete.
2. From the list of settings, select the setting to remove and click Delete. When you are prompted to confirm the deletion, click OK.
   
   The deleted controls item no longer appears as a choice in dialog boxes.

User Defined Prompts

Add User Defined Prompts to customize Cornerstone for your practice. Set up prompts for standard information you record (that is not already included in Cornerstone) and then answer the prompts on the Prompts/Notes tab when adding or editing client, patient, or staff information.

Note: You should never store sensitive client data, such as credit card numbers or Social Security numbers, in Cornerstone. If you want to use Cornerstone to process payments in a manner that is PCI
PA-DSS (Payment Credit Industry Payment Application Data Security Standard) certified, be sure to use one of our approved Cornerstone payment processing integrations.

**To add or edit a prompt:**

1. On the **Controls** menu, select **User Defined Prompts**. The User Defined Prompts dialog box appears.

![User Defined Prompts dialog box](image)

2. Click the **Client**, **Patient**, **Species**, or **Staff** tab.

3. If setting up a species prompt, on the **Species** tab, in the **Species ID** text box, type the species ID or press F2 to select the species from the Species List.

   **Note:** Species prompts appear only in the Patient Information **Prompts/Notes** tab for patients of that particular species. For example, the Feline prompt *Declawed?* does not appear in a Canine patient’s prompts.

4. Click **New** to add a new prompt or double-click an existing prompt to update it. The applicable Prompts dialog box appears.

![Patient Prompts dialog box](image)

5. In the **Prompt text** text box, type the prompt or question that staff will complete when entering a patient’s information in Cornerstone. This prompt text appears in the Client Information, Patient Information, or Staff Information window and in an alert box if you use this prompt as an alert.

6. In the **Data type** area, select one of the following to determine the method for answering the prompt:
• **Character**—Answered by entering alphanumeric characters (standard text).
• **Number**—Answered by entering numeric characters (only numbers accepted).
• **Yes/No**—Answered by selecting Yes or No in response to a question prompt.
• **List**—Answered by selecting the information from a prepared list. To set up a list, select the **List** data type and then in the **List** area, click **New**. In the **Prompt List** box, type an answer to add to the list, and then click **OK**.

7. On the **Client** or **Patient** tabs, select the **Client Alert** or **Patient Alert** check box if you want to use this prompt as an alert (display an alert when the client or patient records are accessed). To select a color for the alert text, click the colored square and then select a color or define a custom color.

8. On the **Patient** tab, if you want this prompt to display as an alert on the Electronic Whiteboard windows, select the **Whiteboard Alert** check box. If you want to select a color for the alert text, click the colored square and then select a color or define a custom color.

   **Note:** If designating a Patient prompt as both a patient alert and a Whiteboard alert, the selected color will be used for both types of alerts.

9. In the **Status** area, select **Active** or **Inactive**. (Change the status to Inactive only if you no longer want this prompt to appear.)

10. Select the **Required** check box if you want the answer to this prompt to be required in order to complete the record.

11. Click **OK**, and then click **Close**.

   For a complete list of Client prompts currently set up in Cornerstone, print an **Initial Client Setup Report**.

   For a complete list of Species prompts currently set up in Cornerstone, print an **Initial Patient Setup Report** sorted by Species Prompt.

   For a complete list of Staff prompts currently set up in Cornerstone, print an **Initial Staff Prompt Report** sorted by Staff Defined Prompts.

**Classifications**

Use **Classifications** to categorize clients, patients and staff members into groups. Classifications determine:

- Which clients receive reminders.
- The types of clients or patients that need special attention (using the alert **Classification**).
- How some reports are organized.

Classifications appear in the Client Information, Patient Information, and Staff Information windows.
Before You Begin

- Before you assign an alert to a client or patient classification, you should understand how alerts are used. See “Alerts Defaults” on page 85.
- Before deciding which client classifications should receive reminders, you should have a reminder strategy. See “Reminder Strategies” on page 278.

To add or edit a classification:

1. On the Controls menu, select Classifications. The Classifications dialog box appears.

   ![Classifications dialog box](image)

2. Click the Client, Patient, or Staff tab.

3. Click New to add a new classification, or double-click an existing classification to update it. The Classification Setup dialog box appears.

   ![Classification Setup (For Client) dialog box](image)

4. In the Description text box, type an identifying name for the classification.

5. For Client classifications, do any of the following:
   - Select the Client alert check box if you want an alert to display when client records are accessed for this type of client.
   - Select the Send reminders check box if you want this type of client to receive reminders. For example, for seasonal clients, you could select the Send reminders check box in the summer months and clear the check box in the winter months when the client leaves your vicinity.
   - Select the Send statements check box if you want to send statements to this type of client.

6. For Patient classifications, do any of the following:
• Select the **Patient alert** check box if you want an alert to display when patient records are accessed for this type of patient.

• Select the **Whiteboard alert** check box if you want this classification to display as an alert on the Electronic Whiteboard windows.

7. Click **OK**, and then click **Close**.

**Note:** You can set up a default classification to use when entering new clients and patients. See “Client Defaults” on page 96 and “Patient Defaults” on page 120.

For a complete list of client classifications currently set up in Cornerstone, print an *Initial Client Setup Report* sorted by Classifications.

**Patient Colors**

You can use **Colors** to help identify your patients. The selected color displays on the Patient Clipboard* Patient information area and in the Patient Information window.

**Before You Begin**

➢ If you started with a Fastart* or FastInstall database, review the colors that are already set up in the Colors dialog box before adding new colors.

**To add or edit a patient color:**

1. On the **Controls** menu, select **Colors**. The Colors dialog box appears.

2. Click **New** to add a new patient color, or double-click an existing color to update it. The Patient Color Setup dialog box appears.

3. In the **Description** text box, type an identifying name for this color.

4. Click **OK**, and then click **Close**.

**Note:** While you are can manually enter a color when setting up a patient record, the new color is not added to the list of colors. Only patient colors added using **Controls > Colors** are included in reports.

**Reasons for Visit**

The Reason for Visit feature allows you to assign primary and secondary reasons to a patient’s visit to indicate why the patient is being seen at the practice. This information helps staff to better prepare for scheduled appointments and monitor inpatients on the Electronic Whiteboard.

When you set up reasons for visit, keep in mind that the primary reason typically indicates the general type of visit, and the secondary reason is typically used to provide more detail on the specific problem or procedure. For example, if the primary reason is Surgery, the secondary reason might be Spay/Neuter, Hip replacement, Cruciate, or Orthopedic.

Note that secondary reasons are not tied to any particular primary reason—at the time of use, any secondary reason can be selected along with any primary reason. Also note that at the time of use, the primary reason must be selected from your predefined list, but you can type any secondary reason in the **Secondary** text box (you do not have to select it from a list).

**Tip:** To avoid staff having to select from a long list of secondary reasons, you may want to set up the predefined list with only the most common secondary reasons and instruct staff to type other secondary reasons as needed.

If you use the Appointment Scheduler, once you have set up your reasons for visit, you can then set up the color codes, fees, staff, and staff time involved for appointments using these reasons for visit (in

To add or update reasons for visit:


   ![Reasons for Visit dialog box]

2. To add or update a primary reason for visit, in the Primary reason for visit area, click New to add a new primary reason, or double-click an existing reason to update it. The New/Update Primary Reason dialog box appears.

   ![New/Update Primary Reason dialog box]

3. In the Description text box, type a brief identifying name for this primary reason (for example; Surgery, Annual Exam, Grooming).

4. To display a pop-up window that reminds staff of specific information related to this reason for visit, type the information in the Alert note text box (to start a new line, press CTRL+ENTER). When this reason is selected while making an appointment or checking in a patient, a pop-up window displays the information for staff.
For example, when Surgery is selected as the reason for visit, you may want to alert staff with a reminder to discuss the importance of preanesthetic testing. Another example would be displaying an alert to remind staff that a CBC is required when an Annual Exam reason is selected.

5. To link a specific Cornerstone document or documents with this reason for visit so the document prints when the patient is checked in or checked out (for example, link a surgery consent form to Surgery), do the following:
   a. In the Doc ID column of the Patient check-in/out documents area, type the document ID or press F2 to select the document from the Document Template List.
   b. Click the Check-in/out icon to specify if the document should print at check-in time or check-out time:
      - Yellow arrow “in” icon—Document prints at check-in time.
      - Green arrow “out” icon—Document prints at check-out time.
   c. Repeat steps a–b for each document you want to link to this reason for visit.

   **Note:** You can also add or remove documents at check-in time.

6. Click OK to save and return to the Reasons for Visit dialog box.

7. To add or update a secondary reason for visit, in the Secondary reason for visit area, click New to add a new secondary reason, or double-click an existing reason to update it. The New/Update Secondary Reason dialog box appears.

8. In the Add/Update Secondary Reason for Visit text box, type a brief identifying name for this secondary reason (for example; Cruciate, Glucose Curve, Foreign Body Ingestion) and click OK.

9. Click OK.

**Patient Sexes**

Use **Patient Sex** to identify and classify patients, as well as assign the **Modified sex** to apply if a sex changes when certain surgeries (such as ovariohysterectomy) are performed.

**Note:** For a service that changes a patient’s sex, you can set up the service’s invoice item to initiate the Sex Modification special action. When the service is invoiced, if you have assigned a Modified sex for the applicable patient sex, Cornerstone automatically processes the special action during invoicing. See “Setting Up Invoice Items to Initiate a Special Action” on page 202 for more information.

**Before You Begin**

➢ If you started with a Fastart or FastInstall database, review the patient sexes and modified sexes already set up in the Patient Sex dialog box.

**To add or edit a patient sex designation:**

1. On the **Controls** menu, select **Sex**. The Patient Sex dialog box appears.

2. Click **New** to add a new patient sex, or double-click an existing patient sex designation to update it. The Patient Sex Setup dialog box appears.
3. In the **Description** text box, type an identifying name for the patient sex designation you are adding.
4. If this sex changes when certain surgeries are performed, select the appropriate **Modified sex**.
5. If you need to provide state-required controlled substance information, select the applicable **Male** or **Female** option. See “Controlled Substance Export List” on page 33 for more information on the controlled substance export program.
6. Click **OK** and then click **Close**.

### Payment Types

Use **Payment Types** to set up the types of payments you accept in your practice. When a client makes a payment, you must enter a payment type in the Payment dialog box. Payment Types are important because they determine how payments appear in certain reports. For example, any payment type of Check appears on the Deposit Report - Checks. Cornerstone uses Cash, Check, and Other as general payment categories in other reports.

You can also add a prompt to a payment type. For example, add a Check Number prompt to a Check payment type to collect detailed information about the payment.

**Before You Begin**

- If you started with a Fastart or FastInstall database, review the payment types already set up in the Payment Types dialog box.

**To set up a payment type (for non-credit/debit card payment types):**

Note: For information on setting up credit or debit card payment types in Cornerstone, see “Credit and Debit Payment Types” on page 26.

1. On the **Controls** menu, select **Payment Types**. The Payment Type dialog box appears.
2. Click **New** to add a new payment type, or double-click an existing payment type to update it. The Payment Type Setup dialog box appears.
3. In the **Description** text box, type an identifying name for this payment type.
4. In the **Prompt** text box, if applicable, type a prompt to appear when this payment type is selected.
5. If your practice uses the General Ledger Interface, type an account name or number in the GL Account box.

6. In the Type area, select Check or Other.

7. If your practice uses the General Ledger Interface, use the options in the Service charge area to automatically calculate a service charge total amount. For example, if you want to know how much in service charges your practice owes American Express, you can set up your payment type to calculate this total. Select one of the following service charge options:
   - To calculate a percentage, select Percentage and enter the percentage amount in the Amount text box.
   - To calculate a flat amount, select Amount and enter the total in the Amount text box.
   - If you don’t want to calculate a service charge on this payment, select None.

   Note: This information is available only on the GL Batch Report. It does not appear on any other Cornerstone reports.

8. Click OK, and then click Close.

9. If this is a new payment type, be sure to add it to the applicable credit codes you have set up in Cornerstone. See “Credit Codes” on page 28 for information.

Credit and Debit Payment Types
Cornerstone offers a simple and secure solution for integrated credit card processing. Cornerstone works with a third-party payment provider to process credit and debit card transactions through an Internet connection.

XCharge® Card Payment Processing Software
XCharge® software, developed by Accelerated Payment Technologies™, provides third-party card payment processing for Cornerstone. XCharge is a secure and simple-to-use solution that processes both credit and debit card transactions in the United States and Canada.

Note: Credit card numbers are not stored within Cornerstone—the XCharge software, which functions outside of Cornerstone, shields Cornerstone from this information.

Getting Started with XCharge

Step 1–Apply for an XCharge Merchant Account
Contact Accelerated Payment Technologies at 1-888-412-3433 to get started on setting up your XCharge merchant account. You will need to have your business and banking information (Tax ID number, bank account number, bank routing number, etc.) ready when you call. Once approved, you will receive your merchant account number (merchant ID).

Note: If your practice plans to require address verification and/or the CVV2/CVC2 (Card Verification Value/Card Verification Code) when a credit card number is manually entered, notify Accelerated Payment Technologies of this requirement at application time when setting up your merchant account. (Address and CVV2/CVC2 verification is available only in the United States.)

Step 2–Install, set up, and receive training on the XCharge software
An XCharge representative will work with you to install the XCharge software and configure the settings to meet the needs of your practice. In a phone-based installation and training session, your XCharge representative will provide training on setting up users, receipt printing and PIN pad and/or
card swipe reader devices. Your XCharge representative will also walk you through a basic transaction and answer any questions that may arise.

**Step 3—Set up your payment types in Cornerstone**

In Cornerstone, set up payment types for credit and debit payments and specify XCharge as the provider for these payment types. See “Credit and Debit Payment Types” on page 26 for more information.

**Step 4 (Optional)—Set up a signature capture device**

Use a supported signature capture device or tablet PC to capture a client’s electronic signature for all credit card payments. This helps you have fewer paper receipts to manage. For more information, see “Setting Up a Signature Capture Device. For more information, see “Setting Up a Signature Capture Device” on page 16.

**If You Need Help Processing Card Payments with XCharge**

Once you have installed the XCharge software, you can access the XCharge Help and manual from the Help menu within the XCharge software.

If you cannot find the answer to your question in the Help or manual, you can contact Accelerated Payment Technologies Customer Care for technical support toll-free at 1-800-338-6614.

**Setting Up Payment Types for Credit and Debit Payments**

Like other payment types in Cornerstone, the credit card and debit card payment types are set up using `Controls > Payment Types`. These payment types, however, include special setup options that you must configure in addition to the standard payment type options.

**To set up credit/debit card payment types in Cornerstone:**

1. On the `Controls` menu, select `Payment Types`.
2. Select the `Credit Card Payment` (or `Debit Card Payment`) payment type and click `Update`. A `Payment Type Setup` message appears. Click `OK` to close the message box.
3. On the Payment `Type Setup dialog` box, select the `Activate Credit Card Payment Solutions` check box (or the `Activate Debit Card Payment Solutions` check box).
Chapter 2: Setting Up Cornerstone* Controls

Payment Type Setup for Credit Card Payments

4. Click **Configure Payments Solution**. The Credit/Debit Payment Setup dialog box appears.

5. From the **Provider** drop-down list, select the third-party payment solution.

6. Complete the associated fields in the **Settings** area and, if available, click **Setup** to specify additional provider setup options.
   
   **Note:** If you are using a signature capture device for electronic signatures, select the Enable electronic signature capture check box.

7. When you complete the setup for the third-party provider settings, click **OK** on the Credit/Debit Payment Setup dialog box to return to the Payment Type Setup dialog box.

8. In the **Defaults** area, set the following options as needed for your practice:
   
   - **Default amt from invoice**—Select the default payment amount to use if you access the Payment dialog box through an invoice. If you want the default payment amount to come from an open invoice, select **Invoice Amount**. If you want the default payment amount to come from the client’s account balance, select **Client Balance**.
   
   - **Default amt from Client Account**—Select the default payment amount to use if you access the Payment dialog box through a client account. If you want the default payment amount to come from the client’s account balance, select **Client Balance**.

9. If your practice uses the General Ledger (GL) interface for exporting financial data to a file, you can select one of the following options for exporting the card payment data:
   
   - In the **Information** area’s **GL Account** text box, type an account name to use for exporting credit (or debit) card payment data—all payments for this payment type will be listed together under this one account name.
   
   - In the **GL Account Names** area, select the **Breakout GL totals** check box, and then in each of the corresponding text boxes (**Credit**, **Amex**, **Debit**), type the account name to use for each card type when exporting data.

10. In the **Select credit codes** area, add this payment type to the applicable credit codes you have set up in Cornerstone (in **Controls > Credit Codes**) by selecting the credit code(s) in the list.

11. Click **OK**, and then click **Close** to close the Payment Types dialog box.

**Credit Codes**

Cornerstone uses **Credit Codes** to group payment types so that you can specify what types of payments you accept from a particular client. When specific payment types are linked to credit codes, a message appears if you try to post an unacceptable payment type.

For example, for a credit code called No Checks, you could allow all payment types except for Check. After setting up credit codes, you can assign a default credit code to use when setting up new clients. See “Client Defaults” on page 96.

**IMPORTANT:** You must assign a credit code to each client. (Credit codes are assigned in the **A/R Information** tab in the Client Information window.)

**Before You Begin**

- Make sure that you have set up all of your payment types before setting up credit codes.
To add or edit a credit code:
1. On the Controls menu, select Credit Codes. The Credit Codes dialog box appears.
2. Click New to add a new credit code, or double-click an existing code to update it. The Credit Code Setup dialog box appears.
3. In the Description text box, type an identifying name for this credit code.
4. Select the Alert check box if you want an alert to appear when accessing information for a client who is set up with this credit code. The alert displays in red.
5. In the Payment types allowed list, select one or more payment types allowed under this credit code.
   **Note:** Only payment types selected in the Payment types allowed list are used during invoicing.
6. Click OK, and then click Close.
   
   For a complete list of credit codes currently set up in Cornerstone, print an Initial Practice Setup Report by Credit Codes.

**Taxes**
You can set up Taxes to use multiple tax rates in Cornerstone. This is convenient if you need to apply different taxes to certain invoice items or if you have more than one tax per item.

To add or edit a tax:
1. On the Controls menu, select Taxes. The Taxes dialog box appears.
2. Click New to add a new tax, or double-click an existing tax to update it. The Tax Setup dialog box appears.
3. In the Description text box, type an identifying tax name to appear on the invoice.
4. In the Percentage text box, type the percentage to use for this tax.
5. If your practice uses the General Ledger Interface, type an account name or number in the **GL Account** text box.

6. In the **Status** area, select **Active** or **Inactive**. Only Active taxes are used in invoices. (Change the status to Inactive only if you no longer want to use a tax.)

7. Click **OK**, and then click **Close**.

### Discounts

You can set up **Discount** percentages in Cornerstone. Client discounts vary from one practice to another. If you plan to use a discount provided in the Cornerstone database, you must set the discount percentage (the percentages are initially set at 0).

Discounts are tied to invoice items and clients. If a discount is assigned to an invoice item and the same discount is assigned to a client’s account, when the client is invoiced for the invoice item, the discount is applied to that specific invoice item.

To add or edit a discount:

1. On the **Controls** menu, select **Discounts**. The Discounts dialog box appears.
2. Click **New** to add a new discount, or double-click an existing discount to update it. The Discount Setup dialog box appears.

   ![Discount Setup dialog box](image)

   - In the **Description** text box, type an identifying discount name to appear on the invoice.
   - In the **Percentage** text box, type the percentage to use for this discount.
   - If your practice uses the General Ledger Interface, type an account name or number in the **GL Account** text box.
   - In the **Status** area, select **Active** or **Inactive**. Inactive discounts do not appear in any of the lists of available discounts and are not applied to invoice items. Any previous links to invoice items or clients are broken. (Change the status to Inactive only if you no longer want to use a discount.)
3. Click **OK** and then click **Close**.

### Billing Messages

You can print customized **Billing Messages** at the bottom of invoices, statements, and estimates. You can use these billing messages as part of your marketing plan for making announcements or for communicating general information. You can set up an unlimited number of messages and then determine which message you want to print by default on invoices, statements, and estimates.

**Tip:** Change your billing messages periodically to work with your marketing plan.

To add or edit a billing message:

1. On the **Controls** menu, select **Billing Messages**. The Billing Messages dialog box appears.
2. Click **New** to add a new message, or double-click an existing message to update it. The Billing Message Setup dialog box appears.

   ![Billing Message Setup](image1)

   Billing Message Setup dialog box

3. In the **Description** text box, type an identifying name for this billing message.
4. In the **Message contents** box, type the message text to appear for this billing message.
5. Click **OK**, and then click **Close**.

**Tip:** Set up a billing message named **Blank** with no text to use when you want to type a customized message on an invoice, estimate, or statement.

For a complete list of billing messages currently set up in Cornerstone, print an **Initial Practice Setup Report by Billing Messages**.

**Estimate Messages**

You can create **Estimate Messages** to be used on estimates at your practice. When you generate estimates for patients, click the **Messages** button to access a list of predefined estimate messages. Multiple messages can be printed on an estimate.

**To add or edit an estimate message:**

1. On the **Controls** menu, select **Estimate Messages**. The Estimate Message List dialog box appears.
2. Click **New** to add a new message, or double-click an existing message to update it. The Estimate Message Information window appears.

   ![Estimate Message Information](image2)

   Estimate Message Information window

3. In the **ID** text box, type the ID to use for the estimate message.
4. In the **Description** text box, type an identifying name for this estimate message.
5. Under **Estimate message**, type the text for this estimate message.
6. Click **OK**, and then click **Close**.
Invoice Types
You can select an **Invoice Type** for each invoice. Invoice types allow you to analyze the productivity of different areas of your practice. You can also use invoice types to prevent certain invoices (such as hospitalization) from closing at the end of the month.

**To add or edit an invoice type:**
1. On the **Controls** menu, **Invoice Types**. The Invoice Types dialog box appears.
2. Click **New** to add a new invoice type, or double-click an existing invoice type to update it. The Invoice Type Setup dialog box appears.
3. In the **Description** text box, type an identifying name for this invoice type.
4. Select the **Close at end of month** check box if you want Cornerstone to automatically close any invoice of this type during End of Month processing. Clear the **Close at end of month** check box if you want invoices of this type to remain open when you process End of Month.
5. Click **OK** and then click **Close**.

Units of Measure
Each item in your inventory is sold in a Unit of Measure (UOM), such as bag, bottle, can, capsule, or tablet. A variety of common weights, measurements, and amounts are predefined for you in the Cornerstone software, but, if needed, you can set up additional units of measure.

**Note:** If you do not assign a UOM to an invoice item, Cornerstone uses the UOM specified in Invoice Item defaults (see "Invoice Item Defaults" on page 116).

**Before You Begin**
- If you started with a Fastart or FastInstall database, review the weights, measurements, and amounts already set up in the Invoice Item Units of Measure dialog box. If your practice uses the metric system, you may need to replace certain measurements with metric units.

**To add or edit a unit of measure:**
1. On the **Controls** menu, select **Units of Measure**. The Invoice Item Units of Measure dialog box appears.
2. Click **New** to add a new UOM, or double-click an existing UOM to update it. The Invoice Item Unit of Measure Setup dialog box appears.
3. In the **Description** text box, type an identifying name for this unit of measure.
4. Click **OK**, and then click **Close**.
Price Change Reasons
You can specify if the prices on invoice items can be changed. If prices can be changed, your practice can set up **Price Change Reasons** to track why a price was changed. For example, if Dr. Smith approved a price change on the invoice, you might use a price change code called “Dr. Smith approved.”

**Note:** If you want to require that a reason is selected when an item’s price is changed, you must set the item’s **Allow change** setting to **Only with reason** (on the **Info** tab in Invoice Item Information). See “Setting Up Invoice Item Information” on page 186 for more information.

**To add or edit a price change reason:**
1. On the **Controls** menu, select **Price Change Reasons**. The Price Change Reason List dialog box appears.
2. Click **New** to add a new reason, or double-click an existing reason to update it. The Price Change Reason Information dialog box appears.

   ![Price Change Reason Information dialog box]

3. In the **Reason Code** text box, type a reason code (up to three letters or numbers) to assign to this price change reason.
4. In the **Reason** text box, type a brief explanation describing the reason for the price change (for example; Group Item Discount, Free Dose, As per Dr. ____).
5. From the **Status** drop-down list, select **Active** or **Inactive**. (Change the status to Inactive only if you no longer want to use this reason code.)
6. Click **OK**, and then click **Close**.

   When a price is changed, the reason prints on the **Standard Fee Exception Report**, along with the staff member who changed the price.

Controlled Substance Export List
Cornerstone provides an export **Controlled Substance** feature that exports state-required controlled substance information from Cornerstone to a file that can be sent by email or FTP to the appropriate state agency.

**Before You Begin**

- Contact your state’s controlled substance agency to obtain the state’s electronic filing form requirements.

**IMPORTANT:** We recommend keeping a paper record of your practice’s controlled substance information until your state confirms that the electronic filing form that you submit includes all required information.
To add or edit a controlled substance electronic filing form to export:

1. On the Controls menu, select Controlled Substance > Controlled Substance Export. The Controlled Substance Export List appears.

2. Click New to add a new export form, or double-click an existing export form to update it. The Controlled Substance Export List dialog box appears.

3. In the Export ID text box, type an ID for this filing form.

4. In the Description text box, type an identifying name for this filing form.

5. In the Male flag and Female flag text boxes, refer to your state’s controlled substance document and type the required information.

6. Click in the Date format text box, and from the drop-down list, select the date format specified by your state.

   IMPORTANT: In the Export data area, required data items must be entered in the order provided on your state’s controlled substance requirements document.

7. Click in the Field column and select the applicable data item from the drop-down list. If the data item is not available, select Filler to save space for the item (you will enter the filler characters in step 12).

8. In the Justification column, refer to your state’s requirement document and select the applicable right or left justification option from the drop-down list.

9. In the Field Length column, refer to your state’s requirement document and type the required number of characters for the data item.

10. If Client User Defined Prompt is selected in the Field column, in the Client Prompt column, select the required data from the drop-down list.

11. If Patient User Defined Prompt is selected in the Field column, in the Patient Prompt column, select the required data from the drop-down list.
12. If Fill is selected in the Field column; in the Filler character column, type the characters to use for the filler or leave it blank.

13. To move an item up or down the list, click the item and then click the ↑ or ↓ arrow button.

14. When you have entered the required information, click OK, and then click Close.

**To export the controlled substance electronic filing form:**

1. On the Controls menu, select Controlled Substance > Controlled Substance Export. The Controlled Substance Export List dialog box appears.

2. In the list, select the applicable state filing form and click Export. The Controlled Substance Export dialog box appears.

   ![Controlled Substance Export dialog box](image)

3. In the Date range area, in the Start date and End date text boxes, type the dates that apply to this controlled substance export.

4. In the File information area, note the path and file name for the electronic filing form (a .txt file). The default folder is C:\Cstone\Share\CS_Export.

5. Click OK, and then click Close.

   After the electronic filing form (.txt file) has been generated, retrieve it from the folder where it is stored and send it by email or FTP to the appropriate state agency.

**Controlled Substance Reasons**

You can set up a Controlled Substance Reasons list to use when a controlled substance is added to an invoice. Some common reasons are included with your software. When a controlled substance is added to an invoice, the list of controlled substance reasons appears. From the list, select the reason for which the controlled substance is used. This reason prints on the Controlled Substance Log so that you can track why the controlled substance was used.

**To add or edit a controlled substance reason:**

1. On the Controls menu, select Controlled Substance > Controlled Substance Reasons. The Controlled Substance Reason List dialog box appears.

2. Click New to add a new reason or double-click an existing reason to update it. The Controlled Substance Reason Information dialog box appears.

3. In the Description text box, type an identifying name to indicate the reason a controlled substance would be used.

4. From the Status drop-down list, select Active or Inactive. (Change the status to Inactive only if you no longer want to use this controlled substance reason.)

5. Click OK, and then click Close.
Note: After you create a list of reasons for the use of controlled substances, you must select the Use controlled substance reasons check box in Invoice defaults to display the controlled substance reasons in invoicing. See “Invoice Defaults” on page 112.

For a list of controlled substances that are invoiced in Cornerstone, print a Controlled Substance Report. (See “Controlled Substance Report” on page 247 for more information.)

Problem List
The Problem List provides a list of common medical ailments and issues. You can use this list when you enter medical notes on the patient record.

To add or edit a problem category:
1. On the Controls menu, select Problems > Problem Categories.
2. Click New to add a new category, or double-click an existing category to update it. The Problem Category Information dialog box appears.
3. In the Description text box, type an identifying name for this problem category.
4. Click OK, and then click Close.

To add or edit a problem on the Problems List:
1. On the Controls menu, select Problems > Problem List. The Problem List dialog box appears.
2. Click New to add a new problem, or double-click an existing problem to update it. The Problem Information dialog box appears.
3. In the ID text box, type the ID to use for this problem (for example, an abbreviation of the problem).
4. In the Description text box, type the description of the problem.
5. From the Severity drop-down list, select the severity (Major or Minor) that would most commonly be assigned for this problem. You can change the severity when recording the problem in the patient record.
6. From the State drop-down list, select the state (Active, Acute, Chronic, Resolved or Verified incorrect) that would most commonly be assigned for this problem. You can change the state when recording the problem in the patient record.
7. From the **Status** drop-down list, select **Active** or **Inactive**. (Change the status to Inactive only if you no longer want to use this problem.)

8. Click **OK**, and then click **Close**.

**Initial Setup Reports**

Cornerstone includes several reports that show you how the system is currently set up. Reviewing these reports will help you maintain your system.

**Note:** You must have your practice information entered to see data in the initial setup reports. See “Practice Information” on page 41.

**Initial Client Setup Report (Report Group: Client)**

Use the Initial Client Setup Report to review your Cornerstone system settings.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Reminders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breeder</td>
<td>Yes</td>
</tr>
<tr>
<td>Buy/Sell Customer</td>
<td>Yes</td>
</tr>
<tr>
<td>Form</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Initial Client Setup Report**

**Client Defined Prompts**

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Data Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver's License Number</td>
<td>Character</td>
<td>Active</td>
</tr>
<tr>
<td>Employer</td>
<td>Character</td>
<td>Active</td>
</tr>
</tbody>
</table>


Print the Initial Patient Setup Report before setting up species and breeds. To see the species prompts currently set up in your Cornerstone system, select the **Species Prompt** sort order.

<table>
<thead>
<tr>
<th>Species</th>
<th>Prompt Text</th>
<th>Data Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cat</td>
<td>ODDM00pet</td>
<td>Yes/No</td>
<td>Active</td>
</tr>
</tbody>
</table>

**Initial Patient Setup Report**

**Species/Breed Report**

<table>
<thead>
<tr>
<th>Species/Breed Description</th>
<th>Species/Breed Description</th>
<th>Species/Breed ID</th>
<th>Species Type</th>
<th>Unit of Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>African</td>
<td></td>
<td>AU1</td>
<td>Small</td>
<td>grams</td>
</tr>
<tr>
<td>Amazon, Blue Finned</td>
<td></td>
<td>ABF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Initial Practice Setup Report By Billing Messages (Report Group: Practice)

This report shows all the billing messages that you have set up for your practice.

<table>
<thead>
<tr>
<th>Default Messages</th>
<th>Description</th>
<th>Billing Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement</td>
<td>Estimate</td>
<td>Usually prior arrangements have been made with the office, full payment is due upon receipt of this statement.</td>
</tr>
<tr>
<td></td>
<td>New Computer Thank You</td>
<td>We appreciate your patience while we are learning to use our new computer. We know this will allow us to better meet the needs of you and your needs.</td>
</tr>
<tr>
<td>Estimate</td>
<td>Estimate</td>
<td>This estimate is good for 30 days and includes only those items listed. Payment will be required when your bill is released from the hospital.</td>
</tr>
</tbody>
</table>

Initial Practice Setup Report By Credit Codes (Report Group: Practice)

This report shows all the credit codes that you have set up for your practice.

<table>
<thead>
<tr>
<th>Credit Code Description</th>
<th>Payment Type Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>Americans Express</td>
</tr>
<tr>
<td>Cash</td>
<td>Cash</td>
</tr>
<tr>
<td>Cash</td>
<td>Check</td>
</tr>
<tr>
<td>Cash</td>
<td>Discover Card</td>
</tr>
<tr>
<td>Check</td>
<td>Master Card</td>
</tr>
<tr>
<td>Check</td>
<td>Money Order</td>
</tr>
<tr>
<td>Discover Card</td>
<td>Other Credit Card</td>
</tr>
<tr>
<td>Master Card</td>
<td>Visa</td>
</tr>
</tbody>
</table>

Initial Practice Setup Report By Estimate Messages (Report Group: Practice)

This report shows all the estimate messages that you have set up for your practice.

<table>
<thead>
<tr>
<th>Message Description</th>
<th>Message ID</th>
<th>Default Order</th>
<th>Estimate Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment is required</td>
<td>30</td>
<td>1</td>
<td>30 days Payment is required before services are rendered. This estimate is good for 30 days.</td>
</tr>
</tbody>
</table>

Problem List Setup Report (Report Group: Practice)

This report provides a list of problems and shows severity and status.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Severity</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Abdominal Enlargement</td>
<td>Nil</td>
<td>Active</td>
</tr>
<tr>
<td>1A</td>
<td>Abdominal Non-Respiratory</td>
<td>Nil</td>
<td>Active</td>
</tr>
<tr>
<td>100</td>
<td>Child Pain</td>
<td>Nil</td>
<td>Active</td>
</tr>
<tr>
<td>101</td>
<td>Child Ulcers</td>
<td>Nil</td>
<td>Active</td>
</tr>
<tr>
<td>102</td>
<td>Parental Demises</td>
<td>Nil</td>
<td>Active</td>
</tr>
<tr>
<td>104</td>
<td>Pain Muscle Membranes</td>
<td>Nil</td>
<td>Active</td>
</tr>
</tbody>
</table>
Initial Staff Setup Report (Report Group: Staff)

This report shows the custom staff prompts designed for your system.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Data Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Code</td>
<td>Character</td>
<td>Active</td>
</tr>
<tr>
<td>Sec. Sec. Number</td>
<td>Character</td>
<td>Active</td>
</tr>
<tr>
<td>Sponsor's Name</td>
<td>Character</td>
<td>Active</td>
</tr>
</tbody>
</table>
Chapter 3: Setting Up Lists and Information

Overview
List information in the IDEXX Cornerstone* Practice Management System is generally associated with some type of ID (such as client ID, patient ID, species ID, or staff ID) that you set up based on the needs of your practice using the Lists menu. After you have entered your List information, you can press F2 (or double-click) in certain fields to search for and select the needed information.

Updating List Items

To update a List item's information:
1. On the Lists menu, select the type of list item you want to change.
2. From the List, select the item to update and click Update (or double-click the item). The appropriate window appears.
3. Update the information, as applicable.
4. Click OK, and then click Close.

Note: Making certain changes may lead to meaningless information.

Deleting Unused List Items

Note: When you delete a specific item from a Lists menu, it no longer appears as a choice in dialog boxes or in F2 searches.

You can delete any item in a List if the item is not linked to a patient, client or invoice item record. Deleting items you’ll never use saves you time when you select information from windows.

Some information dialog boxes contain subsets of information that you may want to remove. (For example, you may want to remove an invoice item subclass from an invoice item classification or an owner from a patient.) To do this, follow the instructions in the “To delete information from within Information dialog boxes” section below.

Note: You cannot delete the postal code that is set up in Client defaults and you cannot delete a VPI® (Veterinary Pet Insurance) diagnostic code.

To delete items set up through the Lists menu:
1. On the Lists menu, select the type of List item you want to delete.
2. In the list, select the item to remove and click Delete. You are prompted to confirm the deletion. Click Yes.

To delete information from within Information dialog boxes:
1. From the list, select the item to remove information from and click Update (or double-click the item).
2. Select the row with the information to delete.
3. Press the DELETE key to delete.
Practice Information
Practice information includes the practice name, address, phone number, and other practice-specific settings. Enter this information exactly as you want it to appear on invoices, statements, and estimates. Include only practice phone numbers that you want your clients to use.

Note: You must have your practice information entered to see data in the initial setup reports.

Setting Up Practice Information for a Single Location Configuration (Standard)
The Single Location configuration is the standard (default) practice setup in Cornerstone. With this type of setup, a single practice name, practice ID, and practice address is configured, and no additional setup is required.

To enter practice information for a Single Location configuration:
1. On the Lists menu, select Practice. The Practice List dialog box appears.
2. With your practice name selected, click Update (or double-click the practice). The Practice Information dialog box appears.
   
   Note: With a standard Single Location configuration, there can be only one practice set up in the Practice List. If you click New, a “Please call Cornerstone Support to set up multiple practices” message appears.

3. In the Practice Information area, edit the practice name and address information, if necessary.
4. In the Settings area, edit the following information, if necessary:
   - Revenue Center—If you want to specify the revenue center to use for the practice when adding an item to an invoice, type the revenue center ID or press F2 to use the Revenue Center List. When adding an item to an invoice, Cornerstone checks for an assigned revenue center in this order: 1) the individual invoice item, 2) the invoice item classification, 3) the staff member’s defaults, and 4) the practice default revenue center.
Note: Cornerstone does not use the revenue center that’s assigned to the practice unless you remove the revenue center from the Staff defaults (or from the individual invoice item or invoice item classification).

- **Practice ID**—Type up to three alphanumeric characters to use as the abbreviated practice name throughout Cornerstone.

- **LabREXX ID**—If applicable, type the IDEXX LabREXX® ID for the practice (all practices may use the same ID or each practice may have its own ID). This is the ID that identifies this practice to IDEXX Reference Laboratories when printing LabREXX forms. You must enter this ID before the LabREXX feature can be turned on in the Lab Information setup.

- **Practice Color**—You can select a color to use as the identifying color for the practice throughout Cornerstone and on the status bar at the bottom of the main Cornerstone application window. **Note:** This color identifier is used with a Multi-Location/Single Database configuration and is not necessary for a Single Location configuration.

5. In the **Login/Password Management** area, set up login and password information for the following features:

- **Antech Reference Lab Results** – The Antech Diagnostics® laboratory module allows you to order tests online and automatically download results. Contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for information about purchasing and activating the Antech Diagnostics laboratory module. For detailed information on setting up and using the Antech Laboratory module, see the help within Cornerstone.

   **To activate the Antech Diagnostics Laboratory Module:**
   a. From the **Account information for** drop-down list, select **Antech Reference Lab Results**.
   b. If you already have Antech set up in Cornerstone, click **Apply Primary Practice Settings**. The account information boxes are automatically completed.
   c. If you don’t already have existing Antech account information, enter the information provided when you set up your account.
   d. Click **Test**. Then, when the Login Settings Passed message appears, click **OK**.

- **Communications – Email** – Use IDEXX Email Service to email medical notes, correspondence documents, and estimates directly from the Cornerstone Editor (this service must be activated in Cornerstone). To activate Communications Management email features, you may need to perform a one-time setup to specify your account information. If you are already using Microsoft® Outlook® for email, this setup is not necessary.

   **To activate IDEXX Email Service and set login/password settings:**
   a. From the **Account Information for** drop-down list, select **Communications – Email**.
   b. Select the email service you prefer to use:
      o **My Desktop email client**—Select this option if you plan to use your existing email software.
        **Note:** This will already be selected if you are using your existing email software. You must have properly configured software to use this option.
      o **Cornerstone Imaging SMTP email settings**—Select this option if you want to use the SMTP (web-based mail, such as Gmail™ and Hotmail®) set up in Imaging defaults. To
view and edit current settings, click the **edit imaging SMTP settings** link to open the Configuration window and click **Email** to view the default settings. For more information, see “Image Email Defaults” on page 158.

- **Communication – Fax** – Use IDEXX Faxing Service to fax medical notes, correspondence documents, and estimates directly from the Cornerstone Editor (this service must be activated in Cornerstone). To activate IDEXX Faxing Service, you must be an administrator or be provided administrative rights and complete the activation setup process below. For more information on the IDEXX Faxing Service, contact Cornerstone Support at 1-800-695-2877.

  **To activate IDEXX Faxing Service and set login/password settings:**
  
  a. From the **Account information for** drop-down list, select **Communication – Fax**.
  
  b. Select the **Use IDEXX Faxing Service** check box. A pop-up box displays the terms and conditions of use.
  
  c. Review the terms and click **Accept** to activate the service.

  Upon successful activation, the system will log the user who enrolled the IDEXX Faxing Service. In the Practice Information window, the name, time/date stamp, and a link to the IDEXX Faxing terms and conditions are displayed. Note that all practices in a Multi-Location/Single Database configuration must accept the terms and conditions.

  **To terminate IDEXX Faxing Services:**
  
  a. On the menu bar, select **Lists > Practice**. The Practice List dialog box appears.
  
  b. With your practice name selected, click **Update** (or double-click the practice). The Practice Information dialog box appears.
  
  c. On the Practice Information window, in the **Login/Password Management** area, select **Communications – Fax** from the **Account information for** drop-down list.
  
  d. Clear the **Use IDEXX Faxing Service** check box.
  
  e. Click **OK** when you are prompted to confirm your intent to terminate the service.

  **To reactivate IDEXX Faxing Services:**
  
  ➢ If you have previously activated and then terminated the IDEXX Faxing Service, follow the instructions for initial activation and enrollment, select the **Use IDEXX Faxing Service** check box, and follow the same steps involved in the initial activation.

  **Note:** You must agree to the terms and conditions again and **will** be subject to the activation setup fees agreed to in the terms and conditions.

- **Vendor – MWI Veterinary Supply** – IDEXX SmartOrder* electronic inventory ordering in Cornerstone allows for a more efficient inventory work flow with real-time online inventory ordering through MWI® Veterinary Supply. For additional information, see the “Electronic Inventory Ordering” help topic in Cornerstone.

  IDEXX SmartOrder service requires the following:

  - Have or establish an account with MWI at mwivet.com. If you do not have an account, contact your MWI representative.
    
    o New MWI customers must contact MWI to set up your account and activate online ordering with mwivet.com. If you do not have an account set up, contact your MWI representative.
Existing MWI customers can use their current MWI customer number to activate electronic inventory ordering in Cornerstone, but you must also contact MWI to enable online ordering through MWI.

- A consistent, high-speed Internet connection.

**To activate IDEXX SmartOrder service and set login/password settings for MWI Veterinary Supply:**

a. From the Account Information for drop-down list, select Vendor – MWI Veterinary Supply.

b. From the Associated Cornerstone Vendor drop-down list, select the practice-specific vendor associated with MWI to use for this service.

c. In the Customer Number text box, enter your practice’s MWI customer number. You can find this information on your mwivet.com account.

d. Select the **Enable Online Ordering** check box.

e. A pop-up box displays the terms and agreement. Review the terms and click **Accept** to activate the service.

f. When you are notified that activation was successful, click **OK**.

Click **Test** to verify that you have a working Internet connection and valid login information for accessing the vendor’s online ordering system.

In the Practice Information window, the user acceptance, date/time stamp, and a link to the MWI terms and agreement is displayed when online ordering is enabled.

**Note:** You have now setup Cornerstone for online ordering. If you have not contacted MWI E-Commerce Support to activate online ordering with MWI, you must do so before you can begin placing orders. If you have not activated online ordering and place an order through Cornerstone, it will not be processed and you will not receive your order.

**To disable electronic inventory ordering with MWI Veterinary Supply:**

a. On the **Lists** menu, select **Practice**. The Practice List dialog box appears.

b. With your practice name selected, click **Update** (or double-click the practice). The Practice Information dialog box appears.

c. On the Practice Information window, in the Login/Password Management area, select Vendor–MWI Veterinary Supply from the drop-down list.

d. Clear the **Enable Online Ordering** check box.

**Note:** If you have open orders, a message indicating that you cannot disable online ordering until all orders are closed appears.

e. If you have no open orders, click **Yes** when the message confirming your intent to disable online ordering appears.

f. A message informing you that you have disabled online ordering in Cornerstone appears. To complete your MWI unenrollment, you must contact MWI E-Commerce Support.

**To reactivate electronic inventory ordering with MWI Veterinary Supply:**

- If you have disabled your enrollment with MWI, you must first contact MWI E-Commerce Support (see above) to establish or reactivate your account. Then, follow the setup instructions above to reactivate online ordering within Cornerstone.
Chapter 3: Setting Up Lists and Information

- **VetConnect** PLUS – VetConnect PLUS is a web-based tool that lets you view and compare IDEXX in-house diagnostics and IDEXX Reference Laboratories data side by side.

  Your practice must have:
  - Internet access at the workstation where you want to view VetConnect PLUS.
  - Windows®Internet Explorer® 7 or later must be installed on each Cornerstone workstation. It does not have to be the default Internet browser.
  - If you want to view in-house results, you must have IDEXX SmartLink* technology to provide bidirectional flow between Cornerstone and your IDEXX VetLab* Station. In addition, IDEXX SmartService* Solutions must be set up for the IDEXX VetLab Station. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink for your IDEXX VetLab Station if your practice does not already have it.
  - If you want to view IDEXX Reference Laboratories results, you must have IDEXX SmartLink* technology to provide bidirectional flow between Cornerstone and the IDEXX Reference Laboratories. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink if your practice does not already have it.
  - A VetConnect* account with administrator user name and password. Call VetConnect PLUS Client Services at 1-888-433-9987 to request an account if your practice does not already have one.

  Note: This must be your primary practice if you are a Multi-Location/Single Database user.

  **To activate VetConnect PLUS and set login/password settings:**

  You can activate VetConnect PLUS immediately following installation of Cornerstone 8.3 software or anytime after that. After you activate VetConnect PLUS from within Cornerstone, activate VetConnect PLUS from your IDEXX VetLab Station (if applicable).

  a. From the **Account information for** drop-down list, select **VetConnect PLUS**.
  b. If you are a new IDEXX Reference Laboratories user, select the **VetConnect** option, enter your practice’s VetConnect administrator user name and password, and then click **Submit to Activate VetConnect PLUS**.

  OR

  If you are an existing IDEXX Reference Laboratories user, the **VCAgent** option should be selected and your VetConnect user name and password should be completed. Click **Submit to Activate VetConnect PLUS**.
  c. Read the agreement, and then click **Accept**.

  A message states that IDEXX Reference Laboratories historical data will be uploaded.
  d. Click **Next**.
  e. **IDEXX VetLab Station only**: A message giving you the option to print instructions on uploading data displays. Click **Yes** to open the printable message or **No** to continue.
  f. Click **Finish**.
  g. A message states that activation is complete and that data upload will continue. Close the message window.

  The upload of IDEXX Reference Laboratories historical data that began during activation will continue, with the most recent results uploaded first. Upload can take up to 24 hours,
depending on the number of results being uploaded. You can continue to use Cornerstone software during the upload; Cornerstone performance will not be affected.

To upload data from your IDEXX VetLab Station:

a. On the IDEXX VetLab Station, tap **Settings**, and then select the **VetConnect PLUS** tab.
b. Tap **Activate VetConnect PLUS**.
c. Accept the VetConnect PLUS user agreement.
d. Enter your VetConnect user name and password.
e. Tap **Next**. A confirmation message is displayed. Close the message. Data is uploaded in reverse order, starting with your most recent results. You can continue to use the IDEXX VetLab Station during the upload.

If you prefer to use the standard Cornerstone workflow for viewing results, you do **not** need to deactivate VetConnect PLUS. All your test results are always available in standard Cornerstone windows. However, if you want to disable access to VetConnect PLUS, you can do so in Cornerstone.

To disable access to VetConnect PLUS:

a. From the **Account information for** drop-down list, select **VetConnect PLUS**.
b. Select **Disable VetConnect PLUS** online services, and then click **OK**.

6. In the **Phones** area, click **Add** to enter a new practice phone number, or select an existing phone number, and then click **Update** to edit the information. The Practice Phone Setup dialog box appears.

![Practice Phone Setup dialog box](image)

7. In the Practice Phone Setup dialog box, do the following:
   a. In the **Phone information** area, enter the phone number, extension (if applicable), and the phone number description.
   b. In the **Notes** area, type any notes pertaining to this phone number.

   **Tip:** If a phone number has a note, type “see notes” (or an asterisk *) to indicate a note exists) in the **Description** text box. Phone notes do not appear in the Practice Information dialog box.
   c. If this is the main phone number for your practice, select the **Primary phone** check box.
Note: The primary phone number is the only practice phone number that prints on invoices, statements, and estimates. However, you can choose to include multiple practice phone numbers in correspondence documents.

d. When finished, click OK to return to the Practice Information dialog box.

8. Click OK, and then click Close.
Setting Up Practice Information for a Multi-Location/Single Database Configuration (Advanced)

The Multi-Location/Single Database configuration option is available for those practices running multiple businesses or sites that need to use a single shared Cornerstone database. A Multi-Location/Single Database configuration allows you to view and separate specific areas of Cornerstone by practice. This allows for practice-specific workstation logins, letterhead information on client documents, invoices, estimates, and more.

Note: The staff member who configures the Multi-Location/Single Database settings must have appropriate security permissions to access the associated screens in Cornerstone.

Step 1–Activate Multi-Location/Single Database

To ensure a smooth transition of your Cornerstone software to a Multi-Location/Single Database configuration, your practice’s Cornerstone Administrator must contact Cornerstone Support at 1-800-695-2877 for activation instructions. Upon activation of a Multi-Location/Single Database configuration, you can then begin to add the additional practices and separate clients by practice.

Notes:

- After you convert to a Multi-Location/Single Database configuration, to convert back to your previous Single-Location (single practice) configuration, you must inactivate the unwanted practices and have your practice’s Cornerstone Administrator contact Cornerstone Support for further assistance.

- Many of the features described in this section are not available until a Multi-Location/Single Database configuration is activated and more than one practice exists in your Practice List.

Step 2–Add Practices to the Practice List

Once a Multi-Location/Single Database configuration is activated, the Practice Information dialog box allows you to add as many practices as necessary, with one practice designated as the primary practice.

To add a new practice with a Multi-Location/Single Database configuration:

1. On the Lists menu, select Practice. The Practice List dialog box appears.
2. Click New. The Practice Information dialog box appears.

Note: If a “Please call Cornerstone Software Support to enable multiple practices” message appears, you must complete Step 1–Activate Multi-Location/Single Database (earlier in this section) before continuing.
3. To designate this practice as the primary practice, select the **Primary** check box. (Note that the primary practice cannot be flagged as inactive.)

   **Note:** If a practice is flagged as inactive, things such as saved invoices and reprints continue to use the practice that was used when they were originally created, even if that practice is now inactive.

4. In the **Practice Information** area, enter the practice name and address information.

5. In the **Settings** area, enter the following practice-specific information:
   - **Revenue Center**—If you want to specify the revenue center to use for the practice when adding an item to an invoice, type the revenue center ID or press F2 to use the Revenue Center List. When adding an item to an invoice, Cornerstone checks for an assigned revenue center in this order: 1) the individual invoice item, 2) the invoice item classification, 3) the staff member’s defaults, 4) the practice default revenue center.
     
     **Note:** Cornerstone does not use the revenue center that’s assigned to the practice unless you remove the revenue center from the Staff defaults (or from the individual invoice item or invoice item classification).
   - **Practice ID**—Type up to three alphanumeric characters to use as the abbreviated practice name throughout Cornerstone.
   - **LabREXX ID**—If applicable, type the IDEXX LabREXX ID for the practice (all practices may use the same ID or each practice may have its own ID). This is the ID that identifies this practice to IDEXX Reference Laboratories when printing LabREXX forms. You must enter this ID before the LabREXX feature can be turned on in the Lab Information setup.
   - **Practice Color**—You can select a color to use as the identifying color for the practice throughout Cornerstone and on the status bar at the bottom of the main Cornerstone application window.
     
     **Note:** This color identifier is used with a Multi-Location/Single Database configuration and is not necessary for a Single Location configuration.
6. In the Login/Password Management area, set up login and password information for the following features:

- **Antech Reference Lab Results** – The Antech Diagnostics® laboratory module allows you to order tests online and automatically download results. Contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for information about purchasing and activating the Antech Diagnostics laboratory module. For detailed information on using the Antech Laboratory module, see the help within Cornerstone.

  **To activate the Antech Diagnostics Laboratory Module:**
  a. From the Account Information for drop-down list, select Antech Reference Lab Results.
  b. If you already have Antech set up in Cornerstone, click Apply Primary Practice Settings. The account information boxes are automatically completed.
  c. If you don’t already have existing Antech account information, enter the information provided when you set up your account.
  d. Click Test. Then, when the Login Settings Passed message appears, click OK.

- **Communications – Email** – Use IDEXX Email Service to email medical notes, correspondence documents, and estimates directly from the Cornerstone Editor (this service must be activated in Cornerstone). To activate Communications Management email features, you may need to perform a one-time setup to specify your account information. If you are already using Microsoft® Outlook® for email, this setup is not necessary.

  **To activate IDEXX Email Service and set login/password settings:**
  a. From the Account Information for drop-down list, select Communications – Email.
  b. Select the email service you prefer to use:
     o **My Desktop email client**—Select this option if you plan to use your existing email software. **Note:** This will already be selected if you are using your existing email software. You must have properly configured software to use this option.
     o **Cornerstone Imaging SMTP email settings**—Select this option if you want to use the SMTP (web-based mail, such as Gmail and Hotmail) set up in Imaging defaults. To view and edit current settings, click the edit imaging SMTP settings link to open the Configuration window and click Email to view the default settings. For more information, see “Image Email Defaults” on page 158.

- **Communication – Fax** – Use IDEXX Faxing Service to fax medical notes, correspondence documents, and estimates directly from the Cornerstone Editor (this service must be activated in Cornerstone). To activate IDEXX Faxing Service, you must be an administrator or be provided administrative rights and complete the activation setup process below. For more information on the IDEXX Faxing Service, contact Cornerstone Support at 1-800-695-2877.

  **To activate IDEXX Faxing Service and set login/password settings:**
  a. From the Account Information for drop-down list, select Communication – Fax.
  b. Select the Use IDEXX Faxing Service check box. A pop-up box displays the terms and conditions of use.
Chapter 3: Setting Up Lists and Information

To terminate IDEXX Faxing Services:

a. On the menu bar, select Lists > Practice. The Practice List dialog box appears.

b. With your practice name selected, click Update (or double-click the practice). The Practice Information dialog box appears.

c. On the Practice Information window, in the Login/Password Management area, select Communications – Fax from the Account information for drop-down list.

d. Clear the Use IDEXX Faxing Service check box.

e. Click OK when you are prompted to confirm your intent to terminate the service.

To reactivate IDEXX Faxing Services:

- If you have previously activated and then terminated the IDEXX Faxing Service, follow the instructions for initial activation and enrollment, select the Use IDEXX Faxing Service check box, and follow the same steps involved in the initial activation.

  Note: You must agree to the terms and conditions again and will be subject to the activation setup fees agreed to in the terms and conditions.

- Vendor – MWI Veterinary Supply – IDEXX SmartOrder* electronic inventory ordering in Cornerstone allows for a more efficient inventory work flow with real-time online inventory ordering through MWI® Veterinary Supply.

  IDEXX SmartOrder service requires the following:

  - An account with MWI at mwivet.com. If you do not have an account, contact your MWI representative.
  
  - A consistent, high-speed Internet connection.

  To activate IDEXX SmartOrder service and set login/password settings for MWI Veterinary Supply:

  a. From the Account Information for drop-down list, select Vendor – MWI Veterinary Supply.

  b. From the Associated Cornerstone Vendor drop-down list, select the practice-specific vendor associated with MWI to use for this service.

  c. In the Customer Number text box, enter your practice’s MWI customer number. You can find this information on your mwivet.com account.

  d. Select the Enable Online Ordering check box.

  e. A pop-up box displays the terms and agreement. Review the terms and click Accept to activate the service.

  f. When you are notified that activation was successful, click OK.

  Click Test to verify that you have a working Internet connection and valid login information for accessing the vendor’s online ordering system.

  In the Practice Information window, the user acceptance, date/time stamp, and a link to
the MWI terms and agreement is displayed when online ordering is enabled.  
**Note: Multi-Location/Single Database (MLSD) configuration only**—The primary practice reviews and agrees to the MWI terms of sale on behalf of all locations within the MLSD group. An administrator must set up each secondary practice by following steps 1-4 above. Each secondary location can click the *Apply Primary Practice Settings* button to use those settings or enter its own MWI customer number (if applicable). The user acceptance, date/time stamp, and a link to the MWI terms of sale agreed to by the primary practice are displayed for both primary and secondary practices when online ordering is enabled.

**To disable electronic inventory ordering with MWI Veterinary Supply:**

a. On the *Lists* menu, select *Practice*. The Practice List dialog box appears.

b. With your practice name selected, click *Update* (or double-click the practice). The Practice Information dialog box appears.

c. On the Practice Information window, in the Login/Password Management area, select *Vendor—MWI Veterinary Supply* from the drop-down list.

d. Clear the *Enable Online Ordering* check box.  
   **Note:** If you have open orders, a message indicating that you cannot disable online ordering until all orders are closed appears.

e. If you have no open orders, click *Yes* when the message confirming your intent to disable online ordering appears.

f. A message informing you that you have disabled online ordering in Cornerstone appears.  
   To complete your MWI unenrollment, you must contact MWI E-Commerce Support.

**To reactivate electronic inventory ordering with MWI Veterinary Supply:**

If you have disabled your enrollment with MWI, you must first contact MWI E-Commerce Support (see above) to establish or reactivate your account. Then, follow the setup instructions above to reactivate online ordering within Cornerstone.

- **VetConnect PLUS** – VetConnect PLUS is a web-based tool that lets you view and compare IDEXX in-house diagnostics and IDEXX Reference Laboratories data side by side.

Your practice must have:

- Internet access at the workstation where you want to view VetConnect PLUS.

- If you want to view in-house results, you must have IDEXX SmartLink technology to provide bidirectional flow between Cornerstone and your IDEXX VetLab Station. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink for your IDEXX VetLab Station if your practice does not already have it.

- If you want to view IDEXX Reference Laboratories results, you must have IDEXX SmartLink* technology to provide bidirectional flow between Cornerstone and the IDEXX Reference Laboratories. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink if your practice does not already have it.

- A VetConnect account with administrator user name and password. Call VetConnect PLUS Client Services at 1-888-433-9987 to request an account if your practice does not already have one.  
   **Note:** This must be your primary practice if you are a Multi-Location/Single Database user.
To activate VetConnect PLUS and set login/password settings:

a. From the Account information for drop-down list, select VetConnect PLUS.

b. If you are a new IDEXX Reference Laboratories user, select the VetConnect option, enter your practice’s VetConnect administrator user name and password, and then click Submit to Activate VetConnect PLUS.

OR

If you are an existing IDEXX Reference Laboratories user, the VCAgent option should be selected and your VetConnect user name and password should be completed. Click Submit to Activate VetConnect PLUS.

c. Read the agreement, and then click Accept. A message states that IDEXX Reference Laboratories historical data will be uploaded.

d. Click Next.

e. IDEXX VetLab Station only: A message giving you the option to print instructions on uploading data displays. Click Yes to open the printable message or No to continue.

f. Click Finish.

g. A message states that activation is complete and that data upload will continue. Close the message window.

The upload of IDEXX Reference Laboratories historical data that began during activation will continue, with the most recent results uploaded first. Upload can take up to 24 hours, depending on the number of results being uploaded. You can continue to use the Cornerstone software during the upload; Cornerstone performance will not be affected.

To upload data from your IDEXX VetLab Station:

a. On the IDEXX VetLab Station, tap Settings, and then select the VetConnect PLUS tab.

b. Tap Activate VetConnect PLUS.

c. Accept the VetConnect PLUS user agreement.

d. Enter your VetConnect user name and password.

e. Tap Next. A confirmation message is displayed. Close the message. Data is uploaded in reverse order, starting with your most recent results. You can continue to use the IDEXX VetLab Station during the upload.

If you prefer to use the standard Cornerstone work flow for viewing results, you do not need to deactivate VetConnect PLUS. All your test results are always available in standard Cornerstone windows. However, if you want to disable access to VetConnect PLUS, you can do so in Cornerstone.

To disable access to VetConnect PLUS:

f. From the Account information for drop-down list, select VetConnect PLUS.

g. Select Disable VetConnect PLUS online services, and then click OK.

7. In the Phones area, click Add to enter a new practice phone number or select an existing phone number, and then click Update to edit the information. The Practice Phone Setup dialog box appears.
8. In the Practice Phone Setup dialog box, do the following:
   a. In the Phone information area, enter the phone number, extension (if applicable), and the phone number description.
   b. In the Notes area, type any notes pertaining to this phone number.
      Tip: If a phone number has a note, type “see notes” (or an asterisk *) to indicate a note exists in the Description text box. Phone notes do not appear in the Practice Information dialog box.
   c. If this is the main phone number for your practice, select the Primary phone check box.
      Note: The primary phone number designated for each practice is the only practice phone number that prints on invoices, statements, and estimates for that practice. However, you can choose to include multiple practice phone numbers in correspondence documents.
9. Click OK, and then click Close.
   The newly added practice displays in the Practice List with the designated background color.

Step 3—Update Settings for the Original Practice
Before continuing with your Multi-Location/Single Database setup, be sure to update the practice information for your original practice (the one that existed in the database prior to setting up the additional practices).

To update the original practice:
1. On the Lists menu, select Practice.
2. In the Practice List, select the original practice and click Update. The Practice Information dialog box appears.
3. In the Settings area, update the Revenue Center, Practice ID, and Practice Color, and LabREXX ID fields as needed. (See step 5 in the previous section for more information.)
4. In the Login/Password Management area, update the Account Information for settings as needed. (See step 6 in the previous section for more information.)
5. Click OK.

Step 4—Designate a Default Practice
In Staff Defaults:
With a Multi-Location/Single Database configuration activated, you can use the Default practice setting on the Staff Defaults Miscellaneous tab to set the default practice to use when a staff member logs into Cornerstone. At login, the staff member is automatically logged in to the correct practice. All invoices, statements, estimates, etc. are created using this practice.

Note: When determining the practice to use at login time, Cornerstone first looks at the Staff default practice. If no Staff default practice has been set, it uses the Workstation default practice. If a default practice has not been set for Staff or Workstation defaults, then the primary practice is used.

See “Chapter 5: Setting Staff Defaults” beginning on page 150 for information.

In Workstation Defaults:
With a Multi-Location/Single Database configuration activated, you can set a default practice to use when logging in from each workstation. All invoices, statements, estimates, etc. are created using this practice.
Note: When determining the practice to use at login time, Cornerstone first looks at the Staff default practice. If no Staff default practice has been set, it uses the Workstation default practice. If a default practice has not been set for Staff or Workstation defaults, then the primary practice is used. See “Workstation–All Defaults” on page 148 for information.

Step 5–Configure Security Settings

Before your staff can begin to take full advantage of the features and reports available with a Multi-Location/Single Database configuration, a Cornerstone Administrator must first ensure that all necessary security permissions are given to applicable staff members.

Step 6–Assign Clients to a Practice

If a Multi-Location/Single Database configuration is activated, you can use the Assign Clients to Practice tool to perform a mass update that assigns an entire group of clients to a particular “home” practice (the practice ID is associated with that client).

When using the Assign Clients to Practice tool, you can quickly select a group of clients by filtering the client list by current home practice, client ID range, client classification, area code, phone prefix, state, postal code range, and client user-defined prompt and answer.

Notes:

- At the time that a Multi-Location/Single Database configuration is activated, the current (logged in) practice is automatically assigned as the home practice for all clients.
- The home practice is used to separate accounts receivable (A/R). When A/R reports are generated, the client appears on the A/R list for only their home practice, regardless of where the services were performed.
- The client balance reflects the total outstanding balance for charges from all practices combined.
- The Assign Clients to Practice tool is not available on mobile computers.

To assign clients to a practice:

1. On the Tools menu, select Assign Clients to Practice. The Assign Clients to Practice window appears.
2. In the Client Search area, set up one or more client search filters using the following fields:

- **Home Practice**—Allows you to specify a currently assigned home practice for finding clients who belong to the same home practice and reassigning them to a different practice. (If setting up a Multi-Location/Single Database configuration for the first time, all clients in your database will have the same home practice.)

- **Client IDs**—Allows you to specify a range of client IDs for reassigning clients who have IDs within a particular number range. (Note: You can leave either the first or second text box blank to open up the range to all client IDs above or below a given ID number. For example, if you leave the first text box blank and enter 2000 in the second text box, the range is 0 to 2000.)

- **State/Prov**—Allows you to specify a particular state/province for reassigning clients who reside in the same geographic area.

- **Classification**—Allows you to select a client classification (for example, Boarding only) for reassigning clients in a particular classification.

- **Postal codes**—Allows you to specify a range of postal codes (ZIP Codes) in either standard (such as 54701) or postal + 4 (such as 54703-3234) format for reassigning clients who reside in the same geographic area. (Note: You can leave either the first or second text box blank to open up the range to all postal codes above or below a given code. For example, if you enter 54700 in the first text box and leave the second text box blank, the range is 54700 to 99999.)

- **Phone**—Allows you to specify a telephone number area code (3 numeric characters) and prefix (3 numeric characters) for reassigning clients who have phone numbers associated with a particular geographic area.

  **Note:** The Phone search options are not available in Australia.

- **Client prompt/Prompt answer**—If your practice uses a custom client prompt (Controls > User Defined Prompts, select the Client tab) to flag specific clients, you can select that client prompt and prompt answer here to distinguish a certain group of clients and reassign them to a different practice.

- **Include inactives**—Select this check box if you want to include both active and inactive clients in your search.

3. Once you have set the search criteria, click Search. All clients matching the defined search criteria appear in the client list area.

4. To change the sort order of the client list, click a column header (City, State, etc.) to sort the list by that property.

5. To select the clients to assign to a different practice, select the check box to the left of each client’s row. You can also click Select All to select all clients in the list or click Deselect All to deselect all clients.

6. After selecting one or multiple clients, from the Assign selected clients to drop-down list (below the client list), select the practice to which you want to assign the selected clients.

7. Click the Assign button to assign the selected clients to the selected practice.

8. Repeat steps 2–7 as necessary to assign clients to practices.

9. When finished, click Close.
**Step 7—Assign Revenue Centers**

When adding or updating a revenue center, the color-coded **Practice** drop-down list allows you to assign a practice to associate with the revenue center for reporting purposes.

When End of Period (EOP) reports are run by practice (such as Daily Summary Report—By Practice), the assigned revenue center(s) are used to automatically print the applicable sales amounts.

See “Revenue Centers” on page 71 for information on setting up revenue centers.

**(Optional)–Switch Between Practices**

The **Switch Logged In Practice** option allows a staff member (with proper security) to switch between multiple practices.

**To change the logged in practice:**

1. Close all active Cornerstone windows and dialog boxes on the workstation (do not close Cornerstone).

2. On the **File** menu, select **Switch Logged in Practice** (this menu option is available only if multiple active practices exist). The Switch to Practice dialog box appears, displaying a list of color-coded practices.

3. From the **Practice** drop-down list, select the applicable practice.

4. Click **OK**.

   The Cornerstone status bar refreshes to display the newly selected practice name and associated background color.

**Staff Information**

**Entering Staff Members in the Cornerstone System**

Set up each of your staff members in Cornerstone and assign them to a staff classification. Staff classifications are used for staff commissions and in Cornerstone performance tracker.

**Note:** You should also set up security for each staff member. Until a staff member has security access set up, the “Access denied” message appears when the staff member tries to open a dialog box or generate a report. To set up security for each staff member, follow the Cornerstone **Staff Security** instructions you received separately when you purchased your Cornerstone software.

**Before You Begin**

- Set up your staff classifications. You do not have to set up classifications if you are setting up a temporary staff member for initial setup of your system.
To add or edit a staff member:

1. On the Lists menu, select Staff. The Staff List dialog box appears.

   ![Staff List dialog box](image)

   Tip: To include inactive staff members in the staff list, select the Include inactives check box.

2. Click New to add a new staff member or double-click an existing staff member to update the information. The Staff Information window appears.

   ![Information tab on Staff Information window](image)

3. Type a unique Staff ID.

4. On the Information tab, from the Status drop-down list, select Active or Inactive. (Change the status to Inactive only if a staff member is no longer employed at your practice.)

5. From the Classification drop-down list, select the staff member’s classification.

6. Enter the staff member’s name and address information.

7. If applicable, type the staff member’s license number in the License # text box. The license number is included on rabies certificates.

8. If applicable, type the staff member’s DEA number in the DEA # text box. The DEA # is used only in the controlled substance export if required by a specific state.
9. In the *Phones* area, double-click or right-click and select **New** (or press CTRL+N) to open the Phone Information dialog box.

![Phone Information dialog box]

10. In the Phone Information dialog box, do the following:
   a. In the *Phone information* area, type the phone number and extension in the *Phone number* and *Extension* text boxes (if applicable).
   b. From the *Location* drop-down list, select the location associated with this phone number, such as home, cellular, etc. You can view the location from the Staff Information window.
   c. In the *Notes* text box, type any notes associated with this phone number, such as times available. If you enter notes, a special note icon shows next to this phone number on the Staff Information window. To view the notes from the Staff Information window, double-click the note icon. (Phone notes do not appear in the Staff Information window.)
   d. When finished, click **OK** to return to the Staff Information window.

11. Click **OK** to save your changes and close, or click another tab to add more information for the staff member.

   - To view a list of staff members and their telephone and address information, print a **Staff Summary Report**.
   - To view staff phone numbers only (no address information), print a **Staff Phone List**.

**Answering Staff Prompts and Adding Notes to Staff Information**

You can record additional information about employees on the **Prompts/Notes** tab in the Staff Information window. You can view a note in Staff Information at any time, and the note also appears on the Staff Summary Report.

**Before You Begin**

- Set up your staff prompts (**Controls > User Defined Prompts > Staff** tab). You don’t have to set up prompts if you are setting up a temporary staff member to initially set up your system.

**To answer staff prompts and add a staff note:**

1. On the **Lists** menu, select **Staff**.
2. Select a staff member and click **Update**.
3. Click the **Prompts/Notes** tab.
4. Answer the staff Prompts and in the Note area, add any note concerning the staff member.
5. Click OK to save your changes and close, or click another tab to add more information for the staff member.

For a list of the answers to staff prompts, print a Staff Defined Prompts Report. (See “Staff Defined Prompts Report” on page 63.)

Adding Electronic Signatures for Staff

You can create an electronic staff signature and store it for use in medical notes or correspondence documents. (See “Chapter 17: Using Medical Notes and Correspondence” in the Cornerstone User’s Manual for information on including electronic signatures in a document.)

**To create an electronic signature for a staff member:**

1. On the Lists menu, select Staff.
2. Select a staff member and click Update.
3. Click the Signature tab.
4. Click the New button. A pop-up box appears, asking for your signature.
5. Using the signature capture device, sign your name and click OK. The signature appears in the Signature box.
6. If you want to password protect the signature, type and confirm the password in the provided text boxes on the **Signature** tab. When the Signature w/pwd bookmark is used in a document, the signature password is required before placing the signature on the document.

7. Click **OK** to save your changes and close, or click another tab to add more information for the staff member.

**Staff Reports**

You can generate a variety of reports related to staff information.

**To access Staff reports:**

1. On the **Reports** menu, select **Find a Report**. The Report Search window appears.
2. In the Reports list, click the plus sign to the left of **Staff** to expand the list of staff reports.
Chapter 3: Setting Up Lists and Information

Staff Reports

Initial Staff Setup Report
This report shows the custom staff prompts designed for your system.

Sort options: Staff Defined Prompts

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Data Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Birthday</td>
<td>Character</td>
<td>Active</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Character</td>
<td>Active</td>
</tr>
<tr>
<td>Emergency Contact</td>
<td>Character</td>
<td>Active</td>
</tr>
<tr>
<td>License #</td>
<td>Character</td>
<td>Active</td>
</tr>
</tbody>
</table>

Staff Class Commission Percentage Report
This report lists staff commission percentages that are based on classification.

Sort options: Staff Classification

<table>
<thead>
<tr>
<th>New Classification</th>
<th>Item Description</th>
<th>Default Commission Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOARDING LAGE ANIMAL</td>
<td></td>
<td>0.00</td>
</tr>
<tr>
<td>BOARDING - SMALL</td>
<td></td>
<td>0.00</td>
</tr>
<tr>
<td>UNIDENTIFIED - SMALL</td>
<td></td>
<td>0.00</td>
</tr>
<tr>
<td>NUTRITIONAL</td>
<td></td>
<td>3.00</td>
</tr>
<tr>
<td>SUPPLIES</td>
<td></td>
<td>0.00</td>
</tr>
<tr>
<td>MISCELLANEOUS</td>
<td></td>
<td>0.00</td>
</tr>
</tbody>
</table>
Staff Commission Percentage Report
This report lists staff commission percentages for individual staff members.

Sort options: Staff Classification by Last Name

<table>
<thead>
<tr>
<th>Staff Classification</th>
<th>Staff Subclass</th>
<th>Staff ID</th>
<th>Description</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC</td>
<td>McCoy, Melissa</td>
<td></td>
<td>Default Commission Percentage</td>
<td>20.00</td>
</tr>
<tr>
<td>BOARDING</td>
<td></td>
<td></td>
<td></td>
<td>00</td>
</tr>
<tr>
<td>CITY LICENSE</td>
<td></td>
<td></td>
<td></td>
<td>00</td>
</tr>
<tr>
<td>GROOMING</td>
<td></td>
<td></td>
<td></td>
<td>00</td>
</tr>
<tr>
<td>Supplies</td>
<td></td>
<td></td>
<td></td>
<td>00</td>
</tr>
<tr>
<td>Video Rental</td>
<td></td>
<td></td>
<td></td>
<td>00</td>
</tr>
<tr>
<td>MISCELLANEOUS</td>
<td></td>
<td></td>
<td></td>
<td>00</td>
</tr>
</tbody>
</table>

Staff Defined Prompts Report
This report lists the answers to prompts for staff members. Staff members who do not have answers to the prompts in their record do not appear on the report.

Sort options: Classification by Last Name, Classification by Staff ID

<table>
<thead>
<tr>
<th>Staff Classification</th>
<th>Staff Subclass</th>
<th>Staff ID</th>
<th>Description</th>
<th>Staff Defined Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterinary Technician</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JJA</td>
<td>James, John</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Birthday:</td>
<td>03/20/1985</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Date Hired:</td>
<td>01/02/2005</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Emergency Contact:</td>
<td>JJA Jones (Vet)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>License Renewal Date:</td>
<td>07/10/2018</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Staff Phone List
This report lists all the phone numbers for staff members. You can choose to print the report for all staff or for active staff only.

Sort options: Staff ID, Staff Last Name

<table>
<thead>
<tr>
<th>Staff ID/Name</th>
<th>Telephone</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(716) 555 - 1501 (Home)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(716) 555 - 5021 (Pager)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(716) 555 - 1204 (Mobile Phone)</td>
<td></td>
</tr>
</tbody>
</table>
Staff Summary Report
This report shows a list of staff members with a summary of their information.

Sort options: Classification by Last Name, Classification by Staff ID

<table>
<thead>
<tr>
<th>Name</th>
<th>Address/Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doctor</td>
<td>3403 W. Holly St.</td>
</tr>
<tr>
<td></td>
<td>East Cake, WI 54703</td>
</tr>
<tr>
<td></td>
<td>(715) 855-8545 (Home)</td>
</tr>
<tr>
<td></td>
<td>(715) 555-9294 (Mobile Phone)</td>
</tr>
<tr>
<td></td>
<td>(715) 300-8821 (Fax)</td>
</tr>
</tbody>
</table>

Species and Breeds
Use Species and Breeds to identify patients. Most common species and breeds are already set up for you in Cornerstone, but you can add to or update this list if needed.

Before You Begin
- If you started with a Fastart* or FastInstall database, review the species and breeds already set up in the Species List.

To add or edit a species:
1. On the Lists menu, select Species. The Species List dialog box appears.
2. Click New to add a new species or double-click an existing species to update it. The Species Information dialog box appears.
3. In the Species ID text box, type an ID (up to three characters) for this species.
4. In the Description text box, type an identifying name for this species.
5. In the System template drop-down list, select a default system template for this species. This is used with the Physical Exam feature and the Patient Advisor* module.
6. Under Species type, select Small or Large so Cornerstone can filter the species list accordingly when generating reminders.
7. If this species is used for herd records (such as bovine), select the **Herd** check box. This option prevents Missing Birthdate, Missing Weight, and Patient Born In alerts from displaying on herd records.

8. Click **OK**, and then click **Close**.

For a list of the species and breeds in Cornerstone, print an **Initial Patient Setup Report** sorted by Species/Breed.

**To add a breed to a species:**
1. On the **Lists** menu, select **Species**. The Species List dialog box appears.
2. Select the applicable species and click **Update**. The Species Information dialog box appears.
3. In the **Breeds** area, click **Add**. The Breed Setup dialog box appears.

![Breed Setup dialog box]

4. In the **Breed ID** text box, type an ID.
5. In the **Description** text box, type a description.
6. Click **OK** to add the new breed and close the Breed Setup dialog box.

**To define lab age groups for a species:**
Lab age groups are used when setting up default template ranges for manually entered lab results.
1. On the Species Information dialog box (**Lists > Species > Name > Update**), click the **Lab Age Grps** button. The Lab Age Groups dialog box appears.
2. Click **New** to add a new age group, or double-click an existing group to update it. The Lab Age Group Information dialog box appears.

![Lab Age Group Information dialog box]

3. In the **Description** text box, type an identifying name for the age group.
4. Use the **Age/to years, months, and days** text boxes to set the range for this age group.
5. Click **OK** to save the lab age group settings and close the Lab Age Group Information dialog box.
Setting Species-Specific Rabies Tag Defaults

Practices that set up their vaccine/vaccination invoice items prior to Cornerstone 8.1 may have a SERVICE-based system in place, where items are set up as vaccination service items (with no links to vaccine inventory items). If this is the case, you can use the Species Specific Rabies Tag defaults to set up species-specific rabies tag information for the vaccine used most often for a species. This information is used on the Vaccine Tag window when issuing a tag, if you have a SERVICE-based vaccine/vaccination system in place.

See “Rabies Default Settings” on page 142 for information on the Rabies Default settings used on the window if species-specific defaults have not been set.

Note: If you have an INVENTORY-based vaccine/vaccination system in place, species-specific rabies/vaccine tag defaults are set on the Invoice Item Information Vaccine tab. See “Setting Up Vaccine Invoice Items” on page 206 for information.

To set Species-Specific Rabies Tag Defaults:

1. On the Species Information dialog box, click the Rabies Default button. The Species Specific Rabies Tag dialog box appears.

2. In the Brand and Producer/Mfr. text boxes, type the vaccine brand and producer/manufacturer information for the vaccine used most often for this species.

3. In the Lot. # text box, type the vaccine lot number.

4. In the Expires text box, enter the date this lot of vaccines expires.

5. In the # of years text box, type the number of years the vaccine is viable (the certificate expiration).

6. In the Manner of administration area, specify how this vaccine is administered (Subcutaneously, Intranasal, or Intramuscular).

7. In the Vaccine type area, select the vaccine type (Killed or MLV).

8. In the Staff ID text box, specify a staff member to display by default on the Vaccine Tag window when issuing a tag. Type the ID or press F2 to select a staff member from the Staff List.

   Note: An informational message displays at the bottom of the dialog box if there are any existing inventory items with rabies/vaccine tag defaults set up on the Invoice Item Information Vaccine tab. If vaccine/vaccination inventory items exist, this message indicates the number of items and serves as a reminder that the Vaccine tab defaults will be used for those items.
9. Click OK to save the rabies tag settings and close the Species Specific Rabies Tag dialog box.

Diagnostic Codes

Use Diagnostic Codes to enter information in a patient’s medical history to target and track patients with particular disorders and characteristics. Obesity, infectious diseases, and skin problems are examples of conditions that could have diagnostic codes.

You can also use diagnostic codes with insurance billing. VPI (Veterinary Pet Insurance) codes are already set up for you and cannot be deleted. You cannot change a VPI code, but you can update the description.

You can print diagnostic codes on the Check-In Report and Patient History Report. You can also print a Patient Diagnosis Report that includes patients with the same diagnosis.

You can link documents to a specific diagnostic code.

To add or edit a diagnostic code:

Note: We recommend that you create a new diagnostic code if the description you want to use does not exist. Do not use the Hospital description to change the meaning of a VPI code name.

1. On the Lists menu, select Diagnostic Codes. The Diagnostic Codes dialog box appears.
2. Click New to add a new diagnostic code, or double-click an existing code to update it. The Diagnostic Code Setup dialog box appears.

3. In the Diagnostic code text box, type the diagnostic code. The code must begin with a letter and cannot exceed ten characters. (You may notice that you have codes with numbers on your system; only VPI codes begin with numbers. By beginning your code with a letter, it will be easy to distinguish the codes created by your practice.)
4. In the Hospital description text box, type the description.
5. From the Default status drop-down list, select Tentative or Final. (You can change the diagnosis status when you use it.)
6. From the **Status** drop-down list, select **Active** or **Inactive**. You cannot enter an inactive code as a diagnosis. (Change the status to Inactive only if you no longer want to use a diagnostic code.)

7. If your practice uses the Cornerstone Patient Advisor module, in the **Patient Advisor settings** area, change the settings as needed. See the Patient Advisor documentation for details.

8. To link documents to this diagnostic code, in the **Documents** area, in an empty **Doc ID** field, double-click or press F2 search for and select a document template from the Document Template List. Repeat the step as needed to select all applicable documents to link to this diagnostic code.

9. Click **OK**, and then click **Close**.

For a list of the diagnostic codes in Cornerstone, print a **Diagnostic Code Report**.

### Cashier IDs

**Cashier IDs** allow you to track which staff members can accept payments.

If cashier IDs are required in your practice, when the Payment window appears, the staff member must enter his or her cashier password. Cashier passwords are also required when processing a returned check or giving a refund.

You can also use Cashier IDs to specify a location; for example, the cash drawer in the reception area or a satellite clinic.

**Note:** Only a staff member with administrator privileges can add or update cashier IDs.

#### Before You Begin

- Select the **Use Cashier ID** check box in Account defaults (see "Account Defaults" on page 84).

#### To add or edit a cashier ID:

1. On the **Lists** menu, select **Cashier ID**. The Cashier ID List dialog box appears.
2. Click **New** to add a new cashier ID or double-click an existing ID to update it.
3. The Administrator Login box appears. Type an administrator name and password and then click **OK**. The New Cashier ID dialog box appears.

![New Cashier ID dialog box](image)

4. In the **Cashier ID** text box, type a cashier ID. You can use up to three letters or numbers. This cashier ID prints on End of Day and End of Month reports.

5. From the **Status** drop-down list, select **Active** or **Inactive**. (Change the status to Inactive only if you no longer want this cashier ID to be used.)

6. In the **Cashier name** text box, type the cashier name.

7. In the **Password** text box, type the password (up to six letters or numbers). For security, asterisks display when the password is typed.

8. In the **Confirm password** text box, retype the password to confirm it.
9. Click OK, and then click Close.

**Rooms**

Rooms are an integral part of Cornerstone software and are used in many areas of the program, including the Appointment Scheduler and the Patient Advisor module.

You can check a patient into a specific room in the Patient Check-in/out window (you can select a default room in Check-in defaults) and track where the patient is within your practice. The room a patient is checked into displays in the Census List.

**Before You Begin**

- Define an appointment scheduling plan for your practice before setting up rooms. See “Creating an Appointment Scheduling Plan” on page 264 for information.

**IMPORTANT:** Carefully choose your room setup now, as it is very difficult to delete a room once it is in use.

**To add or edit a room:**

1. On the Lists menu, select Room. The Room List dialog box appears.
2. Click New to add a new room, or double-click an existing room to update it. The New Room dialog box appears.

![New Room dialog box](image)

3. In the **Room name** text box, type a name for the room (such as a doctor’s name, a location or room number in the facility, or Grooming). The room name is used as the column header displayed in the Appointment Scheduler’s “Schedule for Today” window.

   If overbooking is allowed in the practice, you should create a separate Overbook room column. For example, you might want to set up a Dr. Jones column and a Dr. Jones–Overbooks column and arrange them to display next to each other to view at a glance from the Schedule for Today window.

   **Tip:** If you use the Boarding and Grooming module, you can link grooming appointments to an Appointment Scheduler “Grooming” column through the Boarding and Grooming module.

4. If the room will be used to schedule appointments exclusively for a particular staff member, in the **Restrict room use to staff member** text box, type the staff ID or press F2 to select a staff member from the Staff List. For example, if you are adding the “Dr. Jones” room name and only Dr. Jones will have appointments scheduled in this room, specify his staff ID here.
Note: When using the Appointment Scheduler, if an appointment is moved to a restricted room, a message appears to notify you that this room is restricted to the specific staff member. The original staff member on the appointment is changed automatically to the designated staff member for this room.

5. If you want to change the order in which rooms are listed, click the room and then click the or arrow button to move the room up or down in the list. The order of the rooms as they appear here and in the Room List is the order used to display their associated column headers in the Schedule for Today window.

6. Click OK, and then click Close.

To delete an unused room:
If you are using the Appointment Scheduler, we recommend that you contact Cornerstone Support at 1-800-695-2877 before deleting rooms. You cannot delete a room if a patient is currently checked into that room or if there are scheduled appointments for that room.

1. In the Room List, select the room to delete and click Delete. You are prompted to confirm the deletion.
2. Click OK.

Patient Hospital Status
The Patient Hospital Status feature provides staff with a way to quickly determine the status of a patient in the hospital.

The patient’s hospital status appears on the Census List, Patient Clipboard*, and Electronic Whiteboard windows. On the Patient Orders window, the status can be changed as the patient’s status in the hospital changes.

The following status options are included with Cornerstone and cannot be updated or deleted:

- Inpatient
- Ready to go home
- Discharged

Note: A custom status is considered equal to the “Ready to go home” status in Cornerstone only if it contains one of the following keywords: Ready, Home, Pick, Release, or Discharge.

To add or edit a hospital status:
1. On the menu bar, select Lists > Patient Hospital Status. The Patient Hospital Status List dialog box appears.
2. Click New to add a new status or double-click an existing status to update it. The Patient Hospital Status Information dialog box appears.
3. In the Description text box, type a hospital status description.
4. Click OK, and then click Close.

To set the order of the Status drop-down list:
1. On the Lists menu, select Patient Hospital Status. The Patient Hospital Status List dialog box appears.
2. Click Order. The Patient Hospital Status Display Order dialog box appears.
3. For each status you want to move, select the status and use the up or down arrow button to move the status to a different position on the list.
4. When you have finished setting the order of the list, click OK and then click Close.

**Wards/Locations**

You can use the Ward/Loc feature to set up a ward or designate a specific location within the practice where patients reside before and after treatments are performed. Common examples of wards and locations include Recovery, ICU, Treatment, and Kennel Ward Number.

You can view wards and locations for a patient on the Census List, Patient Clipboard, and Whiteboard. This helps staff keep track of patients within the hospital.

**To add or edit a ward or location:**
2. Click New to add a new ward/location, or double-click an existing ward/location to update it. The Ward/Loc Information dialog box appears.
3. In the Description text box, type an identifying name for the ward or location.
4. Click OK, and then click Close.

**Postal Codes**

You can set up commonly used Postal Codes (ZIP Codes) and their corresponding cities and states. When these codes are set up, whenever you enter a postal code in Cornerstone and press the TAB key, the city and state automatically appear. This can save time when staff members add new clients to your system.

**Tip:** You can press F2 in any postal code text box in Cornerstone to select a postal code from the Postal Code List.

**To add or edit a postal code:**
1. On the Lists menu, select Postal Codes. The Postal Code List dialog box appears.
2. Click New to add a new postal code, or double-click an existing postal code to update it. The Postal Code Setup dialog box appears.
3. Enter the postal code information.
4. Click OK, and then click Close.

**Revenue Centers**

The Revenue Centers feature allows practices to track revenue separately. You can use revenue centers in different ways.

- You can use revenue centers to keep track of your business by department.
Practices that have separate businesses that are run independently of the practice business, like a boarding facility or a satellite clinic, may use revenue centers.

Practices that run an emergency clinic at night may want to use revenue centers to track business during the day and at night.

**Note:** H-hospital is the default revenue center. All revenue is credited to the H revenue center unless you set up additional revenue centers. You cannot delete the H revenue center.

### How Cornerstone Manages Revenue Centers

You can assign default revenue centers to individual invoice items, invoice item classifications, and individual staff members. In addition, if you are using a Multi-Location/Single Database configuration, you can assign a revenue center to each practice (used for reporting purposes).

Cornerstone checks for an assigned revenue center in this order: 1) the individual invoice item, 2) the invoice item classification, 3) the staff member’s defaults, 4) the practice default revenue center.

Revenue centers may also be changed on the invoice. If a default revenue center is not set up, you must manually enter the revenue center.

**Note:** If, after using Cornerstone, you update or change revenue centers and you want the change to apply to all open invoices and estimates, on the **Tools** menu, select **Update Revenue Centers**.

**To add or edit a revenue center:**

1. On the **Lists** menu, select **Revenue Centers**. The Revenue Center List dialog box appears.

2. Click **New** to add a new revenue center or double-click an existing revenue center to update it. The Revenue Center Information dialog box appears.

   Revenue Center Information dialog box

3. In the **Revenue center** text box, type a brief name to identify this revenue center.

4. In the **ID** text box, type the ID (up to three characters) to use for this revenue center.

5. Click **OK**, and then click **Close**.

   For daily reports of your sales by revenue center, print a **Serv. And Inv. Sales by Revenue Center Report**, a **Sales Tax Summary–by Revenue Center Report**, or an **Itemized Audit Trail for Revenue Center Report**.

   For monthly sales reports by revenue center, print the **Sales Tax Summary–by Revenue Center Report**, the **Inventory Sales - by Revenue Center Report**, or the **Service Sales–by Revenue Center Report**.

   For a yearly sales tax report, print the **Sales Tax Summary–by Revenue Center Report**.

### Using Revenue Centers with a Multi-Location/Single Database Configuration

For a Multi-Location/Single Database configuration, reports for each practice are based on the revenue centers set up for that practice. When EOP reports are run by practice (such as Daily Summary Report–By Practice), the assigned revenue centers are automatically used to print the applicable sales amounts.
You can also use separate sales, taxes, and discounts by practicing using revenue centers. This includes support for differing sales tax rates across multiple locations. (Note: There is one set of services and inventory. If separate pricing is needed, you must create multiple services and inventory items.)

For a Multi-Location/Single Database configuration, each revenue center and the practice associated with it are indicated on the Revenue Center List by practice-specific color coding to distinguish the practice assignments.

When adding or updating a revenue center with a Multi-Location/Single Database configuration, select a practice from the color-coded Practice drop-down list to associate the practice with the revenue center for reporting purposes.

**Partnerships**

The Split Billing feature allows you to divide the total owed to the practice among multiple owners of a patient, based on the percentage of ownership. The patient must be owned by the Partnership. You must set up partnerships before you can use Split Billing.

- You can divide the dollar amount owed among multiple owners. Separate invoices are sent to the owners.
- Bills are automatically split when End of Month processing is run; however, you can split the bills at any time.

**To add or edit a partnership:**

2. Click New to add a new partnership, or double-click an existing partnership to update it. The Partnership Information window appears.
3. In the Partnership ID text box, enter the client ID for the partnership. Press F2 to select an existing partnership from the Client List or enter a new partnership as a new client record.

**IMPORTANT:** You can use an existing client ID for a partnership only if the existing client ID does not have a balance and the ID is not the client ID for a member of the partnership.

4. In the Members area, in the Member ID column, type the client ID of the first member of the partnership or press F2 to select the client from the Client List. The associated Member Name appears.

5. In the Percentage column, enter the percentage of ownership that the first member holds.

6. Select the Send Reminders check box if this partnership member should receive reminders. You must also set the classification on the client record to receive reminders.

7. Continue adding partnership members until all the members are added. The total of the percentages must equal 100%.

8. Click OK, and then click Close.

For a complete list of partnerships, print a Partnership Report.

**Call Back Notes**

You can create a Call Back Notes list of commonly used call back notes, such as "Left message on answering machine." When you call the client back, you can quickly retrieve the call back record, and select the applicable note from the Call Back Notes list.

**To add or edit a call back note:**

1. On the Lists menu, select Call Back Notes. The Call Back Notes dialog box appears.

2. Click New to add a new call back note, or double-click an existing note to update it. The Call Back Note Information dialog box appears.
3. In the **Description** text box, type a description for the note.
4. In the **Note** text box, type the call back note text.
5. Click **OK**, and then click **Close**.

**To add a note to a call back in invoicing:**

When an invoice item with a reminder call back is entered on an invoice, a Call Back Note Information dialog box appears. This is the default.

**Note:** If you do not want to enter call back notes during invoicing, you can turn off this option by clearing the **Prompt for call back note** check box in Invoice defaults (see “Invoice Defaults” on page 112).

1. On the **Activities** menu, select **Invoice** and then select the client and patient.
2. Enter items as usual. When an invoice item with a reminder call back is entered, the Enter Note dialog box appears.

![Enter Note dialog box in invoicing](image)

3. In the **Call back note** area, do one of the following:
   - Type the note.
   - Click the **Select Note** button to select a note from a list of commonly used call back notes. The Call Back Notes List appears. Select the note that applies to the call back and click **Select**. Click **Close** to return to the Enter Note dialog box.
4. Click **Spell Check** to review the call back note for spelling errors.
5. Click **OK** to exit the Enter Note dialog box and return to the invoice.

**Note:** For information on setting up invoice items, see “Chapter 10: Setting Up Your Invoice Items” on page 180.

**Travel Sheets**

Create custom **Travel Sheets** of frequently used products and services used in your practice. You can use the travel sheet on your computer or print copies.

When you install your software, Cornerstone automatically creates a Sample Travel Sheet with the top 150 invoice items from the last twelve months to help you get started. You cannot make changes to the Sample Travel Sheet; however, you can save the travel sheet with a different name and make changes to the new travel sheet.

**To add or edit a travel sheet:**

1. On the **Lists** menu, select **Travel Sheets**. The Travel Sheet List dialog box appears.
2. Click New to add a new travel sheet or double-click an existing travel sheet to update it. The Travel Sheet Setup dialog box appears.

3. In the Enter description for travel sheet text box, type a description.

4. Click Setup to build your travel sheet. The Build Travel Sheets dialog box appears.

5. In the Invoice Item Information area and Type area, use the drop-down lists and check boxes to filter the item IDs list for quick selection from a narrowed list of items.

6. In the Item ID list, select the items to add to the travel sheet(s).
   - To select all item IDs in the list, click Select All.
   - To select more than one item, press and hold the CTRL key while you click to select each item.
   - To select a range of consecutive items, click the first item and then press and hold the SHIFT key while you click the last item in the range.

7. In the Travel Sheet Description list, select the travel sheets to which you want to add the selected products and services and click Add.
   - To select more than one travel sheet, press and hold the CTRL key while you click to select each sheet.
   - To select a range of consecutive travel sheets, click the first sheet and then press and hold the SHIFT key while you click the last sheet in the range.

8. Repeat steps 5–7 until you have added all items.

9. To remove an item from a travel sheet, select the item in the Item ID scroll list, select the applicable travel sheet or sheets in the Travel Sheet Description list, and click Remove.

10. To see a list of all items selected for an individual travel sheet, click View. On the View Travel Sheet dialog box, select a travel sheet and scroll through the list to view the items. Click Close when finished.

11. When finished building your travel sheet, click OK two times, and then click Close.
To arrange the order of the classifications on your travel sheet:

Note: You cannot change the order of the items on your travel sheet, but you can change the order of the classifications.

1. On the Lists menu, select Travel Sheets.
2. Select the travel sheet to change and click Update.
3. Click Order. The Travel Sheet Classification Order dialog box appears.

![Travel Sheet Classification Order dialog box](image)

4. Select a classification and then use the  and  arrow buttons to move the classification into a different order on your travel sheet.
5. Continue to move classifications using the arrow buttons until they are in the order you want.
6. Click OK two times and then click Close.

To print a travel sheet:

1. On the Lists menu, select Travel Sheets. The Travel Sheet List dialog box appears.
2. Select the travel sheet and click Print. The Travel Sheet Print window appears.

![Travel Sheet Print window](image)
3. Set the print options.
4. To view a preview of the travel sheet before printing, click **Preview**.
5. To print the travel sheet, click **Print**.

**To save an existing travel sheet under a new name:**
1. On the **Lists** menu, select **Travel Sheets**. The Travel Sheet List dialog box appears.
2. Select the travel sheet to save under a new name and click **Save As**. The Travel Sheet Save As dialog box appears.
3. Type the new name and click **Save**.

**To base a travel sheet on your Sample Travel Sheet:**
1. On the **Lists** menu, select **Travel Sheets**.
2. In the list of travel sheets, select the **Sample Travel Sheet** and click **Save As**.
   
   **Note:** If the Sample Travel Sheet is not listed, use **Tools > Update/Create Sample Travel Sheet** to create it.
3. Enter the new name for the travel sheet and click **Save**.
   
   You can now edit your new travel sheet as needed.

**To update your Sample Travel Sheet:**
As the top 150 items sold may change over time, you can update the Sample Travel Sheet at any time to reflect the current picture of sales.
1. On the **Tools** menu, select **Update/Create Sample Travel Sheet**.
2. When notified that the update is complete, click **OK**.

**Departing Instructions**

Use **Departing Instructions** to explain the care of an animal after treatment, surgery, or after administering medications or vaccinations. You can also use these educational paragraphs to recommend needed services and to advise when a return visit is necessary.

Set up departing instructions now and link them to invoice items later. Invoicing a linked item automatically prints the departing instruction on the invoice.

**To add or edit a departing instruction:**
1. On the **Lists** menu, select **Departing Instructions**. The Departing Instruction List dialog box appears.
2. Click **New** to add a new departing instruction or double-click an existing instruction to update it. The Departing Instruction Setup dialog box appears.
3. In the **Instruction ID** text box, type an ID (up to 7 characters) for the departing instruction.
4. In the **Description** text box, type a description for the departing instruction.
5. In the **Departing instruction** area, type the departing instruction text. You can edit the instruction during invoicing.
6. Click **Spell Check** to review your departing instruction for spelling errors.
7. Click **OK**, and then click **Close**.

**Tip:** Set up a miscellaneous departing instruction to use during invoicing for “special” instructions.

For a complete list of departing instructions, print a [Departing Instructions Report](#). (See “Departing Instructions Report” on page 247.)

### Prescription Instructions

Setting up **Prescription Instructions** is similar to setting up departing instructions: create a list of instructions and then link a specific instruction to a prescription invoice item. The prescription instruction prints on the prescription label.

You can use departing instructions with prescription invoice items, even if the items have a prescription instruction; however, you can use only **one** (1) prescription instruction per prescription invoice item.

**Note:** You cannot delete a prescription instruction if it is linked to an invoice item.

**To add or edit a prescription instruction:**

1. On the **Lists** menu, select **Prescription Instructions**. The Prescription Instruction List dialog box appears.
2. Click **New** to add a new prescription instruction, or double-click an existing instruction to update it. The Prescription Instruction Setup dialog box appears.
3. In the **Instruction ID** text box, type an ID (up to 7 characters) for the prescription instruction.

4. In the **Description** text box, type a description for the prescription instruction. Use descriptions that are easily connected to the prescription instruction ID.

5. In the **Instruction** text box, type the prescription instruction. Limit the prescription instruction text to fit the size of your label. You can edit the instruction when you create a prescription label.

6. Click **Spell Check** to review your prescription instruction for spelling errors.

7. Click **OK**, and then click **Close**.

For a complete list of prescription instructions currently set up in Cornerstone, print a **Prescription Instruction Report**.

**Staff Commission**

You can set up **Staff Commission** percentages for staff members or for an entire staff classification (such as all groomers). Percentages can be set up by invoice item classification, subclass, or invoice item. Staff commissions are based on sales totals, not receipts.

**To add or edit staff commissions:**

1. On the **Lists** menu, select **Staff Commission**. The Staff Commission List dialog box appears.

2. Click **New** to add a new staff commission, or double-click an existing staff commission to update it. The Staff Commission Information dialog box appears.

3. In the **Staff ID** text box, type the staff ID or press F2 to select a staff member from the Staff List.

4. In the **Default commission** text box, type the percentage. This percentage is used on all items not listed as exceptions.

5. To copy the commission settings from another staff member, select the **Copy commission settings from staff ID** check box and type the staff ID in the text box.

6. To copy the commission settings from a staff classification, select the **Copy commission settings from staff classification** check box and type the classification in the text box. (You must have set up your staff commissions by classification to use this option.)
**Note:** If you copy settings from another staff member or staff classification, it creates a new record. Any changes you make to the original at a later time will not be reflected in the new record.

7. To enter individual exceptions to the commission, in the *Commission exceptions* area, enter the class, subclass, or item ID, as appropriate, and the percentage. (The percentage can be zero if no commission is received for this item.)

8. Click **OK**, and then click **Close**.

**To set up staff commissions based on classification:**

1. On the **Lists** menu, select **Staff Classification Commission**. The Staff Classification Commission List dialog box appears.

2. Click **New** to add a new staff classification commission, or double-click an existing commission to update it. The Staff Classification Commission Information dialog box appears.

3. From the **Staff classification** drop-down list, select the staff classification.

4. In the **Default commission** text box, type the percentage.

5. To copy the commission settings from another staff member, select the **Copy commission settings from staff ID** check box and type the staff ID in the text box.

6. To copy the commission settings from another staff classification, select the **Copy commission settings from staff classification** check box and type the classification in the text box.

7. In the **Commission exceptions** area, enter individual exceptions to the commission (Class, Subclass, or Item ID, as appropriate) and the percentage.

8. Click **OK**, and then click **Close**.
Section 2–Cornerstone* Defaults Setup

Chapter 4: Setting Practice and Workstation Defaults
Chapter 5: Setting Staff Defaults
Chapter 6: Setting Cornerstone* Imaging Defaults
Chapter 4: Setting Practice and Workstation Defaults

Overview
A default is a setting you define so that either a particular setting automatically appears in a commonly used dialog box or the software automatically performs a particular action.

You do not have to set defaults; however, setting defaults saves time later if you enter the most commonly used answers or actions as the default settings. You can change the default settings that were preset when the IDEXX Cornerstone® Practice Management System was installed.

Accessing Practice and Workstation Defaults
1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. The left navigation pane lists the available properties that you can configure. A plus sign (+) box to the left of a property indicates that it has one or more associated subproperties—click the (+) box (or click the property) to expand its list of subproperties. Select the property or subproperty to configure.
   The corresponding configuration pane shows on the right.

Practice and Workstation Defaults Window

Note: The default properties listed in the navigation pane in the figure above may differ from the properties appearing in your installation of Cornerstone software. This may be because appropriate security permissions have not been granted for these areas of Cornerstone or because your
practice has not purchased and installed the Cornerstone feature associated with a particular default property. Depending on your actions, the following buttons may be available on the bottom of the Practice and Workstation Defaults window:

- **Apply**—Applies any changes made since the last time you clicked *Apply* and leaves the Practice and Workstation Defaults window open so you can continue viewing and changing additional properties as needed.
- **OK**—Applies any changes and closes the Practice and Workstation Defaults window.
- **Cancel**—If you have made any changes, you are asked if you want to save the changes and then closes the Practice and Workstation Defaults window. (Any previous changes applied using the *Apply* button are retained, not cancelled.)
- **Close**—Closes the Practice and Workstation Defaults window (appears in place of the *Cancel* button if no changes have been made or if changes have been applied).

### Account Defaults

Use **Account** defaults to set up the selections you use most frequently when working with client payments, returned checks, and account adjustments.

**Before You Begin**

- Set up payment types (*Controls > Payment Types*).
- Set up billing messages (*Controls > Billing Messages*).

**To set the Account defaults:**

1. On the *Controls* menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Account**. The Account configuration pane appears.

![Account defaults](image)

3. In the **Payment** area, do the following:
a. From the **Payment type** drop-down list, select the payment type to appear when a client makes a payment.

b. Select the **Calculate change given** check box to automatically calculate the amount of change to give to the client after receiving a payment. If you do *not* select this option, you must manually type the amount you return to the client.

c. Select the **Use Cashier ID** check box to track which staff members can accept payments.

d. Select the **Print heading** check box if you want your practice information to print on the payment receipt. (At posting, the payment appears on the invoice if payments have been applied on an invoice.)

e. In the **Copies** text box, enter the default number of copies of the payment receipt to print.

4. In the **Returned check area**, in the **Service charge** text box, type the service charge to apply for returned checks.

5. In the **Adjustment comment** area, type the default comment to appear when you adjust an account. You can edit this comment whenever you adjust an account.

   **Tip:** If you are just starting to set up your system, type the adjustment comment that you want to appear when you set up your clients’ accounts, such as “Balance transferred on 00/00/00.”

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

### Alerts Defaults

**Alerts** defaults allow you to set up alerts boxes to appear when you access records for a patient or client who meets certain conditions. You can also customize alerts using client and patient classifications.

When an alert appears, you can immediately update the missing information by clicking the **Process** button. When you have updated the information, Cornerstone returns you to the alert box so any other alerts can be processed. You must click **OK** to close the message box or process the alert before you can continue.

Alerts make staff aware of the following:

- Missing client or patient information
- Illogical information (such as a patient with a birth date over 100 years ago)
- Bad payment history
- Open invoices
- Multiple patient ownership
- Overdue or missing reminders
- Check-in alerts
- Specific types of clients and patients in your practice

**Notes:**

- **Cancelled** and **Failed Appointment** alerts are used with the Appointment Scheduler.
- The **No show reservation** alert applies only if you have the Boarding and Grooming module.
The Classification alert appears only if the Alert check box is selected in the Client Classification Setup or Patient Classification Setup. (The classification description and the classification answer both appear in the Alerts message box.)

Tip: You can set up a “Seasonal” client classification alert to notify staff if a client lives out of the area for some time during the year. The staff member can then take this into account when setting up reminders or payment schedules.

Before You Begin

- Set up client classifications for types of clients you want to identify (Controls > Classifications > Client tab).
- Set up patient classifications for types of patients you want to identify (Controls > Classifications > Patient tab).

To set the Alerts defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Alerts. The Alerts configuration pane appears.
3. Select or clear the client and patient alerts that you want to use or not use. Selected alerts are active.
4. If you are activating client and patient alerts and you do not want the alerts to reappear when the same client or patient is used multiple times on the same computer, select the Suppress consecutive client/patient alerts check box.
5. If you are activating client and patient alerts and you do not want the alerts to appear when a client or patient record is accessed from the Patient Clipboard*, select the Suppress client/patient alerts on patient clipboard check box.
6. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.
Compliance Alerts Defaults

With Compliance Alerts defaults, you can set up your system to display an alert when a patient who needs a recommended service is seen. When the alert displays, you can process the alert to see which services or tests are missing from the patient record.

Before You Begin

➢ Set up protocols (Reports > Compliance Assessment Tool > Protocol Setup Wizard).

To set the Compliance Alerts defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Alerts to expand its subproperties, and then click the Compliance Alerts subproperty. The Compliance Alerts configuration pane appears.

3. In the Compliance alerts area, select the protocols for which you want an alert to appear. Selected protocols are active. You can select more than one protocol.

➢ A number of predefined protocols are available with Cornerstone. Click the Display predefined IDEXX protocols check box to view the protocols.

4. In the Display compliance alerts area, select where in Cornerstone you want the compliance alerts to appear (Appointment Scheduler, Boarding Reservations, Check-In, Estimates, Invoices, Patient Clipboard). Selected display areas are active.

5. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Appointment Scheduler Defaults

The general Appointment Scheduler defaults allow you to set the Appointment Scheduler refresh rate, display, and resizing options, as well as specify the default appointment suite to display.
To set the Appointment Scheduler defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Appointment Scheduler. The Appointment Scheduler configuration pane appears.

3. The Appointment Scheduler screen refresh rate (in seconds) option allows the screen to refresh to reflect appointments made recently by other staff members on other workstations. In the text box, type the time (in seconds) you want to pass before the screen refreshes.

   **Note:** In general, a refresh rate of 60–90 seconds is recommended. Depending on your system resources, a rate below 60 seconds may slow down your system.

4. Select the Display appointment detail check box to view tooltip-style appointment details when you move the mouse over an appointment slot.

5. By default, the Schedule for Today window automatically resizes to fit the screen. Select the Turn off scheduler resizing for this workstation check box to turn off the resizing option. For practices using Terminal Services, turning off this option may help the Schedule for Today load faster.

6. From the Appointment suite drop-down list, select the suite to display by default when accessing the Schedule for Today window. The default suite displays unless there is a different suite assigned to the staff member currently logged in.

7. In the Next Appointment Reminder Messages area:
   a. Select the Display next appointment reminders check box. This check box is selected by default. If you don’t want reminders, clear the check box.
   b. To display messages only for certain items, select the Only display messages for invoice items in the list below check box. To add items to the list, enter the invoice item ID in an empty Item ID box or press F2 to select from a list.

8. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.
**Appointment Scheduler–Holiday Defaults**

Holiday defaults allow you to define and set up the holidays on which your practice will be closed so that appointments cannot be scheduled for those days.

**Tip:** Use a 5-year planning calendar to set up holidays in advance.

**To set the Appointment Scheduler–Holiday defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Appointment Scheduler** to expand its subproperties, and then click the **Holidays–Appointment Scheduler** subproperty. The Holidays–Appointment Scheduler configuration pane appears.

3. In the **Holiday preferences** area, select the check box for each holiday that your practice will be closed. (Appointments can be scheduled on these days, but Cornerstone displays a Practice Holiday message and the time slots are shaded gray.)

4. Select the **Utilize date-sensitive holidays** check box to automatically schedule holidays that fall on weekends. (A Saturday holiday is taken on Friday; a Sunday holiday is taken on Monday.)

5. In the **Additional holidays** area, do the following to schedule additional holidays:
   a. Click **Add**. The cursor will appear in the next available row in the **Name of holiday** column.
   b. In the **Name of holiday** column, type the name of the holiday and press TAB.
   c. In the **Date** column, type the date of the holiday (or date that the practice is closed for in-service, etc.) or press F2 to use the Calendar tool to choose a date.
      
      **Note:** You must enter additional holiday dates for each year they occur.
   d. To delete an additional holiday you have added, click within the holiday’s row and click the **Delete** button.

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.
Appointment Scheduler–Practice Hours Defaults

You must set up practice hour defaults before you can begin to schedule appointments using the Appointment Scheduler. This involves defining which days and hours the practice will be open.

To set the Appointment Scheduler–Practice Hours defaults:

IMPORTANT: Carefully choose the length of appointment times now. In order to change the time units after you have saved your changes here, you must purge all appointments, remove the practice hours, and start the practice hours setup again.

1. On the Controls menu, select Defaults > Practice and Workstation. The Defaults window appears.

2. In the navigation pane, click Appointment Scheduler to expand its subproperties, and then click the Hours–Appointment Scheduler subproperty. The Hours–Appointment Scheduler configuration pane appears.

3. For the Time units option, select 10 minutes or 15 minutes to specify the increment for scheduling appointments. This should be the minimum amount of time scheduled for an appointment. (If the practice schedules 20-minute appointments, select 10 minutes so you can easily block two 10-minute time units for the 20-minute appointments.)

4. Select the Open check box for each day your practice is open, and then type the start and close times for each day in the Start and Close text boxes. (Enter times as 8:00 am, 5:00 pm, etc.)

   Tip: You can use military time to quickly enter times that are on the hour (for example, 14 is 2:00 p.m.). You can also use Copy (CTRL+C) and Paste (CTRL+V) to enter times.

5. Select the Take lunch check box for days you close for lunch. Type the time you close for lunch and the time you reopen the practice in the Lunch text boxes for each day. The lunch block appears in yellow on the Appointment Scheduler. (Appointments can still be scheduled during this time.)

6. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.
Boarding Defaults

IDEXX Cornerstone Boarding & Grooming allows you to schedule boarding reservations and check your reservations in and out independently of your clinic/hospital patients. Although Cornerstone Boarding & Grooming is an optional module that is sold separately, its **Boarding** defaults are defined from the main Cornerstone program’s Practice and Workstation Defaults window.

There are two “styles” of boarding reservations in Cornerstone:

- **A hotel style** reservation spans more than one day, with check-in and check-out occurring on different dates.
- **A daycare style** reservation is for a period of time within a single day, with check-in and check-out occurring on the same date.

**Before You Begin**

- Set up classifications for clients, patients, and staff (**Controls > Classifications**).
- Set up the reasons for visit (**Controls > Reasons For Visit**).
- Set up rooms (**Lists > Room**).
- Set up cage types and reservation types (**Activities > Boarding > Cage Types or Activities > Boarding > Reservation Types**).

**To set the Boarding defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Boarding**. The Boarding configuration pane appears.
3. From the **Reservation type** drop-down list, select the default reservation type to use for making boarding reservations. Select **<None>** if you don’t want a default reason.
4. In the **Staff ID** text box, type the staff ID of the staff member who usually provides boarding services or press F2 to select a staff member from the Staff List. (Leave the Staff ID blank if you have multiple staff members who provide boarding services.)
5. Select the **Assign cage numbers** check box to automatically assign cages when making or checking in reservations. If this option is selected, the system will not let you check in a reservation without first assigning a cage number.

**Note:** If you select this option and pets are already checked in for boarding, the system displays a list of the checked-in pets and prompts you to enter valid cage numbers for them.

6. In the **Hotel Style check-in time/check-out time** text boxes, type the default check-in and check-out times to use when making hotel-style boarding reservations.

**Tip:** Depending on the type of reservation (hotel style or daycare style), the default check-in (or check-out) time is automatically placed in the *Arrival* text box (or *Departure* text box) on the Reservations window when a reservation is made. You can enter a different time or press TAB to accept the default time.

7. In the **Daycare Style check-in time/check-out time** text boxes, type the default check-in and check-out times to use when making daycare-style boarding reservations.

8. In the **How to bill for multiple pets** area, select one of the following fee options:

   - Select **Use primary fee for first pet** if none of your cages are shared or if cages are shared but you want to charge only one fee for the cage and not assess a separate fee for each pet sharing the cage. For example, if this option is selected and the cage is shared, the same price is charged for cage occupancy whether one pet or five pets occupy the cage.
   - Select **Use primary fee for first, multiple fee for all others** if cages are shared and you want to charge a separate fee for the first pet and a different fee for additional pets that occupy a cage.
   - Select **Use multiple fee for each pet** if cages are shared and you want to charge the same fee for each pet occupying the cage.

**Tip:** You can automatically link an invoice item to a cage type with the fee to charge for cage occupancy, depending on whether the fee charged is a primary fee, a multiple fee, or both. Then each time a reservation is made for a cage, the invoice item and its price are automatically included on the reservation. If necessary, you can change this invoice item and price.

9. In the **Round down reservation hourly charge** area, select the time increment that you want to round down to (15, 30, or 60 minutes). These options apply only to reservation types with the **Number of times to charge for cage** set as **Once each hour**.

   - For example, if you choose to round down to 15 minutes, the client is charged for 15 minutes only after the entire 15 minutes has passed. So if a pet is checked in at 1:00 p.m. and checked out at 6:12 p.m. the same day, the charges will be calculated for 5 hours (not 5.25 hours).

10. In the **Grooming appointment** area, do the following:

   a. From the **Staff classification** drop-down list, select the default staff classification to use for making grooming appointments.
   b. From the **Reason for visit** drop-down list, select the default reason for visit to use for making grooming appointments.
   c. In the **Check rooms to use for grooming** table, select the check box in the **Use For Grooming** column for each room you use for grooming appointments. These rooms are used when searching for available grooming appointments.

11. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.
Holidays–Boarding Defaults

Holidays–Boarding defaults indicate when the boarding facility is staffed to provide service to clients independently of the veterinary practice. Set up boarding facility holidays so you can schedule boarding check-in/out on holidays when staff are available and avoid scheduling on holidays when staff members are not on duty.

Tip: Boarding holidays must be set up specifically for each year; they do not automatically carry over to the next year. If you use a 5-year calendar to set up holidays in advance, you will not have to remember to do this every year.

To set the Holidays–Boarding defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Boarding to expand its subproperties, and then click the Holidays–Boarding subproperty. The Holidays–Boarding configuration pane appears.

3. In the Date column, type the date of the holiday or press F2 to use the Calendar tool to choose a date, and then press TAB.

4. In the Description column, type a description (name) for the holiday.

5. If the boarding facility is open for check-in/out on a holiday, click No in the Open column for that holiday to switch it to Yes. The standard office hours for that date (set up in Appointment Scheduler) appear in the Start and Close columns.

6. If the boarding facility start and close times are different from the practice hours for that date, type the times in the Start and Close columns.

   Note: To remove a holiday from the list, select a field in the holiday line that you want to delete and press CTRL+D.

7. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.
Check-in Defaults

Check-in defaults include the information to print on check-in reports, as well as the most commonly used check-in reason for visit, staff ID, and room.

Before You Begin

- Set up reasons for visit (Controls > Reason For Visit).
- Enter staff members (Controls > Staff).
- Set up rooms (Lists > Room).

To set the Check-in defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Check-in. The Check-in configuration pane appears.
3. From the Reason for visit drop-down list, select the reason for visit that applies to the majority of your patients (or select <None> if you don’t want a default reason).
4. In the Staff ID text box, type the staff ID of the staff member who sees most of the patients or press F2 to select a staff member from the Staff List. (Leave the Staff ID blank if you do not want to specify a default staff member for check-in.)
5. From the Default room drop-down list, select the room where most patients are received (or select <None> if you don’t want a default room).
6. Select the Verify check out check box to have the software prompt: “Are you sure you want to check out?” when you click Check-out from the Census List or the Check-in window.
7. If your practice wants to count only compliance for patients that were checked into the practice through Cornerstone, click the Use check-in date for compliance check box.
8. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.
Check-in Print Options Defaults

The Check-in Print Options defaults allow you to set printing preferences and specify the types of information to print on the Check-In Report.

To set the Check-in Print Options defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Check-in to expand its subproperties, and then click the Check-in Print Options subproperty. The Print Options configuration pane appears.

3. In the Information to print area, clear the check boxes of any information that you do not want to print on the Check-In Report (for example, billing messages). A check mark in a check box means that the corresponding item will print.

4. In the Information to print area, if you do not want all information for a selected item to print, select a time range from the drop-down list.

   Note: The Exams (Patient Advisor exams), Lab results, and Image cases check boxes are applicable only if your practice has purchased the corresponding Cornerstone modules.

5. To exclude voided items on the Check-In Report, select the Hide voided items check box.

6. To print the patient’s birth date as the age (such as 2 yrs, 3 mths, 1 day), select the Print birth date as age check box.

7. From the Print check-in report drop-down list, select one of the following options to set the default behavior for printing a Check-In Report when a patient is checked in:

   - **Always ask** displays a message box asking if you want to print the report.
   - **Always print** automatically prints the report.
   - **Never print** does nothing (no report prints).
8. If you want to print patient history in date order on the Check-In Report, select the **Print history in date order** check box. If this option is selected, you also need to specify the **# of lines of history to print** (default number of patient history lines to print) on the Check-In Report.

9. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Client Defaults**

Use **Client** defaults to set up the selections you use most frequently when setting up a new client’s information or accounts receivable (A/R) information. Setting up Client defaults saves you time when you add new clients.

**Before You Begin**

- Practices in a network environment should devise a system for entering new clients. If you choose to assign your own IDs, either specify which users enter new clients or specify ranges of IDs to use at specific workstations.
- Set up client classifications (**Controls > Classifications > Client** tab).
- Set up credit codes (**Controls > Credit Codes**).
- Set up postal codes (**Lists > Postal Codes**).
- If your practice uses CareCredit®, set up client user-defined prompts (**Controls > User Defined Prompts > Client** tab).

**To set the Client defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Client**. The Client configuration pane appears.

3. In the **Client information** area, do the following:
a. In the **Client ID** text box, type the beginning client ID. You can use both letters and numbers; however, only numeric client IDs are automatically assigned.

   **Note:** The Cornerstone system uses an alphanumeric sorting process that allows you to use alphanumeric IDs. This means that numbers are treated as letters when they are sorted (like a dictionary). Numbers do *not* appear to be sorted “numerically.” The ID “10” appears after “1” and before “2.” If you want a “numerical” sort, you must start your IDs at a large enough number that Cornerstone will not have to add another digit. For example, setting the beginning ID at 1,000 gives you 8,999 IDs before Cornerstone adds another digit (at 10,000).

b. Select the **Auto assign** check box if you want ID numbers to be generated automatically when setting up new clients.

c. From the **Classification** drop-down list, select the client classification used most often (or select `<None>` if you don’t want a default classification).

d. In the **Recently accessed clients** text box, enter the number of clients (up to 99) you want Cornerstone to remember. The recent clients appear first when you press F2 to select a client from the Client List. See “Chapter 1: Getting Started with Cornerstone” in the *Cornerstone User’s Manual* for information on using recent clients.

e. Select the **Use most recent client** check box to display the client whose record was last open in any of these windows: estimate, invoice, correspondence, prescriptions, lab requests, and client account.

f. In the **Postal code** and **Area/City code** text boxes, type the postal code and area or city code to appear by default in Client Information when setting up new clients.

4. In the **A/R information** area, do the following:

   a. From the **Credit code** drop-down list, select the credit code used most often (or select `<None>` if you do not want a default credit code).

   b. Select the applicable check boxes (**Billing charge**, **Finance charge**, and **Tax exempt**) for A/R defaults.

   c. Select the **Show client balances on trainer reminder groups** check box if you want to include account balances on trainer reminder groups.

5. If you would like to omit voided invoices when printing monthly statements and invoices, select the **Omit voided invoices and payments on statements** check box. (If necessary, you can override this setting at statement time on the Statements and Monthly Invoices dialog box.)

   **Note:** If **Omit voided invoices…** is selected, note that a voided invoice is omitted only if the original invoice is also part of the current statement. If the original invoice was included in a prior Month-End period that is not selected, the voided invoice is included in the current statement (regardless of the **Omit voided invoices…** setting).

6. **CareCredit users only:** In the **CareCredit** area, select settings from the **Client Birthdate** and **Client SSN** drop-down lists, if applicable. (You can set up these fields in **Controls > User Defined Prompts**, on the **Client** tab.)

7. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.
Daily Entries Report Defaults

Use the Daily Entries Report defaults to specify the types of information to use for tracking changes, additions and deletions of billed lines on invoices, and the Patient Visit List (PVL). The invoice and PVL information options selected here print on the Daily Inv. and PVL Entries reports.

To set the Daily Entries Report defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
3. Select the Include invoice entries on report check box and select the invoice changes your practice wants to audit and include on End of Period reports.
4. Select the Include patient visit list entries on report check box and select the Patient Visit List changes your practice wants to audit and print on End of Period reports.
5. In the Number of months to keep report information text box, enter the number of months.
6. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Daily Planner Defaults

The Daily Planner defaults allow you to specify settings pertaining to the Daily Planner Diagnostics tab, which allows you to manage laboratory results and requests for a specific staff member or for all staff.

To set the Daily Planner defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Daily Planner. The Daily Planner configuration pane appears.
3. In the **Include posted lab results from the last ___ days** text box, set the time frame (in days) for displaying posted laboratory results on the **Diagnostics** tab.

4. Using the **Include**... check boxes, select the check box for each type of laboratory request and result to display by default on the **Diagnostics** tab:
   - **Include posted results**—Display laboratory results that have been posted to the patient’s history.
   - **Include pending results**—Display laboratory requests.
   - **Include completed results**—Display laboratory results that need to be reviewed and posted to the patient’s history or rejected.
   - **Include orphan results**—Display laboratory results that cannot be matched to a patient within Cornerstone.
   - **Include not requested results**—Display laboratory results that were not part of the original request.
   - **Include no template results**—Display laboratory results that do not fit in one of the existing templates within Cornerstone.
   - **Include rejected results**—Display laboratory results that have been declined by staff and not posted to the patient’s history.

5. If staff would like the option to generate call backs for lab results within the **Diagnostics** tab, do the following:
   a. In the **Item ID** text box, type the ID of the invoice item you have set up for lab call backs or press F2 to select the item from the Invoice Item List.
   b. In the **Days** text box, enter the standard number of days needed before a lab call back is due. This number is used to calculate the date listed by default when scheduling a call back within the **Diagnostics** tab.
Note: You must specify a lab call back item ID in Daily Planner defaults in order to use the call back features on the Diagnostics tab.

6. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Documents Defaults

The Documents defaults allow you to set preferences for creating and printing medical notes and correspondence documents.

To set the Documents defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Documents. The Documents configuration pane appears.

3. In the Medical Note options area, do the following:
   a. Select the Display partial medical note in correspondence (classic only) check box if you want to be able to select the information from your medical note templates to include in correspondence (available only for Classic medical notes). See "Chapter 18: Setting Up Classic Medical Notes" beginning on page 351 for information on Classic medical notes.
   b. Select the Medical Note must be finalized before patient can be checked out check box if you want to require medical note templates be finalized before a patient can be checked out from the Check-in/out window (with no override available at check-out time). As this type of setup could cause delays at check-out time, in most cases you would not want to select this option.
   c. If you want medical note templates to be finalized automatically after a certain number of days, enter the time period in the Autofinalize after __ days text box. The number of days specified here is the general default used for all documents (including correspondence), but you can change this value for each document.

   Note: Medical notes and correspondence documents saved in Draft mode will not auto finalize.
Chapter 4: Setting Practice and Workstation Defaults

4. In the Default templates area, specify the templates to use by default for creating or converting to a new enhanced template or adding a Medical Note Quick Text document for a patient:

- **For new templates use**—This setting allows you to specify the default setup document template used for creating a new enhanced document template or for converting to a new enhanced document template. To designate this default template, in the Medical Note ID text box, type the ID of the template or press F2 to select the template from the Document Template List. See “Customizing the Default Setup Document Template” on page 335 for more information.

- **For Medical Note Quick Text documents use**—This setting allows you to specify the text-only template that is used when you add a Quick Text medical note for a patient. To designate this default template, in the Text Only ID text box, type the ID of the template or press F2 to select the template from the Document Template List.

5. In the Invoice Items area, select your preferences for printing invoice items on medical notes or correspondence:

- **Include invoice items when printing Medical Notes**—On medical notes, prints invoice items with a Patient Visit List (PVL) status of Recommended, Selected, or Performed.

- **Include invoice items when printing Correspondence**—On correspondence, prints invoice items with a PVL status of Recommended, Selected, or Performed.

If either of the above options is selected, its Also Include options are also available:

- Declined item—Also prints items with a PVL status of Declined, Declined to history, or Blank.
- Amount—Also prints the Amount for each invoice item.
- Staff ID—Also prints the Staff ID for each invoice item.

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Favorite Documents Defaults**

The Favorite Documents defaults allow you to designate a list of the practice’s favorite document templates, which can simplify document template searches on the Document Template List window and Start New Document window.

**To set the Favorite Documents defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Documents** to expand its subproperties, and then click the **Favorite Documents** subproperty. The Favorite Documents configuration pane appears.

d. Type a number in the **Ask for weight if last entry is older than __ days** text box to specify the number of days to use for determining if the most recent patient weight entry is considered current. The Cornerstone Editor compares this setting to the date of the most recent weight recorded for the patient in Cornerstone. If the date of the weight is older than the specified number of days, the staff member is prompted to enter a current weight for the patient.
3. In the Favorite document templates area, specify the “Practice Favorites” templates to appear in the Favorites drop-down list when searching for a template.

   **Note:** You cannot select Classic medical note templates as favorites.

   - To add a document template to the list, in the first available row’s ID column, type the template ID or press F2 to select a template from the Document Template List.
   - To remove a document template from the list, click the template’s ID in the ID column and then press CTRL+D.

   **Tip:** You can also designate a template as a favorite by selecting the Show in Practice Favorites check box in the Template Properties when creating or updating a template.

4. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

### End of Period Defaults

End of Period defaults include the reports that automatically print when you process End of Day, End of Month, and End of Year, as well as the charges that are calculated by default at End of Month.

**To set the End of Period defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **End Of Period**. The End Of Period configuration pane appears.
3. To select the reports to print by default when you print End of Period reports, select each report name under Daily reports, Monthly reports, and Yearly reports. Use the scroll bars to view each complete list. (Highlighted/shaded reports are selected.)

4. In the Monthly closing area, select the appropriate check boxes to specify the End of Month closing charges to apply and type the corresponding amount or percentage in the text box:
   - Finance charge percent (monthly percentage)
   - Minimum finance charge (amount)
   - Billing charge (amount)
   - Billing threshold (minimum amount for billing charge). The minimum owed to the practice must be more than the billing threshold or a statement will not print.

   **Tip:** A billing charge is applied to all accounts that will receive a bill at End of Month closing. If you would like to apply a billing charge only to accounts 30 days and over, we suggest you put the charge amount in the Minimum finance charge text box instead.

5. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

   **Note:** For information on the settings in the Mobile computing area, see “Chapter 31: Setting Up the Mobile Computing Module” beginning on page 462.

**Estimate Defaults**

The Estimate defaults allow you to set estimate printing preferences and specify the default messages used most frequently when printing estimates.

**To set the Estimate defaults:**

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Estimate. The Estimate configuration pane appears.
3. In the Estimate area, do the following:
   a. In the Staff ID text box, type the ID for the staff member to use by default on new estimates or press F2 to select a staff member from the Staff List.
   b. In the Number of days to store unsigned estimates text box, enter the default number of days (up to 999). Estimates that have not been electronically signed by the client are deleted during End of Day processing after the specified number of days.
   c. Select the Finalize estimate check box to set the default status of an estimate to final when it is saved. (Depending on how Add invoice items to PVL field is set, invoice items may automatically transfer to the Patient Visit List when the estimate is finalized.)

4. In the Transfer to patient visit list when finalized area, do the following:
   a. Select Low prices to automatically transfer the low prices from a finalized estimate to the Patient Visit List, or select High prices to automatically transfer high prices.
   b. Use the Add invoice items to PVL drop-down list to specify if invoice items should automatically be added to the Patient Visit List from a finalized estimate.

5. In the Estimate print area, do the following:
   a. Select the Print staff name check box if you want to print the staff name on estimates.
   b. Select the Print item ID check box if you want to print invoice item IDs on estimates. These IDs will print instead of the date on each line of the estimate.
   c. Select the Use authorizing signature check box if you want the option to have clients provide electronic signatures on estimates. This setting also determines which option is selected by default on the Save Estimate dialog box—Preview/Signature (if check box is selected) or Save and continue (if check box is not selected).
   d. If the Use authorizing signature check box is selected, a Use witness signature check box is also available. Select the Use witness signature check box to add a Witness Signature line to the estimate.
Chapter 4: Setting Practice and Workstation Defaults

Page 105

e. If you are not using electronic signatures on estimates (for example, if Use authorizing signature is not selected), you can select the Preview before printing check box to set the Preview option to be selected by default on the Save Estimate dialog box.

f. In the # copies text box, enter the number of estimate copies to print by default.

6. In the Print prices area, select one of the following print prices options:
   - Only low prices prints only low prices on the estimate.
   - Only high prices prints only high prices on the estimate.
   - Both low and high prices prints both low and high prices on the estimate.
   
   **Note:** The default estimate price options set here can be changed at the time a new estimate is saved by clicking the Options button on the Save Estimate dialog box.

7. In the Print area, select one of the following print options:
   - Both detail and total prints detailed pricing on the estimate.
   - Only total prints only the total prices on the estimate.

8. In the Estimate message area, you can specify one or more estimate messages to use by default on estimates. Do the following:
   a. In the ID text box, type the estimate message ID or press F2 to select a message from the Estimate Message List. You can click the estimate number (to the left of the message row) to view the associated message text in the Message lines area.
   b. Add additional messages as needed.

9. Select the Print estimate messages on separate page check box if you want estimate messages to print on a separate page, not on the same page as the actual estimate.

10. If necessary, use the ‹ and › arrow buttons (below the Message lines area) to change the order in which the messages display on the estimate.

11. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

**Estimate Address Defaults**

The Estimate Address defaults allow you to change where the practice and client addresses print on the estimate to accommodate different types of window envelopes.
If you specified a practice logo in Practice defaults, you have the option to include that logo in the header of your estimates. You can set up your estimate header layout to include or exclude the practice address and practice logo, depending on your preferences and the information included in your logo. See “Practice Defaults” on page 127 for more information on adding a practice logo.

**IMPORTANT:** If you choose to print a practice logo on your estimates, ensure that the logo does not cover important header information, such as the client name, address, and date. Other header information is not adjusted or positioned relative to the physical space taken up by the logo.

**To set the Estimate Address defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Estimate** to expand its subproperties, and then click the **Estimate Address** subproperty. The Estimate Address configuration pane appears.

   ![Estimate Address Defaults](image)

   **Estimate Address defaults**

   **Tip:** If you have already set up a header layout for use on invoices and want to use the same layout for estimates, in Invoice Address defaults, select the **Use address layout for estimates** check box. This allows you to set up your header positioning once for use on both invoices and estimates.

3. To include the practice address in the estimate header, select the **Print practice address on estimates** check box. The **Practice Address** positioning box appears.
4. To include a practice logo in the estimate header, select the **Print practice logo on estimates** check box. (Note: This option is not enabled until you specify a practice logo graphic file in Practice defaults.) The **Practice Logo** positioning box appears.
5. Click the logo or address positioning box you want to move, and then use your keyboard arrow keys to reposition the box.
6. Depending on the **Practice Logo** and **Practice Address** box positioning, you may want to change the **Align practice address text** setting (Left, Center, or Right) to align the name and address text accordingly. For example, if you position the **Practice Address** at the left margin, you may also want to align the name and address text at the left margin.
7. To print a test page that includes placeholder blocks for the header and footer fields in your current layout, first click **Apply** and then click **Test Page**.
   **Note:** On the test page, the two sets of blocks on the right side of the header are reserved for the estimate date and client ID; you cannot move these blocks.
8. If necessary, click **Reset** to undo your positioning changes and start over based on the default alignment settings.
9. If you want to use the same layout for invoices, select the **Use address layout for invoices** check box. This allows you to set up your header positioning once for use on both estimates and invoices.
10. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.
   **Tip:** We recommend printing a sample estimate to check your address alignment before printing actual client estimates. You may need to readjust depending on your envelope.

**IDEXX VetLab* Settings**
You can specify default computers to be used for specific workstations and practice locations. When ordering tests, staff can always override these defaults and choose from the entire list of IDEXX VetLab* Station computers. When patients are checked in through the Cornerstone Census List, the patient information is automatically displayed on the Census List of the IDEXX VetLab Station computers associated with the check-in practice or the check-in workstation.

**To specify default IDEXX VetLab Station computers for a practice and/or workstation:**
1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **IDEXX VetLab Settings**. The IDEXX VetLab Settings configuration pane appears.
3. **Multi-Location/Single Database Only:** To specify a default IDEXX VetLab Station for a practice location, select the practice name from the **Practice** drop-down list, and then select the IDEXX VetLab Station from the **VetLab Station** box or select the **Use all** check box.
4. To specify a default IDEXX VetLab Station for a workstation, select the workstation name (workstation names are displayed on each IDEXX VetLab Station) from the **Workstation** drop-down
list, and then select the IDEXX VetLab Station from the VetLab Station box or select the Use all check box.

**Note:** If practice and workstation settings conflict, the workstation settings take precedence.

5. Click Apply.

6. Repeat steps 3–5, as needed, for other practice locations and workstations.

7. When finished, click OK.

**Imaging Defaults**

The Imaging defaults allow you to set preferences for pet picture compression and image storage. In addition, if IDEXX Diagnostic Digital Imaging Integration is activated, you can set preferences for using image request features in Cornerstone.

**Note:** System settings for imaging are defined in Controls > Defaults > Imaging. See “Chapter 6: Setting Cornerstone* Imaging Defaults” beginning on page 155 for information.

**To set the Imaging defaults:**

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Imaging. The Imaging configuration pane appears.

3. In the Imaging Defaults area, do the following, if necessary:
   - Adjust the Pet picture image compression setting. Enter a range from 1 (small file and lower quality) to 99 (larger file and highest possible quality).
   - Change the Maximum files per folder setting to specify the number of images stored per folder.

   **Note:** For information on the Copy images to mobile computer setting, see “Copying Images to a Mobile Computer” on page 465.

4. **IDEXX Digital Imaging Integration only:** In the Image Requests area, do the following:
Note: The Activate image requests option is used to activate IDEXX Digital Imaging Integration if you have purchased this feature.

a. Select the Use Special Actions check box if you want invoice items that are set up to initiate the Image Request special action to also activate the New Image Requests dialog box when the item is added to the Patient Visit List (PVL) or invoice for a patient.

b. If the Use Special Actions check box is selected, you can select the Use billing staff on a new image request check box to use the billing staff on the PVL or invoice as the staff who is associated with an image request when the request is initiated using a special action. If this option is not selected, the default staff is based on the last staff member who performed an image request on that workstation.

c. From the Staff to use on requests without Special Action drop-down list, select the default staff to associate with an image request that is created without the use of a special action. Options include:
   - No default staff—No default staff is associated with the image request, requiring you to select a staff member at the time the request is created.
   - Last staff used on workstation—Uses the last staff member who performed an image request on that workstation.
   - Specific staff—To designate a specific staff member, type the staff ID or press F2 to select a staff member from the Staff List.

d. From the Default invoice item class drop-down list, specify a default classification (such as Radiology) to narrow the list of items displayed when creating an image request. This allows you to filter out unrelated invoice items and speed up the search process.

5. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Inventory Defaults

The Inventory defaults save time and keystrokes when placing orders and setting up inventory items. Enter the most commonly used answers or actions as the default settings. You can always modify default settings when they appear in a window.

Note: Some Inventory default settings are available only if using a multiple location per item inventory setup.

Before You Begin

- Set up taxes (Controls > Taxes).
- Set up vendors (Inventory > Vendors).
- Set up inventory locations (Inventory > Locations).

To access the Inventory Defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Defaults window appears.
2. In the navigation pane, click Inventory. The Inventory configuration pane appears.
3. In the **Inventory defaults** area, do the following:

a. In the **Vendor ID** text box, type the ID of your primary vendor (the vendor that you order from most often) if you want this vendor to be used by default when setting up new inventory items. You can also press F2 to select the vendor from the Vendor List.

b. In the **Order ID** text box, type the number to use to begin numbering new orders. The next available ID appears in a new order. (The default order ID is updated as numbers are used.)

c. In the **Usage tax** list, select the usage taxes that apply to the majority of your inventory items (you can apply more than one tax). See “Linking Taxes and Discounts to Invoice Items” on page 194 for information on usage taxes.

   **Note:** You can also set up taxes for an entire invoice item classification by updating an item classification in **Lists > Invoice Item Class**. Any defaults that apply to the item classification are in addition to the taxes set up here.

d. In the **Show item history for** text box, enter the number of months to display an inventory item’s history (receipts, returns, orders, and transfers). To view an item’s history, click the **Item History** tab on applicable Cornerstone Inventory windows.

e. **Multiple location inventory only:** From the **Receiving location** drop-down list, select a default receiving location. Initially, the default location is **Central Storage**; however, you can select any location at the practice.

f. If you do not want to review adjustments before confirming them, select the **Auto confirm adjustments** check box. (Note: Unconfirmed adjustments can be voided; confirmed adjustments cannot be voided.)

g. If you do not want to review transfers before confirming them, select the **Auto confirm stock transfer** check box.

h. To automatically delete items from the Want List after they are completed, select the **Delete want items on completed** check box. (Want Items are “completed” when they are added to an order.)
i. To automatically print notes attached to the purchase order, select the Print purchase order notes check box.

4. In the When inventory details need to be verified area, specify when inventory details (location, lot number, expiration date) need to be verified.
   a. Inventory details are required for a prescription when you post an invoice; however, you can require inventory details earlier, when the prescription is created. In the Prescriptions drop-down list, select one of the following:
      • Not required—Do not require inventory details when the prescription is created.
      • Warn if not verified—Display a warning if the inventory details are not filled in and verified when the prescription is created.
      • Required—Require staff to fill in the inventory details and mark as verified when the prescription is created.
   b. Inventory details are required when you post an invoice; however, you can require inventory details earlier when you save the Patient Visit List (PVL), invoices, and Patient Advisor* exams. From the Performed PVL items and Saved Invoices drop-down list, select one of the following:
      • Not required—Do not require inventory details when the PVL, invoice, or exam is saved.
      • Warn if not verified—Display a warning if inventory details are not filled in and verified when the PVL, invoice, or exam is saved.
      • Required—Require staff to fill in inventory details and mark as verified before they can save the PVL, invoice, or exam.
   c. You can specify what should happen if a staff member tries to send invoice items from a document (medical note or correspondence) to the PVL when inventory details have not been verified. From the Performed Document Items drop-down list, select one of the following:
      • Not required—Do not require inventory details to be verified at the time that the invoice items are sent from the document to the PVL. (The inventory details would still need to be verified later on the PVL or invoice.)
      • Warn if not verified—Display a warning if inventory details are not filled in and verified at the time that the invoice items are sent from the document to the PVL. (The inventory details would still need to be verified later on the PVL or invoice.)
      • Required—Require staff to fill in inventory details and mark as verified before they can send invoice items from a document to the PVL.

5. In the Inventory depletion area, do the following:
   a. Multiple location inventory only: When inventory items that track quantity on hand are consumed, to automatically set a default location and mark it as verified, select the Automatically mark inventory details as verified when location is defaulted in check box. (If you want to require staff to verify the location when an item that tracks quantity on hand is consumed, clear this check box.)
   b. If you want to select the item with the oldest expiration date at a location as the default when consuming inventory (for example, when invoicing an item), select the Automatically default in the oldest expiration date in the location check box.
IMPORTANT: Use the Automatically default in the oldest expiration date in the location option only if your practice’s policy is to always consume the oldest inventory stock first.

6. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Invoice Defaults

Use Invoice defaults to set up the selections you use most frequently when working with invoices.

Before You Begin

➢ Set up invoice types (Controls > Invoice Types).

To set the Invoice defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Invoice. The Invoice configuration pane appears.

3. In the Invoice area, do the following:

   a. In the Staff ID text box, type the ID for the staff member to use by default on new invoice or press F2 to select a staff member from the Staff List.

   b. From the Invoice type drop-down list, select the type of invoice to use by default when creating a new invoice.

   c. Select the Invoice type required check box to make an invoice type mandatory.

   d. Select the Display patient visit message check box if you always want to see a message asking you if you want to see the Patient Visit List (PVL). Clear the check box if you want the PVL to automatically appear when it includes items for the patient you are invoicing.

   e. Select the Automatically mark patient as deceased check box to automatically change a patient’s status to Deceased when they are invoiced for an item with the special action Mark As
Deceased. If this option is not selected, staff must verify the patient’s status each time the special action is used.

f. Select the **Apply group item pricing before dispensing fee and minimum price** check box if your practice gives discounts on invoice item groups and you want to exclude dispensing fees and minimum prices from the discount.

g. Select the **Prompt for call back note** check box if you want to be prompted to enter a call back note when a call back reminder is entered on an invoice. Clear the check box if you do not want a prompt.

h. Select the **Display below reorder point warning** check box if you want an alert box to open when an item that is at or below the reorder point is placed on an invoice. Clear the check box if you do not want an alert.

i. Select the **Omit duplicate special action documents** check box to prevent duplicate documents from printing when multiple items on the invoice are set up to print the same document.

j. Select the **Use controlled substance reasons** check box if you want to require staff to enter a reason when a controlled substance is dispensed. The controlled substance reason prints on the Controlled Substance Log. See “Controlled Substance Reasons” on page 35.

4. In the **Invoice print** area, do the following:

a. Select the **Print heading** check box if you want your practice information to appear at the top of invoices. Clear the check box if you do not want to print practice information; for example, if your practice uses invoice paper with a preprinted logo.

b. In the **# copies** text box, specify the number of invoice copies to print by default.

c. Select the **Print staff name** check box if you want the name of the provider who performed the service to print on the invoice. Clear the check box if you do not want the name to print.

d. Select the **Print patient reminders** check box if you want to print patient reminders on invoices.

e. To print future appointments for active patients on the bottom of invoices, enter the number of months in the **Number of months to print appointments for** text box.

f. Select the **Turn on invoice receipt option** check box to allow printing 3-1/8” invoice receipts instead of full page invoices (an Epson TM-T88IV receipt printer is required for printing invoice receipts). You can also specify **Full Invoice** or **Invoice Receipt** as the default for this workstation using the Workstation default settings.

5. In the **A/R by provider** area, do the following:

a. Select the **Calculate accounts receivable by provider** check box if you pay your providers based on collected accounts receivable. Selecting the A/R by provider defaults activates the Aged Accounts Receivable Report by Staff and the Productivity by Staff Report. If you do not pay your providers this way, do not activate these reports.

b. Select the **Apply payment to specific invoices for A/R by provider** check box to always apply payments received to the specific invoice (if this option is not selected, the payment on the invoice will be applied to the oldest balance first). In general, we recommend that you do not select this option unless you are also using the previous Calculate accounts receivable by provider option.
Note: If you activate the A/R by provider defaults, when you save the defaults, the system requires that you enter the percentage of accounts receivable for each aging period (30, 60, 90) that currently exists for each provider.

6. In the Patient visit list area, do the following:
   a. When you open the Patient Visit List, recommended, accepted, and performed items are automatically selected to be transferred to an invoice. To change the types of items that are selected automatically, clear the Include recommended, Include accepted, and Include performed check boxes as needed.
   b. To turn off the blue comment line that displays in the Patient Visit List by default, clear the Display blue comment line check box.
   c. Select the Display duplicate items warning check box if you want the software to warn you when duplicate items are entered for a patient on the Patient Visit List.

7. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Invoice Address Defaults

The Invoice Address defaults allow you to change where the practice and client addresses print on the invoice to accommodate different types of window envelopes.

If you specified a practice logo in Practice defaults, you have the option to include that logo in the header of your invoices. You can set up your invoice header layout to include or exclude the practice address and practice logo, depending on your preferences and the information included in your logo. See “Practice Defaults” on page 127 for more information on adding a practice logo.

IMPORTANT: If you choose to print a practice logo on your invoices, ensure that the logo does not cover important header information, such as the client name, address, and date. Other header information is not adjusted or positioned relative to the physical space taken up by the logo.

To set the Invoice Address defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Invoice to expand its subproperties, and then click the Invoice Address subproperty. The Invoice Address configuration pane appears.
Invoice Address defaults

**Tip:** If you have already set up a header layout for use on estimates and want to use the same layout for invoices, in Estimate Address defaults, select the *Use address layout for invoices* check box. This allows you to set up your header positioning once for use on both estimates and invoices.

3. To include the practice address in the invoice header, select the *Print practice address on invoices* check box. The Practice Address positioning box appears.

4. To include a practice logo in the invoice header, select the *Print practice logo on invoices* check box. (Note: This option is not enabled until you specify a practice logo graphic file in Practice defaults.) The Practice Logo positioning box appears.

5. Click the logo or address positioning box you want to move, and then use your keyboard arrow keys to reposition the box.

6. Depending on the Practice Logo and Practice Address box positioning, you may want to also change the *Align Practice Address text* setting (*Left*, *Center*, or *Right*) to align the name and address text accordingly. For example, if you position the Practice Address at the left margin, you may also want to align the name and address text at the left margin.

7. To print a test page that includes placeholder blocks for the header and footer fields in your current layout, first click *Apply*, and then click *Test Page*.

   **Note:** On the test page, three blocks on the right side of the header are reserved for the client ID, invoice number, and date; you cannot move these blocks.

8. If necessary, click *Reset* to undo your positioning changes and start over based on the default alignment settings.

9. If you want to use the same layout for estimates, select the *Use address layout for estimates* check box. This allows you to set up your header positioning once for use on both invoices and estimates.

10. Click *Apply* to save your changes and continue setting defaults, or click *OK* to save your changes and close the window.
**Tip:** We recommend printing a sample invoice to check your address alignment before printing actual client invoices. You may need to readjust depending on your envelope.

**Invoice Item Defaults**

Invoice Item defaults are used when you set up new invoice items. The defaults include ID numbering, applying taxes and discounts, dispensing fee amount, and the item’s unit of measure.

**Before You Begin**

- Set up taxes (Controls > Taxes).
- Set up discounts (Controls > Discounts).

**To set the Invoice Item Defaults:**

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Invoice Item. The Invoice Item configuration pane appears.

![Invoice Item defaults](image)

3. In the **Item ID** text box, type the beginning invoice item ID. If item IDs are auto-assigned, Cornerstone uses the item ID entered here as the starting (first) ID from which to increment when generating a new ID.
4. To have Cornerstone automatically generate item ID numbers when setting up new invoice items, select the **Auto assign** check box.
5. In the **Service tax** and **Inventory tax** lists, select the tax settings that apply to the majority of invoice items (you can apply more than one tax).

**Note:** You can also set up taxes for an entire invoice item classification when updating an item classification in Lists > Invoice Item Class. Any defaults that apply to the item classification are in addition to the taxes set up in Invoice Item defaults.

6. In the **Service discount** and **Inventory discount** lists, select the discount settings that apply to the majority of invoice items (you can apply more than one discount).
7. In the Dispensing fee text box, type the dispensing fee that applies to the majority of new invoice items. This is the default dispensing fee that will display when you set up a new invoice item, but you can change it at that time.

8. From the Unit of measure drop-down list, select the unit of measure that applies to the majority of new invoice items. Select [None] if you do not want to use a default unit of measure.

9. From the Group item printing option drop-down list, select the default printing option to use for printing group items on the invoice:
   - Print all lines, show line amounts—Prints the name of the group and individual lines for each item in the group and amounts for each item.
   - Print all lines, show group total amount—Prints the name of the group and individual lines for each item in the group but shows only the total amount on the group line at the top. The individual lines will have an amount of zero.
   - Print detail lines only—Prints only the individual lines for each item in the group and the amount for each item.
   - Print group line only—Prints only the name of the group and the total amount.

10. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

**Labs Defaults**

You can specify a default staff ID for laboratory requests, including a “No default staff” option.

**To set the Labs defaults:**

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Labs. The Labs configuration pane appears.
3. For requests associated with special actions, select the **Use billing staff on a new lab request** check box to designate that the billing staff on the Patient Visit List or the invoice should be used as the default staff ID on the request.

If this option is not selected, then the default staff ID for special action requests is the ID of the last staff member who performed a lab request on the workstation.

4. For lab requests not associated with special actions, select from the following options:
   - **No default staff**—The person creating a request will need to select a staff ID for each request.
   - **Last staff used on workstation**—The default staff ID will be the ID of the last staff member who created a request on the workstation.
   - **Specific staff**—Type a default staff ID, or press F2 to search for and select the ID.

5. Click **OK**.

**Messages Defaults**

Use Messages defaults to select the messages you print most often on invoices, estimate footers, and statements.

**Before You Begin**

- Set up billing messages (**Controls > Billing Messages**).

**To set the Messages defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Messages**. The Messages configuration pane appears.

3. From the Invoice, Estimate footer, Current, 30 days, 60 days, and 90 days drop-down lists, select the default messages to print. (These messages are set up in **Controls > Billing Messages**.)

   **Note:** Current, 30, 60, and 90 days messages print on the statement according to the client’s account status.
4. Click **Apply** to save your changes and continue setting defaults or click **OK** to save your changes and close the window.

**Password Defaults**

The **Password** defaults allow practices to set a higher level of system security for increased information control or to meet regulatory compliance requirements. With the enhanced password security settings, you can add a new level of security to your Cornerstone software by managing password strength and duration requirements.

**Note:** The staff member modifying Password defaults must have appropriate security permissions to perform such tasks in Cornerstone. We recommend that only the Cornerstone Administrator have access to the Password defaults.

**To set the Passwords defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Passwords**. The Enhanced Passwords configuration pane appears.

3. If you want to set up requirements for password strength and duration, select the **Use Enhanced Passwords** check box. With this option selected, each password must contain a combination of **three** of the following:
   - Uppercase letter
   - Lowercase letter
   - Number
   - Special character (such as !@#$%)

4. Specify the enhanced password requirements using the following settings:
   - **Minimum password length**—Password must meet the specified minimum character length to be valid.
• **Password history**—Password cannot be the same as the last [specified number] of passwords used.
• **Minimum password age**—Password must be [specified number] of days old before it can be changed.
• **Maximum password age**—Password must be changed every [specified number] of days.

5. To allow staff members to log in using only a password, select the Password log on check box. To use this feature, each staff member’s login must have a unique password.

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Patient Defaults**

Patient defaults include preferences for patient information and the Patient List display.

**Before You Begin**

• Set up patient classifications (**Controls > Classifications**).

**To set the Patient defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Patient**. The Patient configuration pane appears.

3. In the **Patient information** area, set the following options as needed for your practice:
   a. In the **Patient ID** text box, type the beginning Patient ID to be used when a new patient record is created.
   b. Select the **Auto assign** check box if you want ID numbers to be generated automatically when setting up new patients. Clear the check box if you do not want ID numbers to be generated automatically.
c. In the **Recently accessed patients** text box, enter the number of patients (up to 99) you want Cornerstone to remember. The recent patients appear first when you press F2 to select a patient from the Patient List. See the *Cornerstone User’s Manual* for information on using recent patients.

d. From the **Classification** and **Species** drop-down lists, select the classification and species that apply to the majority of your patients.

e. In the **Staff ID for notes/Dx** text box, type the ID of the staff member most likely to be entering medical notes and diagnostic codes. You can also press F2 to select the staff member from the Staff List.

f. In the **Quick Patient Label** text box, type the document ID (Doc ID) of a label (or document) to automatically print each time you add a new patient.

g. Select the **Use most recent patient** check box to display the patient whose record was last opened when you accessed the Patient File or Patient Visit List or one of these windows: patient weight, patient diagnosis, patient reminders, or medical notes.

h. Select the **Show trainer and barn** check box if you want to be able to designate clients as trainers or barns and associate patients with trainers and barns.

4. In the **Patient list** area, do the following:

   a. Select the **Display breed** check box if you want Cornerstone to display the breed of the animal in the Patient List.

   b. Select the **Display owner name** check box if you want the Owner Name column to replace the Client ID column in the Patient List. The owner names display in alphabetical order for quick retrieval.

5. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

### Physical Exam/Patient Advisor* Defaults

The **Patient Exam/Patient Advisor** defaults allow you to specify preferences for printing Pet Health Report Cards. In addition, if you have Patient Advisor*, you can set preferences for printing and posting Treatment Plans.

The **Physical Exam** feature (also known as Patient Exam) is included with all Cornerstone systems. It allows practices to record physical exam observations and comments using standard body system templates and to print a Pet Health Report Card.

The **Patient Advisor** feature is available if your practice purchased the module before it was discontinued. If Patient Advisor is installed, it replaces the basic Physical Exam features in the program. Patient Advisor includes all of the functionality of Physical Exam, plus it includes client instructions and medical protocols that you can customize to your practice’s needs to create and print a Treatment Plan.

**Note:** If you have installed the Patient Advisor module, “Patient Advisor” displays in place of “Physical Exam” in several areas within Cornerstone (Practice and Workstation defaults, right-click menu on Patient Clipboard, Activities menu, etc.).

**To set the Physical Exam/Patient Advisor defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Physical Exam** or **Patient Advisor**. The Physical Exam or Patient Advisor configuration pane appears.

![Physical Exam/Patient Advisor defaults](image)

**Note:** The figure above shows the configuration pane for the Patient Advisor defaults. If you have not purchased the Patient Advisor feature, you will use the Physical Exam configuration pane, which does not include all of the options shown above.

3. In the **Pet Health Report Card—print options** area, do the following:
   a. To print the Pet Health Report Card after the physical exam is saved or posted, select the **Print when saving/posting exam** check box. Then, in the adjacent **Copies** text box, enter the default number of copies to print.
   b. To print the pet’s picture on the Pet Health Report Card, select the **Print patient picture** check box.
   c. If you have a color printer and want the abnormal observations headings to print in red, select the **Print abnormals in red** check box.
   d. In the **Footer message** drop-down list, select a message to print by default in the footer of the Pet Health Report Card. (You can add or edit messages in Controls > Billing Messages.)

4. **Patient Advisor only:** In the **Treatment Plan—print options** area, do the following:
   a. To print the Treatment Plan after the physical exam is saved or posted, select the **Print when saving/posting exam** check box. Then, in the adjacent **Copies** text box, enter the default number of copies to print.
   b. To print the pet’s picture on the Treatment Plan, select the **Print patient picture** check box.
   c. To print your practice’s invoice item IDs on the Treatment Plan, select the **Print item ID** check box. Do not select this option if you want to keep your practice’s item IDs confidential.
   d. To print prices on the Treatment Plan, select the **Print prices** check box.
   e. To print totals on the Treatment Plan, select the **Print totals** check box.
f. Select the **Header message** and **Footer message** to print on the top and bottom of the Treatment Plan. If necessary, you can change the messages when you print the Treatment Plan.

5. *Patient Advisor only:* In the *Save/Post Options* area, if you want to automatically update the Patient Visit List (PVL) with items in the Treatment Plan only when you post it (versus when you post it and when you save it), select the **Update patient visit list on post** check box. If the check box is cleared, the PVL is also updated upon saving, not just upon posting.

   **Note:** Each time the PVL is updated, all prior lines that were written to the PVL are deleted and then replaced with the updated lines.

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

### Performance Tracker Defaults

The **Performance Tracker** defaults allow you to set preferences for displaying data and dynamic graphs using the Cornerstone performance tracker feature.

**To set the Performance Tracker defaults:**

1. On the Controls menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Performance Tracker**. The Performance Tracker Summary configuration pane appears.

   ![Performance Tracker Summary defaults](image)

3. If you want to see the practice goals in Cornerstone performance tracker, select the **Display hospital goals** check box.

4. In the **Doctor Classify** column, select **Yes** or **No** for each type under **Staff Classifications** used at your practice for “doctors.”

5. In the **Summary display and goals** area, select the time period for which you want to set goals (by month), and then click to select options for which you want to set goals and enter the dollar amounts.
Chapter 4: Setting Practice and Workstation Defaults

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Example:**
Your practice wants to set a goal of $5,000 in gross sales for this January. To do this, under Processed, click **Current**. Under Description, locate gross sales and select the check box next to **Gross sales**. Enter $5,000 as the dollar amount you want your practice to attain in the first month.

**Miscellaneous–Performance Tracker Defaults**
The Miscellaneous–Performance Tracker defaults allow you to define miscellaneous settings and sales ranges for use in Cornerstone performance tracker.

**To set the Miscellaneous–Performance Tracker defaults:**
1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Performance Tracker** to expand its subproperties, and then click the **Miscellaneous–Performance Tracker** subproperty. The Performance Tracker Miscellaneous configuration pane appears.

   ![Performance Tracker Miscellaneous Defaults](image)

3. In the **Define active client as seen within # of months** text box, enter the frequency of office visits in months used to determine your practice’s definition of an active client. For example, if your practice defines an “active client” as a client who has visited your office in the last year, enter 12 months.

4. In the **Define active patient as seen within # of months** text box, enter the frequency of office visits in months used to determine your practice’s definition of an active patient. For example, if your practice defines an “active patient” as a patient that has been seen in your office in the last two years, enter 24 months.

5. In the **Define number of postal code characters to use** text box, specify the number of postal characters by which results will be sorted (Cornerstone performance tracker sorts your sales by postal code). In most cases, we recommend that United States locations leave this setting at the
default of 5 characters (or set to 9 characters to sort results by 9-digit ZIP Codes); Canada locations would typically use 6 characters.

6. Sales ranges display on the Client tab in Cornerstone Performance Tracker. If you want to adjust the default ranges, in the Define Sales Ranges area, click the sales range number to change in the Less Than Equal To column and type the new number.

7. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

**Reminders–Performance Tracker Defaults**

The Reminders–Performance Tracker defaults allow you to select the species and their associated reminders and services to use in Cornerstone Performance Tracker.

**To set the Reminders–Performance Tracker defaults:**

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Performance Tracker to expand its subproperties, and then click the Reminders–Performance Tracker subproperty. The Performance Tracker Reminders configuration pane appears.

3. In the Select a species area, select a species. The reminders and services related to that species display on the right side of the configuration pane.

4. In the Missing and overdue reminders by species and category area, do the following:
   a. Select the category from the Category box.
   b. To create a new reminder category, right-click in the Category box and select New, then type the name of your new category. To update an existing category, right-click it and select Update; then, type the new category name in the text box. To delete an existing category, right-click it and select Delete.
c. Use the **Search by description** text box to locate the reminders you want to place in this category, and select the **Display** check box next to the applicable reminders.

5. In the **Service items never received by species** area, use the **Search by description** box to locate the services you want to associate with this species, and click the **Display** check box next to the applicable services.

**Note:** If you do not select reminders and services for which you want to collect data, nothing will display on the **Reminders** tab in Cornerstone Performance Tracker.

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Example:**

Your practice wants to know which clients own dogs that have never received a rabies vaccination. To do this, select **Canine** for the species and create a new category called **Rabies**. Then locate all item IDs that are used for rabies vaccinations.

**Pharmacy Formulary Defaults**

Pharmacy Formulary is a separate module available for purchase. Before using the Pharmacy Formulary, you must set up the **Pharmacy Formulary** defaults to match the species codes in Cornerstone with the species codes in the formulary.

**To set the Pharmacy Formulary defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Pharmacy Formulary**. The Pharmacy Formulary configuration pane appears.
3. The Cornerstone species are found in the left column and cannot be changed. Under the Pharmacy Species column, select the matching species from the drop-down list.

4. Select the Auto perform interaction matrix when drug entered on prescription check box if you want the drug interaction to be automatically performed when you choose a drug on the Prescription window. Selecting this option may take more time because your software will always perform the drug matrix when you choose the drug.

5. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Practice Defaults

Practice defaults allow you to specify a health certificate document and a practice logo—the logo can be printed on estimates, invoices and monthly statements.

If setting up a practice logo, note the following:

- The logo prints on the estimate, invoice, and statement in the exact size displayed in Practice defaults. If the size of the logo is not suitable, you should modify it in a separate graphics editing program outside of Cornerstone and then import the image. (Press F1 on the Practice defaults pane to view Help instructions on resizing your logo in Microsoft® Paint.)
- The anchor point for all logos is based off the top left corner of the Practice Logo repositioning box, regardless of whether the logo has a horizontal or vertical orientation.
- If you have a logo that includes your practice name, address, and phone number (similar to letterhead), you may want to set up the estimate, invoice, and/or statement headers to include only the Practice Logo, as the text-based Practice Address information included would be a duplicate of the information already included in the logo.
- Multi-Location/Single Database configurations only: If you have multiple practices activated in Cornerstone, you can use a different logo image for each practice. It is important to note that although you can specify a different logo for each practice, the logo use and placement settings (set up in defaults for Estimate Address, Invoice Address, and Statement Print Options) apply for all logos across all practices. For any practices that do not have a logo specified, the estimates, invoices, and statements will print with the standard text-based practice name and address information.

To set the Practice defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Practice. The Practice configuration pane appears.
3. In the **Health certificate document** text box, type the ID of the document you want to designate as the practice’s default health certificate (prints when **Print button > Health Certificate** is selected in patient reminders). Press F2 to use the Document Template List to choose a document.

4. If you want to set up a practice logo to print on invoices, estimates, or monthly statements, in the **Practice Logo** area, do the following:
   a. **Multi-Location/Single Database configuration only:** In the **Practice** drop-down list, select the applicable practice.
   b. If necessary, click **Clear** to remove a previously added logo.
   c. Click **Browse** to find and select the graphic file to be used for the practice logo. Supported graphic file types include BMP, GIF, JPG, and JPEG. The selected logo graphic file will display in its original size.

   **Tip:** Use the defaults for Estimate Address, Invoice Address, and Statement Print Options to set up logo use and placement for printing.

5. Click **Apply** to save your changes and continue setting defaults or click **OK** to save your changes and close the window.

### Prescriptions Defaults

The **Prescriptions** defaults allow you to set preferences for creating and printing prescriptions and lab request labels.

**To set the Prescriptions defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Prescriptions**. The Prescriptions configuration pane appears.
Prescriptions defaults

3. In the Prescription label/lab request label area, do the following:
   a. Select the Print heading check box to print practice information on prescription and lab request labels.
   b. Select the Print staff license check box to print the staff license on the prescription label.
   c. Select the Small font check box to use a smaller font for the text on labels.
   d. Select the Print client addr if controlled substance check box to print the client’s address on prescription labels for controlled substances. (You must also select the Small font check box.)
   e. Select the Print NDC/DIN (National Drug Code/Drug Identification Number) check box to print drug identification numbers on prescription labels. If one exists, the NDC/DIN Code prints on the prescription label in place of the serial number.

4. In the Prescription area, do the following:
   a. Select the Warn user when quantity is 1 check box to display an alert if a prescription quantity is 1.
   b. Select the Override expiration date check box and enter the Maximum number of months. This feature applies to veterinary practices in states mandating that a maximum expiration date print on prescription labels. If a maximum expiration date is not set here and your practice uses Cornerstone Inventory, the expiration date from the item’s record is used on the prescription label.
      
      Note: If the expiration date for the invoice item has not expired and occurs before the current date plus the maximum number of months, the expiration date on the invoice item is used on the prescription label. If the expiration date occurs after the current date plus the maximum number of months, then the current date plus the maximum number of months is printed on the label.
   c. Select the Filled by staff required check box if staff must complete the Filled by text box on the Prescription Information dialog box before processing a prescription.
5. If you are having difficulty with text positioning on pharmacy or lab labels, you can adjust the printer using the **Enter printer type** settings.

   a. In the **Enter printer type 1** text box, type the share name of the printer. (This is the name assigned to the printer in the Windows® setup.) If you have more than one printer of the same printer model, type the share names for each printer, separated by a semicolon.

   b. If it is necessary to adjust text positioning on labels, in the **Lower label text down** text box, enter the number of units to lower the text. Approximately 10 units equal 1 line.

   c. If you have more than one printer type that needs adjusting, repeat the previous steps as needed in the **Enter printer type 2** fields.

   **Note:** Only prescription and lab labels are adjusted by these defaults. Labels set up in correspondence are not.

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

### Purging Defaults

The **Purging** defaults allow you to specify the default number of periods to retain information when purging data.

**To set the Purging defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Purging**. The Purging configuration pane appears.

3. In the **Number of years to retain** text boxes, enter the number of years to retain **Client accounts**, **Patient billing**, and **Boarding** information. You cannot purge client or patient information within this number of years. Cornerstone also uses this date as the default **Last date to purge** when you open the Purge Information window.
4. In the **Number of months to retain** text boxes, enter the number of months to retain reminder letters and reminder calls information. You *cannot* purge reminders within this number of months.

   **Note:** This purges the prompt to call; it does not purge the actual history of the call.

5. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Report Language Defaults**

The **Report Language** defaults allow you to set the language and customize specific headings that print on the following types of client documents:

- Invoices
- Estimates
- Statements
- Payment on account documents
- Rabies certificates
- Prescription labels
- Inventory order forms

**To set the Report Language defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Report Language**. The Report Language configuration pane appears.

![Report Language defaults](image)

3. Select the language (**English**, **Spanish**, or **French**).

4. To change the text that appears for a specific item, click the text in the right column and type the new text. For example, instead of printing “Expire date” you may want to print “Expiration Date.”

   **Tip:** Click **New** to clear the entire right column.
5. Select the **Set as default language** check box if you want this language text to appear on the client documents. (If another language was previously selected, the prior language is no longer the default.)

6. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Required Data Defaults**

The **Required Data** defaults allow your practice to require information in selected fields in client and patient records. This means Cornerstone users who enter information in client and patient must provide information in the required fields to save a record.

For example, if the patient’s birth date is set as a required field at your practice, when you try to save a new patient record without entering a birth date, a message box appears to remind you to enter the birth date. You cannot save the record until you enter a birth date.

**To set the Required Data defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Required Data**. The Required Data configuration pane appears.

3. In the boxes, select (or deselect) the data fields to specify the mandatory data at your practice. Use the scroll bars to view all of your choices. (Highlighted/shaded data fields are selected.)

4. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Statement Print Options Defaults**

The **Statement Print Options** defaults allow you to change where the practice and client addresses print on the monthly statement to accommodate different types of window envelopes that may be used to mail statements.
If you specified a practice logo in Practice defaults, you have the option to include that logo in the header of your statements. You can set up your statement header layout to include or exclude the practice address and practice logo, depending on your preferences and the information included in your logo. See “Practice Defaults” on page 127 for more information on adding a practice logo.

**IMPORTANT:** If you choose to print a practice logo on your statements, ensure that the logo does not cover important header information, such as the client name, address, and date. Other header information is not adjusted or positioned relative to the physical space taken up by the logo.

**Before You Begin**
- If you plan to print a practice logo in the header of statements, specify the logo graphic file in Practice defaults.

**To set the Statement Print Options defaults:**
1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Statement Print Options**. The Statements Print Options configuration pane appears.

![Statement Print Options](image)

**Statements Print Options defaults**

3. To include the practice address in the statement header, select the **Print practice address on statement** check box.
4. **Multi-Location/Single Database configuration only:** If printing the practice address on statements, specify the practice address to print—select **Print Primary Practice Address** or **Print Client Home Practice Address**.
5. To include a practice logo in the statement header, select the **Print practice logo on statement** check box. (Note: This option is not enabled until you specify a practice logo graphic file in Practice defaults.) The Practice Logo positioning box appears.
6. Click the logo or address positioning box you want to move, and then use your keyboard arrow keys to reposition the box.
7. To print a test page that includes placeholder blocks for the header and footer fields in your current layout, first click **Apply** and then click **Test Page**.

   **Note:** On the test page, the blocks on the right side of the header are reserved for the statement date and client ID; you cannot move these blocks.

8. If necessary, click the **Reset to default position** button to undo your positioning changes and start over based on the default alignment settings.

9. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

   **Tip:** Print a sample statement to check your address alignment before printing an entire batch of statements. You may need to readjust depending on your envelope.

### Toolbar Defaults

The **Toolbar** defaults allow you to designate which Cornerstone buttons are visible on the main Cornerstone toolbar. In addition, you can select the type of animal picture to be used for the **Patient** button.

**To set the Toolbar defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Toolbar**. The Toolbar configuration pane appears.

3. If you want to change the picture that displays on the **Patient** toolbar button, select the animal you want (Cat, Dog, or Horse) from the **Default patient icon** drop-down list.

4. All toolbar buttons display on the Cornerstone toolbar by default. To remove a toolbar button from the display, clear the **Visible** check box next to the toolbar button.

   **Note:** The toolbar buttons selected here are the practice defaults. The toolbar button display can also be set separately for each staff member in Staff defaults (**Controls > Defaults > Staff > Toolbar** tab).
5. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Unattended End of Period (EOP) Defaults**

If you plan to use unattended End of Period processing, set your preferences using the **Unattended EOP** defaults.

If you plan to use unattended End of Period processing, you must also select a workstation to use as your End of Period workstation (see “Workstation Defaults” on page 146) and specify End of Period default settings (see “End of Period Defaults” on page 102).

**To set the Unattended EOP defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Unattended EOP**. The Unattended EOP configuration pane appears.

Unattended EOP defaults

**WARNING:** Only the Cornerstone Administrator should have access to the **Database copy script** setting. Most practices will probably not need to change the database copy script. We recommend that this option be adjusted only with the help of Cornerstone Support.

3. If it is necessary to make changes to the **Database copy script**, contact Cornerstone Support at 1-800-695-2877 for assistance.

**Note:** You can click **Reset** to change the copy script to the original default.

4. Select the **Show notifications only on the End of Period workstation** check box if you want any warnings or errors that are encountered during End of Period to display only on your End of Period workstation. If this box is not selected, warnings or errors will display on all workstations.
5. Click **Apply** to save your changes and continue setting defaults or click **OK** to save your changes and close the window.
Unattended End of Day (EOD) Defaults

Use Unattended EOD defaults to set up your Cornerstone system to automatically process End of Day and/or automatically make a copy of your database. When unattended EOD runs, Cornerstone displays a progress window that allows you to view the status. Warnings will display if anything goes wrong during processing.

**IMPORTANT:** The copy of the database does not replace your normal backup procedures. The automatic copy is made on the server and the selected workstation. We strongly recommend backing up your Cornerstone files regularly on backup tapes, CDs or DVDs. Store your backup files off the premises every night.

**Note:** When the Cornerstone Administrator logs in, Cornerstone software displays a window to remind the administrator to set up unattended End of Day preferences. Once you set up the system to copy the database every day, the reminder window will not display and you will not need to access these options unless changes need to be made. (To turn off the reminder, select the **Do not remind me again** check box on the reminder window.)

**To set the Unattended EOD defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Unattended EOP** to expand its subproperties, and then click the **Unattended EOD** subproperty. The Unattended EOD configuration pane appears.

3. In the **When** area, specify when you want to automatically run End of Day processing.
4. In the **What** area, select **Make a copy of the database**, **Run End of Day**, or both. If you choose to make a copy of the database, the database will be copied to both the dailycopy folder on the End of Period workstation and the dailycc shared folder on the server. These copies of the database are overwritten each time a new copy is made. This process does not replace your normal backup procedure.
5. In the Settings area, select the **Print the default daily reports** check box if you want daily reports to print automatically. (Default daily reports are set in Controls > Defaults > Practice and Workstation > End of Period.)

   **Tip:** At any time, you can view the details from the most recent unattended EOD process. The details include the date and time the process was run and whether or not the process was successful. These details are provided in the *Current end of day notification* area, the *Current database copy notification* area, and the *Current database carbon copy notification* area within the Unattended EOD defaults.

6. Cornerstone will display a notification window every half hour if an unattended End of Day process was not run successfully. For example, if a user left an exclusive use window open on a workstation, Cornerstone cannot start the process and will display a notification. To suppress a specific notification message at the time it is generated (and only for the day on which it occurs), select the applicable **Suppress this notification** check box. (The notification will then reappear after the next unsuccessful unattended EOD process.)

7. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

### Unattended End of Month (EOM) Defaults

Use **Unattended EOM** defaults to set up your Cornerstone system to automatically process End of Month and/or automatically make a copy of your database. When Unattended EOM runs, Cornerstone displays a progress window that allows you to view the status. Warnings will display if anything goes wrong during processing.

**IMPORTANT:** The copy of the database does *not* replace your normal backup procedures. The automatic copy is made on the server and the selected workstation. We strongly recommend backing up your Cornerstone files regularly on backup tapes, CDs, or DVDs. Store your backup files off the premises every night.

**To set the Unattended EOM defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Unattended EOM** to expand its subproperties, and then click the **Unattended EOM** subproperty. The Unattended EOM configuration pane appears.
3. In the When area, specify when you want to automatically run End of Month (EOM) processing. If you choose one of the options that does not run following an unattended End of Day (EOD) process, Cornerstone automatically runs an EOM process before running the End of Month process.

4. In the What area, select Make a copy of the database, Run End of Month, or both. If you make a copy of the database, the database is copied to both the dailycopy\monthly folder on the End of Period workstation and the dailycc\monthly shared folder on the server. These copies of the database are overwritten each time a new copy is made.

5. In the Settings area, select the Print the default monthly reports check box if you want monthly reports to print automatically.

   Tip: At any time, you can view the details from the most recent unattended EOM process. The details include the date and time the process was run and whether or not the process was successful. These details are provided in the Current end of month notification area, the Current database copy notification area, and the Current database carbon copy notification area within the Unattended EOM defaults.

6. Cornerstone displays a notification window every half hour if an unattended EOM process was not run successfully. For example, if a user left an exclusive use window open on a workstation, Cornerstone cannot start the process and will display a notification. To suppress a specific notification message at the time it is generated (and only for the month on which it occurs), select the applicable Suppress this notification check box. (The notification will then reappear after the next unsuccessful unattended EOM process.)

7. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

**Vaccination Bookmarks Defaults**

The Vaccination Bookmarks defaults allow you to select a set of vaccinations to include on documents, such as health certificates. Only those vaccinations selected in vaccination preferences that correspond to vaccination reminders found in the patient’s record are included on a health certificate for the patient.
This allows you to create one set of vaccination preferences for multiple species. For example, if your vaccination preferences include Feline Leukemia Booster and Canine DHLPPC, only Canine DHLPPC is included on a health certificate for a canine patient because no vaccination reminder for Feline Leukemia Booster will be found in the patient’s record.

**To set the Vaccination Bookmarks defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Vaccination Bookmarks**. The Vaccination Bookmarks configuration pane appears.

![Vaccination Bookmarks defaults](image)

3. The **Vaccinations to appear on the document** area lists all items for which reminders are generated when an item is added to an invoice (for example, if Item A generates a reminder for Item B, Item B will appear in this list as an option). In the list, click to select all of the vaccinations you want Cornerstone to include in the search when a vaccination certificate (or similar document) is created for a patient. Only those vaccinations selected here that correspond to vaccination reminders found in the patient’s record are included on a patient’s certificate.

4. In the **Vaccination line pattern** area, click the buttons in the order you want vaccination reminder information to appear on the vaccination certificate. On the certificate, the reminder information appears in the order the buttons are selected (this pattern displays in the text box as buttons are selected). For example, click the **DESC** button if you want the Reminder Due description to print first, and then click **DUE** to print the reminder due date next to the description.

   ➢ To delete the pattern and start over, click in the text box and press DELETE.

5. Click **Apply** to save your changes and continue setting defaults or click **OK** to save your changes and close the window.
Vaccine Tag Defaults

The Vaccine Tag defaults allow you to specify required fields, a custom rabies certificate, and default tag number settings to be used on the Vaccine Tag window when issuing a rabies/vaccine tag for a patient. These global default settings apply to all vaccine tags, including rabies.

Note: To set up species-specific defaults for your vaccine/vaccination inventory items, see “Setting Up Vaccine Invoice Items” on page 206.

To set the Vaccine Tag defaults:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Vaccine Tag. The Vaccine Tags configuration pane appears.

3. To have Cornerstone display a warning if a duplicate tag number is entered on the Vaccine Tag window when issuing a tag, select the Warn User on Duplicate Tags check box.
4. To require a vaccine expiration date and lot number to be specified on the Vaccine Tag window, select the Require expiration date and lot number check box. (Note: If lot numbers and expiration dates are tracked through Cornerstone Inventory, these settings will be controlled by consumption.)
5. To require the Manner of Administration and Number of Years information to be provided on the Vaccine Tag window when issuing a tag, select the Require manner of administration/years check box.
6. To print a document other than the standard rabies certificate in Cornerstone, select the Custom rabies certificate check box. Then, in the adjacent text box, type the ID of the document to use as your custom rabies certificate or press F2 to search for and select the custom certificate from the Document Template List. (See the “Standard Cornerstone Rabies Certificate” section that follows for information on the standard rabies certificate provided in Cornerstone.)
7. If you want to specify the default number of rabies certificates to print, enter the number in the Number of copies text box. This setting can be changed at print time if necessary.
8. **Multi-Location/Single Database configuration only:** The Tag number prefix, Last used tag number and Staff for tag defaults can be set up by practice if a Multi-Location/Single Database configuration has been activated. If you would like to specify these settings by practice, select the practice from the Practice drop-down list.

9. If you use a prefix with your tag numbers, specify a default prefix (up to five characters) in the Tag number prefix text box. This prefix displays automatically on the Vaccine Tag window when you issue a tag, but it can be changed or removed at that time if necessary.

10. If you want Cornerstone to automatically generate tag numbers, provide the Last used tag number in the text box. When issuing a tag on the Vaccine Tag window, you can click the Increment Tag button to use the next available tag number (increments by one for each vaccine tag created).

11. If you want to specify the staff to display by default on the Vaccine Tag window when issuing a tag, select an option from the Staff for tag drop-down list. Options include None (no default staff), Billing Staff (the staff ID listed for this line item on the Patient Visit List or invoice), or Always Use This Staff (type the staff ID or press F2 to search for and select a staff member from the Staff List).

12. Click Apply to save your changes and continue setting defaults or click OK to save your changes and close the window.

**Standard Cornerstone Rabies Certificate**

Cornerstone provides a standard rabies certificate that includes the following:

- Practice name and address
- Client name, ID, address, and phone number
- Patient ID, name, species, breed, sex, color, markings, birthday, and weight
- Vaccine tag number
- Vaccine invoice item lot number, producer, and type (killed or MLV)
- Date the vaccine was given and the date it expires
- Name and license number of the staff member who administered the vaccination
- Microchip ID
- Picture of the patient (Note: The patient’s picture will print on the certificate only if you have set up this option in Workstation defaults and there is a picture of the patient in the patient’s record.)
Example of a standard rabies certificate

**Rabies Default Settings**

Practices that set up their vaccine/vaccination invoice items prior to Cornerstone 8.1 may have a SERVICE-based system in place, where items are set up as vaccination service items (with no links to vaccine inventory items). If this is the case, you have several options:

- Continue using your current setup without taking advantage of new rabies/vaccine tag features that were introduced in Cornerstone 8.1. This option uses the prior version Species-Specific Rabies Tag defaults (accessed from the Species Information window and covered on page 66) and the prior version Rabies Default settings (covered here).

- Reconfigure your current setup as an INVENTORY-based system that takes advantage of rabies/vaccine tag features, such as the ability to set up multiple rabies/vaccine tag defaults per species. See “Setting Up Vaccine Invoice Items” on page 206 for more information.

If you are continuing to use your current SERVICE-based system, use the Rabies Default settings to specify the default rabies tag information for the vaccine used most often in your practice. This information will be used on the Vaccine Tag window when a tag is issued only if you have not set up Species-Specific Rabies Tag defaults for the species.

**To set the Rabies Defaults:**

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click Vaccine Tag to expand its subproperties, and then click the Rabies Default subproperty. The Rabies Default configuration pane appears.
Rabies Default settings

3. In the **Brand** and **Producer/Mfr** text boxes, type the vaccine brand and producer/manufacturer information for the vaccine used most often in your practice.

4. In the **Lot. #** text box, type the vaccine lot number.

5. In the **Expiration date** text box, enter the date this lot of vaccines expires.

6. In the **# of years** text box, enter the number of years the vaccine is viable (the certificate expiration).

7. From the **Manner of administration** drop-down list, select the appropriate option to specify how this vaccine is administered.

8. From the **Vaccine Type** drop-down list, select the applicable vaccine type (**Killed** or **MLV**).

9. In the **Staff ID** text box, specify a default staff member to for the Vaccine Tag window when issuing a tag by typing the ID or pressing F2 to search for and select a staff member from the Staff List.

   **Note:** An informational message displays at the bottom of the Rabies Default pane if there are any existing inventory items with rabies/vaccine tag defaults set up on the Invoice Item Information Vaccine tab. If vaccine/vaccination inventory items exist, this message indicates the number of items and serves as a reminder that the Vaccine tab defaults will be used for those items.

10. Click **Apply** to save your changes and continue setting defaults or click **OK** to save your changes and close the window.

**Web Links Defaults**

The **Web Links** defaults allow you to add up to four links to directly access your favorite websites from the Cornerstone Web Links menu.

**To set the Web Links defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Web Links**. The Web Links configuration pane appears.
Web Links defaults

3. For each Web link you want to add to the Web Links menu in Cornerstone:
   a. In an available Web Address text box, type the web address of the website you want to link to from Cornerstone. (Note: Do not include the http:// prefix.)
   b. In the corresponding Description text box, type a brief description (site name) for the web link. This is the text that will appear in the Cornerstone Web Links menu.
      Note: The custom web links will be available in the Web Links menu on all workstations in the practice. To activate the links, you must close and reopen Cornerstone.

4. Click Apply to save your changes and continue setting defaults, or click OK to save your changes and close the window.

Whiteboard Defaults

The Whiteboard defaults allow you to set preferences for display settings and invoicing settings pertaining to Electronic Whiteboard windows in Cornerstone.

To set the Whiteboard defaults:
1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Whiteboard. The Whiteboard configuration pane appears.
3. In the **Whiteboard auto refresh timer** text box, specify the default number of minutes between each refresh of the information on the Whiteboard. If the rate is set to zero, the Whiteboard will not refresh automatically.

   **Note:** In general, a refresh rate of 1 minute or more is recommended. Depending on your system resources, a rate of less than 1 minute may slow down your system.

   **Tip:** When using the Whiteboard, click **Refresh** to refresh immediately (before the auto-refresh time period has elapsed).

4. In the **Length of time to keep discharged patients on the Whiteboard** text box, enter the number of hours to keep discharged patients on the Whiteboard.

5. Select one of the following **Hours to show** options to specify the number of one-hour columns to include on the Whiteboard:
   
   - **Current day only**—Includes 24 1-hour columns on the Whiteboard window.
   
   - **Current day with 3 hours for previous and next days**—Includes 24 1-hour columns, with 3 1-hour columns added before and after this 24-hour period. This option adds blue << Previous and Next >> links that display when you scroll horizontally to the outer limits of the displayed hour columns. You can click the appropriate link to move the grid columns to change the date and display the hours for the previous day or next day.

   This ability to see into the next day without manually changing the date is helpful for preparing for the next day and especially useful for 24-hour clinics.

   **Note:** For both **Hours to show** options, the number of columns visible at one time without scrolling depends on the monitor size.
6. From the **Doctor to use on invoice line** drop-down list, select which default staff ID, based on the provider type selected here, will display within the **Items** area of the Patient Treatment window for each line item completed. The charge for the line item will be credited to this person unless the staff ID is changed when the treatment is posted. Options include:
   - **Current Care Dr.**—Doctor who assumes care of patient because of shift change or because the supervising doctor is unavailable. The Current Care Dr. is the doctor present in the clinic who makes “on the spot” decisions for patients.
   - **Supervising Dr.**—Doctor who admits the case and is the overriding decision maker for the case.
   - **Who Performed**—Staff member who does the work.

7. Select the **Use doctor from Patient Visit List** check box if you want Cornerstone to override the **Doctor to use on invoice line** default and insert the staff ID associated with the item if it was originally on the Patient Visit List.

8. From the **Invoice when patient is not at ‘Ready to go home’ status** drop-down list, select one of the following as the default setting:
   - **Allow**—Allow staff to invoice an inpatient without a “Ready to go home” status.
   - **Manager Override**—Display a warning and prompt for a manager’s approval before staff are allowed to continue invoicing.
   - **Stop**—Prohibit invoicing until the patient is given a “Ready to go” status.
   - **Warn**—Display a warning message about the status, but allow staff to continue invoicing.

   **Note:** If a user-defined patient hospital status is used, this custom status will be considered equal to the “Ready to go home” status only if it contains one of the following keywords: Ready, Home, Pick, Release, or Discharge.

9. In the **Allow invoice if uncompleted treatments** text box, select one of the following as the default setting:
   - **Allow**—Allow staff to invoice without all the patient’s treatments being marked as completed.
   - **Manager Override**—Display a warning and prompt for a manager’s approval before staff are allowed to continue invoicing.
   - **Stop**—Prohibit invoicing until all treatments are completed.
   - **Warn**—Display a warning message indicating uncompleted treatments, but allow staff to continue invoicing.

10. In the **Future hours to check for uncompleted treatments when invoicing** text box, based on discharge time, enter the number of hours in the future to check for uncompleted items when invoicing.

11. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Workstation Defaults**

The **Workstation** defaults allow you to specify workstation-specific preferences for pet picture use on documents, invoice type to print, and default document margin and font settings. In addition, you can designate the workstation as the End of Period workstation.
To set the Workstation defaults:

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Workstation**. The Workstation configuration pane appears.

3. In the **Print patient pictures on** area, select the client communication documents on which you want to include the pet’s picture when printing from this workstation.

4. The **Invoice Print** drop-down list is available if the **Turn on invoice receipt option** check box is selected in Invoice defaults. Once enabled, the **Invoice Print** drop-down list allows you to select one of the following options as the default for this workstation:
   - **Full Invoice**—Prints full page (8-1/2" x 11") invoices.
   - **Invoice Receipt**—Prints 3-1/8" invoice receipts (an Epson TM-T88IV receipt printer is required for printing invoice receipts).

5. In the **Document Settings** area, set the **Margins**, **Fonts**, and **Effects** to use by default for documents created on this workstation.

6. In the **Whiteboard sort** area, specify a default sort order for the Whiteboard **Patients** column on this workstation (for example, Boarding may want a different default sort order than ICU). If a sort order is not specified here, the column is sorted by Patient Name.
   
   **Note:** You can also change the **Patients** column sort order at any time directly on the Whiteboard using its **Sort** drop-down list.

7. In the **End of Period Workstation** area, type the workstation to use as your End of Period (EOP) workstation for unattended EOP processing.

8. On the workstation you have selected as your EOP workstation (for unattended EOP processing), select the **Use this workstation to run unattended end of period processes** check box. The currently selected EOP workstation displays.
**Tip:** To select a different workstation as your EOP workstation, follow the above steps on that workstation and the software will change your workstation selection automatically.

**Note:** The workstation you select as the EOP workstation must be turned on and be running Cornerstone at the time the End of Day or End of Month process is set to run. However, a user does not have to be logged into Cornerstone.

9. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.

**Workstation–All Defaults**

The **Workstation–All** defaults allow you to set up workstation-specific settings for each workstation in the practice.

You can designate the default inventory location to be used on each workstation (only applies to inventory items for which quantity on hand is tracked). By default, inventory items on the invoice are automatically assigned to the default location and the quantity on hand for the items is decreased in the default location. But if the item is taken from a different location, this location can be selected to replace the default location when the item is put on the Patient Visit List or invoice.

In addition, if you have a Multi-Location/Single Database configuration, you can set the practice to be used by default when logging in on each workstation.

**To set the Workstation–All defaults:**

1. On the **Controls** menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.

2. In the navigation pane, click **Workstation** to expand its subproperties, and then click the **Workstation–All** subproperty. The Workstation–All configuration pane appears.

3. In the **Workstation** drop-down list, select the workstation to which you want to assign a default inventory location (and select a default practice, if applicable).
4. *Multi-Location/Single Database configuration only:* In the **Default Practice** drop-down list, select the practice to be used by default when logging in on the selected workstation.

5. In the **Inventory** area, do the following:
   a. If applicable, in the inventory **Location Group** drop-down list, select **All locations** or a specific group location. The corresponding locations display in the list.
   b. In the **Location** list, select the default inventory location to be used on the selected workstation.

6. Click **Apply** to save your changes for the currently selected workstation.

7. Repeat steps 3–6 as needed to set up defaults for additional workstations.

8. Click **Apply** to save your changes and continue setting defaults, or click **OK** to save your changes and close the window.
Overview
Staff defaults allow you to personalize your IDEXX Cornerstone* Practice Management System settings for a specific staff ID. For individual staff members, you can customize the Patient Clipboard* and specify the toolbar buttons to appear on the Cornerstone toolbar. In addition, you can also set staff-specific defaults and favorite document templates for medical notes and correspondence.

Accessing Staff Defaults
1. On the Controls menu, select Defaults > Staff. The Staff Defaults window appears.
2. In the Staff box, type the staff ID of the staff member for whom you want to set defaults, or press F2 to use the Staff List to choose a staff ID.
3. Press TAB.
   The Staff defaults configuration settings are available on the five tabs.

Note: A staff member must have appropriate security permissions to make changes to his or her Staff defaults. The Cornerstone Administrator can make changes to any staff member’s default settings.

Staff Defaults for Patient Clipboard
The Staff defaults Patient Clipboard tab allows you to select the tabs to display on the Patient Clipboard when a particular staff ID is logged in to Cornerstone.

To set the Staff Defaults for Patient Clipboard:
1. On the Staff Defaults window, click the Patient Clipboard tab.
2. In the **Client information tabs** area, in the **Display** column, select the check box for each tab to appear in the Client information area on the Patient Clipboard for this staff ID. To change the settings back to the original selections, click the **Reset Defaults** button.

3. In the **Patient information tabs** area, in the **Display** column, select the check box for each tab to appear in the Patient information area on the Patient Clipboard for this staff ID. To change the settings back to the original selections, click the **Reset Defaults** button.

4. To change the display order of the tabs on the Patient Clipboard, use the and arrow buttons.

5. Click **Save** to save your changes and continue setting staff defaults, or click **OK** to save your changes and close the Staff Defaults window.

### Staff Defaults for the Toolbar Display

The Staff defaults **Toolbar** tab allows you to select the buttons to display on the Cornerstone toolbar when a particular staff ID is logged in to Cornerstone.

**To set the Staff Defaults for the Toolbar display:**

1. On the Staff Defaults window, click the **Toolbar** tab.

2. Select the **Visible** check box for each toolbar button to display for this staff ID. To remove a toolbar button from the display, clear the **Visible** check box.

3. Click **Save** to save your changes and continue setting staff defaults or click **OK** to save your changes and close the Staff Defaults window.
Staff Defaults for Miscellaneous Settings

The Staff defaults Miscellaneous tab allows you to set defaults for Cornerstone settings, miscellaneous practice settings, and imaging settings to apply when a particular staff ID is logged in to Cornerstone.

**To set the Staff Defaults for Miscellaneous settings:**

1. On the Staff Defaults window, click the Miscellaneous tab.

2. **Multi-Location/Single Database configurations only:** From the Default practice drop-down list, if operating in a multi-practice environment, select the default practice to associate with this staff ID. (This Staff default practice overrides any Workstation default practice.)

3. From the Login page drop-down list, select the window to display automatically each time the staff ID logs into Cornerstone.

4. In the Revenue center text box, type the default revenue center to use for this staff ID.

5. From the Appointment suite drop-down list, select the suite to display when the staff member logs in to Cornerstone and accesses the Schedule for Today window.

6. To automatically see the log from your backup when the staff ID logs in to Cornerstone, select the Display backup log when logging in check box.

7. To enable the use of keyboard shortcuts in the Image Viewer, select the Enable keyboard shortcuts check box.

8. To set the Advanced Search as the default search option on the Image Explorer for this staff ID, select the Show advanced search on Image Explorer check box.

9. Click Save to save your changes and continue setting staff defaults, or click OK to save your changes and close the Staff Defaults window.
Staff Defaults for Inventory

The Staff defaults Inventory tab allows you to set defaults for saving and deleting when using Cornerstone Inventory, as well as assigning a default location for inventory depletion when a particular staff ID is logged in to Cornerstone.

To set the Staff Defaults for Inventory:

1. On the Staff Defaults window, click the Inventory tab.

2. For the Auto save changes without prompting check box, do one of the following:
   - If you want a “Do you want to save?” confirmation prompt to appear if the staff member switches windows without saving inventory changes first, clear the check box (recommended).
   - If you want the program to automatically save inventory changes the staff member makes without displaying a confirmation prompt, select the check box.

3. For the Auto delete changes without prompting check box, do one of the following:
   - If you want a “Do you want to delete?” confirmation prompt to appear for this staff member when the Delete button is clicked on any inventory window, clear the check box (recommended).
   - If you want the program to automatically delete within inventory (when the Delete button is clicked on any inventory window) without displaying a confirmation prompt for this staff member, select the check box.

4. Multiple location inventory only: If using a multi-location per item inventory setup, from the Inventory location group drop-down list, select the default group of locations the staff member will use to deplete inventory.

   Note: If a Workstation default and a Staff default location are set, the Workstation location is used.

5. Multiple location inventory only: If using a multi-location per item inventory setup, from the Location list, select a specific location (within the selected location group) that the staff member will use to deplete inventory.
6. To view a list of the default inventory location assigned to each staff ID, click **Print**.

7. Click **Save** to save your changes and continue setting staff defaults, or click **OK** to save your changes and close the Staff Defaults window.

**Staff Defaults for Favorite Document Templates**

The Staff defaults **My Favorites** tab allows you to designate enhanced medical notes or correspondence templates as staff favorites to appear in the template list when filtering on **My Favorites** (in the Document Template List window and Start New Document window).

**To set the Staff Defaults for My Favorites:**

1. On the Staff Defaults window, click the **My Favorites** tab.

![My Favorites tab in Staff Defaults window](image)

2. In the **Document templates** list:
   
   - To add a document template to the list, double-click in the blank row at the bottom of the list or press F2 to display the Document Template List and select the template to add to the favorites list.
   
   - To remove a document template from the list, click on the template’s ID in the ID column and then press CTRL+D.

**Note:** Classic medical note templates cannot be selected as favorites.
Overview

Cornerstone* Imaging defaults include system settings for the following areas of Cornerstone Imaging:

- Archiving images
- Setting modality layout defaults
- Emailing images
- Setting general imaging defaults
- Setting up keywords
- Setting up IDEXX Integration Technology for Telemedicine

Note: This chapter covers Cornerstone Imaging (the imaging functionality that is included with Cornerstone software). For information on setting defaults for the IDEXX Digital Radiography module and IDEXX Diagnostic Imaging module, see the Cornerstone Diagnostic Imaging User’s Guide (available online at idexx.com/cornerstoneresources).

Note: For information on Practice and Workstation defaults for imaging (pet picture compression, image storage, and IDEXX SmartLink Digital Imaging preferences for image requests), see “Imaging Defaults” on page 108.

Image Archiving Defaults

Archiving refers to moving images from your computer to another storage location. Archiving is usually not necessary; however, if you do choose to archive images, you can set up the software to alert you when it is time to archive.

Note: If your Images folder nears its storage capacity, you are prompted to archive images.

To set the Archive defaults:

1. On the Controls menu, select Defaults > Imaging. The Imaging Configuration window appears.
2. In the navigation pane, select Archive.
Chapter 6: Setting Cornerstone* Imaging Defaults

3. If you want the software to alert you when it is time to archive, select the Enable Archive Alerts check box.

4. In the Alert Frequency area, specify when you want an alert to appear:
   - To be alerted when a certain number of images have accumulated, select the Images option and type the number of images in the text box.
   - To be alerted when a certain number of days have occurred, select the Days option and type the number of days in the text box.

   Tip: When the value of images or days is reached, a pop-up box opens, indicating that it is time to archive your images.

5. In the Archive Location text box, specify the location where you want to store archived files.

6. Click Save.

Modality Layout Defaults

You can set up how you want images to be displayed on the Image Viewer window based on the modality of the images. Images with a modality of Intra-oral Radiography are set up in a slightly different manner than images from other modalities.

Note: When you change these settings, you are changing how all images of that modality are displayed. For example, if you change the settings for arranging Digital Radiography (DR) images in the viewer, the new settings are applied any time you look at DR images.

To set Image Viewer display formats for Intra-oral Radiography:
1. On the Controls menu, select Defaults > Imaging. The Imaging Configuration window appears.
2. In the navigation pane, select Modality Layout.
3. Select the image modality from the **Modality** drop-down list.

4. Select a dental template from the **Template** drop-down list. The template layout is displayed in the **Preview** area of the window.

*Note:* The **Study Layout** area and the **Series Layout** area do not apply.

5. Click **Save**.

**To set Image Viewer display formats for other modalities:**

1. On the **Controls** menu, select **Defaults > Imaging**. The Imaging Configuration window appears.
2. In the navigation pane, select **Modality Layout**.
3. To set up how individual series are displayed within a study, type the number of rows in the **Rows** text box and columns in the **Columns** text box.

4. To set up how individual images are displayed within a series, type the number of rows in the **Rows** text box and columns in the **Columns** text box.

5. If you want to display the images in a stacked display, select the **Stacked** check box.

   **Note:** The **Template** drop-down list and the **Preview** area do not apply.

6. Click **Save**.

**Image Email Defaults**

To email images from within Cornerstone software, you must have an email system set up on your computer that is configured in Cornerstone.

**Note:** High-speed Internet access is highly recommended because you will be transmitting large amounts of data when you send images.

If you set up a particular email account to be used for a staff member, that account will be used for emails sent from the Image Explorer, Image Viewer, or the **Email** tab of the Case Actions pane on the Case Details window when that staff member is logged in to Cornerstone.

If you do not set up an email account for a staff member, image emails will use the account that has been set up at the system level.

**To set up image email to use a staff-member specific email account:**

1. On the menu bar, select **Controls > Defaults > Imaging**. The Imaging Configuration window appears.

2. In the navigation pane, click **E-mail**. Email configuration options appear on the right.

3. Click the tab with that staff member’s name.
4. In the SMTP Server Name text box, type the name of your email server.

5. In the SMTP Port text box, type the number of the port on your computer from which email will be sent.

6. Select the Enable SSL check box if your email provider requires the use of SSL (Secure Socket Layer) ports. Many Internet-based email providers have this requirement.

7. In the SMTP User Name and SMTP Password text boxes, type the information that Cornerstone needs to log into your email server.

8. From the Default E-mail Attachment File Type drop-down list, select the type of file to use for sending images. This default can be changed when emailing images.

9. In the Default Send E-mail Address text box, type the address to be listed as the sender.
   Note The email address cannot begin with a number.

10. In the Reply E-mail Address text box, type the address to which the recipient should reply.
    Note The email address cannot begin with a number.

11. Click Save to save and close the Imaging Configuration window or click Apply to save without closing the window.

To set up the system-level image email account:
1. On the Controls menu, select Defaults > Imaging. The Imaging Configuration window appears.

2. In the navigation pane, select E-mail.

3. In the configuration pane, click the System tab.

4. In the SMTP Server Name text box, type the name of your email server.

5. In the SMTP Port text box, type the number of the port on your computer from which email will be sent.
6. Select the **Enable SSL** check box if your email provider requires the use of SSL (Secure Socket Layer) ports. Many Internet-based email providers have this requirement.

7. In the **SMTP User Name** and **SMTP Password** text boxes, type the user name and password provided by your Internet service provider.

8. From the **Default E-mail Attachment File Type** drop-down list, select the type of file (.jpeg, .bmp, etc.) to use for sending images. This default can be changed when emailing images.

9. In the **Default Send E-mail Address** text box, type the address to be listed as the sender.  
   **Note** The email address cannot begin with a number.

10. In the **Reply E-mail Address** text box, type the address to which the recipient should reply.  
    **Note** The email address cannot begin with a number.

11. Click **Save**.

**Cornerstone Imaging Defaults**

**To set up Cornerstone Imaging defaults:**

1. On the **Controls** menu, select **Defaults > Imaging**. The Imaging Configuration window appears.

2. In the navigation pane, select **Imaging**.

   ![The Imaging Configuration window, displaying the Imaging defaults](image)

3. In the **Image Scan Settings** area, do the following:
   a. Select your scanner from the **TWAIN Source** drop-down list.
   b. Select the resolution values in dots per inch (dpi) from the **Horizontal Resolution** and **Vertical Resolution** drop-down lists.
   c. Select the pixel type (**Black-and-white**, **Grayscale**, or **Color**) from the **Pixel Type** drop-down list.
d. If you want Cornerstone to use your scanner’s user interface when you scan an image, select the **Enable TWAIN UI** check box.

4. In the *Image Viewer* area, from the **Ruler Units** drop-down list, select the default ruler unit for the Image Viewer ruler.

5. Skip the *Image Capture Settings* area, the **DICOM® Compression Settings** area, and the **Apply Window/Level to Exported Images** check box; these settings do not apply to Cornerstone Imaging.

   **Note:** For information about these settings, see section 8.7 in the *Cornerstone Diagnostic Imaging User’s Guide* (available at [idexx.com/cornerstoneresources](http://idexx.com/cornerstoneresources)).

6. In the *Image Export* area, do the following:

   a. If you want images to contain the overlay information displayed in the Image Viewer, select the **Apply Overlays to exported images** check box. When you begin a print, send, or save action, the **Apply Overlay** option is selected for you, but you will be able to deselect it.

   b. If you want the images to contain the annotations created in the Image Viewer, select **Apply Annotations to exported images**. When you begin a print, send, or save action the **Apply Annotations** option is selected for you, but you will be able to deselect it.

7. To add a capture device, in the *Capture Sources* area, click **Add Capture Source**. A blank line is added to the list. In the **Description** text box, type a description of the device.

8. Click **Save**.

**Image Keywords Defaults**

Keywords (such as cardiovascular, ears, hematology) appear in a list box when you add an image, allowing you to choose one or more keywords to associate with the image. You can also use keywords to search for images. For more information about associating keywords with images, see section 5.13, “Editing Image Details,” in the *Cornerstone Diagnostic Imaging User’s Guide*. For information about searching for images, see section 2.2, “About the Image Explorer” in the *Cornerstone Diagnostic Imaging User’s Guide*.

For your convenience, a number of keywords have been preloaded on your system. You can add, delete, or edit keywords.

**To add a keyword to the Keywords list:**

1. On the **Controls** menu, select **Defaults > Imaging**. The Imaging Configuration window appears.

2. In the navigation menu, select **Keywords**.
The Imaging Configuration window, displaying the Keyword defaults

3. Click **Add** to add a keyword to the Keywords list.
4. In the **Description** text box, type the name of the keyword (up to 30 characters).
5. Click **Save**.

**To edit a keyword from the Keywords list:**
1. Select a keyword in the **Keywords** list.
2. In the **Description** text box, type changes to the keyword.
3. Click **Save**.

**To delete a keyword from the Keywords list:**
> Select a keyword in the **Keywords** list and click **Delete**.

**Note:** You cannot delete a keyword once it has been associated with an image.

**Telemedicine Provider Defaults**

You can submit a case to a telemedicine provider directly through the telemedicine provider’s website. The Telemedicine Provider default settings allow you to enter the provider’s website address and associated information used to reach the telemedicine provider.

**To set up Integration Technology for Telemedicine:**
1. On the **Controls** menu, select **Defaults > Imaging**. The Imaging Configuration window appears.
2. On the left, click **Telemedicine Provider**. The Telemedicine Provider configuration table appears on the right.
3. To add a new provider, click Add.

4. In the row that appears, in the Name text box, type the name that you want to be displayed for this provider on the Case Detail window.

5. In the API URL text box, type the web address you use to reach the telemedicine provider. Be sure to start with “http://” or “https://” per the instructions of your telemedicine provider. For example, you would type https://api.vetmedstat.com/VMSIntegrations/VMSTMS.asmx for IDEXX Telemedicine Consultants.

6. Skip the Homepage text box—it has been provided to support future functionality.

7. In the Login and Password text boxes, type the login name and password you use to log into the telemedicine provider’s site.

8. From the Authentication drop-down list, select the password authentication method that your telemedicine provider specifies.

9. Click the row you just entered to select it.

10. Click Apply.

11. Click Test Tele-provider. A confirmation message appears.

12. Click Save to save and close the Imaging Configuration window or click Apply to save without closing the window.
Section 3–Items and Inventory Setup

Chapter 7: Getting Started with Cornerstone* Inventory Setup
Chapter 8: Setting Up a Single Location Inventory System
Chapter 9: Setting Up a Multiple Location Inventory System
Chapter 10: Setting Up Your Invoice Items
Chapter 11: Other Inventory Setup Tasks
Chapter 7: Getting Started with Cornerstone* Inventory Setup

Overview
Because so many components of the IDEXX Cornerstone* Practice Management System are linked to inventory, inventory setup is an important part of your initial Cornerstone software configuration.

This chapter covers the following inventory topics:
- Comparing the two types of Cornerstone Inventory (single or multiple location)
- Setting up your list of vendors
- Setting up cost centers
- Setting up inventory adjustment reasons

Notes:
- For practices upgrading from Cornerstone 6.2 or earlier, if you have existing inventory items with expiration dates, your existing expiration dates will be removed when you upgrade to a newer version of the Cornerstone software because it has no way of verifying that the inventory expiration dates in your system are correct. To protect the integrity of your data, any existing inventory will display “unknown” as the expiration date. See “Setting Barcodes, Expiration Dates and Lot Numbers” on page 241 for more information about using existing expiration dates from your system.
- The inventory windows require that Windows® Internet Explorer® 7 or later be installed on each workstation. It does not have to be used as the default Internet browser.

Inventory Setup–Single or Multiple Location
There are two different ways you can set up your Cornerstone Inventory system, depending on the needs of your practice.

Single Location per Item Inventory (Basic)
With single location inventory, an inventory item is stored in only one location. Inventory can be stored in multiple locations in the clinic, but each item can be stocked in only one location. For example, dog food might be stored in the stockroom and medications might be stored in the pharmacy.

With a single location per item setup, each item is associated with a single location and quantities of an inventory item may only be received into, adjusted in, or consumed for this single location.

Note: For Cornerstone 7.6 and later, single location inventory is the default inventory setup used for all new Cornerstone system installations.

Multiple Locations per Item Inventory (Advanced)
With multiple location inventory, each item can have quantities stored in multiple locations (any item can be used in any location). For example, a popular type of canned dog food might be stored both in reception and in the stockroom.

When using multiple location inventory, a location can be assigned to a specific location group and may have multiple location types.

If you have more than one practice using quantities of inventory stored in multiple locations, you may want to consider using a multiple location inventory setup.
### Single and Multiple Location Inventory—Cornerstone Functionality Comparison Table

<table>
<thead>
<tr>
<th>Inventory Feature/Functionality</th>
<th>Single Location Inventory</th>
<th>Multiple Location Inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Want List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Order List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Purchasing Work List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Receipt List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Quantity on Hand</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Return to Vendor</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Internal Stock Use</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Backorder List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Adjustment List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Vendors</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Locations</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cost Centers</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Adjustment Reasons</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Assign One or More Locations per Item</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Find and Transfer Items</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Use Stock Transfer List</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Use Location Groups</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Use Location Types</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

For information on setting up a single location inventory system, see “Chapter 8: Setting Up a Single Location Inventory System” beginning on page 171.

For information on setting up a multiple location inventory system, see “Chapter 9: Setting Up a Multiple Location Inventory System” beginning on page 174.

**How Can I Tell Which Type of Inventory Setup Is in Use Now?**

For Cornerstone versions 7.6 and later, you can check to see what type of inventory setup was installed by checking the display of your Purchasing Work List window (`Inventory > Purchasing Work List`). If you have single location inventory, the **Want/Suggested List** tab is the only tab available at the top of the window. If you have multiple location inventory, the **Locate an Item** and **Quantity at Location** tabs are also available.

**Tip:** For Cornerstone 7.6 and later, single location inventory is the default inventory setup used for all new Cornerstone system installations.

**What if My Practice Wants to Switch Its Inventory Setup Type?**

If you have single location inventory and would like to move to multiple location inventory (or vice versa), contact Cornerstone Support at 1-800-695-2877 for information on converting your inventory system.
### Setting Up Your List of Vendors

From the Vendor List, you can add vendors, update a vendor’s information, delete a vendor that has never been used, or inactivate a vendor you no longer use.

Vendor information tracked in Cornerstone Inventory includes:

- Vendor name, address and website (if applicable)
- Vendor contacts, telephone numbers, email addresses and notes
- An alert message that appears when placing an order with the vendor
- Additional notes about the vendor

**To add a new vendor or edit information for a vendor:**

1. On the **Inventory** menu, select **Vendors**. The Vendor List window appears.

#### Vendor List window

The Vendor List window is shown with a list of vendors and a search bar.

**Tip:** To search for a vendor, in the **Vendor** text box, type the beginning letters or full name of the vendor and click **Search**.

2. Do one of the following:
   - To edit information for a vendor, select the vendor in the vendor list and click the **Edit** button. The vendor’s information appears.
   - To add a new vendor, click the **Add New** button. The Add a New Vendor window appears.
Add or edit a vendor

**Note:** Fields with an asterisk (*) next to them are required fields.

3. If adding a new vendor, in the **ID** text box, type a unique identification code to distinguish this vendor in Cornerstone.

4. If you no longer use this vendor, select the **Inactive** check box to inactivate the vendor. When you do a vendor search, inactive vendors can be hidden.

5. In the **Vendor name** text box, type the vendor’s name.

6. In the **Account Number** text box, type the practice’s account number with the vendor.

7. From the **Vendor Type** drop-down list, select the vendor type (Manufacturer, Distributor, or Other).

8. In the **Web site address** text box, type the vendor’s website address. After you enter the address, it becomes a hyperlink that you can click to access the site (Internet access required). To change the website address, click the **Edit** button and make changes.

9. In the applicable fields, enter the vendor’s address, city, state, and postal code information.

10. In the **Phone numbers** area, do the following:

   - Enter the names of your vendor contacts, their phone numbers, extensions, email addresses, and any notes about the contacts.

   - To indicate your primary contact with the vendor, click the round option button to the left of the contact’s name.

   - To remove a contact from the list, select the contact and then click the **Delete** button.

11. In the **Notes** area, type any notes pertaining to this vendor. The notes will print on the Vendor Summary Report.
12. In the **Alerts** area, type any information you would like to appear in an alert when placing a new order or receiving an order from the vendor (for example, minimum order requirements or shipping policies).

13. Click **Save** to save your changes.

**To delete a vendor:**

**Note:** If there is a history with the vendor, it cannot be deleted, only inactivated.

1. On the **Inventory** menu, select **Vendors**. The Vendor List window appears.

2. To search for a vendor, in the **Vendor** text box, type the beginning letters or full name of the vendor and click **Search**.

3. Select the vendor you want to delete and click **Delete**. You are prompted to confirm the deletion.

   **Note:** If the **Remember my decision** check box is selected, the confirmation message will no longer appear after performing a Delete operation within Cornerstone Inventory. We recommend that you leave this option unchecked.

4. Click **Yes** to delete the vendor.

   [To view a list showing the primary vendor for each inventory item, print an **Inventory–Item Vendor Information Report**.]

   [For a list of vendors, print an **Inventory–Vendor Summary Report**.]

**Setting Up Internal Cost Centers**

The Internal Stock Use feature tracks inventory costs associated with items you use within your practice. In order for this feature to correctly reflect your internal inventory costs, you need to first set up cost centers and any applicable usage taxes in your practice. (For more information on setting up taxes, see “Taxes” on page 29.)

Cost Centers are specific areas in your practice where you use inventory items that are not invoiced. You can set up several cost centers that represent different facets of your business.

**To set up cost centers:**

1. On the **Inventory** menu, select **Cost Centers**.

2. Click **Add New**. The **Add a Cost Center** window appears.

   ![Add a Cost Center window](image)

3. In the **ID** text box, type an ID for the cost center.

4. In the **Description** text box, type a brief description for the cost center.

5. To inactivate the cost center, select the **Inactive** check box.

6. Click **OK** to save your changes.
To see the cost of inventory used within your practice within each cost center, print an Inventory–Internal Usage Report.

**Setting Up Inventory Adjustment Reasons**

An adjustment reason must be selected from a drop-down list when quantity on hand is adjusted. Several of the most common reasons for adjusting inventory have already been set up for you in Cornerstone. In addition to the reasons included with the software, custom adjustment reasons can be added, edited, deleted, or designated as inactive.

**To maintain the list of adjustment reasons:**

1. On the Inventory menu, select Adjustment Reasons. The Adjustment Reasons List window appears.

2. Do one of the following:
   - To add a new adjustment reason, click Add New.
   - To change an existing reason, select the reason that you want to change and click Edit.
   - To delete a reason, select the reason that you want to delete and click Delete.

   If you clicked Add New or Edit, a window appears allowing you to add or edit the description for the adjustment reason.

3. In the Description text box, type a brief description for the adjustment reason.
4. To inactivate the adjustment reason, select the Inactive check box.
5. When finished, click Save.
Chapter 8: Setting Up a Single Location Inventory System

This chapter includes steps required to set up a single location inventory system in the IDEXX Cornerstone* Practice Management System. For information on daily usage tasks for single location inventory, see “Chapter 22: Using a Single Location Inventory System” in the Cornerstone User’s Manual.

Overview

With single location inventory, each item is associated with a single location and quantities of an inventory item may only be received into, adjusted in, or consumed for this single location. This makes initial inventory setup less complicated and fairly straightforward.

The following table lists 15 steps for a complete single location inventory setup.

<table>
<thead>
<tr>
<th>Step</th>
<th>Single Location Inventory Task</th>
<th>Cornerstone Location</th>
<th>Link to Section in this Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set up departing instructions</td>
<td>Lists &gt; Departing Instructions</td>
<td>Departing Instructions</td>
</tr>
<tr>
<td>2</td>
<td>Set up prescription instructions</td>
<td>Lists &gt; Prescription Instructions</td>
<td>Prescription Instructions</td>
</tr>
<tr>
<td>3</td>
<td>Set up units of measure</td>
<td>Controls &gt; Units of Measure</td>
<td>Units of Measure</td>
</tr>
<tr>
<td>4</td>
<td>Set up price change reasons</td>
<td>Controls &gt; Price Change Reasons</td>
<td>Price Change Reasons</td>
</tr>
<tr>
<td>5</td>
<td>Set up vendors</td>
<td>Inventory &gt; Vendors</td>
<td>Setting Up Your List of Vendors</td>
</tr>
<tr>
<td>6</td>
<td>Set up locations</td>
<td>Inventory &gt; Locations</td>
<td>Setting Up Locations</td>
</tr>
<tr>
<td>7</td>
<td>Set up cost centers</td>
<td>Inventory &gt; Cost Centers</td>
<td>Setting Up Internal Cost Centers</td>
</tr>
<tr>
<td>8</td>
<td>Set up adjustment reasons</td>
<td>Inventory &gt; Adjustment Reasons</td>
<td>Setting Up Inventory Adjustment Reasons</td>
</tr>
<tr>
<td>9</td>
<td>Inactivate invoice items not used</td>
<td>Lists &gt; Invoice Item</td>
<td>Inactivating Invoice Items</td>
</tr>
<tr>
<td>10</td>
<td>Set up item classifications and subclassifications</td>
<td>Lists &gt; Invoice Item Class</td>
<td>Setting Up Invoice Item Classifications and Subclasses</td>
</tr>
<tr>
<td>11</td>
<td>Set up inventory items</td>
<td>Lists &gt; Invoice Item</td>
<td>Setting Up a New Invoice Item</td>
</tr>
<tr>
<td></td>
<td>Use the Invoice Item Setup tool</td>
<td>Tools &gt; Invoice Item Setup</td>
<td>Using the Invoice Item Setup Tool</td>
</tr>
<tr>
<td>12</td>
<td>Link inventory items</td>
<td>Lists &gt; Invoice Item</td>
<td>Linking Inventory Items</td>
</tr>
<tr>
<td>13</td>
<td>Receive past invoices</td>
<td>Inventory &gt; Receipt List</td>
<td>Receiving Past Invoices</td>
</tr>
<tr>
<td>14</td>
<td>Perform a cycle count using the Inventory–Counts Report</td>
<td>Reports &gt; Find a Report &gt; Inventory report group</td>
<td>Performing a Cycle Count</td>
</tr>
<tr>
<td>15</td>
<td>Adjust quantity on hand and cost</td>
<td>Inventory &gt; Adjustment List</td>
<td>Adjusting Quantity on Hand and Cost</td>
</tr>
</tbody>
</table>

**Note:** If you are currently using single location inventory and have more than one practice using quantities of inventory stored in multiple locations, you may want to consider using multiple location inventory. With this type of setup, each item can have quantities stored in multiple locations (any item can be used in any location) and location groups are enabled. Contact Cornerstone Support at 1-800-695-2877 for instructions on activating this functionality in your Cornerstone software.
Setting Up Locations for Single Location Inventory

In Cornerstone Inventory, locations are the physical places in your practice where you keep inventory items. With single location inventory, more than one location can be set up by the practice for tracking inventory, but each inventory item can be assigned to only one location.

Examples of locations include room names, room numbers, shelf numbers, reception areas, stockrooms, trucks, refrigerators, lock boxes, kennels and controlled substance cabinets.

Note: At least one location is required if your practice wishes to track the quantity on hand of inventory items.

Before You Begin

- Set up Practice and Workstation defaults for Inventory (see “Inventory Defaults” on page 109).
- Set up Staff defaults for Inventory (see “Staff Defaults for Inventory” on page 153).

To set up inventory locations:

1. On the Inventory menu, select Locations. The Locations List window appears.

2. Do one of the following:
   - To add a new location, click Add New.
   - To change an existing location, select the location that you want to change and click Edit.
   - To delete a location, select the location that you want to delete and click Delete. (Note: You cannot delete a location if it is assigned to an invoice item or is part of purchase history.)

If you clicked Add New or Edit, a window appears allowing you to add/edit the identifying information for the location.
**Note:** Fields with an asterisk (*) next to them are required fields.

3. If adding a new location, in the **Location ID** text box, type a unique identification code to distinguish this location from other locations in Cornerstone.

4. In the **Description** text box, type a name to describe the location.

5. If this location is no longer used by the practice, select the **Inactive** check box to inactivate it.

6. When finished, click **Save**.

7. Click **Back** to return to the Locations List or click `×` to close.
Overview

With multiple location inventory, each item can have quantities stored in multiple locations, and location groups and types are enabled. The initial inventory setup for multiple location inventory can be fairly straightforward or more advanced, depending on the needs of your practice.

The following table lists 18 steps for a complete multiple location inventory setup.

<table>
<thead>
<tr>
<th>Step</th>
<th>Multiple Location Inventory Setting</th>
<th>Cornerstone Location</th>
<th>Link to Section in this Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set up departing instructions</td>
<td>Lists &gt; Departing Instructions</td>
<td>Departing Instructions</td>
</tr>
<tr>
<td>2</td>
<td>Set up prescription instructions</td>
<td>Lists &gt; Prescription Instructions</td>
<td>Prescription Instructions</td>
</tr>
<tr>
<td>3</td>
<td>Set up units of measure</td>
<td>Controls &gt; Units of Measure</td>
<td>Units of Measure</td>
</tr>
<tr>
<td>4</td>
<td>Set up price change reasons</td>
<td>Controls &gt; Price Change Reasons</td>
<td>Price Change Reasons</td>
</tr>
<tr>
<td>5</td>
<td>Set up vendors</td>
<td>Inventory &gt; Vendors</td>
<td>Setting Up Your List of Vendors</td>
</tr>
<tr>
<td>6</td>
<td>Set up location types</td>
<td>Inventory &gt; Location Types</td>
<td>Setting Up Location Types</td>
</tr>
<tr>
<td>7</td>
<td>Set up location groups</td>
<td>Inventory &gt; Location Groups</td>
<td>Setting Up Location Groups</td>
</tr>
<tr>
<td>8</td>
<td>Set up locations</td>
<td>Inventory &gt; Locations</td>
<td>Setting Up Locations</td>
</tr>
<tr>
<td>9</td>
<td>Set up cost centers</td>
<td>Inventory &gt; Cost Centers</td>
<td>Setting Up Internal Cost Centers</td>
</tr>
<tr>
<td>10</td>
<td>Set up adjustment reasons</td>
<td>Inventory &gt; Adjustment Reasons</td>
<td>Setting Up Inventory Adjustment Reasons</td>
</tr>
<tr>
<td>11</td>
<td>Inactivate invoice items not used</td>
<td>Lists &gt; Invoice Item</td>
<td>Inactivating Invoice Items</td>
</tr>
<tr>
<td>12</td>
<td>Set up item classifications and subclassifications</td>
<td>Lists &gt; Invoice Item Class</td>
<td>Setting Up Invoice Item Classifications and Subclasses</td>
</tr>
<tr>
<td>13</td>
<td>Set up inventory items and/or Use the Invoice Item Setup Tool</td>
<td>Lists &gt; Invoice Item Tools &gt; Invoice Item Setup</td>
<td>Setting Up a New Invoice Item Using the Invoice Item Setup Tool</td>
</tr>
<tr>
<td>14</td>
<td>Link inventory items</td>
<td>Lists &gt; Invoice Item</td>
<td>Linking Inventory Items</td>
</tr>
<tr>
<td>15</td>
<td>Receive past invoices</td>
<td>Inventory &gt; Receipt List</td>
<td>Receiving Past Invoices</td>
</tr>
<tr>
<td>16</td>
<td>Transfer items to appropriate locations</td>
<td>Inventory &gt; Find and Transfer Items</td>
<td>Transferring Items to the Appropriate Locations (Multiple Location Only)</td>
</tr>
<tr>
<td>17</td>
<td>Perform a cycle count using the Inventory–Counts Report</td>
<td>Reports &gt; Find a Report &gt; Inventory report group</td>
<td>Performing a Cycle Count</td>
</tr>
<tr>
<td>18</td>
<td>Adjust quantity on hand and cost</td>
<td>Inventory &gt; Adjustment List</td>
<td>Adjusting Quantity on Hand and Cost</td>
</tr>
</tbody>
</table>
Note: If you have a multiple locations per item inventory setup and would like to simplify inventory to have each item associated with a single location, there is a Cornerstone Location Consolidator Utility available that automates this process for you. Contact Cornerstone Support at 1-800-695-2877 for instructions on using the Consolidator Utility.

Location Groups, Locations, and Location Types
Practices using multiple location inventory have the option to set up location groups and location types, which can be helpful when needing to maintain a logical organization for complex inventory systems.

Note: You can receive inventory only into locations (not into location groups or types).

- **Location Groups**—Location groups are primarily used within practices that have satellite clinics or separate facilities, where each clinic or facility can be designated as a separate location group. This enables staff to track inventory information by locations within a specific clinic or facility and allows ordering by location group.

  Other examples of location groups include mobile units or warehouses.

- **Locations**—More than one location can be set up by the practice in order to track inventory. With multiple location inventory, an inventory item can be stored in multiple locations (e.g., cans of ABC Dog Food might be stored in both the reception room and the stockroom).

  Examples of locations include room names, room numbers, shelf numbers, reception areas, stockrooms, trucks, refrigerators, lock boxes, kennels, and controlled substance cabinets.

- **Location Types**—Practices that have multiple locations set up to store inventory may use location types to categorize locations. Location types provide an additional way of defining and distinguishing inventory storage locations.

  Examples of location types include trucks, refrigerators, retail centers, pharmacy centers, and supply centers.

Multiple Location Inventory Setup Examples

**Example 1: Locations Only**
In this example, the practice stores inventory items in multiple locations but does not use location groups or location types.

**Example 2: Locations and Location Groups**
In this example, the practice stores inventory items in multiple locations and uses location groups to separate the two different clinic locations.
Example 3: Locations and Location Types
In this example, the practice stores inventory items in multiple locations and uses location types.

Example 4: Locations, Location Groups and Location Types
In this example, the practice stores inventory items in multiple locations and uses location groups and location types.

Setting Up Location Types
Location types are an optional inventory feature available only with a multiple location per item inventory setup. Location types provide an additional way of defining inventory storage locations. See “Location Groups, Locations, and Location Types” on page 175 for more information on location types.

To set up a location type:
1. On the Inventory menu, select Location Types. The Location Types window appears.

2. In the Description text box, type a description for the type of location (e.g., Primary Storage, Refrigerators, Supply Centers, etc.).

3. Click Add.

4. If an existing location type is no longer used by the practice, you can delete it by highlighting it in the list and clicking Delete. (Note: You cannot delete a location type if it is assigned to a location.)

5. Click to close.
Setting Up Location Groups

Location groups are an optional inventory feature available only with a multiple location per item inventory setup. Location groups are especially useful for practices that have satellite clinics or separate facilities, where each clinic or facility can be designated as a separate location group. See “Location Groups, Locations, and Location Types” on page 175 for more information on location groups.

After inventory groups are set up, inventory locations can be assigned to them. Note, however, that a location may be part of only one location group.

Before You Begin

- Set up Practice and Workstation defaults for Inventory (see “Inventory Defaults” on page 109).
- Set up Staff defaults for Inventory (see “Staff Defaults for Inventory” on page 153).
- Set up Workstation defaults for Inventory (see “Workstation–All Defaults” on page 148).

To add or maintain location groups:

1. On the Inventory menu, select Location Groups. The Location Group List window appears.

2. Do one of the following:
   - To add a new location group, click Add New.
   - To change an existing location group, select the group that you want to change and click Edit.
   - To delete a location group, select the group that you want to delete and click Delete. (Note: You cannot delete a location group if it is assigned to a location, order or Want List item.)

If you clicked Add New, or Edit, a window appears allowing you to add/edit the identifying information for the location group.

3. In the Description text box, type a brief description for the location group.
4. To inactivate the location group, select the Inactive check box.
5. When finished, click Save.
6. Click **Back** to return to the Location Group List or click **X** to close.

**Setting Up Locations for Multiple Location Inventory**

In Cornerstone Inventory, locations are the physical places in your practice where you keep inventory items. With multiple location inventory, you can set up multiple locations within your practice and track inventory items by location (with one inventory item being stored in multiple locations). More than one location can be set up by the practice in order to track inventory in specific areas within the practice, as well as in satellite clinics or mobile units.

Examples of locations include room names, room numbers, shelf numbers, reception areas, stockrooms, trucks, refrigerators, lock boxes, kennels, and controlled substance cabinets.

If you choose to set up multiple locations per inventory item, when orders are received or inventory is adjusted, you must select a location for items for which you track quantity on hand.

A location can be assigned to a specific location group and may have multiple location types.

**Note:** At least one location is required if your practice wishes to track the quantity on hand of inventory items.

**To set up inventory locations:**

1. On the **Inventory** menu, select **Locations**. The Locations List window appears.

![Locations List window](image)

2. Do one of the following:
   - To add a new location, click **Add New**.
   - To change an existing location, select the location that you want to change and click **Edit**.
   - To delete a location, select the location that you want to delete and click **Delete**. (Note: You cannot delete a location if it is assigned to an invoice item or is part of purchase history.)

If you clicked **Add New** or **Edit**, a window appears allowing you to add/edit the identifying information for the location.
Chapter 9: Setting Up a Multiple Location Inventory System

Add or edit a location

**Note:** Fields with an asterisk (*) next to them are required fields.

3. If adding a new location, in the **Location ID** text box, type a unique identification code to distinguish this location from other locations in Cornerstone.

4. In the **Description** text box, type a name to describe the location.

5. If you are using location groups and you want to include this location in a group, select the specific group this location should be assigned to from the **Group** drop-down list.
   
   **Tip:** To set up location groups, see “Setting Up Location Groups” on page 177.

6. If this is a location from which you supply other locations, select the supply order for the location (First, Second, etc.) from the **Supply location** drop-down list. For example, if the supply order for this location is second, then staff would come to this location if the first supply location did not have the needed item.

7. If you are using location types, in the **Type of location** list, highlight the applicable types that are included in this location.
   
   **Tip:** To set up location types, see “Setting Up Location Types” on page 176.

8. If this location is no longer used by the practice, select the **Inactive** check box to inactivate it.

9. When finished, click **Save**.

10. Click **Back** to return to the Locations List or click  to close.
Chapter 10: Setting Up Your Invoice Items

Overview
Invoice items are the service and inventory items that you sell. As you invoice these items, you will:

- Add the items to the patient’s medical history
- Add the invoice amount to the client’s A/R balance (for credit accounts)
- Print item-specific departing instructions on the invoice
- Add reminders to the patient’s medical history
- Take the items out of your physical inventory

Invoice Item Terminology
Before you begin setting up your invoice items, you should understand the terminology used in the program.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage Tax</td>
<td>Tax applied when the item is used internally.</td>
</tr>
<tr>
<td>Sell UOM</td>
<td>The unit of measure used when invoicing.</td>
</tr>
<tr>
<td>Buy UOM</td>
<td>The unit of measure used when purchasing the item from the vendor.</td>
</tr>
<tr>
<td>Buy/Sell Ratio</td>
<td>The ratio that defines how many sell units are in each unit purchased from the vendor. (For example, 1 case to 24 cans.)</td>
</tr>
<tr>
<td>Quantity on Hand (QOH)</td>
<td>The current physical inventory of the item (using the Sell UOM).</td>
</tr>
<tr>
<td>Average Cost</td>
<td>The average cost you pay the vendor for the item for each unit you sell (using the Sell UOM). The total cost is calculated by multiplying the average cost by the quantity on hand.</td>
</tr>
<tr>
<td>Markup (dollar amount or percentage)</td>
<td>The amount or percentage to mark the item up when the vendor increases their cost to you.</td>
</tr>
<tr>
<td>Reorder Point</td>
<td>The stock level (using the Buy UOM) at which the item appears as a suggested item to order.</td>
</tr>
<tr>
<td>Reorder Quantity</td>
<td>The amount (using the Buy UOM) Cornerstone* Inventory automatically enters when you place an order for this item. (You can change this number in the order itself.)</td>
</tr>
<tr>
<td>Overstock Point</td>
<td>The stock level you do not want to exceed. This number must be greater than the Reorder Point plus the Reorder Quantity (using the Sell UOM).</td>
</tr>
<tr>
<td>Primary Vendor</td>
<td>The main supplier for this product.</td>
</tr>
</tbody>
</table>

Inventory Calculations
The IDEXX Cornerstone* Practice Management System uses the following calculations for determining inventory quantities, costs, and prices.

Place Order

\[
\text{New Qty On Order} = \frac{\text{Qty Ordered}}{\text{Sell Ratio}} + \text{Current Qty On Order}
\]

\[
\text{New Qty On Order} = \text{Qty Ordered} + \text{Current Qty On Order}
\]
Chapter 10: Setting Up Your Invoice Items

Backordered Items

**Buy UOM**

New Qty On Order = Qty Back ordered + Current Qty On Order

New Qty On Backorder = Qty Back ordered + Current On Back order

**Sell UOM**

New Qty On Order = Quantity Back ordered / Sell Ratio + Current Qty On Order

New Qty On Backorder = Qty Back ordered / Sell Ratio + Current Qty On Back order

Return to Vendor

**Buy UOM**

New QOH = Current QOH - (Qty Returned * Sell Ratio)

Total Cost = If [Old Total Cost - (Qty Returned * Cost Returned)] < 0, then 0

Total Cost = If [Old Total Cost - (Qty Returned * Cost Returned)] > 0, then Old Total Cost - (Qty Returned * Cost Returned)

**Sell UOM**

New QOH = Current QOH - Qty Returned

Total Cost = If [Old Total Cost - (Qty Returned * Cost Returned)] < 0, then 0

Total Cost = If [Old Total Cost - (Qty Returned * Cost Returned)] > 0, then Old Total Cost - (Qty Returned * Cost Returned)

Receive Order

**Buy UOM**

On Hand = Current QOH + (Qty Received * Sell Ratio)

Total Cost = Current Total Cost + [(Qty Rec'd * Sell Ratio) * (Rec'd Cost / Sell Ratio)]

If QOH < 0 = [Current Total Cost + (Qty Rec'd * Sell Ratio)] * (Rec'd Cost / Sell Ratio)

On Order = Current Qty On Order - Qty Rec'd

On Backorder = Current Qty On Back order - Qty Rec'd

**Sell UOM**

On Hand = Current QOH = Qty Received

Total Cost = Current Total Cost + (Qty Rec'd * Rec'd Cost); If QOH < 0 = (Current Total Cost + Qty Rec'd) * Rec'd Cost

On Order = Current Qty On Order - (Qty Rec'd / Sell Ratio)

On Backorder = Current Qty On Back order - (Qty Rec'd / Sell Ratio)

Item Markup

If Auto Calculate is checked:

\[
\begin{align*}
\text{\$ (If received using the Sell UOM)} & \quad \text{New Price} = \text{Unit Cost on Receipt} + \text{Markup} \\
\text{\$ (If received using the Buy UOM)} & \quad \text{New Price} = \left(\text{Unit Cost on Receipt} / \text{Sell Ratio}\right) + \text{Markup} \\
\text{\% (Sell UOM)} & \quad \text{New Price} = \left(\text{Unit Cost on Receipt} \times \text{Markup}\right) + \text{Unit Cost on Receipt} \\
\text{\% (Buy UOM)} & \quad \text{New Price} = \left(\left(\text{Unit Cost on Receipt} / \text{Sell Ratio}\right) \times \text{Markup}\right) + \left(\text{Unit Cost on Receipt} / \text{Sell Ratio}\right)
\end{align*}
\]

All calculations are rounded up to the Round To value.
You can choose to increase the item base price by either a **markup** percentage or a **margin** percentage.

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Markup %</td>
<td>Base price ÷ (Cost minus 1)</td>
</tr>
<tr>
<td>Margin %</td>
<td>1 minus Cost ÷ Base price</td>
</tr>
</tbody>
</table>

### Internal Usage and Invoices

<table>
<thead>
<tr>
<th>Property</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hand</td>
<td>Current QOH - Qty Returned</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Current Total Cost - [(Qty Returned * (Current Total Cost / Current QOH)]</td>
</tr>
<tr>
<td>Linked Items On Hand</td>
<td>Current QOH - (Qty Returned * Link Qty)</td>
</tr>
<tr>
<td>Linked Items Total Cost</td>
<td>Current Total Cost - [(Qty Returned * Link Qty) * (Current Total Cost / Current QOH)]</td>
</tr>
</tbody>
</table>

### Setting Up Invoice Item Classifications and Subclasses

Invoice items are divided into primary classes and then divided further into subclasses. By classifying invoice items, you can:

- Generate more specific information in reports
- Mark up or mark down entire groups of similar invoice items
- Narrow invoice item searches
- Create pick lists

Anesthesia, Supplies, and Pharmaceuticals are examples of invoice item classifications.

### Before You Begin

- If you started with a Fastart* or FastInstall database, review the classifications and subclasses already set up in the Invoice Item Classification List.

### To add an invoice item class and subclass:

1. On the **Lists** menu, select **Invoice Item Class**. The Invoice Item Classification List dialog box appears.

![Invoice Item Classification List dialog box](image)

2. Click **New**. The Invoice Item Classification Information dialog box appears.
3. In the **Class ID** text box, type the classification ID.
4. In the **Description** text box, type the classification description.
5. If your practice uses the General Ledger Interface, in the **GL Account** text box, type a GL Account name.
6. In the **Default Revenue Center** text box, type the default revenue center for this classification.
7. In the **Classification sales tax** and **Classification usage tax** areas, click any taxes that you want to automatically apply to all invoice items in the class. Class taxes are applied only to new invoice items.

   **Note:** In addition to the selected class taxes, if there are any practice default taxes, these taxes will also be applied to new items in the class. Practice default taxes are set in Inventory defaults (see “Inventory Defaults” on page 109) and in Invoice Item defaults (see “Invoice Item Defaults” on page 116).

8. If you want to add a subclass for this class, in the **Subclass** area, click **Add**. The Invoice Item Subclass Information dialog box appears.

9. In the **Subclass ID** and **Description** text boxes, type the ID and description and then click **OK** to return to the Invoice Item Classification Information dialog box.

10. Click **OK**.
For a complete list of classifications and subclasses, print an Invoice Item Classification Setup Report.

The Invoice Item List

Many item setup tasks can be initiated from the Invoice Item List (Lists > Invoice Item), including creating, modifying, deleting, or selecting invoice items within Cornerstone.

The different areas and elements on the Invoice Item List help you to accomplish a variety of tasks.

Invoice item classification area

- **Classification** text box—Allows you to narrow the list of invoice items to a specific category.

Search by area

- **Description** option—Allows you to search the list of items by name.
- **Item ID** option—Allows you to search the list of items by item ID.

Invoice item information area

- **Description** text box—If searching by description, type the name of the invoice item you are searching for. The list automatically scrolls to the area that most closely matches what you have typed.
- **Item ID** text box—If searching by item ID, type the identification code of an invoice item.
- **Search for word** check box—If searching by description, select this check box to narrow the list to any item containing the letters typed in the **Description** text box. For example, if you type “rabies” in the description text box with **Search for word** selected, any invoice item containing this word will display in the list (such as Rabies Canine 1 Year and Feline Rabies 1 Year).
- **Include** area check boxes—Narrows the list of invoice items to a specific type of item.
- **Pound sign (#)** icon—Indicates the inventory item is marked to maintain quantity on hand in Cornerstone. In other words, Cornerstone is tracking the quantity of the inventory item that is received and consumed.
- **Dollar sign ($)** button—Click the button to display the Invoice Item Price Information window to view general pricing information for the item.
Item Price Information window

The Invoice Item Price Information window includes:

- **Minimum price**–The minimum price to charge for the item. (This price is set in the Invoice Item Information window Information tab Minimum price text box.)

- **Dispensing fee**–The additional fee added to the price of the product. (This fee amount is set in the Invoice Item Information window Information tab Dispensing fee text box.)

- **Last cost**–The vendor’s last cost for the item based on when this item was last received.
  
  **Note:** The last cost information is displayed only if the logged in staff member has the appropriate security permissions in Cornerstone.

- **Quantity/Amount/Markup %**–General pricing breakdown for the product, including price breaks. (This information is set up in the lower right area of the Invoice Item Information window Information tab.)

- **Dispensing items**–The list of choices for dispensing fees associated with the product. (This information can be set up by clicking the Dispensing button in the Invoice Item Information window Information tab Dispensing button. Each dispensing code that is highlighted on this list displays in the Dispensing items list.)

If you click the **Dollar sign ($)** button for a group item, the Invoice Item Group Information window displays information for all items included in the group.

Invoice Item Group Information window

For a complete list of invoice items currently set up in Cornerstone, print an **Invoice Item Setup Report**.


**Setting Up Invoice Item Information**

Before you can begin invoicing, you must set up all of the items you sell. These include products (inventory items) and services (service items). In addition, you can set up common combinations of several items (group items), pick items, and dispensing items.

- For information on adding Group items, see “Setting Up Invoice Item Groups” on page 213.
- For information on adding Pick items, see “Setting Up Pick Lists” on page 211.
- For information on adding Dispensing items, see “Setting Up Dispensing Items” on page 221.

**Before You Begin**

- If you started with a Fastart or FastInstall database, review the invoice items included. Customize these items to meet the specific needs of your practice by adding or modifying item information, reminders, taxes, discounts, departing instructions, and prescription instructions. Enter additional invoice items and delete unnecessary invoice items.
- Set your Invoice Item defaults (see “Invoice Item Defaults” on page 116).

For a complete list of invoice items currently set up in Cornerstone, print an Invoice Item Setup Report.

**To add or update an invoice item:**

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Do one of the following:
   - To create a new invoice item, click New.
   - To modify information for an existing invoice item, select the item and then click Update.

The Invoice Item Information window appears.
3. If you are creating a new item, if your practice enters new invoice item IDs manually, type the invoice item ID in the **ID** text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears. Press **TAB**.

4. If you are creating a new item, specify the type of item by selecting the appropriate option:
   - **Inventory**, **Service**, **Group**, **Pick**, and **Dispensing**.
   
   **Note:** The tabs and settings available on this window will change depending on the item type selected.

5. On the **Information** tab, in the **Item information** area, do the following:
   a. In the **Hospital description** text box, type an internal description of the item to display in the Invoice Item List in your reports, in the patient’s medical file, and on invoices and reminders if there is not a Client description.
   b. If you would like an alternate description to display on client documents, in the **Client description** text box, type a description of the item to print on the invoice and estimate, and also on reminders.

6. In the **Classification** area, do the following:
   a. Select a classification for the item from the **Primary** drop-down list. The classification is used to generate more specific information in reports, to mark up or mark down entire groups of similar invoice items and narrow invoice item searches.
   b. If applicable, select a subclassification for the item from the **Subclass** drop-down list.
   
   **Tip:** A benefit of creating subclasses and assigning these to individual invoice items is that these items can easily be grouped into pick lists.

7. In the **Type** area, do the following:
   a. Select the item status from the **Status** drop-down list. For a new item, do not change the default status of **Active**. Mark an invoice item as **Inactive** only when you have discontinued use of the item and do not want it to display on lookup lists related to invoicing.
   b. Select the **Miscellaneous item** check box if you want to be able to type over the description of the item when it is invoiced. The client description will not print if the item is marked as miscellaneous.
   c. **Inventory items only:** Select the **Controlled substance** check box to track the item on the Controlled Substance Report.

   **Note:** The Controlled Substance Report records the amount of the drug that is invoiced. It does not reflect the difference between the invoiced amount and the administered amount. See “Controlled Substance Report” on page 247 for more information on the Controlled Substance Report.
   
   d. **Inventory items only:** Select the **Hazardous** check box if the product is considered hazardous material. If this item is marked as a hazardous material, select the **MSDS** check box if your practice has the product’s Materials Safety Data Sheet required by law. This information does not print from Cornerstone.
   
   e. **Inventory items only:** From the **Unit of measure** drop-down list, select the selling unit of measure (UOM) for the item. If you do not want to use a UOM with this item, select **[None]**.
**Note:** If this item is marked to maintain quantity on hand, the UOM should be the lowest unit administered or dispensed. If the UOM is not on the list of options, you can add the UOM using **Controls > Units of Measure**.

8. In the **Default revenue center** text box, specify a default revenue center for this item by typing a revenue ID or pressing F2 to use the Revenue Center List to choose a revenue center. This is used to track revenue separately by different areas for the business. See “Revenue Centers” on page 71 for information about revenue centers.

9. If your practice uses barcodes, in the **Sell barcode** text box, scan (or type) the barcode used to sell the invoice item.

**Note:** The **Sell barcode** is how you sell the item to your clients. If the item is sold by the bottle, scan or type the barcode used on the bottle.

10. In the **Pricing** area, do the following:
   a. If applicable, type a **Minimum price** to charge the client for this item. For example, you may want to charge a minimum price on a medication item that is dispensed per capsule. This price appears on the invoice until the invoice item’s (quantity x price) + dispensing fee equals the base price (located in the **Amount** column on the right). Then the item is priced as usual.
   b. If your practice has an additional charge that’s assessed for dispensing this item, type the amount in the **Dispensing fee** text box. The dispensing fee is included in the cost of the item when the item is invoiced. Dispensing fees are in addition to the price of the product set in the **Amount** column on the right. This fee generally covers costs of extra items such as bottles and labels and time spent preparing the item for the client. If your practice charges dispensing fees, use either the **Dispensing fee** text box or the **Dispensing** button; not both.
   c. **Inventory items only:** Select the **Omit dispensing fee for multiple patients** check box to charge for the dispensing fee only once per invoice, regardless of the number of patients charged for the item. Use this option if you charge only one fee for dispensing medications to multiple patients in the same household. The invoice item is still placed in each patient’s medical file.
   d. If the practice has several possible dispensing fees that may be charged for the invoice item depending on different situations, click the **Dispensing** button and set up the dispensing information for the item. See “Setting Up Dispensing Items” on page 221 for more information on setting up dispensing information.
   e. In the **Estimate markup** text box, type the percentage used to estimate the high price range on estimates for this item. (The low price range on the estimate is based on the price listed in the **Amount** column on the right.)
   f. To have Cornerstone automatically calculate a new price to charge clients for this item when it’s received from the vendor, select the **Auto calculate price** check box. Cornerstone will calculate a new price when the last cost from the vendor is higher than the last time the item was received. (If the cost is lower, the unit cost will recalculate, but the current price will not change.) If you have selected this option, specify how Cornerstone should calculate the price:
      - Select **Percentage** to have Cornerstone automatically calculate the new price to charge the client based on the percentage entered in the Markup (%) column on the right.
      - Select **Dollar amount** to have Cornerstone automatically calculate the new price to charge the client based on the dollar amount entered in the Markup ($) column on the right.
Chapter 10: Setting Up Your Invoice Items

g. From the **Round to** drop-down list, select the amount to round to if an amount does not calculate evenly.

11. In the **Quantity/Amount/Markup** table, do the following:
   
a. In the Base row in the **Amount** column, type the base amount (price for one selling unit of the item) to charge the client. This price appears in the **Price** column in the Invoice Item List.

b. If your practice offers price breaks (tiered pricing) for the item and you want this pricing calculated automatically, type the price to charge the client in the **Amount** column based on the associated quantity listed in the **Quantity** column to the left. For service and inventory items, quantity pricing information appears when you click the **Price** button for an item in the Invoice Item List.

   **Example:**
   A can of food is sold for $2.00 each, but if the client buys a case of 12 cans, they are charged $1.85 per can for the case. In the Base **Amount** column, the price would be $2.00; the next line would list 12.00 in the **Quantity** column with $1.85 in the **Amount** column. If the client buys 13 cans, the client would still be charged $1.85 per can. (Note: If the client purchases a case of food and returns all but 1, the client may get back more money than they paid originally.)

c. In the **Markup (%)/**Markup ($) column, type the percentage/dollar amount that will be added to the cost when the item is received in inventory. (Note: This applies only if the **Auto calculate price** check box is selected.)

12. In certain circumstances, a price may need to be changed on an estimate, on the Patient Visit List, or on an invoice. From the **Allow change** drop-down list, select one of the following price change settings to apply to this invoice item:

   - **Always**—Allows the price to be overwritten.
   - **Never**—Does not allow the price to be overwritten unless the user has administrator security privileges.
   - **Only increases**—Allows the price to be increased, never decreased (except by a user with administrator security privileges).
   - **Only with reason**—Allows the price to be changed, but a reason must be selected for the change. To use this option, you must first create a list of price change reasons (**Controls > Price Change Reasons**). When a price is changed, the reason will print on the Standard Fee Exception Report, along with the staff member who changed the price. See “Price Change Reasons” on page 33 for more information.
   - **Require change**—Always forces the price to be changed. This safeguard is used in cases where the price fluctuates and ensures that the correct price is charged. The price on the item must be set to $0.00.

13. Click **OK** to save your changes, or click another tab to add more information for the item.
Inactivating Invoice Items

You can inactivate discontinued invoice items. Inactive invoice items will not appear on lookup lists related to invoicing but will still appear on some reports.

Note: You cannot inactivate an invoice item that is in a group or listed as a reminder.

To inactivate an invoice item:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the Invoice Item to inactivate and click Update. The Invoice Item Information window appears.
3. On the Information tab, in the Type area Status drop-down list, select Inactive.
4. Click OK to save your changes.

Deleting Invoice Items

If your practice does not need all of the invoice items provided, remove any unnecessary items.

Note: You cannot delete an item if it is used in an invoice or an estimate.

To delete an invoice item:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the invoice item to delete and click Delete. You are prompted to confirm the deletion. Click Yes.
3. Click OK.

Linking Instructions to Invoice Items

Departing instructions print on the invoice based on the items invoiced. You can link an unlimited number of departing instructions to an invoice item. While invoicing, you can add, modify, or delete departing instructions for that specific invoice.

Prescription instructions print on the prescription label based on the items invoiced. You can link only one prescription instruction per invoice item.

Before You Begin

- Set up your departing instructions (Lists > Departing Instructions).
- Set up your prescription instructions (Lists > Prescription Instructions).

To link or unlink a Departing Instruction or Prescription Instruction to an invoice item:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the item that you want to add instructions to and click Update. The item information displays in the Invoice Item Information window.
3. Click the Instructions tab.
4. In the Departing instructions area, do the following:
   a. In the ID column, type a departing instruction ID or press F2 to use the Departing Instruction List to choose a departing instruction to link to the item. The instruction(s) will print on invoices and are listed in the patient’s medical history.
   b. To unlink an item, select the departing instruction to delete and then press CTRL+D.

5. In the Prescription instruction area, do the following:
   a. In the Prescription ID text box, type a prescription instruction ID or press F2 to use the Prescription Instruction List to choose a default prescription instruction to link to the item. This instruction will display when creating prescription labels for the item; it can be changed on an individual basis.
   b. To unlink an item, select the prescription instruction to unlink and press the DELETE key.

   Note: The Pharmacy link information area settings are for use with the Pharmacy Formulary module.

6. Click OK to save your changes, or click another tab to add more information for the item.

   For a list of departing instructions currently set up in Cornerstone, print a Departing Instructions Report.
   For a complete list of invoice items and their linked departing instructions currently set up in Cornerstone, print an Invoice Item Information Report.
   For a list of prescription instructions currently set up in Cornerstone, print a Prescription Instructions Report.
Adding Reminder Information to Invoice Items

Reminders are an important means of contacting clients. With a solid reminder strategy, a practice can protect its client base, enhance client loyalty, improve preventative care, and increase revenue.

You can automatically add reminders to patients’ records if you link reminders to invoice items. When the item is invoiced, a reminder for a future item or service is placed in the patient’s file.

If a reminder exists in a patient’s file, the reminder is satisfied whenever the future item or service is invoiced for that patient. Many times, reminders may satisfy themselves (when the item that generates the reminder and the item that satisfies the reminder are one in the same).

There are two types of reminders that can be set up from the Invoice Item Information Reminders tab:

- **Letter**—The reminder will be printed and sent to the client or emailed as a reminder to come in for a future service(s).
- **Call**—Staff will contact the client by phone to remind them to come in for the service(s). Calls are used to contact clients in more immediate situations, such as follow-up calls after a surgery and reports on hospitalized patients.

**Tip:** Call reminders are often referred to as “call backs,” which can be viewed on the Daily Planner or the Reminder Recall Report.

Common reminder strategies include the following:

- Reminders for vaccinations in a series
- Preventative care
- Prescription refills
- Call backs

**Before You Begin**

- See “Reminder Strategies” on page 278 to better understand reminder strategies.
- Set up reminders to satisfy sequential items and interchangeable items. See “Setting Up a Reminder System” on page 281 for more information.

**To add reminders to an invoice item:**

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the item that you want to add reminders to and click Update. The item information displays in the Invoice Item Information window.
3. Click the Reminders tab.
4. In the Reminders to generate area, right-click and select New. The Reminder To Generate dialog box appears.

5. In the Reminder to generate area Item ID text box, type the item ID or press F2 to use the Invoice Item List to choose the product or service of which you want to remind the client (such as the service that is due next). (For call backs, this item displays as the Reminder Item in the Daily Planner Call Backs tab.)
   
   When the invoice item that you are creating a reminder for is invoiced, the invoice item listed in the Reminder to generate area (as a reminder for a future service) is inserted in the patient’s history.

6. From the Type drop-down list, select Letter or Call as the method for reminding the client.

7. To set the reminder timeframe, choose one of the following options:
   - If the reminder time often varies, select the Ask for month/days in invoicing check box to prompt staff to enter the reminder due date when invoicing the client.
   - If there is a standard reminder time for this item that does not often vary, specify the Months and/or Days for the reminder.

8. Click OK to save changes and return to the Invoice Item Information window.
9. **Reminder letters only:** If applicable, in the *Letter reminders to satisfy* area, do the following to specify the reminder to satisfy:
   
a. Right-click and select **New**. The Reminders To Satisfy dialog box appears.

   ![Reminders To Satisfy dialog box](image)
   
The Item ID specified here is the invoice item to satisfy

   Reminders To Satisfy dialog box

   b. In the **Item ID** text box, type the item ID or press F2 to use the Invoice Item List to choose the invoice item to satisfy (e.g., the service that was performed first). Some reminders may satisfy themselves.

   c. Click **OK** to save changes and return to the Invoice Item Information window.

10. Click **OK** to save your changes, or click another tab to add more information for the item.

   For a complete list of the reminders linked to invoice items, print an **Invoice Item Reminder Information Report**.

   **Example:**

   In this example, when a patient is invoiced for item 1271 (the first vaccination), a reminder for the second vaccination (item 1272) will be created in the patient’s record. If a reminder for item 1271 exists in the patient’s record, when the second item is invoiced, the reminder will be satisfied.

   ![Invoice Item Reminders example](image)

   **Linking Taxes and Discounts to Invoice Items**

   You must set up the applicable taxes and discounts for each invoice item so that Cornerstone can automatically tax items or apply discounts at invoicing time.
Chapter 10: Setting Up Your Invoice Items

Note that a tax is not applied for an item on the invoice if the client is tax exempt, and a discount is applied only if the client being invoiced is set up to receive the discount.

**Tip:** The taxes and discounts that appear in the Invoice Item Information window **Tax/Disc** tab are taxes and discounts set up using **Controls > Taxes** and **Controls > Discounts**.

**Before You Begin**
- Set up the taxes your practice uses (**Controls > Taxes**).
- Set up the discounts your practice applies (**Controls > Discounts**).

**To link a tax or discount to an invoice item:**
1. On the **Lists** menu, select **Invoice Item**. The Invoice Item List appears.
2. Select the item that you want to link taxes or discounts to and click **Update**. The item information displays in the Invoice Item Information window.
3. Click the **Tax/Disc** tab.

**Note:** If this is a new item, some taxes or discounts appear highlighted/shaded if they were previously selected as defaults.

4. In the **Sales tax to apply** area, select each sales tax that applies to this item. This tax will be applied when the client is invoiced and excludes clients marked as tax exempt in their file. (Note: It is possible to remove a tax during invoicing.)

**Tip:** Do not link the Non Taxable tax designation to an invoice item.

5. In the **Usage tax to apply** area, select each tax to apply to items used internally by the practice but not invoiced. (This tax is not associated with tax applied to the client when invoicing.)

6. In the **Discounts to apply** area, select each client discount that may apply to this item. Be aware that if the client has one or more of the discounts applied to their account, they will receive each discount for the item. (Note: It is possible to apply or remove a discount during invoicing.)

7. Click **OK** to save your changes, or click another tab to add more information for the item.
Tip: To apply or remove taxes or discounts from a group of invoice items (such as a classification or subclass), use the Mass Markup feature (select Tools > Mass Markup).

For a complete list of the taxes linked to invoice items, print an Invoice Item Tax Setup Report.

For a complete list of the discounts linked to invoice items, print an Invoice Item Information Report.

Adding Inventory Information to an Invoice Item

Once an item is entered as an invoice item in Cornerstone, you can add the inventory information to the item.

To add inventory information:

1. From the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the item that you want to add inventory information to and click Update. The item information displays in the Invoice Item Information window.
3. Click the Inventory tab.

4. If applicable, in the NDC/DIN Code text box, type the National Drug Code/Drug Identification Number of the item. This information will print on the Controlled Substance Report. It will also print on prescription labels if the Print NDC/DIN check box is selected in Prescriptions defaults (see “Prescriptions Defaults” on page 128). If the Print NDC/DIN check box is selected and an NDC/DIN Code exists, it will print on the prescription label in place of the information listed in the Serial number text box.

5. If applicable, in the Serial number text box, type the serial number of the item.

6. To track the item’s quantity on hand (QOH) with Cornerstone, select the Maintain QOH check box.

Note: The Maintain QOH check box must be selected to activate many of the settings on the Inventory tab.
7. To track the item’s expiration date within Cornerstone, select the **Track expiration dates** check box. Expiration dates can be tracked only if the item is marked to Maintain QOH; this information must then be entered when receiving or depleting inventory.

8. To track the item’s lot numbers within Cornerstone, select the **Track lot numbers** check box. This allows staff to track this drug by lot number. Lot numbers can be tracked only if the item is marked to Maintain QOH; this information must then be entered when receiving or depleting inventory.

9. If maintaining the item’s quantity on hand, specify the **Buy/sell ratio** by doing the following:
   a. From the drop-down list, select the Buy unit of measure to indicate how the practice purchases the item (e.g., 1 case).
   b. In the text box to the right of the $=\ $ sign, enter the total number of sellable units (e.g., 24 cans) contained in the purchase unit of measure. (Note: The Sell unit of measure is assigned on the **Information** tab.)

   **Note:** “Item on Order” displays if the item is on a purchase order; you cannot change the buy/sell ratio for an item on order.

   **Examples:**
   If you sell Amoxicillin (50 mg.) by the tablet, but purchase it in bottles that contain 100 tablets, the buy-to-sell ratio would be 1 (bottle) $= 100$ (tablets). Other examples include 1 case $= 24$ can, 1 bag $= 1$ bottle $= 500$ tablets, 1 tray $= 50$ doses.

   **Tip:** For bottle/tablet ratios where a client may purchase 250 or 500 tablets as one invoice item, set the buy/sell ratio to 1:1. Then, when receiving, staff must enter the number of tablets that were received and then calculate the unit cost per tablet.

10. If your practice uses barcodes, in the **Buy barcode** text box, scan (or type) the barcode used when the practice buys the item from a vendor. For example, if your practice purchases canned dog food from the vendor by the case, scan the barcode located on the case packaging.

   **Note:** The **Buy barcode** text box is available only if the buy/sell ratio is greater than 1:1.

11. To display and/or set up information about the vendor(s) used to purchase this product:
   a. Click the **Item Vendor** button to display the Item Vendor Information dialog box.

   ![Item Vendor Information dialog box](image)

   **Note:** Item Vendor Information is available for all inventory items, regardless of whether quantity on hand is tracked for the item. If the item is received by a vendor that is not currently on this list, it will automatically be added after posting the receipt.

   b. To add a vendor for this item, in the **Vendor ID** column, type the vendor ID or press F2 to use the Vendor List to choose a vendor. Note that you can have multiple vendors for each inventory item, but you can specify only one primary vendor.
c. To designate a primary vendor for this item, click the **Primary** check mark button for the vendor that the item is ordered from a majority of the time.

d. In the **Lead time** column, enter the number of days it usually takes to receive the item after an order is placed.

e. In the **Cost** column, type the item’s cost (per Buy UOM).

f. In the **Date** column, type a date or press F2 to use the Calendar tool to choose a date, and then press TAB.

   **Tip:** The Cost and Date are automatically updated when items are received from this vendor, unless the received item is marked **Special Price**. It displays the last cost the practice brought the product for and the last date it was received.

g. In the **Vendor item ID** column, type the vendor’s item ID (product ID). If the vendor’s item ID is provided, it will automatically print on purchase orders and on the Inventory - Vendor Information Report, which is helpful if faxing or emailing orders.

h. In the **Contact** column, type the name of the vendor contact person, if applicable.

i. To add or view a note about this inventory item, click the **Notes** button. (This information is only available via the **Item Vendor** button.)

j. Click **OK** to save your changes and return to the **Inventory** tab.

12. On the **Inventory** tab, in the **Stock at locations** list (bottom left), click the location or locations where this item will be stored. If the **Maintain QOH** check box is selected, you must select at least one location.

   **Note:** If you have items marked to maintain QOH and they are already assigned the Central Storage location, you can use the **Move Items** tab in **Tools > Invoice Item Setup** to quickly assign many items to a different location all at once.

13. In the **Reorder information by location** area, to set up reorder information, do the following:

   a. **Multiple location inventory only:** Scroll through the **Select location** drop-down list of locations where the item is stored and select a location to which the reorder information will apply. The associated reorder information displays in the area below the selected location.

   b. If setting up seasonal reorder information for the item, after selecting the location, select the monthly ranges for the breakdown of the seasons using the **From** and **To** text boxes.

      **Note:** Quantities for the reorder point, reorder quantity and overstock point can be set to 0.00, as long as they are not set up for seasonal reordering.

   c. In the **Reorder Pt** text box, specify the lowest quantity allowed (in selling units) for this location before the item should be placed on the list of suggested items to order. If the item reaches or gets below this reorder point, the item is automatically placed on the Suggested Items list, accessed from the Purchasing Work List window. (Note: An alert box will appear when the item gets below this reorder point when placed on the invoice if the **Display below reorder point warning** default is selected in Invoice defaults. See “Invoice Defaults” on page 112.)

   d. Type the amount to purchase, based on the buying unit, once the reorder point is reached in the **Reorder Qty** text box. This recommended reorder quantity will display on the Purchasing Work List’s Want/Suggested List.
Chapter 10: Setting Up Your Invoice Items

Example:
The practice has the rabies vaccine set up as 1 tray = 50 doses with a reorder point of 50 doses, a reorder quantity of 2 trays, and an overstock of 101 doses. If the practice has more than 50 doses, the Purchasing Work List does not display the item because there is enough in stock according to the reorder information. However, if the vaccine has 50–0 doses of the vaccine, the Purchasing Work List will display 1 tray as the suggested reorder quantity. If the item gets below 0 doses, the Purchasing Work List will display 2 trays as the suggested reorder quantity.

e. Type the maximum amount of the product the practice would like to keep in stock at the location, based on the selling unit, in the Overstock Pt text box.
   Tip: The calculation used for this is Minimum overstock: Reorder Pt + Reorder Qty (converted to how many selling units this would be) + 1 selling UOM.

f. Type the Reorder Pt., Reorder Qty., and Overstock Pt. for each period.

g. If necessary, click the Clear button to remove the reorder information that displays.
   Tip: Most practices sell more heartworm preventatives from March through August. To make sure enough stock is maintained to meet the higher demand (without overstocking the product during periods of lower demand), adjust the Reorder Information. Each season (monthly range) you define must have a Reorder Point, Reorder Quantity, and Overstock Point.

14. Click OK to save your changes, or click another tab to add more information for the item.

Example:
This example will show the setup for an item that is ordered in cases of 24 cans. Case is the Buy UOM. The Buy/Sell Ratio is 1 (case) to 24 (cans).

First, we set up invoice item 06690 in Cornerstone as Senior Canine 14.75 oz Original, which the practice sells by the can (for $1.25) or by the case of 24 (at $0.98 per can).

Next, we determine the number of cans we want to have on the shelf when it’s time to reorder this item. This information is on the Inventory tab of the Invoice Item Information window.
Let's choose 48 as the **reorder point**. When the quantity on hand of item 06690 falls to 48 cans, Cornerstone Inventory suggests you order more.

A typical order of this item is 6 cases; this is the **reorder quantity**. Cornerstone Inventory automatically enters 6 cases when item 06690 is added to an order as a suggested item. You can change the number (and UOM) in the order itself.

If there are 12 cans on the shelf at the time of the order, Cornerstone Inventory notes that we first need 36 cans (1.5 case) to get the inventory level up to the reorder point. Next, Cornerstone adds the reorder quantity of 6 cases. In this scenario, Cornerstone will suggest that you reorder 7.5 cases (1.5 + 6).

The final calculation to determine is the **overstock point**. If an order will cause the quantity on hand to reach this number, a warning appears in the order. The minimum overstock point is 1 (Sell UOM) greater than the reorder point plus the reorder quantity. So, in this example, the overstock point must equal at least 229 (cans).

1 Sell UOM + reorder point + reorder quantity =  
1 can + 48 cans + 7.5 cases =  
1 + 48 + 180 (cans) = 229 (cans)

Your reorder point can also be set by month to cover seasonal usages. For example, if you have product that is used mostly in the summer, enter May through September in the reorder information.

### Linking Inventory Items

Use the **Link Items** tab in the Invoice Item Information window to:
- Identify inventory items that you want to track as they are used in services or internally
- Group items you do not want listed separately on invoices

Linked items are deducted from quantity on hand (QOH) through Internal Usage or from the invoice.  
**Note:** Only items marked to track QOH can be linked to another inventory item or to a service item.
The difference between a group item and a link item is that each item within a group item appears separately on invoices. Group items also cannot be deducted through internal usage. See “Setting Up Invoice Item Groups” on page 213 for instructions on setting up group items.

**Note:** Taxes are applied only to the invoice item. Individual items within the Link Items tab will not have tax applied; therefore, adjust the invoice item’s tax accordingly.

**To set up a Link Item:**

1. From the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the item to be linked and click Update. The item information displays in the Invoice Item Information window.
3. Click the Link Items tab.

4. In the Item ID column, type the ID of the item to link to the invoice item or press F2 to use the Invoice Item List to choose the item. (Items must maintain QOH and have reorder information set up before you can link them on the Link Items tab.)
   
   ➢ The name of the inventory item will display in the Description column, and the selling unit of measure (UOM) for the item will display in the Unit of Measure column.
5. In the Quantity column, type the quantity of the item to remove from inventory (based on the sell UOM).
6. Repeat steps 4 and 5 as needed to link additional items.
7. Click OK to save your changes, or click another tab to add more information for the item.

**Example:**

A practice usually sells a flea pills product in a package of 6 pills. They also occasionally sell the flea pills individually. To keep an accurate QOH total for this product, the practice maintains quantity on hand only on the package of 6 pills. Using the Link Items tab, they linked a sixth of a package to the individual flea pill (Quantity of 1 and UOM is Pill). Therefore, each time they sell 1 pill, the computer automatically takes 1 out of the pack of 6.
**Tip:** Set up an inventory invoice item called Injection Package. Link one syringe and one hypodermic needle to this item, then link the Injection Package item to each of your vaccinations. (Make sure that you have already set up Reorder Information for the items "hypodermic needle" and "syringe" to use the items within Cornerstone Inventory.)

**Setting Up Invoice Items to Initiate a Special Action**

A **special action** is an option you can set up for an invoice item so that use of the item on the Patient Visit List (PVL) or invoice will automatically prompt Cornerstone to perform a certain action.

The following table lists the special action options and gives examples of common uses:

<table>
<thead>
<tr>
<th>Special Action</th>
<th>Description</th>
<th>When to Apply</th>
<th>Information to Provide During Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feeding Guide Software</td>
<td>Set up a Hill’s® Pet Food product (invoice item) to print special feeding instructions you can provide to clients.</td>
<td>Optional on invoice</td>
<td>N/A</td>
</tr>
<tr>
<td>Image Request (IDEXX SmartLink* Digital Imaging module only)</td>
<td>(Available for Service items only) Set up an imaging item to initiate an imaging request.</td>
<td>Immediately on invoice/PVL</td>
<td><strong>Tips:</strong> Click if you want to select image shots to be associated with this item by default. <strong>Exam Description:</strong> Type any needed shot request notes to display with the invoice item by default when an image request is made for this item.</td>
</tr>
<tr>
<td>Lab Request (Lab module only)</td>
<td>Set up a lab item to initiate a lab request.</td>
<td>Immediately on invoice/PVL</td>
<td><strong>Profile:</strong> Click in the right-most text box and press F2 to search for and select the lab profile to link to the invoice item.</td>
</tr>
<tr>
<td>Mark as Deceased</td>
<td>Associate with special invoice items (such as euthanasia or cremation) to change the patient’s status to Deceased during the invoicing process. You will also have the option to remove any future appointments associated with the patient.</td>
<td>Optional on invoice</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Prescription Label                    | Associate with prescription invoice items so staff is prompted to create a prescription. | • Optional on invoice  
• Immediately on invoice/PVL | N/A                                |
### Chapter 10: Setting Up Your Invoice Items

<table>
<thead>
<tr>
<th>Special Action</th>
<th>Description</th>
<th>When to Apply</th>
<th>Information to Provide During Setup</th>
</tr>
</thead>
</table>
| Print Document     | Associate with an invoice item so that a specified document automatically opens in the Cornerstone Editor when the designated ‘When to apply’ action takes place. At that point, staff can add information to the document and save it in patient history and/or print it.                                      | • Optional on invoice  
• Before invoice is posted  
• Immediately on invoice/PVL  
• Print after invoice is posted | Doc ID: Click in the text box and press F2 to search for and select the document template to print.  
Note: Verify the selected document template does not contain this item as a default invoice item, as this would create a perpetual loop. |
| Sex Modification   | Associate with sex modification invoice items (such as ovariohysterectomy) to change the patient’s sex during the invoicing process. If you have assigned Modified Sexes for applicable patient sexes, Cornerstone will update the sex in the patient’s record automatically. | Optional on invoice            | N/A                                                                                       |
| Update Microchip ID| Associate with an invoice item so that staff will be prompted to enter the patient’s microchip ID. | • Optional on invoice  
• Before invoice is posted  
• Immediately on invoice/PVL | N/A                                                                                       |
| Update Vital Signs | Associate with certain invoice items (such as exams and anesthesia) so that staff will be prompted to enter the patient’s weight if it is not current. Staff can also access the Vital Signs window, if necessary, to enter additional vitals for the patient. | • Optional on invoice  
• Before invoice is posted  
• Immediately on invoice/PVL | Weight days: Type the number of days before staff must enter a new weight for a patient (default is 30 days). |
| Vaccine Tag        | Associate with vaccine/vaccination invoice items so that staff will be prompted to issue a rabies/vaccine tag for the patient (and print a rabies certificate, if applicable). | • Optional on invoice  
• Before invoice is posted  
• Immediately on invoice/PVL | N/A                                                                                       |

**Notes:**
- If you process the Update Vital Signs special action during invoicing or on the PVL, Cornerstone displays the weight entry dialog box. If you process it from the Whiteboard Patient Treatments window, Cornerstone displays the full Vital Signs entry and viewing window.
• Vaccination invoice items must be set up to initiate the Vaccine Tag special action, which displays the Vaccine Tag window during invoicing. This is the only way to issue a new rabies/vaccine tag (and rabies certificate) for a patient.

• To make sure that all patients who are invoiced for items with the special action Mark as Deceased are changed to a status of Deceased, select the Automatically mark patient as deceased check box in the Invoice defaults. See “Invoice Defaults” on page 112.

Options for When to Apply a Special Action

The following table describes the special action When to apply options that determine when the special action will be applied during invoicing or on the Patient Visit List (PVL).

<table>
<thead>
<tr>
<th>When to Apply option</th>
<th>Result on the Invoice/Patient Visit List</th>
</tr>
</thead>
</table>
| Optional on invoice                         | With the invoice item added to the invoice/PVL, staff can choose when to perform the special action:  
  • To process the special action at any time while in the invoice/PVL, click the Special button, highlight the desired special action, and click Process.  
  • If the special action has not yet been processed when the invoice/PVL is saved or posted, the Special Action dialog box appears. At this point you can highlight the desired special action and click Process or bypass it by clicking Continue.  
  Note: For the Mark as Deceased and Sex Modification special actions, the special action can be processed only on the invoice, not on the Patient Visit List.                                                                                                                                                                                                                           |
| Before invoice is posted                    | With the invoice item added to the invoice, this option displays the Special Action dialog box when you click the Post button on the invoice (before the invoice is actually posted). At this point you can highlight the desired special action and click Process or bypass it by clicking Continue.  
  Note: For the Print Document special action, information on the invoice will not be available for inclusion in the document.                                                                                                                                                                                                                                                                                                                                 |
| Immediately on invoice/PVL                  | When the invoice item is added to the invoice/PVL, Cornerstone immediately processes the special action or displays the Special Action dialog box. At this point you can highlight the desired special action and click Process or bypass it by clicking Continue.                                                                                                                                                                                                                                                                                           |
| Print after invoice is posted (applies only to the Print Document special action) | For the Print Document special action, the selected document will open in the Cornerstone Editor for printing once the invoice has been posted. Because the invoice has already been posted, information on the invoice will be available for inclusion in the document.  
  Note: If the document template you are linking contains default invoice items, it cannot be set up to print after the invoice is posted.                                                                                                                                                                                                                                                                                                                                 |

Before You Begin

• If you started with a Fastart or FastInstall database, review the special actions linked to invoice items. To do this, print an Invoice Item Information Report.

• Set up your Feeding Guide Software. See “Setting Up the Feeding Guide Software” on page 420.

• Set up your patient sexes and associated modified sexes (Controls > Sex).
To link or unlink a Special Action to an invoice item:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.

2. Select the item that you want to add instructions or special actions to and click Update. The item information displays in the Invoice Item Information window.

3. Click the Spec. Actions tab.

4. From the Special action drop-down list, select a special action to be automatically performed for this invoice item.

5. From the When to apply drop-down list, select an option to specify when to apply the special action: See “Options for When to Apply a Special Action” on page 204 for information on the When to apply options.

   Note: All When to apply options are not available for all special actions.

6. For the following special actions, provide additional information on the Spec. Actions tab as needed:
   - **Image Request**–If you want to select shots to be associated with this item by default, click the Shot Selection icon and select the image shots. If necessary, in the Exam Description text box, type any needed shot request notes to display with the invoice item by default when an image request is made for this item.
   - **Lab Request**–In the Profile text box (right-most text box), press F2 to search for and select the lab profile to link to the invoice item.
   - **Print Document**–In the Doc ID text box, type a document ID or press F2 to search for and select a document template from the Document Template List.
   - **Update Vital Signs**–In the Weight days text box, enter the number of days that the weight is considered current. (Staff will not be prompted for a new weight if the patient’s weight is current.)

7. Click OK to save your changes, or click another tab to add more information for the item.
For a complete list of invoice items and their linked special actions currently set up in Cornerstone, print an Invoice Item Information Report.

For information on processing special actions during invoicing, see “Chapter 12: Invoicing” in the Cornerstone User’s Manual.

Setting Up Vaccine Invoice Items

Rabies/Vaccine Tag Terminology

The following terms are used throughout this section to differentiate between different types of tags and types of vaccine/vaccination invoice items you can set up in Cornerstone.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine tag</td>
<td>Encompasses tags issued for all types of vaccinations, including rabies and large animal vaccinations (e.g., Brucellosis vaccinations). The term “vaccine tag” is used interchangeably with “vaccination tag.” Vaccine tags (including rabies) that have been issued by the practice appear on the Vaccine Tag Report.</td>
</tr>
<tr>
<td>Rabies tag</td>
<td>Specifically refers to tags issued for a rabies vaccination. In most cases, a rabies certificate is printed when a rabies tag is issued. Rabies tags that have been issued by the practice appear on the Rabies Tag Report.</td>
</tr>
<tr>
<td>Vaccine item</td>
<td>Invoice item for the actual product/tangible good (bottle, dose, vial, etc.); usually set up as an Inventory item.</td>
</tr>
<tr>
<td>Vaccination item</td>
<td>Invoice item for the service performed to administer the vaccine; commonly set up as a Service item.</td>
</tr>
<tr>
<td>Inventory item</td>
<td>An invoice item with the type set to Inventory on the Invoice Item Information window. The Vaccine tab is available in Invoice Item Information only for inventory items.</td>
</tr>
<tr>
<td>Service item</td>
<td>An invoice item with the type set to Service on the Invoice Item Information window. (Note: The Invoice Item Information Vaccine tab is not available for service items.)</td>
</tr>
</tbody>
</table>

Vaccine Invoice Item Setup Options

Cornerstone offers several options for setting up your vaccine/vaccination items. When trying to determine the best option for your practice, the initial factor to consider is whether your practice tracks vaccination revenue as services or as inventory.

If You Track Vaccination Revenue as Services

For those practices that track vaccination revenue as services, the recommended option uses a vaccination SERVICE item that includes a link to a vaccine INVENTORY item. This setup option allows you to:

- Track vaccinations as services using Cornerstone service revenue reports
- Use service revenue information to compare against industry benchmarks
- Set up multiple species-specific Manner of Administration/Years combinations for each vaccine
- Auto-populate the rabies/vaccine tag vaccination certificate default information on each Inventory item through invoicing
### Vaccine/Vaccination Setup Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Recommendation for Reminders</th>
<th>Special Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccination SERVICE item that includes a link to a vaccine INVENTORY item</td>
<td>Set up reminders on the vaccination SERVICE item.</td>
<td>If you use the same vaccine for variable years (e.g., use IMRAB for both 1 yr and 3 yr), set the Years text box to Ask on the Vaccine tab during setup. Then, when issuing a tag, train staff to look at the vaccination SERVICE item description (e.g., Rabies 1 Yr Booster) as a guide for entering the number of years for the tag (the certificate expiration).</td>
</tr>
</tbody>
</table>

**Example:**
- Canine Rabies 1 Yr Booster (service item) includes a link to IMRAB® (inventory item)

### Recommendation for Reminders

**Note:** Although it is possible to set up vaccine/vaccination items as service only (with no link to an inventory item), this option is not recommended as it does not offer multiple species-specific defaults or the ability to auto-populate rabies/vaccine tag vaccination certificate default information.

### If You Track Vaccination Revenue as Inventory

For those practices that track vaccination revenue as inventory, there are two available setup options:

- An INVENTORY item only (one invoice item serves as both vaccination/vaccine for simpler invoice item setup and management)
- A vaccination INVENTORY item that includes a link to a vaccine INVENTORY item

These setup options allow you to:

- Measure profitability using the Items Profit Analysis Report
- Set up multiple species-specific Manner of Administration/Years combinations for each vaccine
- Auto-populate the rabies/vaccine tag vaccination certificate default information on each inventory item through invoicing

### Vaccine/Vaccination Setup Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Recommendation for Reminders</th>
<th>Special Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>INVENTORY item only (serves as both vaccination/vaccine item)</td>
<td>Set up reminders on the INVENTORY item (the only option with this type of setup).</td>
<td>If you are tracking quantity on hand (QOH), this is a good option only if you use a different vaccine for each species/year combination (e.g., IMRAB® Canine 1 Yr, PUREVAX® Feline 3 Yr, etc.). If your practice wants to set up multiple species/years combinations but uses only one vaccine, you would have to set up the same invoice item multiple times, which would prevent you from accurately tracking QOH for inventory.</td>
</tr>
</tbody>
</table>

**Examples:**
- Rabies IMRAB 1 Yr
- Rabies IMRAB 3 Yr

<table>
<thead>
<tr>
<th>Option</th>
<th>Recommendation for Reminders</th>
<th>Special Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccination INVENTORY item that includes a link to a vaccine INVENTORY item</td>
<td>Set up reminders on the vaccination INVENTORY item (not on the linked vaccine item).</td>
<td>This is a good option if you change brands of vaccine often. If you use the same vaccine for variable years (e.g., use IMRAB for both 1 yr and 3 yr), set the Years text box to Ask on the Vaccine tab during setup. Then, when issuing a tag, train staff to look at the vaccination INVENTORY item description (e.g., Rabies Vaccination 1 Yr) as a guide for entering the number of years for the tag.</td>
</tr>
</tbody>
</table>

**Example:**
- Canine Rabies Vaccination 1 Yr (Inventory item) includes a link to IMRAB (Inventory item)
**Setting Up a Vaccine Invoice Item**

The Invoice Item Information window’s **Vaccine** tab allows you to set vaccine inventory item defaults for the most frequently used vaccine information and set up multiple species-specific Manner of Administration/Years combinations for each vaccine. These settings will be automatically completed for you when issuing a tag during invoicing (although you can change these settings at invoice time, if necessary).

**Note:** The following procedure covers only those steps needed to create an invoice item and set the rabies/vaccine tag defaults on the **Vaccine** tab. For information on other invoice item setup tasks (for adding inventory information, linked items, reminders, taxes, discounts, etc.) on the Invoice Item Information tabs, see the corresponding section in this chapter.

**To set up a vaccine Inventory item:**

1. On the **Lists** menu, select **Invoice Item**. The Invoice Item List appears.
2. Click **New**. The Invoice Item Information window appears.
3. If your practice enters new invoice item IDs manually, type the invoice item ID in the **ID** text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears.
4. Press TAB.
5. At the top of the Invoice Item Information window, select the **Inventory** item type to designate this item as an Inventory item.
6. On the **Information** tab, in the **Hospital description** text box, type a description of the vaccine for internal use. This description enables your staff to identify the vaccine invoice item.
7. If you would like an alternate description to display on client documents, in the **Client description** text box, type a description of the item to print on the invoice and estimate, and also on reminders.
8. Select a classification for the item (e.g., Vaccines) from the **Primary** drop-down list.
9. If applicable, select a subclassification for the item from the **Subclass** drop-down list.
10. Click the **Vaccine** tab.

**Note:** The **Vaccine** tab is available in Invoice Item Information only for inventory items.
11. Select the **Issue vaccination tag** check box to enable the vaccine tag settings. (Note: The **Issue vaccination tag** and **Rabies tag** check boxes will be selected automatically if the Vaccine Tag special action has been set up for the inventory item.)

12. If this is a rabies vaccine (vs. a nonrabies large animal vaccine), select the **Rabies tag** check box. This flags the item as a rabies vaccine to be added to the Rabies Tag Report, which is available for those practices required to submit rabies tag information to a state agency. Selecting this check box will also display the **Print certificate** check box on the Vaccine Tag window.

13. Type the **Producer/Mfr.** and **Brand** information for this vaccine so staff will not need to complete this information manually when generating a vaccine tag at invoice time.

14. In the **Type** drop-down list, select the applicable vaccine type (Killed, MLV, etc.)

15. In the **Administration by species** area, do the following:
   a. In the scroll-list on the left, select the species for which you want to set up rabies/vaccine tag defaults.
   b. In the adjacent check box selection area on the right, select all possible Manner of Administration/Years combinations that apply to this vaccine and species by selecting the applicable check box in the left-most column. All combinations selected here will be available for selection from drop-down lists on the Vaccine Tag window.
   c. For a selected Manner of Admin./Years combination, if you want the **Print certificate** check box to be selected by default on the Vaccine Tag window at invoice time, select the **Print Rabies Cert.** check box next to the applicable combination.
   d. If you want to designate a particular Manner of Admin./Years combination as the default for this species, select the **Default** check box next to the applicable combination. This default combination will automatically populate **Manner of administration** and **Number of years** on the Vaccine Tag window at invoice time (although you can select different settings from the drop-down lists, if necessary).
16. If you would like to add or delete Manner of Admin/Years combinations, click the **Manage List** button. The Manner of Administration/Years dialog box appears, with all existing combinations listed.

![Manner of Administration/Years dialog box]

- **a.** To add a new combination, click **New**, select the appropriate **Manner of Admin**. and **Years** settings, and click **OK**.
  
  **Note:** For the **Years** setting, if the number of years for a vaccine can vary, set the years to **Ask**, which will require staff to input the years manually on the Vaccine Tag window at invoice time.

- **b.** To remove a combination, select the combination in the list and click **Delete**. You are prompted to confirm the deletion. Click **Yes**.

- **c.** When you are finished, click **Close**. Any Manner of Administration/Years combinations you added or deleted will be reflected in the list available on the **Vaccine** tab.

17. In the **Available lot number and expiration dates** area, create a list of valid lot numbers and expiration dates for this vaccine. This information will be available for selection from the **Lot number** and **Drug expires** drop-down lists on the Vaccine Tag window.

  **Note:** The Lot Number/Expiration Date settings are not available if lot numbers and expiration dates are tracked through Cornerstone Inventory and controlled by consumption.

18. Click **OK** to save your changes, or click another tab to add more information for the item.

For information on issuing a rabies/vaccine tag on the Vaccine Tag window during invoicing, see “Chapter 12: Invoicing” in the *Cornerstone User’s Manual*.

**Placing Invoice Items on Travel Sheets**

After an invoice item is created, you can choose to have it print on any of your practice’s travel sheets. See “Travel Sheets” on page 75 for more information on travel sheets.

**Before You Begin**

- Set up your travel sheets (**Lists > Travel Sheets**).
To place an invoice item on a travel sheet:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the item that you want to add to a travel sheet and click Update. The item information displays in the Invoice Item Information window.
3. Click the Travel tab.

   ![Travel tab on Invoice Item Information window]

4. In the Travel Sheets to appear on list, select each travel sheet the invoice item should be linked to. (Note: Items that appear on the Sample Travel Sheet cannot be changed.)

   **Note:** Travel sheets must be set up in Lists > Travel Sheets in order to appear in the list on the Travel tab.

5. Click OK to save your changes, or click another tab to add more information for the item.

Setting Up Pick Lists

Pick lists allow you to quickly choose from a list of related invoice items. Pick lists are also useful when using smart codes. (See “Setting Up Smart Codes” on page 216 for information on smart codes.)

**Note:** Pick lists are not available in prescriptions, boarding, lab requests, or reminders.

To set up a pick list:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Click New. The Invoice Item Information window appears.
3. If your practice enters new invoice item IDs manually, type the invoice item ID in the ID text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears.
4. Press TAB.
5. At the top of the Invoice Item Information window, select the Pick item type to designate this item as a pick list. The number of available tabs is reduced to three.
6. On the Information tab, in the Hospital Description text box, type a description of your pick list for internal use. This description enables your staff to identify the pick list.
7. Select a classification for the pick list from the **Primary** drop-down list.
8. If applicable, select a subclassification for the item from the **Subclass** drop-down list.
9. Click the **Pick** tab.

![Pick tab on Invoice Item Information window](image)

10. To set up the pick list type, do one of the following:
    - Select the **Classification** option to set up a basic pick list with items from the same class/subclass. From the **Primary** drop-down list, select the primary invoice item classification. If applicable, select a subclass from the **Subclass** drop-down list.
    - Select the **List** option to create a custom list by choosing specific invoice items to appear on the list. In the *User defined list* area *Item ID* column, type an item ID to be added to the pick list or press F2 to use the Invoice Item List to choose an item. Repeat as necessary to add the applicable invoice items to the pick list.

11. Click **OK** to save your changes, or click another tab to add more information for the item.

**Example:**

In this example, the practice has set up a Classification pick list that includes all items in the Surgery classification.
When selecting items to put on the invoice, the staff member enters the pick list ID. A list of all items from the Surgery classification will display.

The staff member highlights the item to add to the invoice and clicks Select. The selected item will be added to the invoice in place of the pick list ID.

**Setting Up Invoice Item Groups**

For items that you often invoice at the same time, you can combine these items as group items. When you invoice, simply enter the Group ID to have all of the items in the group automatically added to the invoice at once. When you invoice a group item, each item within the group appears in the invoice. At that point, if necessary you can modify/remove items, change the quantity, pricing, taxes or discounts associated with each item.

Common examples of group items are annual exams, dental exams and geriatric exams.

**Note:** Pricing and dispensing fees are calculated from each individual item’s information.
To create a Group Item:
1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Click New. The Invoice Item Information window appears.
3. If your practice enters new invoice item IDs manually, type the invoice item ID in the ID text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears.
4. Press TAB.
5. At the top of the Invoice Item Information window, select the Group item type to designate this item as a group item. The number of available tabs is reduced to three.
6. On the Information tab, in the Hospital description text box, type an internal description of the group item to appear in the Invoice Item List, in your reports and in the patient’s medical file.
7. If you would like an alternate description to display on client documents, in the Client description text box, type a description of the group item to print on the invoice and estimate, and also on reminders.
8. In the Classification area, do the following:
   a. Select a classification for the group item from the Primary drop-down list. The classification is used to generate more specific information in reports, to mark up or mark down entire groups of similar invoice items, and narrow invoice item searches.
   b. If applicable, select a subclassification for the item from the Subclass drop-down list.
9. Click the Group Items tab.
10. If you want to copy items from another group, in the Copy line items from group ID text box, type the ID of the group or press F2 to select from a list of groups. You can then add and edit items in your new Group items list as necessary.
11. To add items to your Group items list (without copying from another group), in the Item ID column, type an item ID or press F2 to use the Invoice Item List to choose an item.
12. For each item you want to include in the group, if you want to include more than one of the item in the group, type the quantity in the **Quantity** column.

13. To move an item up or down in the **Group items** list, highlight the item you want to move and then click the **↑** or **↓** arrow button.

14. To delete an item from the list, highlight the item and press CTRL+D. You are prompted to confirm the deletion. Click **Yes**.

15. To specify how you want your group to print on an invoice, select one of the following options from the **Printing option** drop-down list:
   - **Print all lines, show line amounts**—Prints the name of the group and individual lines for each item in the group and amounts for each item.
   - **Print all lines, show group total amount**—Prints the name of the group and individual lines for each item in the group, but only shows the total amount on the group line at the top. The individual lines will have an amount of zero.
   - **Print detail lines only**—Prints only the individual lines for each item in the group and the amount for each item.
   - **Print group line only**—Prints only the name of the group and the total amount.

16. If desired, click the **Print** button on the **Group Items** tab preview or print a report with the details of your group.

17. Click **OK** to save your changes, or click another tab to add more information for the item.

For a complete list of group invoice items, print an **Invoice Group Item Setup Report**.

**Example:**

In this example, the practice has set up a Group for the Senior Wellness Exam.

![Invoice Item Information for Senior Wellness Package](image)

When selecting items to put on the invoice, the staff member enters the group item ID. A list of all items in the group will display.
The staff member can then remove items or modify item quantities as needed.

**Setting Up Smart Codes**

Smart codes provide flexibility to choose the proper treatment for a patient based on species, sex, age or weight. Only items matching the patient or invoice criteria are added to the invoice. Individual invoice items, invoice item groups and pick lists can be included in a smart code.

For example, you could create a simple smart code for an office examination and include your invoice item IDs for feline and canine examinations on the smart code. When the smart code is added to the invoice, Cornerstone chooses the correct examination based on the patient’s species.

**To set up smart codes:**

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Click New. The Invoice Item Information window appears.
3. If your practice enters new invoice item IDs manually, type the invoice item ID in the ID text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears.
4. Press TAB.
5. At the top of the Invoice Item Information window, select the Group item type to designate this item as a group item. The number of available tabs is reduced to three.
6. On the Information tab, in the Hospital description text box, type an internal description of the item to appear in the Invoice Item List, in your reports and in the patient’s medical file.
7. If you would like an alternate description to display on client documents, in the Client description text box, type a description of the item to print on the invoice and estimate, and also on reminders.
8. In the **Classification** area, do the following:
   a. Select a classification for the item from the **Primary** drop-down list. The classification is used to generate more specific information in reports, to mark up or mark down entire groups of similar invoice items, and narrow invoice item searches.
   b. If applicable, select a subclassification for the item from the **Subclass** drop-down list.

9. Click the **Group Items** tab.

10. The invoice items in your group appear. In the **Smart?** column, click the **Yes/No** button if needed to change the characteristics of the item. If you clicked the No button, after changes are made to the item, the No button changes to Yes. The Smart Code Item dialog box appears.
11. To limit the item based on the species, select a species (or multiple species) from the Species scroll list.

12. To limit the item based on the patient sex, select a sex (or multiple sexes) from the Sex scroll list.

13. To limit the item based on the patient’s age, select the Only pets with ages check box. Enter the age ranges. If the patient’s birthday is missing on a record, you will be prompted to enter a birth date when the smart code is used.

14. To limit the item based on the weight of the patient, select the Only pets with weights check box. Enter the weight ranges (e.g., 20.00–29.99). To have the system prompt for the patient’s weight, select the Ask for weight check box. To have the system prompt for the patient’s weight if it has not been updated in the last month, select the Ask for weight if none was recorded in the last 30 days check box. You only need to prompt for weight on the first item in the smart code.

15. To always prompt the user whether or not this item should be added to the invoice, click the Ask user before adding this item check box.

16. To always prompt the user to enter a quantity when the item is used, click the Stop and ask for quantity check box.

17. If applicable, set the Group item pricing area options to allow pricing to be different than if the invoice item was billed outside the group:
   a. If applicable, click the Mark up or Mark down option.
   b. Select Percentage and enter a percent to mark up or down or select Amount and enter an amount to mark up or down.
   c. Click the Ignore Minimum Price check box if you do not want the software to take the minimum price into account when the mark up or mark down is calculated.
   d. Click the Group Item Pricing button to see the details of the pricing.
   e. Click OK to return to the Invoice Item Information window.
18. Click **OK** to save your changes, or click another tab to add more information for the item.

**Example:**
A practice sets up a smart code for alter (neuter) surgeries. This code includes ovariohysterectomy (spay) procedures for both dogs and cats. Based on a patient’s species, sex and weight, the correct procedure is added to the invoice. A pick list for presurgical lab work is also included in the smart code. When the smart code is used, the pick list displays, allowing staff to select any lab work that was performed.

Another smart code for postsurgery antibiotic is also included in the alter surgery code. This code is set up to ask staff at invoicing time if the code should be added to the invoice. If a postsurgery antibiotic was used, the correct dosage (based on the patient’s species and weight) is added to the invoice.

**Example of How the Smart Code is Put Together**
1. Create a pick list for lab work as shown below.

![Invoice Item Information for Pre-surgical lab work list](image)

All invoice items that are in the LABORATORY–SMALL classification will display when the ID for the pick list is used.

2. Create a smart code for postsurgery antibiotics.
Because the item IDs for amoxicillin are “smart,” the correct dosage will be added to the invoice based on the patient’s weight and species.

3. Add the lab work pick list, smart code for postsurgery antibiotics and canine and feline castration and ovariohysterectomy (OVH) invoice item IDs to the ALTER SURGERY smart code.

The ALTER SURGERY smart code includes the pre-surgical lab work list created in step 1. It also contains the postsurgery smart code created in step 2. (A group code that is nested within another group code appears in bold.)

**Viewing Your Invoice Group or Smart Code**

To view a report with the details of your group, click the Print button on the Group Items tab.
How it Works

When the ALTER smart code is added to an invoice, the software detects that the patient is a male dog. The software asks the user to select the appropriate pre-surgical lab work from a list. The appropriate neuter code is selected based on species, sex, age, and weight. The software asks the user if a postsurgery antibiotic should be added to the invoice. In this example, the user wanted the antibiotic added and the software automatically selects the correct dosage and amount, based on species and weight.

Setting Up Dispensing Items

Dispensing items are a type of invoice item. They cannot be used by themselves, but instead are linked to an inventory invoice item record. This feature is useful if your practice dispenses an item in different ways. For example, if you have a drug that is used in the practice and is also dispensed as a prescription. When the drug is used in the practice, you may want to charge an additional dispensing fee. When the drug is prescribed for a patient’s use at home, you may not want to charge the additional dispensing fee.

If your practice has a satellite clinic and your prices, sales tax or revenue centers at the satellite clinic are different from those at the main practice, you may want to use dispensing items.

To set up dispensing items:
1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Click New. The Invoice Item Information window appears.
3. If your practice enters new invoice item IDs manually, type the invoice item ID in the ID text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears.
4. Press TAB.
5. At the top of the Invoice Item Information window, select the Dispensing item type to designate this item as a dispensing item. The number of available tabs is reduced to three.
6. On the **Information** tab, in the **Hospital description** text box, type a description of the dispensing item for internal use. This is the description used by staff to find the dispensing item in the Invoice Item List.

7. Select the dispensing item status from the **Status** drop-down list. For a new item, do not change the default status of **Active**. Mark a dispensing item as **Inactive** only when you have discontinued use of the item and do not want to use it any longer.

8. In the **Default revenue center** text box, specify a default revenue center for the dispensing item by typing a revenue ID or pressing F2 to use the Revenue Center List to choose a revenue center. This is used to track revenue separately by different areas for the business. See “Revenue Centers” on page 71 for information about revenue centers.

9. In the **Dispensing fee** area, do one of the following:
   - Select **Amount** and enter the dispensing fee amount that you want added to the cost of the item.
   - Select **Percent of inventory price** and enter the percentage.

   **Note**: Any dispensing fee that is added here will be added to the dispensing fee on the invoice item record.

10. Select the **Override the inventory price and apply only the dispensing fee** check box if you want to use only the amount specified here instead of any amount or dispensing fee found on the item’s record.

11. Click **OK** to save your changes, or click another tab to add more information for the item.

After the dispensing item is set up, it must be linked to an inventory invoice item before it can be used. To link the dispensing item, see “Linking a Dispensing Item to an Inventory Item” on page 224.
Setting Up Taxes and Discounts on Dispensing Items

If you are using dispensing items to charge tax or discounts, use care when setting up dispensing items and linking them to existing invoice items. The taxes or discounts on dispensing items are applied in addition to the taxes and discounts on the invoice items. If the tax or discount applies to all invoice items at your practice, the tax or discount can be placed on either the invoice item or the dispensing item. These taxes or discounts can be changed at invoice time, if needed.

To set up dispensing item taxes and discounts:

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Click New. The Invoice Item Information window appears.
3. If your practice enters new invoice item IDs manually, type the invoice item ID in the ID text box (top left). If your system is set up to generate invoice item IDs automatically, an ID appears.
4. Press TAB.
5. At the top of the Invoice Item Information window, select the Dispensing item type to designate this item as a dispensing item. The number of available tabs is reduced to three.
6. On the Information tab, in the Hospital description text box, type an internal description of the item. This is the description used by staff to find the dispensing item in the Invoice Item List.
7. Click the Tax/Disc tab.
8. In the Sales tax to apply area, select each sales tax that applies to this item. This tax will be applied when the client is invoiced and excludes clients marked as Tax Exempt in their file. (Note: It is possible to remove a tax during invoicing.)
9. In the Discounts to apply area, select each client discount that may apply to this item. Be aware, if the client has one or more of the discounts applied to their account, they will receive each discount for the item. (Note: It is possible to apply or remove a discount during invoicing.)
10. Click OK to save your changes, or click another tab to add more information for the item.

After the dispensing item is set up, it must be linked to an inventory invoice item before it can be used. For information on linking the dispensing item, see "Linking a Dispensing Item to an Inventory Item" in the following section.

Example:

A practice is located in Washington County and its satellite practice is located in Adams County. The counties have different county tax rates. If the practices use the same invoice items, they can set up two dispensing items: one with the tax rate for Washington County and one with the tax rate for Adams County. However, both counties are in your state, so you can have the state tax on the invoice items, instead of the dispensing items.
In this example, the practice set up a dispensing item for Washington County tax. When an invoice item linked with this dispensing item is used on an invoice, you have the option of applying this county tax.

**Linking a Dispensing Item to an Inventory Item**

After the dispensing item is set up, it must be linked to an inventory invoice item before it can be used.

**To link a dispensing item to an inventory item:**

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the invoice item record to which you want to link a dispensing item and click Update. The Invoice Item Information window appears.
3. On the Information tab in the Pricing area, click the Dispensing button. The Dispensing Information dialog box appears.
4. Select the dispensing item(s) that apply to this inventory item.
   - To select multiple dispensing items, press and hold the CTRL key while clicking on the items.
   - To deselect a dispensing item, press and hold the CTRL key while clicking on the highlighted item.

5. Select the Allow All check box if you want to allow staff members to select from a list of all active dispensing items when billing this invoice item. (Selecting Allow All here activates the Show All check box that will display on the Select Dispensing Item dialog box at invoice time, allowing staff to select any dispensing item, instead of being limited to the dispensing item(s) selected at the time of invoice item setup.)

   **Note:** If the Allow All check box is selected, at least two dispensing items must be selected on the Dispensing Information dialog box. (These items will display in the selection list that appears at invoice time.)

6. Click OK to return to the Invoice Item Information window.

7. Click OK to save your changes.

### Setting Up Whiteboard Patient Order Item Defaults

The Invoice Item Information window’s Whiteboard tab allows you to set default values and text box-level rules for each invoice item that staff may enter on the Patient Orders window.

The Patient Order defaults area on the left of the tab lists all fields available on the Patient Orders window entry grid. It includes information in the following three columns:

- **Type column**—The name of the Patient Order item field as it appears in its associated column on the Patient Orders window.
- **Value column**—The default value to use for this field on the Patient Orders window.
- **Rules column**—Icons in this column indicate the current “change rules” set for this field (icon descriptions provided within the procedural steps below).
To set up patient order item defaults and change rules on the Whiteboard tab:

1. In the Invoice Item List (Lists > Invoice Item), double-click an invoice item to update it.
2. Click the Whiteboard tab.

3. Select an item in the Patient Order in the list on the left to display its associated rules on the right.

4. The [Field type] default value setting (top field on the right) may display as a drop-down list, text box, or check box, depending on the field type selected on the left. Specify the default value to use for this Patient Orders item. If you want to require staff to enter or select the value at the time the order item is added on the Patient Orders window, set the value to <Blank>.

5. For the When this default is changed on the Patient Orders window setting, select one of the following "change rules" to be followed when this value is changed on the Patient Orders window:
   - ✗ Also change the above default—When this field’s value is changed on the Patient Orders window, Cornerstone will make the changed value the new default value for this field (and automatically update the default value listed on the Whiteboard setup tab). For all fields except Quantity, this is the option that will be selected by default.
   - ✗ Do not change the above default—When this field’s value is changed on the Patient Orders window, Cornerstone will not make the changed value the new default value (it will leave the default value as it is listed on the Whiteboard setup tab). For the Quantity field, this is the option that will be selected by default.

6. For the Editing permissions setting, select one of the following rules to determine which staff are allowed to edit/overwrite the default value for this field on the Patient Orders window:
   - ✗ All staff may edit—All staff with Patient Orders permissions are allowed to edit/overwrite the default value for this field on the Patient Orders window, regardless of whether they have been
Chapter 10: Setting Up Your Invoice Items

granted Whiteboard Orders Override security permissions. This is the option that will be selected by default.

- Only staff with security permissions may edit—Only those staff members with Whiteboard Orders Override security permissions in Cornerstone are allowed to edit/overwrite the default value for this field on the Patient Orders window.

Note: If a field’s default value is set to <Blank> on the Whiteboard setup tab and therefore appears blank on the Patient Orders window, all staff with Patient Orders permissions are allowed to enter or select a value for this field, regardless of whether they have been granted Whiteboard Orders Override security permissions in Cornerstone.

7. Click OK to save your changes and close the Invoice Item Information window.
8. Repeat the steps above for each Patient Orders item for which you want to set up defaults and change rules.

Tip: To quickly set Whiteboard patient order defaults for multiple invoice items at once, use the Invoice Item Setup tool’s Whiteboard tab. See “Setting Whiteboard Patient Order Defaults for Multiple Items at Once” on page 243 for more information.

Adding Dispensing Items Using Mass Markup

You can use the Mass Markup feature to quickly add (or remove) dispensing items to all invoice items in a particular classification or subclassification, or to quickly add (or remove) dispensing items to multiple invoice items at once.

To add dispensing items using Mass Markup:
2. A “Mass Markup” message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click Yes.

   The Mass Markup dialog box appears.
3. Click the Dispensing tab.
4. In the Invoice item information area, to narrow the list of items displayed on the Dispensing tab, do the following:
   - To add dispensing items to invoice items in a particular classification, in the Class ID text box, type the ID of the class or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To add dispensing items to invoice items in a particular subclassification, in the Subclass ID text box, type the ID of the subclass or press F2 to use the Invoice Item Subclassification List to choose an item subclassification.
   - To add dispensing items to an individual item, in the Item ID text box, type the item’s ID or press F2 to use the Invoice Item List to choose the item.
5. In the lower Dispensing Item ID/Dispensing Item Description selection list, select the dispensing item to add (or remove). You can select only one dispensing item at a time.
6. Select the invoice items to affect by the addition or removal of dispensing items. (Selected items are highlighted/shaded.)
   - To select all items in the list, click Select All.
   - To select more than one item, press and hold the CTRL key while you click to select each item.
• To select a range of consecutive items, click the first item and then press and hold the SHIFT key while you click the last item in the range.

7. Click **Add** to add the dispensing item to the highlighted invoice items or click **Remove** to remove the dispensing item from the highlighted invoice items.

   ➢ The change is not applied to the highlighted items until you click **Apply**. After viewing the applied dispensing items, if you decide you do not want to apply the changes, click **Cancel** or deselect specific items that you do not want to link.

![Dispensing tab on Mass Markup dialog box](image)

8. If you want to allow staff members to select from a list of all active dispensing items when billing for the selected invoice items, you can select **Allow All - Use any Dispensing Item** in the **Dispensing Item ID/Dispensing Item Description** selection list. If the **Allow All/Use any Dispensing Item** option is selected for an item on the Mass Markup dialog box during invoice item setup, then the **Show All** option will be available on the Select Dispensing Item dialog box at invoice time. This allows staff to select any dispensing item when billing any of the selected invoice items.

   **Note:** In order to apply the **Allow All** setting to an item on the Mass Markup dialog box, that item must have at least two dispensing items linked to it.

9. Click **Apply** to link the taxes or discounts to the highlighted invoice items.

   **Note:** Because the **Apply** button applies any changes to highlighted invoice items in all tabs, you should finish working in one tab, apply or cancel your work and then work in a different tab.

10. After the database has been updated, a message appears to inform you that the change is complete. Click **Close**.

**Example:**

This example shows steps a staff member might follow to link the **Allow All–Use any Dispensing Item** option to an invoice item in the Mass Markup dialog box.

1. On the Mass Markup **Dispensing** tab, use the **Class ID** field to display the entire Anti-Inflam/Steroids/Analgesic (IAIF) class of items at once.

2. In the Dispensing Item selection list (at the bottom of the Mass Markup dialog box), select **Allow All–Use any Dispensing Item**.
Chapter 10: Setting Up Your Invoice Items

3. Click the **Select All** button to select all invoice items in the Anti-Inflam/Steroids/Analgesic (IAIF) class. Note that an invoice item must have at least two dispensing items linked to it in order for the Allow All option to be applied successfully.

4. Click the **Add** button to add the dispensing item to the highlighted invoice items.
   
   **Note:** If some of the selected items have one or zero linked dispensing items and you click **Add** to apply the Allow All setting, the Allow All setting will not be applied and these items will remain unchanged.

5. If you are satisfied with the results shown, click **Apply**.

6. Click **Close** to exit.

**Selecting Dispensing Items at Invoice Time**

Dispensing items must be linked to an inventory invoice item and cannot be used alone. When an inventory invoice item that is linked to a dispensing item is added to an invoice, estimate, Patient Visit List, Rx label, Patient Advisor* exam, or Appointment Scheduler, a pop-up box appears. The type of box that appears depends on if one or multiple dispensing items are linked to the invoice item, and if the Allow All check box was selected during the dispensing item setup.

**One Linked Dispensing Item**

If only one dispensing item is linked to the invoice item, a box similar to the one shown below appears. Click **Yes** to apply the dispensing item or **No** to not apply the dispensing item.

**Two or More Linked Dispensing Items**

If two or more dispensing items are linked to the invoice item, a box similar to the one shown below displays. Click the dispensing item to apply and click **select**.
If more than one dispensing item is linked to the invoice item, select which dispensing item to apply and click Select.

Two or More Linked Dispensing Items with SHOW ALL Enabled

If two or more dispensing items are linked to the invoice item and Allow All is selected during the dispensing item setup, then the Show All option will be available on the Select Dispensing Item dialog box at invoice time. This is useful if the item is dispensed a certain way most of the time but may need to be dispensed differently once in a while.

If desired, the staff member can select the Show All check box to display all active dispensing items in the selection list.

Viewing Calculations Associated with Dispensing Items

To view the breakdown of how the software calculated a fee, right-click on the line in the invoice, estimate, reservation or Patient Visit List. The Calculated Price box (shown below) appears. Click OK to close the box when you are done viewing it.
In this example, acepromazine was dispensed at the practice. A dispensing fee (from the invoice item record) is charged, and a dispensing item fee (from the dispensing item), if any, is added to the total cost.

To view a list of invoice items that have dispensing items linked to them, print an Invoice Item Dispensing Setup Report.

### Changing Invoice Item Pricing Information Using Mass Markup

You can change invoice item prices by a specified dollar amount or by a percentage using Mass Markup/Markdown. You can use mass markup for one particular invoice item, all invoice items, service items, inventory items or for an invoice item classification or subclass.

**Note:** We recommend using the Cornerstone server to perform exclusive use options, such as Mass Markup.

**Before You Begin**

- Make a backup of your database.
- Make sure that you are the only user logged in to Cornerstone. See “Viewing Current User Information: Exclusive Use” on page 14.

**To change invoice item prices using Mass Markup:**

**IMPORTANT:** We strongly advise making a backup of your database before using Mass Markup to modify invoice items.

2. A “Mass Markup” message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click Yes.

   The Mass Markup dialog box appears.
3. Click the Price tab.
4. In the Invoice item information area, to narrow the list of invoice items displayed on the Price tab, do the following:

   • To change prices of items in a particular classification, in the Class ID text box, type an ID or press F2 to use the Invoice Item Classification List to choose an item classification.

   • To change prices of items in a particular subclassification, in the Subclass ID text box, type an ID or press F2 to use the Invoice Item Subclassification List to choose an item subclassification. (If you specify a subclass ID, Cornerstone automatically enters the class ID.)

   • To change the price of an individual item, in the Item ID text box, type a specific item ID or press F2 to use the Invoice Item List to choose the item.

5. In the Type area, select the Service or Inventory check boxes to include those invoice item types in the list. The list displays only the items of the types you select.

6. In the Price Type area (lower left), select Base Price to change the base prices of the selected group or Minimum Price to change the minimum prices of the selected groups. The columns displayed in the invoice item list change depending on the price type selected.

7. Specify whether to MarkUp or Markdown the prices of the selected group.

8. Select the Nearest amount to round uneven amounts.

9. Type or select the Percentage to change prices. (To change prices by a flat dollar amount, leave the percentage at .00%.)

10. Type or select the Minimum Amount to change a price. If you are changing prices by a flat dollar amount, type the dollar amount in the box.

11. Select the Include zero check box to change items with no current price by the minimum amount.

12. In the invoice item selection list on the Price tab, select the invoice items to be affected by the price change. (Selected items are highlighted/shaded.)

   • To select all items in the list, click Select All.

   • To select more than one item, press and hold the CTRL key while you click to select each item.
• To select a range of consecutive items, click the first item and then press and hold the SHIFT key while you click the last item in the range.

13. Click **Calculate** to see the effect of the price change in the **New Price** column. (The price change is not applied to the selected items until you click **Apply**. After viewing the new prices, if you decide you do not want to apply the price changes, click **Cancel** or deselect specific items that you do not want to change.)

**WARNING:** Before clicking **Apply** in the next step, make sure you want to permanently change the selected items. **Apply** applies any changes you have made to all of the items.

14. If you are sure you want to permanently change the selected items, click **Apply** to apply the new pricing. You are prompted to confirm the change. Click **Yes**.

**Note:** Because the **Apply** button applies any changes to selected invoice items on all tabs, you should finish working in one tab, apply or cancel your work, and then proceed to work in a different tab.

The New Price column displays the changes you are proposing (when you click **Calculate**). Click **Apply** to make the changes to the Cornerstone database.

15. After the database has been updated, a message appears to inform you that the price change is complete. Click **Close**.
To use Mass Markup to change dispensing fees:
1. On the **Tools** menu, select **Mass Markup**.
2. A “Mass Markup” message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click **Yes**. The Mass Markup dialog box appears.
3. Click the **Price** tab.
4. In the **Invoice item information** area, to narrow the list of invoice items displayed on the **Price** tab, do the following:
   - To change dispensing fees on items in a particular classification, in the **Class ID** text box, type an ID or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To change dispensing fees on items in a particular subclassification, in the **Subclass ID** text box, type an ID or press F2 to use the Invoice Item Subclassification List to choose an item subclassification. (If you specify a subclass ID, Cornerstone automatically enters the class ID.)
   - To change the dispensing fee for an individual item, in the **Item ID** text box, type a specific item ID or press F2 to use the Invoice Item List to choose the item.
5. In the **Price Type** area (lower left), select **Dispensing Fee**. The columns displayed in the invoice item list change accordingly.
6. Enter the **Current Dispensing Fee** and what you want the **New Dispensing Fee** to be.
7. Click **Calculate** to see the effect of the dispensing fee change in the **New Disp. Fee** column. (The fee change is not applied to the selected items until you click **Apply**. After viewing the new fees, if you decide you do not want to apply the changes, click **Cancel** or deselect specific items that you do not want to change.)
   **WARNING:** Before clicking **Apply** in the next step, make sure you want to permanently change the selected items. **Apply** applies any changes you have made to all of the items.
8. Click **Apply** to apply the new pricing.
   **Note:** Because the **Apply** button applies any changes to selected invoice items in all tabs, you should finish working in one tab, apply or cancel your work and then work in a different tab.
9. After the database has been updated, a message appears to inform you that the price change is complete. Click **Close**.

**Changing Linked Taxes and Discounts Using Mass Markup**
You can change taxes or discounts linked to invoice items using **Mass Markup**. You can use mass markup for one particular invoice item, all invoice items, or for an invoice item classification or subclass.

**Note:** We recommend using the Cornerstone server to perform exclusive use options, such as Mass Markup.
Before You Begin

- Make a backup of your database.
- Make sure that you are the only user logged in to Cornerstone. See “Viewing Current User Information: Exclusive Use” on page 14.
- Set up the taxes your practice applies (Controls > Taxes).
- Set up the discounts your practice applies (Controls > Discounts).

To change taxes or discounts linked to invoice items using Mass Markup:

IMPORTANT: We strongly advise making a backup of your database before using Mass Markup to modify invoice items.

2. A “Mass Markup” message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click Yes.
   The Mass Markup dialog box appears.
3. Click the Tax or Discount tab.

4. In the Invoice item information area, to narrow the list of invoice items displayed on the Tax tab/Discount tab, do the following:
   - To change taxes or discounts on items in a particular classification, in the Class ID, text box, type an ID or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To change taxes or discounts on items in a particular subclassification, in the Subclass ID text box, type an ID or press F2 to use the Invoice Item Subclassification List to choose an item subclassification. (If you specify a subclass ID, Cornerstone automatically enters the class ID.)
   - To change the tax or discount for an individual item, in the Item ID text box, type a specific item ID or press F2 to use the Invoice Item List to choose the item.
5. In the Type area, select (or clear) the Service, Inventory or Dispensing check boxes to include those invoice item types in the list. The list displays only the items of the types you select.
6. In the Tax ID or Discount ID selection list (bottom left), select the tax or discount to add (or remove). You can select only one tax or discount at a time.
7. Select the invoice items to affect by the addition or removal of the tax or discount. (Selected items are highlighted/shaded.)
   - To select all items in the list, click Select All.
   - To select more than one item, press and hold the CTRL key while you click to select each item.
   - To select a range of consecutive items, click the first item and then press and hold the SHIFT key while you click the last item in the range.

8. Click Add to add the tax or discount to the selected invoice items, or click Remove to remove the tax or discount from the selected invoice items. (The change is not applied to the selected items until you click Apply. After viewing the applied taxes or discounts, if you decide you do not want to apply the changes, click Cancel or deselect specific items that you do not want to include.)

   **WARNING:** Before clicking Apply in the next step, make sure you want to permanently change the selected items. Apply applies any changes you have made to all of the folders.

9. Click Apply to link the taxes or discounts to the selected invoice items.

   **Note:** Because the Apply button applies any changes to selected invoice items in all tabs, you should finish working in one tab, apply or cancel your work and then work in a different tab.

10. After the database has been updated, a message appears to inform you that the change is complete. Click Close.

   **Note:** Discounts work in the same way as taxes. Instead of the tax IDs, descriptions and percentages, Cornerstone lists the discount IDs, discount descriptions and the discount percentages.

   - For a complete list of the taxes linked to invoice items, print an Invoice Item Tax Setup Report.
   - For a complete list of the discounts linked to invoice items, print an Invoice Item Information Report.

**Using the Invoice Item Setup Tool**

The Invoice Item Setup tool can be used to set up your invoice items for the first time or to quickly make mass changes to many invoice items simultaneously.

Exclusive use is not required to use the Invoice Item Setup tool. Any items that are not updated because of an exclusive use issue are included on a report that prints when you close the tool.

The Invoice Item Setup tool allows you to:

   - Move invoice item reorder information and quantity on hand from one location to another.
   - Copy invoice item reorder information from one location to another (only for multiple location inventory).
   - Set reorder points for multiple items at a specific location.
   - Set up Buy Barcodes and Sell Barcodes.
   - Define whether an item tracks Expiration Dates and/or Lot Numbers for one or multiple items.
   - Set up Whiteboard patient order defaults for multiple items.

**Note:** Within the Invoice Item Setup tool, for all tabs except the Whiteboard tab, the invoice items selected must be inventory items marked to maintain quantity on hand (select Lists > Invoice Items > select the invoice item > Update button > Inventory tab > Maintain QOH check box).
Moving Items

The Invoice Item Setup tool’s Move Items tab provides a quick way to move reorder information and quantity on hand from one location to another. If items are being moved to a location where that item does not exist, use the Move Items option. For example, if a new location is created and you want to move all quantities of the item(s) and reorder points from another location to the new location, use this option.

Tip: You can move more than one item, including moving all items in a single classification at one time.

IMPORTANT: Before using and making changes to invoice items using the Invoice Item Setup tool, make a backup of your database.

To move items from one location to another:

1. On the Tools menu, select Invoice Item Setup.
2. A message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click Yes.
   The Invoice Item Setup dialog box appears.
3. Click the Move Items tab.
4. In the Invoice item and location area, to narrow the list of items displayed on the Move Items tab, do the following:
   - To find and move items in a particular classification, in the Class ID text box, type the ID of the class or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To find and move items in a particular subclassification, in the Subclass ID text box, type the ID of the subclass or press F2 to use the Invoice Item Subclassification List to choose an item subclassification.
   - To find and move an individual item, in the Item ID text box, type the item’s ID or press F2 to use the Invoice Item List to choose the item.
5. In the Location drop-down list, select the location from which to move items.
6. In the Move items to this location drop-down list, select the location to which to move items.

Note: It is possible to select an inactive location as the new location, but be aware that items stored in an inactive location cannot be consumed.
7. Click **Retrieve**. A list of inventory items appears. To remove the list and enter different criteria, click **Clear**.

8. Do one of the following:
   - Click **Select All** to select all items on the list.
   - Hold the CTRL key and click each item you want to select.

   **Tip:** To deselect an item, click the (highlighted) item again. To deselect all selected items, click **Deselect All**.

9. When finished selecting items, click **OK**.

**Copying Items (Multiple Location Inventory only)**

The Invoice Item Setup tool’s **Copy Items** tab provides a quick way to copy inventory items and reorder points to a new location when using a multiple location inventory setup.

**Note:** The Copy Items feature only copies inventory items and reorder points to a new location, but does not copy quantities to the location.

**IMPORTANT:** Before using and making changes to invoice items using the Invoice Item Setup tool, make a back up of your database.

**To copy items from one location to another (multiple location inventory only):**

1. On the **Tools** menu, select **Invoice Item Setup**.

2. A message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click **Yes**.

   The Invoice Item Setup dialog box appears.

3. Click the **Copy Items** tab.

   ![Copy Items tab on Invoice Item Setup window](image-url)
4. In the *Invoice item and location* area, to narrow the list of items displayed on the **Copy Items** tab, do the following:
   - To find and copy items in a particular classification, in the **Class ID** text box, type the ID of the class or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To find and copy items in a particular subclassification, in the **Subclass ID** text box, type the ID of the subclass or press F2 to use the Invoice Item Subclassification List to choose an item subclassification.
   - To find and copy an individual item, in the **Item ID** text box, type the item’s ID or press F2 to use the Invoice Item List to choose the item.

5. In the **Location** drop-down list, select the location from which to copy items.

6. In the **Copy items to this location** drop-down list, select the location to which to copy items.

7. Click **Retrieve**. A list of inventory items appears. To remove the list and enter different criteria, click **Clear**.

8. Do one of the following:
   - Click **Select All** to select all items on the list.
   - Hold the CTRL key and click each item you want to select.
   
   **Tip:** To deselect an item, click the (highlighted) item again. To deselect all selected items, click **Deselect All**.

9. When finished selecting items, click **OK**.

**Setting Reorder Points**

The Invoice Item Setup tool’s **Setting Reorder Points** tab provides a quick way to pull up a list of all items in a class that are found at a selected location and individually change reorder points, reorder quantities, and overstock points for the items. You can also retrieve a single item or retrieve a list of items in a selected subclass and quickly set reorder points, reorder quantities and overstock points.

**IMPORTANT:** Before using and making changes to invoice items using the Invoice Item Setup tool, make a backup of your database.

**To set reorder points:**

1. On the **Tools** menu, select **Invoice Item Setup**.

2. A message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click **Yes**.

   The Invoice Item Setup dialog box appears.

3. Click the **Set Reorder Points** tab.
4. In the Invoice item and location area, to narrow the list of items displayed on the Set Reorder Points tab, do the following:
   - To find and set reorder information for items in a particular classification, in the Class ID text box, type the ID of the class or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To find and set reorder information for items in a particular subclassification, in the Subclass ID text box, type the ID of the subclass or press F2 to use the Invoice Item Subclassification List to choose an item subclassification.
   - To find and set reorder information for an individual item, in the Item ID text box, type the item’s ID or press F2 to use the Invoice Item List to choose the item.

5. In the Location drop-down list, select the location for which you want to set reorder information.

6. Click Retrieve. A list of inventory items appears. To remove the list and enter different criteria, click Clear.

7. For each item on the list for which you want to reorder information, in the applicable text box, type reorder point, reorder quantity, and overstock point.

8. When finished selecting items, click OK.
Setting Barcodes, Expiration Dates and Lot Numbers

The Invoice Item Setup tool’s Set Barcodes/Expdate/Lotnbr tab provides an initial quick setup option for item bar codes, reorder information, expiration dates and lot number tracking. For example, you can retrieve all items in a specific class and quickly mark those items for which you want to require and track expiration dates and/or lot numbers.

In Cornerstone, if an item is set up to track expiration dates, you must enter an expiration date when inventory is received and when inventory is consumed. Likewise if an item is set to track lot numbers, you must enter a lot number when inventory is received and when inventory is consumed.

Managing Expiration Dates When Upgrading from Cornerstone 6.2 or Earlier

For practices upgrading from Cornerstone 6.2 or earlier, if you have existing items with expiration dates your existing expiration dates will be removed when you upgrade to a newer version of the Cornerstone software because it has no way of verifying that the inventory expiration dates in your system are correct. To protect the integrity of your data, any existing inventory will display “unknown” as the expiration date.

For your information, an Expiration Dates Report is generated when you install the new version of Cornerstone software. This report contains the existing expiration dates in your system and is located in your Cornerstone directory (e.g., C:\Cstone).

If you are sure your existing expiration dates are accurate:

If you are sure your existing dates are accurate, you can move them over to your new inventory system using the Set Barcodes/Expdate/Lotnbr tab. Once an item or a group of items has been checked to track expiration dates, a message appears, asking if you want your existing expiration dates copied into inventory when available. If you are confident that your existing dates are accurate, you can click Yes to move them over to your new inventory system.

You will then need to verify the quantity on hand associated with copied expiration dates using the View Quantity on Hand window (Inventory > View Quantity on Hand) to make any needed adjustments.

If you are not sure your existing expiration dates are accurate:

If you are not sure that all of your existing dates are accurate, you will need to do a physical inventory count and manually make updates and adjustments using the View Quantity on Hand window (select Inventory > View Quantity on Hand).

IMPORTANT: Before using and making changes to invoice items using the Invoice Item Setup tool, make a back up of your database.

To set barcodes, expiration dates and lot numbers:

1. On the Tools menu, select Invoice Item Setup.
2. A message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click Yes.
   
   The Invoice Item Setup dialog box appears.
3. Click the Set Barcodes/Expdate/Lotnbr tab.
4. In the *Invoice item and location* area, to narrow the list of items displayed on the *Set Barcodes/Expdate/Lotnbr* tab, do the following:
   - To find items in a particular classification, in the **Class ID** text box, type the ID of the class or press F2 to use the Invoice Item Classification List to choose an item classification.
   - To find items in a particular subclassification, in the **Subclass ID** text box, type the ID of the subclass or press F2 to use the Invoice Item Subclassification List to choose an item subclassification.
   - To find an individual item, in the **Item ID** text box, type the item’s ID or press F2 to use the Invoice Item List to choose the item.

5. Click **Retrieve**. A list of inventory items appears. To remove the list and enter different criteria, click **Clear**.

6. If applicable, scan the item’s Sell Barcode (used to sell the item to your clients) and/or the Buy Barcode (used to buy the item from the vendor). Note: If the item is purchased by the case, scan or enter the bar code on the case.

   **WARNING:** In the next step, if you clear the **Track Exp Dates** check box for an item, all the expiration dates for the item will be lost. We recommend you make an appropriate backup before proceeding, as you will lose all expiration dates currently in the system for those items.

7. Under **Track Exp Dates**, select the applicable option:
   - If you want to track expiration dates for an item, select the item’s **Track Exp Dates** check box. To track expiration dates for all items on the list, click the **Chk All** button.
   - If you do not want to track expiration dates for an item, clear the item’s **Track Exp Dates** check box. If you want to turn off expiration date tracking for all items on the list, click the **Unchk All** button.

   **WARNING:** In the next step, if you clear the **Track Lot Nbrs** check box for an item, all the lot numbers for the item will be lost. We recommend you make an appropriate backup before proceeding, as you will lose all lot numbers currently in the system for those items.
8. Under Track Lot Nbrs, select the applicable option:
   - If you want to track lot numbers for an item, select the item’s Track Lot Nbrs check box. To track lot numbers for all items on the list, click the Chk All button.
   - If you do not want to track lot numbers for an item, clear the item’s Track Lot Nbrs check box. If you want to turn off lot number tracking for all items on the list, click the Unchk All button.

9. When finished selecting items, click OK.

10. If you selected the Track Exp Date check box for items, a message appears, asking if you want to copy expiration dates from your previous version into your new inventory system.
   - If you are confident that your existing item expiration dates are valid and you want to use them in your newly set up inventory system, click Yes; otherwise, click No. (This option is no longer available after an item is included on a received order or after the item’s Track Lot Nbr check box is selected.)
   - If you click Yes, the “If you unchecked the Track Exp Dates box…” message appears. Read the warning message and click OK.

**Setting Whiteboard Patient Order Defaults for Multiple Items at Once**

The Invoice Item Setup tool’s Whiteboard tab allows you to perform a mass setup of default values and field-level rules for invoice items that staff may enter on the Patient Orders window.

**IMPORTANT:** Make sure you have a current backup of your database before using the Invoice Item Setup tool.

**To set patient order defaults for multiple items:**

1. On the Tools menu, select Invoice Item Setup.

2. A message appears to remind you that a backup of the database should be made and asks if you wish to continue. Ensure that a backup has been made, and click Yes.

   The Invoice Item Setup dialog box appears.

3. Click the Whiteboard tab.
4. In the Invoice item and location area, to narrow the list of items displayed on the Whiteboard tab, do the following:
   
   • To find items in a particular classification, in the **Class ID** text box, type the ID of the classification or press F2 to search for and select the classification from the Invoice Item Classification List.
   
   • To find items in a particular subclassification, in the **Subclass ID** text box, type the ID of the subclassification or press F2 to search for and select the subclassification from the Invoice Item Subclassification List.
   
   • To find an individual item, in the **Item ID** text box, type the item’s ID or press F2 to search for and select the item from the Invoice Item List.
   
5. Click **Retrieve**. A list of inventory items appears. To remove the list and enter different criteria, click **Clear**.

6. If you want to view the currently assigned rules for an invoice item, select the single invoice item in the list. Its associated rules display in the **Patient Order Rules** area at the bottom of the tab.

   **Note:** The fields in the **Patient Order Rules** area will be empty if rules have not been specified for the selected item or if multiple items are selected and those items have differing rules.

7. In the list of retrieved invoice items, do any of the following to select the patient order items you want to update:

   • If you want to select more than one item, hold down the CTRL key while you select the items you want.
   
   • If you want to select a group of consecutive items, click the first item in the group and then hold down the SHIFT key while you click the last item in the group. The first and last items and all the items between them are selected.
   
   • If you want to select all items in the list, click **Select All**.
   
   • If you want to deselect all items in the list, click **Deselect All**.

8. With the desired invoice items selected in the list, click **Edit**. The Update Whiteboard Invoice Item dialog box appears.
Chapter 10: Setting Up Your Invoice Items

9. Select a Patient Order defaults field in the list on the left to display its associated rules on the right. 

   Note: In the Patient Order defaults list on the left, if the Value column is empty, this means that there are differing settings for the selected invoice items. (Note that if <Blank> shows in the Value column for the field, this means that the value is set up to appear blank by default on the Patient Orders window; a <Blank> field is not the same as an empty field.)

10. If the selected invoice items have differing settings for this field (indicated by an empty Value column), click edit all to confirm that you want to edit the field and set it to the same value for all selected invoice items at once.

11. Depending on the field type selected on the left, a drop-down list, text box or check box may display on the right. Specify the desired default value to use for this field in its associated column on the Patient Orders window. If you want to require staff to enter or select the value at the time the item is added to the Patient Orders, set the value to <Blank>.

12. For the When this default is changed on the Patient Orders window setting, select one of the following “change rules” to be followed when this value is changed on the Patient Orders window:

   • ✗ Also change the above default—When this field’s value is changed on the Patient Orders window, Cornerstone will make the changed value the new default value for this field (and automatically update the default value listed on the Whiteboard setup tab). For all fields except Quantity, this is the option that will be selected by default.

   • ✗ Do not change the above default—When this field’s value is changed on the Patient Orders window, Cornerstone will not make the changed value the new default value (it will leave the default value as it is listed on the Whiteboard setup tab). For the Quantity field, this is the option that will be selected by default.

13. For the Editing permissions setting, select one of the following rules to determine which staff are allowed to edit/overwrite the default value for this field on the Patient Orders window:

   • 👤 All staff may edit—All staff with Patient Orders permissions are allowed to edit/overwrite the default value for this field on the Patient Orders window, regardless of whether they have been
granted Whiteboard Orders Override security permissions. This is the option that will be selected by default.

- **Only staff with security permissions may edit**—Only those staff members with Whiteboard Orders Override security permissions in Cornerstone are allowed to edit/overwrite the default value for this field on the Patient Orders window.

**Note:** If a field’s default value is set to <Blank> and therefore appears blank on the Patient Orders window, all staff with Patient Orders permissions are allowed to enter or select a value for this field, regardless of whether they have been granted Whiteboard Orders Override security permissions in Cornerstone.

14. Do one of the following:

- If you want to save your updates and continue setting defaults for additional Patient Order fields for the selected items, click **Save** and repeat steps 9–13.
- If you are finished setting Patient Order field defaults for the selected items, click **OK** to save any unsaved changes and return to the Invoice Item Setup tool’s **Whiteboard** tab.

**Invoice Item Reports**

Cornerstone includes several reports related to invoice item information.

**To access Invoice Item reports:**

1. On the **Reports** menu, select **Find a Report**. The Report Search window appears.
2. In the Reports list, click the plus sign to the left of **Invoice Item** to expand the list of invoice item reports.
Note: Invoice item reports may be very large. Be sure to enter a Range to narrow the report results.

Compliance Report

This report details the number of times an item (or items) has been purchased during a particular time period. Use it to monitor which clients are not repurchasing items that should be dispensed at regular intervals (such as Heartworm medication). This report is available only if you have selected a compliance group in Compliance Alerts defaults. See “Compliance Alerts Defaults” on page 87 for more information.

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Item</th>
<th>Patient Name</th>
<th>Patient Weight</th>
<th>Date Dispensed</th>
<th>Avg. Given</th>
<th>Dispensed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nergal, Emma</td>
<td>123</td>
<td>Scoop</td>
<td>20 pounds</td>
<td>3/20/01</td>
<td>1.00</td>
<td>0</td>
</tr>
</tbody>
</table>

Controlled Substance Report

Use the Controlled Substance Report to help account for controlled drugs in your practice. The Controlled Substance Report records the amount of the drug that is invoiced; it does not reflect the difference between the invoiced amount and the administered amount.

In accordance with the requirements of some states, the client’s address is included on the report.

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Description</th>
<th>Current QTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>222222003</td>
<td>MORPHINE INJECTION</td>
<td>100 (Note)</td>
</tr>
</tbody>
</table>

Departing Instructions Report

Use the Departing Instructions Report to see which departing instructions are currently set up in the Departing Instruction List (Lists > Departing Instructions).

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Departing Instruction Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>Declaw</td>
<td>Declaw - Some cats may show some discomfort for 1-2 weeks. Remove all cat litter and replace with shredded newspaper for 10 days. Check the feet daily for...</td>
</tr>
</tbody>
</table>
Invoice Group Item Setup Report

Use the Invoice Group Item Setup Report to see invoice items that are included in a group item. You can also use this report to see the price of each group item.

<table>
<thead>
<tr>
<th>Invoice Group Item Setup Report</th>
<th>Inventory Group Items Sorted By Group Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GF2 FELINE DISTEMPER SECOND VAC</td>
<td>Active</td>
</tr>
<tr>
<td>Item ID</td>
<td>Invoice Item Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>001</td>
<td>FELINE DISTEMPER EXAM</td>
</tr>
<tr>
<td>001</td>
<td>FELINE DISTEMPER EXAM</td>
</tr>
</tbody>
</table>

Invoice Item Classification Setup Report

Use the Invoice Item Classification Setup Report to view the invoice item classifications and subclasses you have set up in Cornerstone.

<table>
<thead>
<tr>
<th>Invoice Item Classification Setup Report</th>
<th>Sorted By Invoice Item Classifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Class/Subclass ID</td>
<td>Primary Class/Subclass Description</td>
</tr>
<tr>
<td>001</td>
<td>Video Rentals</td>
</tr>
<tr>
<td>002</td>
<td>BOOKS</td>
</tr>
<tr>
<td>010</td>
<td>VACCINATIONS</td>
</tr>
<tr>
<td>020</td>
<td>PROFESSIONAL SERVICES</td>
</tr>
<tr>
<td>030</td>
<td>SURGERY</td>
</tr>
</tbody>
</table>

Invoice Item Dispensing Setup Report

Use the Invoice Item Dispensing Setup Report to get a list of invoice items that have been set up as dispensing items.

<table>
<thead>
<tr>
<th>Invoice Item Dispensing Setup Report</th>
<th>Sorted By Classifications By Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item ID</td>
<td>Invoice Item Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>00000</td>
<td>Active Formula Can 45.5 oz</td>
</tr>
</tbody>
</table>
Invoice Item Information Report

Use the Invoice Item Information Report to see what has been set up in the Instructions/Actions tab (in the Invoice Item Information window) for each item. You can view discounts linked to invoice items and whether items are being tracked as controlled substances.

Note: This report does not show linked prescription instructions.

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Invoice Item Description</th>
<th>Item Status</th>
<th>Contr. Status</th>
<th>Dept. Inst. ID</th>
<th>Special Action</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018</td>
<td>Tabacco Product 25 lb Less</td>
<td>active</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tabacco Product 24 lbs Less</td>
<td>active</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Invoice Item Price Information Report

Use the Invoice Item Price Information Report to find out the price of an invoice item on a particular date. To view a list of current pricing only, run an Invoice Item Setup Report.

<table>
<thead>
<tr>
<th>Invoice Item ID</th>
<th>Description</th>
<th>Unit of Measure</th>
<th>Dispensing Fee</th>
<th>Minimum Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>H1003</td>
<td>20 g Cartridge Walk</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1/11/2000</td>
<td>$10.00</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>2/1/2001</td>
<td>$10.00</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>3/15/2002</td>
<td>$10.00</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>4/10/2002</td>
<td>$10.04</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>5/15/2002</td>
<td>$10.04</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>9/10/2002</td>
<td>$10.04</td>
<td>PIECE</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Invoice Item Reminder Information Report

Use the Invoice Item Reminder Information Report to check your reminder strategy.

<table>
<thead>
<tr>
<th>Invoice Item ID</th>
<th>Description</th>
<th>Reminder(s) to Generate</th>
<th>Reminder(s) to Satisfy</th>
</tr>
</thead>
<tbody>
<tr>
<td>3223</td>
<td>Rabies Canine 3 Year Vaccine</td>
<td>active</td>
<td>3222 Rabies Canine 1 Year Booster</td>
</tr>
</tbody>
</table>
Invoice Item Sales Information Report

Use the Invoice Item Sales Information Report to see how invoice items are selling and which staff members are producing sales. You can also use this report to see which patients have been invoiced for particular items.

<table>
<thead>
<tr>
<th>Invoice Item ID</th>
<th>Description</th>
<th>Class ID</th>
<th>Client ID</th>
<th>Patient ID</th>
<th>Patient Name</th>
<th>Date Sold</th>
<th>QTY</th>
<th>Total Invoice</th>
<th>Item ID</th>
<th>Staff Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>ABSESS - LANCE &amp; DRAIN</td>
<td>PRS</td>
<td>29</td>
<td>1</td>
<td>Dr. John Doe</td>
<td>1/1/2023</td>
<td>1.00</td>
<td>$19.50</td>
<td>3</td>
<td>Anne Carter, DVM</td>
</tr>
<tr>
<td>0265/1</td>
<td>Nano</td>
<td>PRS</td>
<td>01</td>
<td>1</td>
<td>John Smith</td>
<td>1/1/2023</td>
<td>1.00</td>
<td>$19.50</td>
<td>1</td>
<td>Fred Jacob, DVM</td>
</tr>
<tr>
<td>12345</td>
<td>Helix</td>
<td>PRS</td>
<td>1</td>
<td>0</td>
<td>Jane Doe</td>
<td>1/1/2023</td>
<td>1.00</td>
<td>$19.50</td>
<td>3</td>
<td>Anne Carter, DVM</td>
</tr>
</tbody>
</table>

Total QTY: 5.00 Total Sales: $97.50

Invoice Item Setup Report

Use the Invoice Item Setup Report to see how invoice items are currently set up. This report can be sorted by classification by description, classification by ID, invoice item description or invoice item ID.

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Description</th>
<th>Type</th>
<th>Item Status</th>
<th>Unit of Measure</th>
<th>Rev Or</th>
<th>Pricing Information</th>
<th>Gross Cost</th>
<th>Sales Tax</th>
<th>Item ID</th>
<th>Sales Tax</th>
<th>Allowance</th>
<th>Price Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>CUSTOM FIRST VAC</td>
<td>1</td>
<td>active</td>
<td>each</td>
<td>$25.00</td>
<td>$0.00</td>
<td>$25.00</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>Active</td>
</tr>
<tr>
<td>02</td>
<td>CUSTOM SECOND VAC</td>
<td>1</td>
<td>active</td>
<td>each</td>
<td>$25.00</td>
<td>$0.00</td>
<td>$25.00</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>Active</td>
</tr>
<tr>
<td>03</td>
<td>CUSTOM THIRD VAC</td>
<td>1</td>
<td>active</td>
<td>each</td>
<td>$25.00</td>
<td>$0.00</td>
<td>$25.00</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>Active</td>
</tr>
</tbody>
</table>

Invoice Item Tax Setup Report

Use the Invoice Item Tax Setup Report to see which taxes are linked to invoice items. This report can be sorted by classification by description or classification by ID.

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Description</th>
<th>Type</th>
<th>Item Status</th>
<th>Tax Description</th>
<th>Tax Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>VACCINATIONS</td>
<td>0</td>
<td>active</td>
<td>Net Taxable</td>
<td>0.00</td>
</tr>
<tr>
<td>1150</td>
<td>VACCINATIONS</td>
<td>1</td>
<td>active</td>
<td>Sales Tax</td>
<td>7%</td>
</tr>
<tr>
<td>1180</td>
<td>VACCINATIONS</td>
<td>1</td>
<td>active</td>
<td>Sales Tax</td>
<td>7%</td>
</tr>
<tr>
<td>02</td>
<td>VACCINATIONS</td>
<td>0</td>
<td>active</td>
<td>Net Taxable</td>
<td>0.00</td>
</tr>
<tr>
<td>1170</td>
<td>VACCINATIONS</td>
<td>1</td>
<td>active</td>
<td>Net Taxable</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Pick Item Setup Report

Use the Pick Item Setup Report to print a list of invoice items set up as pick items.
Chapter 11: Other Inventory Setup Tasks

Overview

Once your invoice items have been set up in the IDEXX Cornerstone* Practice Management System, several additional setup tasks must be completed before you can start to use Cornerstone Inventory. These tasks include:

- Receiving past invoices.
- Transferring items to the appropriate locations (Multiple Location Inventory only).
- Viewing and confirming a stock transfer (Multiple Location Inventory only).
- Performing a cycle count.
- Viewing and adjusting quantity on hand (from View Quantity on Hand window).
- Adjusting quantity on hand and cost (from Adjustment List window).

Receiving Past Invoices

If you have any past invoices that need to be entered, enter these orders to allow your facility to see receipt and cost history for the items.

Note: Do not input past invoices after a physical count has been adjusted within Cornerstone, as receiving orders will add to the current quantity on hand.

To receive an order:

1. On the Inventory menu, select Receipt List.
2. Click Receive an Order. The Receive Order window appears.
3. From the **Vendor** drop-down list, select the vendor to receive stock from. If there are open, unfinished receipts for this vendor, these receipts appear in the **Open receipts for vendor** box. To complete one of the open receipts, select the receipt from the box.

4. In the **Receipt number** text box, type the receipt number and press TAB.

5. In the **Date** text box, enter the date the order was received. The default is today’s date.

6. A list of invoice items on open purchase orders appear for the vendor. To limit the list to one purchase order, from the **Purchase order number** drop-down list, select the applicable purchase order.

7. All the items on the selected purchase order(s) appear on the receipt. To receive order items, choose the option that applies:
   - To receive items individually, click the item in the **Status** list and select **Received**.
   - To receive all items on the order, click the **Receive all** button. The status of all items on the order changes to **Received**. The **Receive all** button is active only when all listed items have a Status of **Not received**.
     **Tip:** If you received a majority of the items from the vendor, select **Receive all** and then go back and enter any back ordered or cancelled items.
   - When an item’s entire order quantity is back ordered, click the item in the **Status** list and select **Backordered**.
   - When only part of the order item is back ordered, click the item in the **Status** list, select **Received**, and in the **Qty** text box, type the quantity received. This creates a second line showing the back order quantity with a status of **Not Received**. Click the second line **Status** item and change the Status to **Backordered**.
   - When an item’s entire order quantity is cancelled, click the item in the **Status** list and select **Cancelled**.
   - When only part of the order item is cancelled, click the item in the **Status** list, select **Received**, and in the **Qty** text box, type the quantity received. This creates a second line showing the cancel quantity with a status of **Not Received**. Click in the second line **Status** item and change the Status to **Cancelled**.
   - To add a received item that is not listed on a purchase order, on the empty line at the end of the list of ordered items, in the **ID** text box, enter the item’s ID and fill in remaining fields, such as quantity.

8. Click the **Receipt item detail** button to receive items into a specific location, to add lot numbers, and/or add expiration dates.
Chapter 11: Other Inventory Setup Tasks

9. When finished receiving items, choose one of the following:
   • Click **Save** to save the receipt. Saved receipts can be edited.
   • Click **Save and Print** to save the receipt and print a copy of the receipt.
   • Click **Post** to post the receipt. The Change Prices window appears. If necessary, click a received item and change its markup or margin percentage, price, dispensing fee and/or minimum price. When finished, click **Post** to return to Receipt List window. Posted receipts cannot be edited.

   ![Change Prices window]

**Transferring Items to the Appropriate Locations (Multiple Location Inventory Only)**

The Find and Transfer feature can be used by practices that have inventory items in multiple locations. Inventory is often physically moved from one location into another to replenish the inventory. This feature is used to track this type of stock movement within Cornerstone.

**To find and transfer items:**

1. On the **Inventory** menu, select **Find and Transfer Items**. The Find and Transfer Items window appears.
2. In the **Transfer to area Location** drop-down list, select a location to be stocked.
   **Note:** A red line item in the **Transfer to** area indicates the product is at or below the recommended reorder point that the practice has set.
3. To narrow the list of inventory items to those at or below the reorder point set by the practice for the selected location, select the **Show only items that are low** check box.
4. Search for and select an item to add to the **Transfer to** list in the Item field; click **Add Item** to include this item on the transfer list.
5. In the *Transfer from* area, to display quantities available for transfer from the specified group of supply locations only, select a location group from the *Show group* drop-down list.

6. Enter the amount to be transferred from the locations listed in the *Transfer from* area’s *Transfer qty* text box located in the lower left area of the window.

7. Click **Transfer** to move the quantities from the location(s) selected to the location above. The quantities transferred from a location appear in parenthesis with a negative sign (- ###) in the *Transfer from* bottom grid and the quantities transferred to a location appear in parenthesis with a positive sign (+ ###) in the *Transfer to* top grid.

   **Note:** It may be necessary to use the scroll bar to the right to view this information on the list.

8. Click **View details** to look at specific transfer information for a highlighted item. The Items being transferred to [Name of Location] window displays the amount to be transferred from other locations. If the amount is not going to be transferred from a location, highlight the line item and click **Delete**. Click **Back** to return to the Find and Transfer Items window.

9. Click **Save** to process the transfer. The Transfer Details report appears. Use this report to view the details of the transfer.

10. Click **Back** to return to the Find and Transfer Items window.

11. Click **X** to close the Find and Transfer Items window.

   **Note:** Once a stock transfer has been saved, it cannot be altered. To correct an error, issue another transfer. If confirmation is required by the practice, another staff member or management must confirm the transfer in the Stock Transfer List.
Viewing and Confirming a Stock Transfer (Multiple Location Inventory Only)

Staff can verify and approve details to confirm the physical transfer of items from one location into another performed in the Find and Transfer Items window by other staff personnel. This is only necessary if the Auto confirm stock transfer check box is not checked in Inventory defaults (see “Inventory Defaults” on page 109).

To search for a stock transfer:
1. On the Inventory menu, select Stock Transfer List.
2. Enter dates in the From and To text boxes to narrow the list of transfers to those performed within a specific date range.
   Note: The From text box is automatically completed with a date two weeks prior to the system date; the To text box is automatically completed with the current system date. This information can be modified.
3. To narrow the list of transfers to the specified transfer location, select the location into which the inventory items were transferred from the Transferred to drop-down list.
4. To narrow the list of transfers to a specific category, select the status of the inventory transfer from the Status drop-down list. Status options include:
   • All—Includes all transfers.
   • Unconfirmed—Transfers waiting to be confirmed.
   • Confirmed—Transfers validated by another person or automatically confirmed by Cornerstone if the default is set.
5. Click Search to find transfers that match the criteria entered in the Search for a transfer area.

To confirm a stock transfer:
Note: Confirming transfers is only necessary if the Auto confirm stock transfer check box is not selected in Inventory defaults (see “Inventory Defaults” on page 109).
1. From the Stock Transfer List, highlight a transfer with the status of Unconfirmed.
2. Click Confirm Transfer to verify the transfer performed by another staff member in the Find and Transfer Items window is accurate and complete. The Confirmation of Transfer window appears.
Confirmation of Stock Transfer window

3. If necessary, modify the quantity to transfer in the **Qty actual** text box.
4. Click **Confirm**.
   
   Cornerstone returns to the Stock Transfer List window; the status of the transfer is now marked as confirmed.

**Performing a Cycle Count**

Use the Inventory–Counts Report to perform a cycle count of inventory items marked to maintain quantity on hand. The report lists the current quantity on hand for each item and provides a space to write the actual number of items physically available for each item.

**To perform a cycle count using the Inventory–Counts Report:**

1. On the **Reports** menu, select **Find a Report**. The Report Search window appears.
2. In the Reports list, click the plus sign to the left of **Inventory**, and then select the **Counts Report**.
3. Click **Create report**, and then click **Run**.
4. In the **Sort by** drop-down list, specify the desired sort order for the report (sort by Item Description, Location or Class ID).
5. In the **Set report range** area, specify a range if you want to filter the information to be included in the report.
6. Click **Print Now** to print the report immediately to the default printer, or click **Print** if you want to specify the printer and print range options before printing.
7. Perform a physical count of inventory items and enter the number of items in the **Actual** column on the printed report.
Viewing and Adjusting Quantity on Hand (View Quantity on Hand window)

Once a physical count of inventory is complete, the next step is to adjust the quantity on hand (QOH) within Cornerstone. Use the Adjustment feature to correct quantities and, if tracking, correct expiration dates and lot numbers for items marked to maintain QOH within Cornerstone. Adjustments are generally made because of a physical count of inventory, damaged or expired products, and entry errors.

**Note:** Only items marked to maintain QOH display on this list. (Items are marked to maintain QOH by selecting the **Maintain QOH** check box in the Invoice Item Information Inventory tab.) If an item is marked to maintain QOH and does not appear, it is possible it has zero quantity within Cornerstone or it is an adjustment that has not been confirmed. In this instance, use the **New QOH Adjust** option to perform the adjustment.

Several buttons are available on the View Quantity on Hand window:

- Click **New QOH Adjust** to adjust QOH and location.
- Click **Edit QOH** to adjust QOH only.
- Click **Edit Lot + Exp** to edit lot number and/or expiration date.

**To access the View Quantity on Hand window:**

- On the **Inventory** menu, select **View Quantity on Hand**.

**View Quantity on Hand window**

**Note:** Adjustments can also be made from the Adjustment List (by staff with required security permissions). See "Adjusting Quantity on Hand and Cost (Adjustment List window)" on page 259.

**To search for an inventory item:**

1. On the View Quantity on Hand window, select an area from the **Location** drop-down list to narrow the list of tracked inventory items to those assigned to the location.
2. Select a classification from the **Classification** drop-down list to narrow the list of inventory items to those assigned to a specific category.
3. Search for and select an inventory item in the **Item** text box to view information for the specific item.
4. Select the **Only show items with a negative quantity** check box to view only inventory items with a negative quantity in Cornerstone.

5. Click the **Advanced Search** button to narrow the list of items to a specific location group (multiple location inventory only), location type (multiple location inventory only), lot number, expiration date range and/or total cost range.

**To adjust a single item:**

1. On the View Quantity on Hand window, highlight an item to adjust and click **Edit QOH** or click **New QOH Adjust** to search for and select an item to adjust. The Make Quantity on Hand Adjustment window appears.

![Make Quantity on Hand Adjustment window](https://via.placeholder.com/150)

**Note:** If an item is selected for editing, the following fields will be filled in for the inventory item: UOM, Location, Expiration date, Lot number, and Quantity.

2. If the **New QOH Adjust** was selected, do the following:
   a. Search for and select the inventory item to adjust in the **Item** text box. The selling unit of measure displays in the **UOM** text box and the amount in stock according to Cornerstone is listed in the **Quantity** text box.
   b. Select the location of the item being adjusted from the **Location** drop-down list.
   c. If applicable, enter the expiration date of the inventory item being adjusted in the **Expiration date** text box.
   d. If applicable, type the lot number of the inventory item being adjusted in the **Lot number** text box.

3. Type the actual quantity available of the item in the selected location in the **Actual** text box. The **Change** text box will display the adjusted quantity (Actual–Quantity = Change).

4. Select an explanation for the adjustment from the **Adjustment reason** drop-down list.

5. Click **Save** to process the adjustment. The View Quantity on Hand window will display the updated information.
To adjust multiple items:
1. On the View Quantity on Hand window, select the items that need to be adjusted.
   - To select nonconsecutive items, hold down CTRL, and then click each item you want to select.
   - To select a consecutive group of items, click the first item, hold down the SHIFT key, and then click the last item.
2. Click Edit QOH to adjust the existing quantity on hand for each item.
3. Enter necessary information for the first item on the Adjusting records list.
4. Click Next Record to advance to the next available item or click Previous Record to return to the last available item.
5. Enter necessary information for each item.
6. Once all items have been updated, click Save to process the adjustments.

To edit the expiration date and/or lot number for an item:
1. On the View Quantity on Hand window, select the applicable item.
2. Click Edit Lot & Exp. The Make Quantity on Hand Adjustment window appears.
3. If applicable, change the expiration date of the item in the Expiration date text box.
4. If applicable, change the lot number of the item in the Lot number text box.
5. Select the reason for the adjustment from the Adjustment reason drop-down list.
6. Click Save to process the change.

Adjusting Quantity on Hand and Cost (Adjustment List window)
Staff/management can use the Adjustment List to verify and approve the adjustment of tracked inventory items performed in the View Quantity on Hand window by other staff personnel. This window can also be used to adjust the vendor’s cost of an item within Cornerstone.

Note: The staff member who will use the Adjustment List to make inventory changes must have appropriate security permissions in Cornerstone.

To search for adjustments:
1. On the Inventory menu, select Adjustment List. The Adjustment List window appears.
2. Select an area from the Location drop-down list to narrow the list of adjustments to those assigned to the location.

3. Select a status from the Status drop-down list to narrow the list of adjustments to a specific status. Status options include:
   - Unconfirmed—QOH adjustments waiting to be confirmed or voided
   - Confirmed—QOH adjustments validated by another person or automatically confirmed by Cornerstone if the default is set.
   - Voided—Cancelled QOH adjustments (only available if confirming adjustments)

4. Enter dates in the Date From/To text boxes to narrow the list of adjustments to those within a specific date range.

5. To narrow the list of items to a specific location group (only for multiple location inventory), item, classification, and which staff member made the adjustment, click Advanced search.

6. Select an adjustment and click View to display the adjustment information. When you are finished viewing the information, click Back to return to the Adjustment List.

7. Click Print to preview, print or save the Inventory–Adjustment Report.

8. If confirming adjustments before applying changes, highlight an adjustment with a status of Unconfirmed and click Confirm. If a confirmation message appears, click Yes.
   
   Note: Confirming adjustments is only necessary if the Auto confirm adjustments check box is not selected in Inventory defaults (see “Inventory Defaults” on page 109).

9. If an adjustment is incorrect, highlight the Unconfirmed adjustment and click Void. If a confirmation message appears, click Yes.

To make a Quantity on Hand adjustment:


   ![Make Quantity on Hand Adjustment window](image)

   Make Quantity on Hand Adjustment window

2. In the Item text box, search for and select the tracked inventory item that needs a quantity on hand adjustment. The selling unit of measure displays in the UOM text box.

3. Select the location the item belongs to in the Location drop-down list.

4. If applicable, select or enter the expiration date for the item in the Expiration date text box.
5. If applicable, select or enter the lot number for the item in the Lot number text box.
6. Type the actual quantity available of the item in the selected location in the Actual text box. The Change text box will display the adjusted quantity (Actual–Quantity = Change).
7. Select an explanation for the adjustment from the Adjustment reason drop-down list.
8. Click Save.
Section 4–Scheduling and Patient Visit Setup

Chapter 12: Setting Up the Appointment Scheduler
Chapter 13: Setting Up the Electronic Whiteboard
Chapter 14: Setting Up a Reminder System
Overview

The Appointment Scheduler is used by a practice to schedule appointments for patients. The settings you specify when setting up the Appointment Scheduler affect how you will view and use the Schedule for Today window, the main window used for scheduling and tracking patient appointments.

Before using the Appointment Scheduler, you will need to complete the setup tasks listed below to ensure that your system is configured properly.

Note: Information on setting up rooms, hours and holidays is provided in other Cornerstone Administrator’s Manual chapters (as indicated below, following each of these tasks). The remaining checklist tasks are covered in this chapter in the following pages.

- Create an appointment scheduling plan
- Set up rooms to appear as column headers on the Schedule for Today window (see “Rooms” on page 69)
- Set up practice hours (see “Appointment Scheduler–Practice Hours Defaults” on page 90)
Chapter 12: Setting Up the Appointment Scheduler

- Set up practice holidays (see “Appointment Scheduler–Holiday Defaults” on page 89)
- Set up staff schedules
- Set up daily staff revenue goals for each room
- Set up links to reasons for visit
- Set up schedule templates to define the appearance of the Schedule for Today window
- Assign practice templates to days of the week
- Set up appointment suite templates

Note: Remember to have a Cornerstone Administrator adjust Appointment security settings as needed for each staff member.

Creating an Appointment Scheduling Plan

You should define an appointment scheduling plan for your practice before setting up rooms. When creating your plan, consider the following key questions:

- Will you schedule appointments by staff member or by room/location?
- What room name (staff name, staff title, location, etc.) do you want to assign to each column displayed in the Schedule for Today window?
- Should there be a separate Surgery column, or are surgeries scheduled in a doctor’s column?
- Will appointments be scheduled for Drop-offs, Groomers, or Technicians?
- Will overbooking be allowed?

Setting Up Staff Schedules

Each staff member who sees patients by appointment needs to have a staff schedule set up. Each staff member’s hours must be defined in staff setup before appointments can be scheduled for that staff member (even if their hours are the same as the practice hours). This also ensures that scheduled hours appear correctly in the daily schedule.

To set up staff hours:
1. On the Controls menu, select Appointment Scheduler > Staff Setup.
2. Select the staff member and click Hours. The Staff Hours dialog box appears.

Staff Hours dialog box
Chapter 12: Setting Up the Appointment Scheduler

**Note:** By default, the staff member is scheduled to work all hours the practice is open.

3. To modify the hours the staff member may be available for appointments, click a time text box and enter the correct time. Clear the Open check box for any days the staff member is not scheduled to work.

**Note:** Individual staff times that differ from the practice hours display with a yellow background.

4. Make sure the Take lunch check box is selected and the correct times are entered if the staff member is unavailable during lunch.

5. Click OK.

**Note:** If you want to set up revenue goals for this staff member now, leave the Staff Setup window open and refer to the following section to set daily revenue goals for staff.

**Example:**

You would like to schedule appointments for Dr. Anne Carson at any time the practice is open. You must select her name in staff setup, click Hours, then click OK in the Staff Hours dialog box. Now her name will appear in the daily schedule in the drop-down list of staff names under the date.

**Setting Daily Revenue Goals for Staff**

Setting up staff schedules and setting staff goals will let you track the revenue generated daily by staff members for each room in your practice. Staff members are linked to revenue goals through rooms. If you schedule appointments for a staff member in a room not normally assigned to that staff member (i.e., they are not linked to the room through staff goals), a warning message will display.

**The Scheduled vs. Goal Ratio**

When you open the Schedule for Today window, your revenue goals are displayed in the upper-left corner near the staff listing. The first number is the scheduled revenue for the day (the sum of reason for visit usual amount or the appointment items added when the appointment is scheduled); the second number is the staff member’s revenue goal for the day.

For the Scheduled/Goal ratio to reflect useful information, staff members with appointments scheduled must have defined goals linked to rooms. As you schedule appointments, the ratio will automatically update. Using staff goals, you can see how close your practice is to achieving the revenue goals you set.

**Example:**

Dr. Jones’ practice schedules appointments in four rooms: Surgery Room 1, Surgery Room 2, Treatment and Grooming. Dr. Jones tries to schedule six hours of surgery time at $50 per hour every Wednesday and Friday in Surgery Room 1. The following must be set up for the Scheduled/Goals ratio to accurately reflect Dr. Jones’ goals:

1) The room Surgery Room 1 must be in the Room List.
2) Dr. Jones’ Wednesday and Friday schedule must have six hours of available time.
3) Dr. Jones’ goals must include $300 (6 hours * $50) in Surgery Room 1 on Wednesday and Friday.
Chapter 12: Setting Up the Appointment Scheduler

How it Works

The $300 of surgery revenue is included in the revenue goal (second number of the Scheduled/Goals ratio) every Wednesday and Friday. As patients are scheduled with Dr. Jones in Surgery Room 1, the usual amount set up in the reason for visit for the appointments is added to the scheduled revenue (first number of the ratio).

To set up staff revenue goals:
1. On the Controls menu, select Appointment Scheduler > Staff Setup.
2. Select the staff member and click Goals. The Staff Goals dialog box appears.

3. In the Room name column, use the drop-down lists to select the name of each room where the staff member may have an appointment scheduled.
4. If the practice tracks daily sales goals for a staff member, type the staff member’s revenue goal (dollar amount) for each day in each applicable room.
   
   **Note:** In order to generate an accurate Scheduled vs. Goals Report, dollar amounts must be entered in the Amount text box when scheduling.
5. Click OK.
   
   The staff member’s scheduled vs. revenue goals will appear in the upper left corner of the Schedule for Today window.

To review the status of staff revenue achievement vs. goals, print the Scheduled vs. Goal Report.

To delete a staff member’s daily revenue goals:
1. On the Controls menu, select Appointment Scheduler > Staff Setup.
2. Select the staff member and click Goals. The Staff Goals dialog box appears.
3. Select the goal to delete and press CTRL+D. You are prompted to confirm the deletion. Click Yes.
Link to Reasons for Visit

You can link information to the appointment types set up in the Reason for Visit list to make it easy to quickly enter appointment information in the schedule.

The following information can be linked to reasons for visit:

- The amount usually charged for the service
- The appointment color and text color (black or white) to be displayed on the schedule
- The staff member who normally provides the service
- The total amount of time required for the service
- The amount of time needed for the staff member to perform the service (of the total appointment time scheduled)

Note: Primary and secondary reasons for visit are set up in Controls > Reasons for Visit. See “Reasons for Visit” on page 22.

To set up Reason for Visit information:


2. Select the reason for visit to which you want to link the information and click Update. The Reason for Visit dialog box appears.

3. If the practice uses revenue goals for staff members, enter the Usual amount charged for this service.

4. Click Set Color or double-click in the Appt. color text box. The Color dialog box appears.
5. Click on the color to assign to this reason for visit and click OK. Do not use black (color of cursor) or white (color of Schedule for Today window background).

6. To define a custom color, click Define Custom Colors and click the area in the color spectrum with the color you want. When you are satisfied with your color selection, click Add to Custom Colors. Your color will appear under custom colors.

   **Tip:** Use pastel colors instead of bright colors and use similar colors within the same palette to group similar reasons for visit.

7. Select the text color (Black text or White text) so it can be seen on the background color in the schedule.

8. From the Performed by drop-down list, select the staff member who normally provides this service.

9. Enter the default Number of units of time (up to 25) the appointment type normally requires, or use the arrows to increase or decrease the number. The unit of time is a 10 or 15 minute interval, based on how the practice hours are set up.

10. From the Dr/Asst Time drop-down list, select the number of time units needed for the scheduled staff member to perform the service. For example, a recheck appointment may be scheduled to take 20 minutes, but the doctor will only be with the patient for 10 minutes. These time units appear on the schedule with an X next to the selected time slots (indicating that a staff member is scheduled to attend to the patient during that time period). You can check boxes without preassigning a staff member to the reason for visit.

11. Click OK.
Example:
A practice uses Feline Wellness Hist & Phy as a reason for visit. To use Feline Wellness Hist & Phy with the Appointment Scheduler, the following settings were defined:

Usual amount: $50,
Color: light green with black text
Performed by: (the doctor who normally performs feline checkups)
Number of units: 2
Dr/Asst Time: time unit 2 (the time that the doctor will actually attend the patient)

When a patient is scheduled for a Feline Wellness Hist & Phy, the appointment appears on the schedule like this (with the applicable background color):

The Usual amount of $50 is added to the scheduled revenue in the upper left corner of the Schedule for Today window. See “Setting Daily Revenue Goals for Staff” on page 265.

Designing a Schedule Template
Template designs define the appearance of the Schedule for Today window for each day of the week a template is assigned. It is used as a general guide for staff when scheduling appointments and should only be set up when your practice has a standard weekly schedule.

Note: Rotating schedules for surgery days or days off cannot be set up through templates. Instead, block times for staff members on the Schedule for Today window, keep a rotation sheet available and make appointments accordingly.

You can assign a schedule template as a default template to each day of the week. This is useful for days when a room is not used or when rooms are used for specific types of appointments. For example, on days when surgeries are performed, use a schedule template (named “Surgery Day”) that reflects how practice rooms are used on surgery days.

The templates you assign to specific days are also used for the Appointment Search. You can search for an available appointment for a specific reason for visit if you set up schedule templates accordingly and then use them as default templates.

To set up a schedule template:
1. On the Controls menu, select Appointment Scheduler > Template Designs.
2. Click New. The Template Designer will open with a column for each room divided into rows with your practice’s scheduled time units. (You can also press CTRL+N to add an item to a list.)
3. In the **Description** text box, enter a description for this template. The description may be a day of the week, staff name, general description or combination. For example, Surgery Day (on days when surgeries are performed), M,W,F (if Monday, Wednesday and Friday schedules are the same) or Monday–Friday (if the facility has the same schedule each day of the week).

4. The **Start time** and **End time** text boxes will display the earliest start time and latest end time you selected for your practice hours. Change the start and end times, if necessary. The schedule will automatically adjust to these times.

5. Select a beginning time slot for a room and click **Modify**, or double-click the time slot. The Template Detail dialog box appears.

   **Note:** Time units are increments of 10 or 15 minutes, depending on the time unit selected in the Appointment Scheduler - Hours defaults.

6. In the **Reason for visit** drop-down list, select a general reason for seeing patients during this specific time slot.

7. Type the time when this particular scheduling block should end in the **End at** text box, and then press **TAB**. The total number of time units for the block will display in the **Units** text box. (Conversely, you can enter the **Units** of time and the **End at** time will adjust accordingly.)

   **Note:** The Template Designer window will automatically adjust to the times listed here. This does not affect the Schedule for Today times, which are based on practice hours set in the Appointment Scheduler - Hours defaults.

8. Click **OK** to return to the Template Designer.

9. Continue to set up the remaining blocks of time as needed.
10. When finished, click OK to save the template.

**Note:** If you change the Template for a particular date in the Schedule for Today window, the default template assigned to that day of the week will still appear whenever you access that date. (The template used to schedule an appointment is not saved with the date.) If you plan to use a template other than the day’s default template for appointments on a specific date (for example, when a doctor is not in the office), save a note to use a different template for that date.

**To delete a template:**

A template cannot be deleted if it is currently being used as a default template, or if it is currently displayed in the Schedule for Today window or Schedule for Week window.

1. On the Controls menu, select Appointment Scheduler > Template Designs.
2. Select a template description and click Delete. (You can also press CTRL+D to delete a selected item from a list.) You are prompted to confirm the deletion. Click Yes.

**Assigning Practice Templates to Days of Week**

Once a template is created, it must be linked to the day(s) of the week it represents. Then, when viewing a specific day on the Schedule for Today window, the template appears automatically.

**Note:** If you define a default template for your daily schedules, the default template is also used when searching for available appointment times. First, the Appointment Search looks at the template for the day selected (for example, Friday), and then it searches for available times set up with the reason for visit.

1. On the Controls menu, select Appointment Scheduler > Practice Setup > Templates. The Practice Template dialog box appears.

   ![Practice Template dialog box](image)

2. From the Monday drop-down list, select the template you want to use to schedule appointments for Monday. If you do not want to use a template for that day, select (None).
3. Repeat this process for Tuesday through Sunday, depending on the days your practice is open.
4. Click OK.
Setting Up Appointment Suites

The Suite Setup feature is used to display selected columns for individual staff members. Using appointment suites, you can group rooms together and arrange the order in which the rooms appear on the daily and weekly schedules. (For example, you may want to group all your boarding rooms together and all your examination rooms together.) If new appointment rooms are added after you set up the suite feature, the room(s) will be added to the bottom of each suite. A default suite will automatically be set up that contains all the rooms in your system. This suite cannot be changed or deleted.

To set up your appointment suites:

2. Click New to add a new suite. The Suite Information dialog box appears.

   ![Suite Information dialog box]

3. In the Suite description text box, type the name of the suite.
4. For the Columns on grid setting, click the number of columns (4, 6 or 8) you want to display when this suite is viewed on the Schedule for Today window.
5. In the Display column, select the check box next to each room that you want to include in the suite.
6. To arrange the order in which the rooms will display, highlight a room and click the ↑ or ↓ arrow button to change its position as needed.
7. Click OK.
This chapter covers the steps required to set up the Electronic Whiteboard the IDEXX Cornerstone Practice Management System. For information on entering treatment orders and other daily usage tasks in the Whiteboard, see “Chapter 10: Using the Electronic Whiteboard” in the Cornerstone User’s Manual.

Overview

The IDEXX Cornerstone* Practice Management System features an Electronic Whiteboard where all treatments for patients can be ordered and tracked by staff. Upon completion of patients' treatments, treatment items are automatically placed on the Patient Visit List and completed treatments are placed in patient history.

The Electronic Whiteboard comes ready to use. Standard categories (vital signs, treatments, etc.), frequencies (SiD, BiD, etc.) and patient hospital statuses (Inpatient, Ready to go home, etc.) have been provided so that no setup is required. However, if desired you can customize the Electronic Whiteboard setup to better meet the needs of your practice using the following setup tasks.

Note: Information on setting up Whiteboard defaults, patient hospital statuses and wards/locations is provided in other Cornerstone Administrator’s Manual chapters (as indicated below, following each of these tasks). The remaining setup tasks are covered in this chapter in the following pages.

- Set up Whiteboard defaults (see “Whiteboard Defaults” on page 144)
- Set up treatment categories
- Set up patient hospital statuses (see “Patient Hospital Status” on page 70)
- Set up wards/locations (see “Wards/Locations” on page 71)
- Set up treatment areas
- Set up treatment frequencies
- Set up Whiteboard alerts

Note: Remember to have a Cornerstone Administrator adjust Whiteboard security settings as needed for each staff member.

Setting Up Treatment Categories

Treatment Categories manage the way tasks are grouped on the Electronic Whiteboard’s Patient Treatments window. The categories are selected on the Patient Orders window and then organized and displayed on the Patient Treatments window’s Treatments column.

There are several categories set up within Cornerstone already, including Vital Signs, Diagnostics, Treatments, Medications, Daily Care, and Communication/Discharge.

To add or edit a treatment category:

1. On the menu bar, select Lists > Electronic Whiteboard > Categories. The Treatment Category List dialog box appears.
2. Click New to add a new category or double-click an existing category to update it. The Treatment Category Information dialog box appears.
3. In the **Description** text box, type or edit the name used to describe the category.

4. Click **OK** and then click **Close**.

**To set the order of the Category drop-down list (available in Patient Orders):**

1. On the menu bar, select **Lists > Electronic Whiteboard > Categories**. The Treatment Category List dialog box appears.

2. Click **Order**. The Treatment Category Display Order dialog box appears.

3. For each category you want to move, highlight the category and use the ▼ and ▲ arrow buttons to move the category to a different position on the list.

4. When you have finished setting the order of the list, click **OK** and then click **Close**.

**Setting Up Treatment Areas**

Treatment areas are locations within the practice where inpatient orders are scheduled to be performed. With treatment areas set up in Cornerstone, it is possible to assign an area to a specific treatment order on the Patient Orders window. This allows staff to narrow the list of patients/treatments that display on the Whiteboard and Patient Treatments window to a specific area.

For example, with the Lab and Radiology/X-ray treatment areas set up, you can easily edit the filters on the Whiteboard to select one of these areas and narrow the list of patients to show only those needing an x-ray or needing lab work.

**To add or edit a treatment area:**

1. On the menu bar, select **Lists > Electronic Whiteboard > Areas**. The Treatment Area List dialog box appears.

2. Click **New** to add a new area or double-click an existing area to update it. The Treatment Area Information dialog box appears.

3. In the **Description** text box, type or edit the name used to describe the treatment area.

4. Click **OK** and then click **Close**.

**Setting Up Treatment Frequencies**

Treatment frequencies are used to determine how often and when a treatment is scheduled for an inpatient on the Whiteboard. The Treatment Frequency List allows you to set up treatment frequencies to occur **Every day** or **Every x days**. The frequencies set up here display as options in the **Frequency** field on the Patient Orders window when adding treatment orders for a patient.

Some common frequencies are included with Cornerstone, including Continuous, One time, Until Completed, SID (once a day), BID (twice a day), TID (three times a day), QID (four times a day), and frequencies performed "Every x number of hours" (e.g., Every 4 hours—q4h).

Some frequencies cannot be updated or deleted, including Continuous, One time, Until Completed and frequencies performed "Every x number of hours."

**To add or edit a treatment frequency:**

1. On the menu bar, select **Lists > Electronic Whiteboard > Frequencies**. The Treatment Frequency List dialog box appears.

2. Click **New** to add a new treatment frequency or double-click an existing frequency to update it. The Treatment Frequency Information dialog box appears.

3. In the **ID** text box, type a unique identification code to use for this frequency (e.g., BANCHG).
4. In the **Description** text box, type a name used to describe the frequency (e.g., Bandage Change).

5. Do one of the following:
   - If this frequency applies to treatments that will be performed every day, click the **Every day** option and then click to place a check mark next to each default time a treatment should be performed for this frequency.
   - If this frequency applies to treatments that will be performed every 2 to 7 days, click the **Every x days** option, select a recurrence of every 2 to 7 days, and then specify the time you would like the treatment to occur on those days.

6. Click **OK** and then click **Close**.
To set the order of the Frequency drop-down list (available in Patient Orders):

1. On the menu bar, select Lists > Electronic Whiteboard > Frequencies. The Treatment Frequency List dialog box appears.
2. Click Order. The Treatment Frequency Display Order dialog box appears.
3. For each frequency you want to move, highlight the frequency and use the ↑ and ↓ arrow buttons to move the frequency to a different position on the list.
4. When you have finished setting the order of the list, click OK and then click Close.

Setting Up Whiteboard Alerts

The Whiteboard Alerts List allows your practice to create a list of commonly used hospitalized patient alerts to be displayed on the Electronic Whiteboard windows for the current visit.

Note: Whiteboard alerts can also be free-form typed for each patient at the time of use as needed. (Alerts entered manually at the time of use are not saved in your Whiteboard Alerts List.)

To add or edit a Whiteboard alert:

2. Click New to add a new alert or double-click an existing alert to update it. The Add/Edit Whiteboard Alert dialog box appears.
3. In the Description text box, type the alert text as you want it to display at the time of use on the Whiteboard.
4. Click OK and then click Close.
Chapter 14: Setting Up a Reminder System

Overview

A reminder is a means of following up with a client about a patient’s specific needs; for example, a reminder to make a phone call or a reminder to send a letter, postcard, or email.

Reminders are a vital component of the IDEXX Cornerstone® Practice Management System. Using reminders, you can:

- Easily contact your clients regularly
- Remind clients of appointments
- Inform clients of medical updates or new products
- Analyze the productivity of your practice

Reminders are also a means of contacting clients who meet specific criteria. Cornerstone software places reminders in a patient’s record when:

- An invoice item linked to a reminder is added to an invoice for the patient.
- A reminder is entered manually in the patient’s reminder information.

For information on linking reminders to invoice items, see “Adding Reminder Information to Invoice Items” on page 192.

Reminder Printing Options–Cornerstone or Microsoft® Word®

The process of generating reminders is done entirely within Cornerstone. As part of this process, the Cornerstone software searches all of the patient reminder files (that meet the criteria you specify) and pulls the reminder information data into a text (.txt) file. This file can then be used to merge the data into reminders that can be printed using Cornerstone software or printed/emails using Microsoft Word.

The process is summarized as follows:

1. Use Cornerstone software to produce the list of clients/patients to whom reminders will be sent.
2. Do one of the following:
   - Use Cornerstone software to print reminder cards with options to include a Postal Bulk Rate (PRESORTED STANDARD) stamp, a pet picture, and/or a four-line reminder message.
   - Use predefined Microsoft Word templates (or other applicable word processing programs) to merge the list of clients and patients into documents that can be printed or emailed.
What Information Prints on a Reminder?

Each reminder template contains the following information:

- Practice name and address (the templates must be customized with your practice’s name and address)
- Patient name
- Client ID, name and address
- Postage information (when applicable)

In most cases, you will need to update the practice name, address and phone, reminder text and postage information to meet your practice’s needs. You can later change these settings by editing the reminder template.

Sample reminder card:

Countryside Animal Medical Clinic
Drs. Papp, Williams, Orosz & Hogue
8338 Main Street
Eau Claire, WI  54701
Phone: 715-555-5432

A reminder that Ghost is due for:
4/6/09  Feline 3 + IMRAB

Your pet’s health is very important to us.
Please call our office for an appointment.

To view reminders, print a Reminder Letter Report.

Reminder Strategies

The Cornerstone reminder system is an important means of contacting clients. With a solid reminder strategy, you can do the following:

- Protect your client base
- Enhance client loyalty
- Improve preventative care
- Increase revenue
- Improve compliance

To use reminders effectively, predetermine and follow a strategy for generating and sending reminders.

Invoice Items and Reminders

When an invoice item that has reminders linked is included on an invoice, Cornerstone automatically places a reminder (or several reminders) in the patient’s file. When the due date is reached, you can print postcards or letters that list these invoice items. See “Adding Reminder Information to Invoice Items” on page 192 for information.
Generally, there are two ways to set up reminders on invoice items and you are encouraged to use both simultaneously.

- Method 1—Set up items that are purchased sequentially
- Method 2—Set up items that are interchangeable

Method 1—Set up items that are purchased sequentially

Items set up sequentially should satisfy all earlier items in the sequence. If a client skips one part of the series, the existing reminders should still be satisfied.

**Example:**

When Molly was one month old, Ms. Carlyle brought her in for her DHLPP 1st vaccination. This invoice item DHLPP1 generated a reminder for another invoice item DHLPP2. When Molly was two months old, however, Ms. Carlyle forgot to bring her in for the DHLPP 2nd vaccination. The practice used Cornerstone to generate a second (unsatisfied) reminder for the DHLPP 2nd vaccination.

Ms. Carlyle brought Molly back in when she was three months old. At this time, Dr. Morris decided to administer the DHLPP 3rd vaccination instead of the DHLPP 2nd. Because Dr. Morris’ reminder system was set up correctly, Ms. Carlyle will not receive another reminder for the DHLPP 2nd even though Molly never received the vaccination. The DHLPP 3rd vaccination satisfied the DHLPP 2nd vaccination and also generated a reminder for a yearly DHLPP Booster.

Method 2—Set up items that are interchangeable

Interchangeable services should satisfy each other.

**Example:**

A practice interchanges two different types of heartworm tests, Heartworm Antigen and Heartworm Occult. Each of these items generates a reminder in 12 months for the same service. In 2004, Ranger gets the Heartworm Antigen. A reminder is created in 2005 for the Antigen test. When Ranger returns to the practice in 2005, Dr. Randolph decides to use the Occult test instead. In order for Cornerstone to delete the existing reminder for the Antigen test, the reminder for the Occult test must also satisfy the reminder for the Antigen test and vice versa.

**Call vs. Letter Reminders**

Patient reminders provide two options for contacting clients—calls and letters.

- **Call** refers to “call backs” or “recalls” that you can view on the Reminder Recall Report or on the Daily Planner. Calls are used to contact clients in more immediate situations, such as follow-up calls after a surgery and reports on hospitalized animals.

- **Letter** refers to a printed reminder. Reminder letter formats include postcards, letters and email reminders.
**Classifications and Flagged Owners**

By classifying clients and flagging owners, you can narrow the focus of your reminders. Some common strategies include:

- Using classifications for various types of clients (preferred, seasonal, etc.). For example, use a classification of Seasonal-W for winter clients. Clear the **Send reminders** check box (**Controls > Classifications**, select the **Client** tab) for that classification during the summer months when you do not want to send reminders to winter clients.

- Using flagged owners to narrow your reminder list. Clients who have the **Send reminders** check box selected in the Patient Owner Information dialog box are considered “Flagged Owners” and will receive mailings sent to flagged owners if their classification is selected. Flagged Owners may be your best clients who receive more frequent reminders.

**Note:** See “Generating Your Reminders” beginning on page 288 for information on selecting classifications and flagged owners when generating reminders.
Setting Up a Reminder System

The following example is of a *three-tiered reminder system*. This means that reminders are generated twice each month (such as at the beginning of the month and at mid-month). Note that this is an ongoing activity; this example only follows reminders that were due between 2/1 and 2/29.

**Note:** This is just one example of a reminder system. Your practice should form its own reminder strategy.

<table>
<thead>
<tr>
<th>Date Reminders Were Generated (Mailed)</th>
<th>Reminder Due Dates (Date Range)</th>
<th>Future or Overdue</th>
<th># Time Sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/15</td>
<td>11/1 - 11/30</td>
<td>Future</td>
<td>1st</td>
</tr>
<tr>
<td></td>
<td>2/1 - 2/29</td>
<td>Overdue</td>
<td>3rd</td>
</tr>
<tr>
<td>1/31</td>
<td>12/1 - 12/31</td>
<td>Overdue</td>
<td>2nd</td>
</tr>
<tr>
<td>2/15</td>
<td>12/1 - 12/31</td>
<td>Future</td>
<td>1st</td>
</tr>
<tr>
<td></td>
<td>3/1 - 3/31</td>
<td>Overdue</td>
<td>3rd</td>
</tr>
<tr>
<td>2/29</td>
<td>1/1 - 1/31</td>
<td>Overdue</td>
<td>2nd</td>
</tr>
<tr>
<td>3/15</td>
<td>1/1 - 1/31</td>
<td>Future</td>
<td>1st</td>
</tr>
<tr>
<td></td>
<td>4/1 - 4/30</td>
<td>Overdue</td>
<td>3rd</td>
</tr>
<tr>
<td>3/31</td>
<td>2/1 - 2/29</td>
<td>Overdue</td>
<td>2nd</td>
</tr>
<tr>
<td>4/15</td>
<td>5/1 - 5/31</td>
<td>Future</td>
<td>1st</td>
</tr>
<tr>
<td></td>
<td>2/1 - 2/29</td>
<td>Overdue</td>
<td>3rd</td>
</tr>
</tbody>
</table>

The first time this group of reminders was sent was two weeks before the first reminder was due.

The second time this group of reminders was sent was when the reminder was two months overdue.

The third (and last) time this group of reminders was sent was two weeks after the second set.

**To calculate your return on reminders**

You can calculate the financial return you’ve gained by using reminders. The *compliance rate* (satisfied reminders) shows the effectiveness of your reminder system. Use the following table to calculate your response rate of satisfied reminders. When you generate your reminders, make a note of the number generated so you can accurately calculate the return.

**Note:** You can use this same method for calculating a response rate on cards generated.
Chapter 14: Setting Up a Reminder System

<table>
<thead>
<tr>
<th>Month</th>
<th>1st A</th>
<th>2nd B</th>
<th>3rd C</th>
<th>4th D</th>
<th>1st A - B</th>
<th>2nd B - C</th>
<th>3rd C - D</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>492</td>
<td>336</td>
<td>239</td>
<td>220</td>
<td>32%</td>
<td>29%</td>
<td>8%</td>
<td>69%</td>
</tr>
<tr>
<td>February</td>
<td>526</td>
<td>347</td>
<td>271</td>
<td>255</td>
<td>34%</td>
<td>22%</td>
<td>6%</td>
<td>62%</td>
</tr>
<tr>
<td>March</td>
<td>427</td>
<td>303</td>
<td>225</td>
<td></td>
<td>29%</td>
<td>26%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>April</td>
<td>359</td>
<td>215</td>
<td></td>
<td></td>
<td>36%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>May</td>
<td>395</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A = # 1st reminders sent, B = # 2nd reminders sent, C = # 3rd reminders sent, D = # 4th reminders (not printed)

Tips for Using Reminders Effectively

- Confirm that interchangeable items satisfy each other.
- Decide on a strategy that works realistically for your practice.
- Track the response rate by keeping track of the number of cards generated for each group each time they are generated. Do not generate two time frame groups together (such as 5/1 - 5/31 and 2/1 - 2/29).
- Set up a method to track when you send reminders. One method of tracking is to use a calendar and three (or the number of times each group of reminders is sent) colored highlighters to track the number of times you have mailed that group of reminders. Circle the date that the first round was generated, and continue to circle that date with a different color as each consecutive round is generated.
- Verify that your reminders are set up in the system correctly. Run an Invoice Item Reminder Information Report to check.
- Be attentive to overdue reminders. Choose a certain period of time (such as monthly or yearly) and pull out the clients that haven’t visited within a specific time period. Send these clients a letter or call them to let them know that you are concerned for their pet and that you would like an update of their pet for your files.
- Talk to one client at a time. As clients come in to your practice, check the reminders on all of their pets. If any reminders are overdue, ask them for an update of that pet. (You can preview a Check-In Report for each animal who enters your practice and look for any overdue reminders.)
- Use Cornerstone performance tracker to gather information about client’s compliance with your recommendations. See “Chapter 27: Using Cornerstone Performance Tracker” beginning on page 441 for more information.

To view a list of reminders that each item generates and satisfies, print the Invoice Item Reminder Information Report.
Cornerstone Reminder Card Setup

If you use Cornerstone software to print reminders, the following items can be printed on reminder cards:

- Postal Bulk Rate (PRESORTED STANDARD) stamp
- Pet pictures
- Four-line reminder message

You can also easily change the alignment and placement of reminder information on reminder cards.

**Setting Up a Bulk Rate (PRESORTED STANDARD) Stamp**

The U.S. Postal Service provides special postage rates for large mailings. If your practice sends a large number of reminders (200 or more), the special rate most likely applies. (There are some restrictions based on the size of the reminder card. Consult your local post office for details.)

To take advantage of the special rate:

- A permit number issued by the post office is required.
- A bulk rate (PRESORTED STANDARD) stamp must be printed on reminder cards.

**Note:** This feature applies only to reminder cards that are printed in Cornerstone, not Microsoft Word. To include a bulk rate stamp on a Microsoft Word reminder, type the bulk rate information and permit # for the stamp on the applicable reminder template.

**To set up a bulk rate stamp:**

1. On the **Activities** menu, select **Reminder Selection > Reminder Print Options > Reminder Bulk Rate Permit Setup**. The Bulk Rate Permit Setup dialog box appears.

   ![Bulk Rate Permit Setup dialog box](image)

   Bulk Rate Permit Setup dialog box

2. Click on the **Permit #** line and type your permit number. Use care to not delete other bulk rate information. This information complies with U.S. Postal Service regulations and should be left as is.

3. Click on the **City, State** line and enter your city and state.

4. If necessary, click **Reset** to reset the bulk rate permit wording to the default standard bulk rate wording.

5. Click **OK**.

**Including Pet Pictures on Reminder Cards**

If you print reminder cards directly from Cornerstone (not Microsoft Word), you can include pet pictures on them. Up to four pictures can print on two and four card reminders and up to three pictures can print on three card reminders.

**Note:** This feature only applies to reminder cards that are printed in Cornerstone, not Microsoft Word.
To include pet pictures on reminder cards:

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click Workstation. The Workstation configuration pane appears on the right side of the window.
3. In the Print patient pictures on area, select Reminder to print pet pictures on reminders.
   
   Note: This setting must be set on each workstation.
4. Click OK.

Modifying Reminder Card Alignment and Placement

You can easily change the alignment and placement of Cornerstone reminder card information by modifying the reminder print options.

Note: This feature only applies to reminder cards that are printed in Cornerstone, not Microsoft Word.

To change alignment and placement of reminder card information:

1. On the Activities menu, select Reminder Selection > Reminder Print Options > Two/Three/Four Card Reminder Alignment. The Reminder Alignment dialog box appears.
2. To change the position of the information on the reminder cards, click a box and use your keyboard arrow keys to move it.

   **Note:** If you choose to include pet pictures on reminders, you need to set Workstation defaults to include reminders. See "Including Pet Pictures on Reminder Cards" on page 283 for more information.

3. To change the alignment back to the original reminder alignment, click **Reset**.

4. To print a test page to check the alignment, click **Test page**.

   **Note:** If you change the alignment of pet picture boxes (the small boxes marked Pix1, Pix2, etc.), we recommend that you test the alignment before printing all of your reminders.

5. Click **OK**.

**Creating a Reminder Message**

You can create reminder messages that print on the bottom of reminder cards. To match the reminder reason, a message can easily be changed each time reminders are generated. You can also create a number of different reminder messages. When you generate reminders, you can select the applicable message from a drop-down list. You can print one four-line message per card.

Other reminder message options allow you to do the following:

- Change the standard Patient message (A reminder that [name] is due for:) to wording of your choice.

- Add a reminder message line for overdue reminders. If you include overdue reminders on reminder cards, this message precedes the overdue reminders.

- Select one set of reminder messages as the default set.

   **Note:** This feature applies only to reminder cards that are printed in Cornerstone, not Microsoft Word.
To set up a reminder message:

1. On the Activities menu, select Reminder Selection > Reminder Print Options > Reminder Message Setup.

2. Click New to add a new message or double-click an existing message to update it. The Reminder Message window appears.

3. In the Message title text box, type the name you want to use for this message. This title will not appear on the reminders, but will appear in the Reminder Message dialog box.

4. In the Patient message text box, type the text that you want to print for the patient message line on the reminder card and press TAB. To include a patient name bookmark in the text, enclose name in brackets (e.g., [name]).

5. In the Past due message text box, type a message line to precede past due reminders. This line prints only if past due reminders are found and included on a patient’s reminder card. If this message is not entered, past due reminders are included with reminders that are currently due for the selected date range.

6. In the Reminder message details area, type the text of your message. Your message is limited to four lines of 60 characters each.

7. If you want this message to be the current message used on your reminder, select the Default message check box. Only one message can be selected as the default.

   Note: A default message is not required. You can select a message when generating reminders.

8. Click OK and then click Close.
Microsoft Word Reminder Card Setup

Reminder templates that can be used when you print reminders using Microsoft Word are included with the software. Before using the templates for reminders, edit the templates to include your practice name, address and telephone number.

Reminder templates included with your software include:

- **reminder2.dot**—Use to print two postcard reminders on a laser printer.
- **lasrem3s.dot**—Use to print three postcard reminders on a laser printer.
- **reminder4.dot**—Use to print four postcard reminders on a laser printer.
- **postcrds.dot**—Use to print postcard reminders on a dot-matrix printer.
- **trifolds.dot**—Use to print letter size reminders which can be folded in thirds and mailed.

**Before You Begin**

1. Save a copy of the .dot (Word template) file that you want to change. You will find the reminder files in your Cornerstone directory (e.g., C:\Cstone). Save a copy in another folder or on CD.
2. Open Microsoft Word.

**Note:** Depending on the version of Microsoft Word you are using, the Word functions and dialog boxes referenced in this section may vary slightly from your version of Word. Refer to the Microsoft Word online Help for instructions specific to your version.

**To edit a reminder template in Word:**

1. In Microsoft Word, open the reminder template you want to use to print reminders:
   a. On the **File** menu, select **Open**.
   b. In the **Files of type** box, select **Document Templates (*.dot)** to view Word template files.
   c. Look in your Cornerstone directory (e.g., C:\Cstone) and select the file.
   d. Note the following:
      - If the Macro Virus Protection Warning box appears, click **No**.
      - If the Print dialog box appears, click **Cancel**.
      - If the Command Failed message appears, click **OK**.
2. Edit your practice information, messages and postage information. Remember to edit all postcards included in the template.
3. On the **File** menu, click **Save** to save your changes in the template.
4. If a message appears asking if you want to overwrite the older Word version with a newer Word version format, click **Yes**.
5. If the message appears to inform you that Word converted the macros in the template and asking if you would like to save a backup copy of the original template, click **Yes**.

For more information on working with document template (.dot) files, refer to your Microsoft Word online Help.
Generating Your Reminders

When you are ready to send a batch of reminders, you must tell Cornerstone which reminders you want to generate. The Cornerstone Generate Reminders window allows you to identify specifically what types of reminders to send and to whom.

In addition, you can set the **Reminder type** field to specify your reminder output and printing preferences. Reminder type options include:

- **Two card/Three card/Four card**—If you select one of these Cornerstone reminder card options, at the end of the Generate Reminders process, the Report Preview window appears and allows you to print your reminders immediately.

- **Create Word file**—Select this reminder type if you plan to generate reminders using Microsoft Word. At the end of the Generate Reminders process, Cornerstone will create a text (.txt) file that can be used to merge the data into reminders that can be printed or emailed from Word.

- **Create Reminder Service file**—Select this reminder type if you plan to generate reminders for the IDEXX Reminder Service. See “Using the IDEXX Reminder Service” on page 291 for more information on using this service.

**Before You Begin**

- Print the **Invoice Item Reminder Information Report** to review a list of reminders that each item generates and satisfies, and verify that your reminder setup is correct.

- Print and review the **Reminder Letter Report** and make any necessary changes.

- If you plan to print reminders in Cornerstone as part of the Generate Reminders process, make sure the applicable reminder cards are loaded in the printer. Reminders print to the printer set up as the default printer.

**To generate reminders:**

1. On the **Activities** menu, select **Reminder Selection > Generate Reminders**. The Generate Reminders window appears.

![Generate Reminders window](image)
2. **Multi-Location/Single Database configuration only:** If desired, select a practice from the Practice drop-down list to filter specific clients based on their assigned home practice. (An All Practices option is also available.)

3. In the **Date range** area, do the following:
   a. Specify the **Beginning date** and **Ending date** of the reminders you want to print. (These dates are the reminder due dates.)
   b. In the **Past Due date** text box, specify a past due date or press TAB and continue to the next field if you do not want to include past due reminders. Any reminders with due dates that fall between the past due date and the beginning date for reminders will be included on the reminder cards. This applies only if the patient also has reminders due that fall in the beginning and ending date range.

4. In the **Client information** area, do the following:
   a. In the **Send reminders to** drop-down list, do one of the following:
      - Select **All owners** to send reminders to all owners who have the Send reminders check box selected and/or who have a classification with the send reminder option set. Continue to the **Sort by** field.
      - Select **Flagged owners** to send reminders to owners based on classification. In the Client Classification selection list, select the classification(s) for which you want to send reminders. Reminders will be generated for all flagged owners (those with the Send Reminders check box selected) who have the selected classification.

      **Tip:** In the Client Classification selection list, all classifications are highlighted and selected by default. Click the classifications you do not want to include to deselect them.
   b. In the **Sort by** drop-down list, do one of the following:
      - Select **Client Name**. In the **Beginning last name** and **Ending last name** fields, enter the range of client names you want to select for reminders, or press TAB for both fields to include all client names.
      - Select **Client ID**. In the **Beginning client ID** and **Ending client ID** fields, enter the range of client IDs you want to select for reminders, or press TAB for both fields to include all client IDs.
      - Select **Postal Code**. In the **Beginning postal** and **Ending postal** fields, enter the range of postal ZIP Codes for reminders, or press TAB for both fields to include all postal codes.

5. In the **Species information** area **Selection type** drop-down list, do one of the following:
   - Select **All** to generate reminders for all species.
   - Select **Small** to generate reminders for all small animal species only.
   - Select **Large** to generate reminders for all large animal species only.
   - Select **Individual** and then in the scroll list, click the species for which you want to generate reminders.

6. In the **Output information** area **Reminder type** drop-down list, select the type of reminder cards to generate:
   - To generate standard Cornerstone reminder cards, select **Two card**, **Three card** or **Four card**.
   - To generate reminders using Microsoft Word, select **Create Word file**.
• To generate reminders for the IDEXX Reminder Service, select Create Reminder Service file.

7. Set the following Output information fields as applicable for the reminder type selected in the previous step (the fields available will vary depending on the selected reminder type):
   • To include the bulk rate permit stamp on the reminders, select the Bulk Rate Permit check box. This applies only to reminders printed in Cornerstone, not Microsoft Word. To set up a bulk rate permit stamp, see “Setting Up a Bulk Rate (PRESORTED STANDARD) Stamp” on page 283.
   • In the Distribution type drop-down list, select the method or methods to use for distributing the reminders.
   • If applicable, in the Reminder message drop-down list, select a message to print on reminders. This applies only to reminders printed in Cornerstone, not Microsoft Word. To set up reminder messages, see “Creating a Reminder Message” on page 285.
   • In the Name text box, type the path to use for generating a your name list (typically saved in your Cornerstone directory as C:\Cstone\namelist.txt). If necessary, click Browse to search for and select an existing file to replace with the newly generated name list.
   • Select the Include Pet Pictures check box to include pet pictures on cards printed using the IDEXX Reminder Service (available only for the Create Reminder Service file option). See “Using the IDEXX Reminder Service” on page 291 for more information on the IDEXX Reminder Service.
   • In the Reminder information to generate box, address information appears. To deselect a highlighted address item (e.g., Client ID), click the item. Deselected items do not print on reminders.
   • In the Number of reminders per card (1 to 9) text box, type the maximum number of reminders to print on a card. If you type 3, up to three reminders appear on a card. If a patient has more than three reminders, a second card is printed. (The default of 9 reminders per card is recommended.)

8. In the Invoice item information area Selection type drop-down list, do one of the following:
   • Select All to include all invoice items.
   • Select Individual to include certain invoice items and specify the items to include.
   • Select Service to include only Service type items.
   • Select Inventory to include only Inventory type items.
   • Select All Except to exclude certain invoice items and specify the items to exclude.

9. Click OK. The Generating Reminders status box displays.

   Cornerstone searches all of the patient reminder files (that meet the criteria you specified) and will either create a namelist.txt file for mail merge with Word or generate the reminders for printing within Cornerstone.

10. When Cornerstone has finished generating the reminders, make a note of the number of reminders that were generated for your records.

11. If applicable, choose one of the following options:
   • If you generated two-card, three-card or four-card reminders, click OK again and the Report Preview window displays, showing the generated reminders. To print the reminders, click Print.
• If you selected **Create Word file** to generate reminders, the Report Preview window does not display. Click **OK** to exit. Open Microsoft Word and print reminders. See “Printing Reminders from Microsoft Word” on page 293.

• If you selected **Create Reminder Service file**, select the **Open IDEXX Reminder Service** check box and click **OK**. The reminder service website displays. Click **Place your order now**, and the reminder service will print and mail reminders directly to your clients. See “Using the IDEXX Reminder Service” in the following section for more information.

### Using the IDEXX Reminder Service

The IDEXX Reminder Service allows you to delegate the printing and mailing of your practice’s reminders to someone else. You can choose from a variety of card designs that will grab your clients’ attention and boost response rates.

#### Option to Include Pet Pictures

You can provide a more personal touch to your clients with the addition of custom-printed pet pictures on their reminder cards. With this IDEXX Reminder Service feature, you can include a small picture of the Cornerstone patient on the client address side of the reminder postcard.

![IDEXX Reminder Service postcard with Pet Picture included](image)

For more information regarding the IDEXX Reminder Card Service, contact IDEXX Practice Solutions at 1-888-224-4408.

**To send reminders using the IDEXX Reminder Service:**

1. On the **Activities** menu, select **Reminder Selection > Generate Reminders**. The Generate Reminders window appears.

2. Set up your reminders as you would normally, and in the **Reminder type** drop-down list, select **Create Reminder Service file**. (See “Generating Your Reminders” on page 288 for information on setting up reminders in the Generate Reminders window.)
3. If you want to include pet pictures on reminders (for those patients having an existing pet picture in Cornerstone), select the **Include Pet Pictures** check box. If this option is selected, Cornerstone will copy the applicable pet pictures and save them to a compressed ZIP file.

4. When you have finished setting up your reminders, click **OK**. The Generating Reminders dialog displays the number of reminders generated and the number of associated reminder cards.

5. On the Generating Reminders dialog box, select the **Open IDEXX Reminder Card Service** check box and then click **OK**. Your web browser will open to the IDEXX Reminder Card Service Web page.

   **Tip:** You can also access the IDEXX Reminder Card Service Web page by selecting **Reminder Service** from the **Web Links** menu in Cornerstone.

6. On the IDEXX Reminder Card Service Web page, click **Place your order now** and enter your login information to create a new order.

7. If you previously selected the **Include Pet Pictures** option on the Generate Reminders window, do the following to upload the pet pictures file:
   a. When specifying the type of cards to create, select the **All Cards** option.
   b. Under the **Select Items** area, click the **Reminder Cards w/Pet Photo** tab.
   c. Complete all required practice information fields, then click the **Upload File** button and browse to select and upload the Cornerstone-generated **namelist.zip** file containing your pet images.

   **Note:** Only one pet picture may be used per reminder card.

8. Follow the on-screen prompts to enter your information, attach your reminder mailing list file and review your order. If you uploaded a pet pictures ZIP file, the reminder service will match up the pet pictures with the corresponding practice ID, patient ID, and client ID information to print the pictures on the reminder cards.

9. When you have reviewed all information and you are ready to submit your order, click **Send Order**. The reminder card will be printed and sent to the recipients on your list.
Chapter 14: Setting Up a Reminder System

Printing Reminders from Microsoft Word

After reminders are generated in Cornerstone, you can use Microsoft® Word software to print the reminders using a reminder template.

If you use Microsoft Word to print your reminders, initially, you will need to enter your practice name, address and phone number and postage information. You may also want to change or add reminder text. You can change these settings by editing the reminder template.

Microsoft Word uses templates (postcrds.dot, trifolds.dot, lasrem3s.dot, reminder2.dot, and reminder4.dot) to merge the client/patient data into a document file and then prints the reminders (in Word). See “Microsoft Word Reminder Card Setup” on page 287.

Before You Begin

- Create the Cornerstone reminder .txt file (Activities > Reminder Selection > Generate Reminders). See “Generating Your Reminders” on page 288.
- Make sure your reminder templates have been customized. See “Microsoft Word Reminder Card Setup” on page 287.
- Make sure the correct paper is in the printer. Reminders print to the printer set up as the default printer.

Tip: You can print mailing labels from the Cornerstone Editor using the sample document template for the Avery® 5160 label.

Note: Depending on the version of Microsoft Word you are using, the Word functions and dialog boxes referenced in this section may vary slightly from your version of Word. Refer to the Microsoft Word online Help for instructions specific to your version.

To print reminders in Microsoft Word:

1. Open a reminder template by browsing to the Cornerstone > Reminder Documents folder in Windows® and then selecting the applicable reminder template.
2. If a SQL command message appears, click Yes to continue.
   The selected reminder opens in Microsoft® Word.
3. Open the Mail Merge window in Word (this varies depending on your version of Word).
4. For the document type, select Letters.
5. For the recipients, select Use an existing list, and then browse to select the namelist.txt file from your Cornerstone directory (usually C:\Cstone). To find this file, search for only text files by selecting Text Files (*.txt) from the Files of type drop-down list. After selecting the namelist.txt file, click Open. The Mail Merge Recipients dialog box opens.
6. To include only some of the people on the list, edit the recipient list.
   Tip: If you do not want to send printed reminders to clients selected to receive email reminders, you can filter out those records using options in the Mail Merge Recipients dialog box: Scroll over to locate the EmailAddr field and select (Blanks) from its associated drop-down list of options. This will change the recipient list to include only those clients with a blank email field.
7. Write and preview your letter, and then complete the merge.
8. Verify that the correct printer and printing options are selected, and then print your reminders.
Troubleshooting: Letter Reminders

If the reminders you printed are not the same as the reminders you thought you printed, check the following in Cornerstone:

- Who did you select to send reminders to? (Flagged Owners or All Owners)
- Is the Send reminders check box selected for the classification assigned to the client? To do this, on the Controls menu, select Classifications. Click the Client tab. Select the classification and click Update. Click the Send reminders check box.
- Is the client a current owner marked as active? (Cornerstone does not generate reminders for inactive clients). To do this, open the client record and check to see that the client’s status is active.
- Is the patient active? (Cornerstone does not generate reminders for deceased and inactive patients, but deceased and inactive patients print on the report unless you filter them out of the report.) To check to see that the patient is active, at the bottom of the Client Information window, double-click to select the patient (or right-click and select Update). In the Patient Information window, select Active as the patient’s status. (You can also check the patient’s reminders while you are here; click the Reminders tab.)
- If you chose Flagged Owners, did you make sure that, in the Patient Owner Information dialog box, the Send reminders check box is selected for clients you want included? (Double-click the owner in the Patient Information dialog box or select the owner, right-click and select Update.)

Tip: Owners who have the Send reminders check box selected but do not have a classification assigned to them are included when All Owners is selected. If a patient has multiple owners, each owner who has the Send reminders check box selected and/or has a classification with the reminder option set receives a reminder.

Emailing Reminders from Microsoft Word

Save postage by sending email reminders instead of regular postal mailings. You can send both electronic and regular mailings to give your clients the extra reminder.

You can send email reminders to clients who have an email address and have the E-mail reminders check box selected in their client record.

Before You Begin

- Enter email addresses on the client record and select the E-mail reminders check box.
- Generate reminders as usual (to generate the namelist.txt file).
- Verify that you have all necessary hardware and software in place:
  - Appropriate hardware and Internet service provider (ISP) for accessing the Internet
  - An email account
  - Microsoft Word and Microsoft Outlook®
- If you have not generated email reminders before, you must edit your email.dot template to include your practice’s location information. If you do not edit this template, you will have incorrect location information on your email reminders. Open Microsoft Word and locate the email.dot template. It should be saved in your Cornerstone directory (usually C:\Cstone). Change the information as needed. Be sure to save the file as a document template (*.dot).
Note: Depending on the version of Microsoft Word you are using, the Word functions and dialog boxes referenced in this section may vary slightly from your version of Word. Refer to the Microsoft Word online Help for instructions specific to your version.

To email reminders in Microsoft Word:
1. Open the email reminder template by browsing to the Cornerstone > Reminder Documents folder in Windows® and then selecting the applicable reminder template.
2. If a SQL command message appears, click Yes to continue.
   The selected reminder opens in Microsoft® Word.
3. Open the Mail Merge window in Word (this varies depending on your version of Word).
4. For the document type, select Email messages.
5. For the recipients, select Use an existing list, and then browse to select the namelist.txt file from your Cornerstone directory (usually C:\Cstone). To find this file, search for only text files by selecting Text Files (*.txt) from the Files of type drop-down list. After selecting the namelist.txt file, click Open. The Mail Merge Recipients dialog box opens.
6. To include only some of the people on the list, edit the recipient list.
7. Write and preview your email message, complete the merge, and then send your message.
Section 5–Pet Health Management Setup

Chapter 15: Setting Up Physical Exam and Pet Health Report Card
Chapter 16: Setting Up Vital Signs/Weight
Chapter 17: Setting Up Medical Notes and Correspondence
Chapter 18: Setting Up Classic Medical Notes
Chapter 19: Setting Up Correspondence in Microsoft® Word
Overview

The Physical Exam feature is included with all Cornerstone systems. It allows practices to record physical exam observations and comments using standard body system templates and print a Pet Health Report Card.

Cornerstone's Physical Exam feature provides the following:

- A quick, easy way to record body system observations and comments while the patient is being examined
- A number of standard body system templates to use to record your observations
- A Pet Health Report Card that can be printed when the exam is complete
- A record of the physical exam that is stored in the patient’s history

Note: If you have installed the Patient Advisor* module, “Patient Advisor Exam” will display in place of “Physical Exam” in several areas within Cornerstone (Practice and Workstation defaults, right-click menu on the Patient Clipboard*, Activities menu, window title bars, etc.).

Ready to Use

The Physical Exam feature is set up so that you can create physical exam records without any additional setup. For your convenience, a number of standard body systems templates are included.

In addition to the standard body system templates provided by Cornerstone, you can add your own system templates or change the templates that came with your software. See the “Creating Your Own System Templates” section that follows for more information. Pet Health Report Card defaults can also be changed. See “Physical Exam/Patient Advisor* Defaults” on page 121.

Creating Your Own System Templates

System templates include the body systems that are applicable to the type of physical exam being performed. System templates can be set up for specific species, and more than one system template can be set up for each species. Only one system template can be designated as the default.

Before You Begin

- Set Physical Exam/Patient Advisor defaults (see “Physical Exam/Patient Advisor* Defaults” on page 121).
To add or edit a system template:

1. On the Lists menu, select Physical Exam > System Templates (or Patient Advisor > System Templates). The System Template List dialog box appears.

2. Click New to add a new template or double-click an existing template to update it. The System Template Setup dialog box appears.

   ![System Template Setup dialog box](image)

3. In the Description text box, type a descriptive name for the system template.

4. If you use this template for the majority of your physical exams, click the Default check box. The default system template automatically appears when a physical exam is started for a patient; however, you have the option of selecting a different template.

   **Note:** You can have only one default template. (If another template is marked as the default, clicking the Default check box here deselects the other template as the default.)

5. To include a body system on a template, click the gray box to the left of the system to make the green check mark appear. To remove a body system, click the check mark to clear it.

6. Click the down arrow to the right of Normal and from the drop-down list, select a default observation status for the system (Normal, Abnormal or Did Not Examine).

7. To arrange the systems in the order in which you want them to appear on the physical exam and on the Pet Health Report Card, click the system you want to move and use the ↑ and ↓ arrow buttons to move the system up or down in the sequence.

8. Click OK and then click Close.

**Creating and Updating Observation Text**

Observation text for each body system can be set up in advance for Normal, Abnormal or Did Not Examine statuses. More than one set of observation text can be set up for each body system status. Only one set per body system status can be designated as the default observation.

Some standard body system observations are included with Cornerstone software. You can modify the text of these observations and create additional sets of observation text.

**To add observation text to body systems:**

2. Click **New** if you want to create a new body system, or select an existing body system and click **Update**. The System Setup dialog box appears.
   a. In the **Description** text box, type a descriptive name for the body system.
   b. If you want the **Vital Signs/Weight** icon to appear with this system in the Physical Exam/Patient Advisor Exam **Observations** tab, select the **Vital Sign System** check box.
   c. Click **OK**.

3. In the left pane of the Physical Exam Setup dialog box, find the body system to which the observation will apply; click the + sign to the left of the system. The body system folder expands with more options.

4. Under the expanded body system folder, click the + sign to the left of **Observations**.

5. Select the status (Normal, Abnormal or Did Not Examine) to which the observation text applies.

6. Click **New** to create a new line of observation text or click **Update** to modify existing observation text. The Observation Setup dialog box appears.

7. If the observation text applies only to a specific species, in the **Species** field, from the drop-down list, select the species to which the observation text applies.
8. Click in the **Observation text** box and type the observation text that you want to add or to change text, position cursor at the applicable spot and change or delete text.

9. To designate the observation as the default, select the **Default** check box.

10. When finished, click **OK**.
Chapter 16: Setting Up Vital Signs/Weight

This chapter covers the steps required to set up the Vital Signs List for your practice. For information on daily usage tasks for Vital Signs/Weight, see “Chapter 16: Recording Vital Signs/Weight Information” in the Cornerstone User’s Manual.

Using the Vital Signs/Weight features in the IDEXX Cornerstone* Practice Management System, you can view, add, edit and graph vital signs for a patient. You can also include vital signs information in medical notes and on Pet Health Report Cards created using Physical Exam/Patient Advisor* Exam.

Before you can start entering vital signs for patients, you must first activate the vital signs you want to track and assign species to applicable lists for List-type vital signs. Optionally, you can also edit the default vital signs, add new vital signs, edit the Weight vital sign, and set the vital signs display order.

The Default Vital Sign List

Cornerstone provides a default Vital Sign List—you can use this list as is (see “Quick-Start Setup—Activating Vital Signs and Assigning Species to Lists” on page 305) or you can customize the list and add vital signs to meet the needs of your practice (see “Editing Default Vital Signs or Adding New Vital Signs” on page 306).

<table>
<thead>
<tr>
<th>Vital Sign</th>
<th>Abbreviation</th>
<th>Type</th>
<th>Start Value</th>
<th>Decimal Places</th>
<th>List Values</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight (always active)</td>
<td>Weight</td>
<td>Weight</td>
<td></td>
<td>2</td>
<td></td>
<td>Canine 0.1–99.9</td>
</tr>
<tr>
<td>Body Score (1-5)</td>
<td>BodyScore5</td>
<td>Numeric List</td>
<td>1</td>
<td>1</td>
<td>1–5**</td>
<td></td>
</tr>
<tr>
<td>Body Score (1-9)</td>
<td>BodyScore9</td>
<td>Numeric List</td>
<td>1</td>
<td>1</td>
<td>1–9**</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>Temp</td>
<td>Numeric</td>
<td></td>
<td>1</td>
<td></td>
<td>95–102.5</td>
</tr>
<tr>
<td>Pulse</td>
<td>Pulse</td>
<td>Numeric</td>
<td></td>
<td>0</td>
<td></td>
<td>40–180</td>
</tr>
<tr>
<td>Respiration</td>
<td>Resp</td>
<td>Alphanumeric</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mucous Membranes</td>
<td>Muc Memb</td>
<td>Alphanumeric List</td>
<td></td>
<td>**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capillary Refill</td>
<td>CRT</td>
<td>Alphanumeric List</td>
<td></td>
<td>**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blood Pressure</td>
<td>BP</td>
<td>Alphanumeric</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dental Score</td>
<td>Dental</td>
<td>Numeric List</td>
<td>1</td>
<td>1</td>
<td>1–5**</td>
<td></td>
</tr>
<tr>
<td>Pain Scale</td>
<td>Pain Scale</td>
<td>Numeric List</td>
<td>0</td>
<td>0</td>
<td>0–4**</td>
<td></td>
</tr>
<tr>
<td>Alert/Attitude</td>
<td>Alert</td>
<td>Alphanumeric List</td>
<td></td>
<td>**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appetite</td>
<td>Appetite</td>
<td>Numeric List</td>
<td>1</td>
<td>1</td>
<td>1–6**</td>
<td></td>
</tr>
<tr>
<td>Urine Output</td>
<td>Urine Outp</td>
<td>Numeric List</td>
<td>1</td>
<td>1</td>
<td>1–8**</td>
<td></td>
</tr>
<tr>
<td>Fecal Output</td>
<td>Feces</td>
<td>Alphanumeric List</td>
<td></td>
<td>**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gut Sounds</td>
<td>Gut Sounds</td>
<td>Numeric List</td>
<td>0</td>
<td>0</td>
<td>0–6**</td>
<td></td>
</tr>
</tbody>
</table>
** List Value Descriptions

- **Body Score (1-5):** 1–Emaciated; 2–Thin; 3–Optimal; 4–Overweight; 5–Obese
- **Body Score (1-9):** 1–Emaciated; 2–Underweight; 3–Slightly Underwt; 4–Ideal - 4; 5–Ideal - 5; 6–Overweight; 7–Moderate Overwt; 8–Signif Overwt; 9–Obese
- **Mucous Membranes:** White; Pale/Anemic; Pink/Healthy; Red; Blue/Cyanotic
- **Capillary Refill:** <2 sec; 2–4 sec; >4 sec
- **Dental Score:** 1–Excellent; 2–Mild; 3–Moderate; 4–Significant; 5–Severe
- **Pain Scale:** 0–No Visible Pain; 1–Mild Pain; 2–Moderate Pain; 3–Extreme Pain; 4–Major Pain
- **Alert/Attitude:** 1–BAR; 2–QAR; 3–QAP; 4–Pain, U; 5–Pain, R; 6–Listless
- **Appetite:** 1–None; 2–Sm Amt w/ Coaxing; 3–Decreased; 4–Normal; 5–Very Hungry; 6–Voracious
- **Urine Output:** 1–No Urine Output; 2–0%–20% of Normal; 3 - 20%–50% of Norm; 4 - 50%–80% of Norm; 5–80%–120%; Normal; 6–120%–150%; 7–150%–200%; 8–>200% of Norm
- **Fecal Output:** Profuse, Bloody; Profuse, Watery; Moderate Diarrh; Soft, Dec Vol; Soft, Norm V/C; Soft, Inc Vol; Mod Constipat; Severe Constip
- **Gut Sounds:** 0–Absent; 1–Signif Decrease; 2–Mod Decrease; 3–Slow/Present; 4–Normal; 5–Hyperactive; 6–Extremely Hyper

**Tip:** For Blood Pressure, if you track only the systolic pressure and you want the ability to graph the values, you could change the type from Alphanumeric to Numeric (where values would be typed as a single number without a “/” character).

**Special Considerations for Body Score:**

- There are two default Body Score vital sign options to choose from—one uses a 1–5 scale and the other uses a 1–9 scale.
- Only one of the Body Score vital sign options can be activated at any given time in your Vital Sign List. If you try to activate a Body Score vital sign and the other Body Score vital sign is already active, Cornerstone verifies that you want to reassign the Body Score, and then automatically inactivates the other Body Score vital sign.

**About the Vital Sign List**

The Vital Sign List window (Lists > Vital Signs/Weight) displays the name, abbreviation, data type and active/inactive status of all vital signs that have been set up for your practice.
Using the buttons available on the Vital Sign List window, you can:

- Set up a new vital sign to appear in the practice’s Vital Sign List.
- Update or edit settings for existing vital signs.
- Copy an existing vital sign’s setup and use it as a starting point for creating a new vital sign.
- Delete a vital sign from the practice’s Vital Sign List.
- Set the order of the vital signs displayed on the Vital Signs window at the time of use.

Notes:

- The order of vital signs on the Vital Sign List window does not reflect the order you specify for the Vital Signs entry and viewing window.
- For Mobile Computing, mobile users can view the Vital Sign List, but cannot perform setup tasks (add new vital sign, update, copy, delete, etc.).
- For Multi-Location/Single Database configurations, all practices use the same Vital Sign List, but the order of the vital signs displayed on the Vital Signs entry and viewing window can be customized for each practice.

**Vital Sign Types**

If you want to create your own vital signs to use in your practice’s Vital Sign List, think about the way you want staff members to enter/select values for each vital sign—this will determine the type of vital sign to select during setup.

**Alphanumeric**

With an Alphanumeric vital sign, at the time of use the value is typed as letters and/or numbers. Blood Pressure is an example of an Alphanumeric vital sign.
Alphanumeric List

With an Alphanumeric List vital sign, at the time of use a value is selected from a list of preconfigured answers containing letters and/or numbers. Mucous Membranes is an example of an Alphanumeric List vital sign.

Example of the Alphanumeric List type during setup

Example of the Alphanumeric List type during use

Numeric List

With a Numeric List vital sign, at the time of use a value is selected from a preconfigured list, where the values are based on a numeric scale with a start value of 0 or 1. You can also simply type the number to quickly assign the associated value in the list. For example, for the “3–Optimal” Body Score value, you can simply type “3” instead of selecting the value from the list.

Dental Score is an example of a Numeric List vital sign.

Note: Numeric List vital signs can be graphed.
Chapter 16: Setting Up Vital Signs/Weight

Numeric

With a Numeric vital sign, you have the option of setting up one or more numeric ranges to serve as a warning mechanism that alerts you when a value is entered outside the “normal” range for the species. For example, a Temperature vital sign could be set up to use a range of 95 (low) to 101 (high). If a staff member accidentally types 966 instead of 96, Cornerstone notifies the staff member that the entry is out of range and asks the staff member whether to use this value.

Note: Numeric vital signs can be graphed.

Example of the Numeric type during setup

Example of a Numeric type entry

Setting Up the Vital Sign List for Your Practice

Quick-Start Setup—Activating Vital Signs and Assigning Species to Lists

If the default Vital Sign List meets your practice’s needs as is with no customization required, then consider using the Quick-Start Setup steps. These steps cover the minimum setup required to get up and running quickly using the default vital signs.

Note: If you plan to edit the default Vital Sign List, add your own vital signs to the list, or set up custom lists by species or group, do not use the Quick-Start Setup. See “Editing Default Vital Signs or Adding New Vital Signs” on page 306 for information on standard setup procedures.

To activate vital signs and assign species to lists:

2. Double-click a vital sign to edit its settings. The Vital Sign Setup window appears.
3. To activate this vital sign, clear the Inactive check box. (Conversely, to mark it as inactive, select the Inactive check box.)

Inactive check box in Vital Sign Setup
4. Do one of the following:
   - If the vital sign you are activating is an Alphanumeric or Numeric type, no additional setup is necessary. Click Save to return to the Vital Sign List.
   - If the vital sign you are activating is an Alphanumeric List or Numeric List vital sign, proceed to step 5.

5. To associate one or more species with a list, select the list and then click each desired species to be associated with it. (Click the species a second time to unlink the species from the list.)

   **Note:** To display this list when adding vital signs for patients, you need to assign the applicable species to the list here, during vital sign setup. If you do not assign at least one species to the list, when you try to enter a value for this vital sign, a message displays to remind you that the patient’s species has not been associated with the list.

6. When you have finished linking all applicable species to a list, click Save to save and return to the Vital Sign List.

**Editing Default Vital Signs or Adding New Vital Signs**

To take advantage of the power and flexibility built into the Vital Signs functionality in Cornerstone, you can customize your practice’s Vital Sign List by doing any of the following:

- Edit the default vital signs
- Add new vital signs
- Add a range of low/high values for one or more species (to have Cornerstone alert staff for values entered outside the range)
Add custom lists for a particular species or group of similar species (Avian, Equine, Small Animal group, Large Animal group, etc.)

To edit or add a vital sign (all vital sign types):
2. Do one of the following:
   - To edit a vital sign, double-click the vital sign (or select it and click Update).
   - To add a new vital sign, click New.
   The Vital Sign Setup window appears.
   Note: The settings available on the Vital Sign Setup window differ depending on the data type selected for the vital sign you are configuring.
3. In the Name text box, type a descriptive name that uniquely identifies this vital sign (maximum 30 characters). The name displays only on setup windows; it does not display on the Vital Signs entry and viewing window or on the Patient Clipboard* Vital Signs tab.
4. To activate the vital sign, clear the Inactive check box. (Conversely, to mark it as inactive, select the Inactive check box.)
5. In the Abbreviation text box, type to edit or enter a shortened version (maximum 10 characters) of the vital sign name. This abbreviation will display in the Vital Signs column (static left column) on the Vital Signs entry and viewing window and in the column headers on the Patient Clipboard Vital Signs tab.
6. If setting up a new vital sign, in the Type field, select Alphanumeric, Alphanumeric List, Numeric List or Numeric. See “Vital Sign Types” on page 303 to view examples of each vital sign type at the time of setup and use.
7. Depending on the vital sign type selected, do one of the following:
   - For Alphanumeric, the setup is complete. Click Save to save and return to the Vital Sign List.
   - For Numeric, proceed to the section for setting up a Numeric vital sign.
   - For Numeric List or Alphanumeric List, proceed to the section on setting up a Numeric List or Alphanumeric List vital sign on page 308.

To set up a Numeric vital sign (and optionally set up one or more low/high ranges):
1. Configure the basic settings on the Vital Sign Setup window according to the steps in the previous “To edit or add a vital sign (all vital sign types)” section on page 307 and make sure the Numeric type is selected.
2. In the Decimal Places field, specify whether to use 0, 1 or 2 decimal places for this vital sign.
3. To add a range of low/high values for one or more species (to have Cornerstone alert staff for values entered outside the range):
   a. Click Add Range.
      Tip: If you are editing a default vital sign, to save time you could edit the default range instead of adding a new range. To edit the default range, select it in the Range area and follow steps b–e to make changes to its settings as necessary.
   b. In the Range name field, type an identifying name for the range. Typically you would want a name that identifies both the vital sign and the type/size of species to be associated with the...
range. For example, for the Pulse vital sign you could set up range names such as “Small Animal - Pulse” and “Large Animal - Pulse.”

c. In the **Low** field, enter a numeric value to represent the low end of the “normal” values for this range.

d. In the **High** field, enter a numeric value to represent the high end of the “normal” values for this range.

   **Note:** If desired, you can specify only a low value or only a high value—you are not required to specify both values.

e. To associate one or more species with the range, select the range and then click each desired species to be associated with it. (Click the species a second time to unlink the species from the range.)

   **Note:** A species can be assigned to only one range per vital sign.

f. Repeat steps a–e as needed to set up each desired range.

4. To delete a range, select it in the **Range** area and click **Delete range**.

5. When you are finished, click **Save** to save and return to the Vital Sign List.

**To set up a Numeric List or Alphanumeric List vital sign (and assign species to lists):**

1. Configure the basic settings on the Vital Sign Setup window according to the steps in the “To edit or add a vital sign (all vital sign types)” section on page 307 and make sure either the Numeric List or Alphanumeric List type is selected.

2. If the Numeric List type is selected, the following two additional fields display:

   - **Body Score (display with weight)**—If this is a Body Score vital sign and you want the body score to display along with the patient weight throughout Cornerstone, select this check box. If selected and there is already an active Body Score, a message appears to verify that Cornerstone should inactivate the current Body Score vital sign and reassign to make this the active Body Score. (There can be only one active Body Score vital sign.)

   - **Start value at**—Specify if you want to use 0 or 1 as the starting value for your Numeric List.

3. To add a list for this vital sign (so staff can select a value from this drop-down list when recording this vital sign for a patient):

   a. Click **Add List**.

      **Tip:** If you are editing a default vital sign, to save time you could edit its default list instead of adding a new list. To edit the default list, select it in the **List** area and follow steps b–g to make changes to its settings as necessary.

   b. In the **List name** text box, type an identifying name for the list. For easy identification, use a list name that includes both the vital sign and the type/size of species to be associated with the list. For example, you could set up list names such as “Small Animal - Body Score” and “Large Animal - Body Score.”

   c. In the first **Description** row, type a list value (maximum 15 characters) to appear in a drop-down list for this vital sign, then press **TAB** twice. (For Numeric List values, a number is automatically assigned to the value based on the selected start value.) Repeat this process to add all desired list values.

      **Note:** A list must have at least one value (description) associated with it.
d. If desired, select the Default check box next to one of the list values to designate it as the default selection. This value will be selected by default in the drop-down list for this vital sign at the time of use on the Vital Signs window. Note that even if you simply click in the entry cell for this vital sign on the Vital Signs window, the default value will be selected automatically.

e. To order the list values as you want them to display in the drop-down list, select a list value and then click the up \( \uparrow \) or down \( \downarrow \) arrow button to move the value within the list.

f. To provide a more detailed description of each list value, select the value in the Description/Default table and then type the description text (maximum of 500 characters) in the Extended description box located at the bottom of the window. The extended description will be accessible on the Vital Signs window at the time of use by clicking the “?” link for that vital sign.

g. To associate one or more species with the list, select the list and then click each desired species to be associated with it. (Click the species a second time to unlink the species from the list.)

Note: To display this list when adding vital signs for patients, you need to assign the applicable species to the list here, during vital sign setup. If you do not assign at least one species to the list, when you try to enter a value for this vital sign, a message displays to remind you that the patient’s species has not been associated with the list.

h. Repeat steps a–g as needed to set up each desired list.

IMPORTANT: Once a list vital sign has been entered for a patient, from that time on, only the Extended description can be changed. You cannot add, edit, delete or reorder list values; you cannot change the species associated with the list (although you can add species to an existing list); and you cannot delete the list. (If necessary, you can copy the vital sign, inactivate the original version that you copied, then edit the copy as needed and assign your species as desired.)

4. To delete a list, select it in the List area and click Delete List.

5. When you are finished, click Save to save and return to the Vital Sign List.

**Editing the Weight Vital Sign**

As with Numeric vital signs that allow you to set up low/high value ranges, the Weight vital sign can be edited to add weight ranges appropriate for the species regularly seen in your practice. In addition, you can specify different units of measure for each range based on species size. For example, you could set up a range for the Avian species that has the Unit of measure set to grams.
To edit the Weight vital sign:
1. On the Lists menu, select Vital Signs/Weight, then double-click the Weight vital sign to edit its settings.
   
   Note: Basic vital sign settings (Name, Inactive check box, Abbreviation and Type) are predefined for the Weight vital sign and cannot be changed.

2. If desired, change the number of Decimal Places to be used for recording the weight (applies across all ranges/species/units of measure).

3. If desired, you can set up weight ranges to alert staff for values entered outside the range. See step 3 in the “To set up a Numeric vital sign (and optionally set up one or more low/high ranges)” section on page 307 for information on setting up a range.

4. For each range, select a Unit of measure appropriate for the range and the associated species.

5. When you are finished, click Save to save and return to the Vital Sign List.

Setting the Vital Signs Display Order

On the Vital Sign Order setup window, you can specify the order of the rows that display in the Vital Signs column on the Vital Signs entry and viewing window at the time of use.

To set the vital sign display order:

1. On the Lists menu, select Vital Signs/Weight, then click Set Order. The Vital Sign Order window appears.

2. Multi-Location/Single Database configurations only: If desired, you can customize the vital signs display order for each practice. In the Practice drop-down list, select the practice for which you want to set up the vital signs display order.

3. Highlight a vital sign and then use the up or down arrow button to move the vital sign to the desired position in the list. Repeat this process until the vital signs are in the desired order.

4. Multi-Location/Single Database configurations only: If you are setting the order differently for each practice, repeat steps 2–3 for each practice.

5. When you are finished, click OK.
Copying a Vital Sign from the Vital Sign List
If an existing vital sign includes settings you would like to reuse when creating a new vital sign, you can take a shortcut and make a copy of the existing vital sign. When setting up a new vital sign in this way, the Type cannot be changed, but all other settings can be edited as needed.

Note: You cannot copy the Weight vital sign.

To copy a vital sign:
2. On the Vital Sign List window, select the desired vital sign and click Copy.
3. On the Vital Sign Setup window, enter a new name and abbreviation for the vital sign, and make other changes as necessary.
4. When you are finished, click Save to save and return to the Vital Sign List.

Deleting a Vital Sign from the Vital Sign List
You can delete a vital sign from the Vital Sign List only if the vital sign has never been used to record vital signs for a patient. If the vital sign has been used (even for a test patient), it cannot be deleted.

Note: Regardless of whether they have been used before, the Weight and active Body Score vital signs cannot be deleted.

Tip: If a vital sign has been used and cannot be deleted, it can still be inactivated (with the exception of the Weight vital sign). Inactive vital signs are listed on the Vital Signs entry and viewing window only if the patient has historic values for that vital sign.

To delete a vital sign from the Vital Sign List:
2. On the Vital Sign List window, select the desired vital sign and click Delete. You are prompted to confirm the deletion.

Note: If the Remember my decision check box is selected, the confirmation message will no longer appear after performing a Delete operation within Vital Sign Setup. We recommend that you leave this option unchecked.
3. Click Yes to delete the vital sign.
Chapter 17: Setting Up Medical Notes and Correspondence

This chapter covers the steps required to set up medical note templates and correspondence templates in the IDEXX Cornerstone* Practice Management System. For information on adding a medical note to a patient record or printing a correspondence document, see “Chapter 17: Using Medical Notes and Correspondence” in the Cornerstone User’s Manual.

Overview
Document templates for both medical notes and correspondence are set up in the Cornerstone Editor. The Cornerstone Editor provides standard editing and formatting features in a familiar word processing environment.

Document templates for enhanced medical notes and correspondence can contain elements such as the following:

- Cornerstone data that is automatically merged with the document using standard bookmarks
- Prompts for situation-specific information using question bookmarks
- Text input fields that can be filled in or "answered" by staff
- Information displayed using design elements such as text boxes, check boxes and tables
- Prompt for inserting patient problem description and details
- Prompt for inserting diagnosis description and details
- Prompt for inserting vital signs information
- Images (e.g., dental chart, eye diagram, etc.)
- Default invoice items
- Signature bookmarks that allow staff members and clients to sign documents electronically

The Cornerstone Editor is used both at the time of setup (when you create or update a document template) and at the time of use (when you add a medical note to a patient record or print a correspondence document).

Template Types
When setting up a new template in the Cornerstone Editor, you specify the template type on the Template Properties dialog box.

Template types include:

- Medical Note—Saved in patient history.
• **Correspondence**—Allows you to save to a patient’s history as Title only (saves only the title to history) or Document (saves entire document to history). Some examples of Correspondence documents are Consent for Euthanasia Forms or Do Not Resuscitate Orders.

When viewing a patient’s history, you can distinguish the two Correspondence-type documents by the icon appearing next to the line in history:

- **Entire Document** saved to history
- **Document Title only** saved to history

• **Print Only**—One-time use documents that are not saved to a patient’s history at the time of use. Some examples of Print Only documents are Boarding Release Forms or Health Certificates.

**Note:** Any of the above template types can be created as simple text-only templates. Text-only templates allow only text-based note entry with no formatting, tables, graphics, check boxes, etc.

The type selected in Template Properties will determine the Type designation for the template on the Document Template List window.

![Image: Document Template List](image)

**Bladder Surgery Report**

*Procedure:* Cystotomy

*Approach:* Ventral midline celiotomy
  - Sterile midline approach
  - Bladder was drained prior to surgery with a French Catheter

Template types shown on the Document Template List window
### Uses for Medical Note Templates

The following table provides brief descriptions and benefits of the various styles of medical note templates you can create in Cornerstone.

<table>
<thead>
<tr>
<th>Style of Medical Note</th>
<th>Description</th>
<th>Key Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced medical note</td>
<td>Allows you to take advantage of the Cornerstone Editor’s full rich-text feature set to create advanced medical note documents. This is the primary style of medical note that is covered in detail in this chapter. To create: On the Document Template List, click <strong>New</strong> and select <strong>Document template</strong>.</td>
<td>Apply text styles and formatting, such as font selection, bold, italics, outlining, numbered/bulleted lists, etc. Include check boxes, tables, images, logo graphics and electronic signatures. Insert a table of problem details, diagnosis details or vital signs information.</td>
</tr>
<tr>
<td>Text-only medical note</td>
<td>Allows you to use the Cornerstone Editor in “text-only mode” to create a simple text-based template (no formatting or graphical elements). To create: On the Document Template List, click <strong>New</strong> and select <strong>Text only template</strong>.</td>
<td>You can create and designate a single “Quick Text” text-only template to be used to quickly enter a medical note. You can view the full contents of a text-only medical note inline on the Patient Clipboard* <strong>Text</strong> tab and <strong>Medical Notes</strong> tab without needing to open the note or use the Preview pane.</td>
</tr>
<tr>
<td>Classic medical note</td>
<td>The old medical notes style used in Cornerstone 7.6 and earlier versions. See “Chapter 18: Setting Up Classic Medical Notes” on page 351 for information.</td>
<td>Classic medical notes are currently the only option available for creating surgery/anesthesia logs.</td>
</tr>
</tbody>
</table>

### Enhanced Medical Notes vs. Text-Only Medical Notes–Feature Comparison Table

The following table summarizes the main features and functionality available with the two main styles of medical notes offered in Cornerstone. Keep these differences in mind when deciding on the style of template to create.

<table>
<thead>
<tr>
<th>Feature/Functionality</th>
<th>Enhanced Medical Notes</th>
<th>Text-Only Medical Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a designated Medical Note Quick Text document for immediate text entry, bypassing the Start New Document window steps</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Apply a single color to all text using the Color All Text option</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Apply multiple colors to select words or paragraphs throughout a document</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Apply text styles and formatting, such as font selection, bold, italics, outlining, numbered/bulleted lists, etc.</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Insert check boxes, tables and other design elements</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Import graphic files, photos and logos</td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>
### Chapter 17: Setting Up Medical Notes and Correspondence

#### Feature/Functionality

<table>
<thead>
<tr>
<th>Feature/Functionality</th>
<th>Enhanced Medical Notes</th>
<th>Text-Only Medical Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add standard text-based bookmarks</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Add image-based bookmarks (bookmarks that include signatures, images, etc. or are inserted in a table format)</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Insert a date/time stamp</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Insert a problem description or diagnosis description</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Insert a table of problem details, diagnosis details or vital signs</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Lock a medical note to create a quick “tab through” form using Text Input fields</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Use spell check</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Use header/footer features</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Include attachments</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Include invoice items</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Use options for page setup and margins</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Email the client directly from the medical note</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Save a document with a Draft, Tentative or Final status and return repeatedly to add to or update the document</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Void a document</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Add an addendum to a document</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Insert an entire medical note into a correspondence document</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>View full contents of the medical note inline on the Patient Clipboard</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Text tab and Medical Notes tab</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>View medical note in the Preview pane on the Patient Clipboard</td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>

#### Uses for Correspondence Templates

Using the Cornerstone Editor, you can create many different types of correspondence document templates for both internal and external use:

- Referral letters
- Client letters
- Account information letters
- Release/consent forms
- Certificates
- Cage cards
- Breed sheets
- Pet ID cards
- PetDetect* collars
- Patient discharge instructions
Note: You can merge a Cornerstone-generated file (e.g., the namelist.csv file) of client/patient information with a document to create mass mailings, postcards or labels for a number of clients and patients. For example, you may want to create geriatric letters and/or mailing labels for senior canine patients. See “Chapter 17: Using Medical Notes and Correspondence” in the Cornerstone User’s Manual for more information.

Note: You can also use Microsoft® Word to create some types of correspondence, although the Cornerstone data available for use in Word bookmarks is rather limited. If you want to use bookmarks with Word documents, you must link them with the applicable Cornerstone merge fields. See “Chapter 19: Setting Up Correspondence in Microsoft® Word” beginning on page 356 for more information.

Getting Ready Checklist

Before you begin to create document templates in the Cornerstone Editor, you should complete the following verification and setup tasks.

- Step 1–Verify adequate system storage capacity
- Step 2–Verify reliable backup of the Cornerstone Share folder
- Step 3–Enable staff permissions
- Step 4–Set Documents defaults
- Step 5–Set up template categories
- Step 6–(Optional) Set up a signature capture device

Step 1–Verify Adequate System Storage Capacity

Because medical notes and correspondence can include media-rich elements such as photos and other images, the file size associated with these documents may be substantial depending on how much you use these features. You must ensure you have adequate hard drive space to accommodate your estimated use level. See the Cornerstone Installation Guide for information on recommended hard drive space for optimal performance.

Step 2–Verify Reliable Backup of the Cornerstone Share Folder

Medical notes and correspondence are saved to the hard drive (in an encrypted, secure format), so you need to verify that you have a reliable method in place for backing up your Cornerstone system—specifically the Cornerstone “Share” folder. If you have questions or need assistance, please contact Cornerstone Support at 1-800-695-2877.

Step 3–Enable Staff Permissions

A Cornerstone Administrator must enable security settings in order for staff members to access and finalize medical notes and correspondence documents. For more information, see the Cornerstone Staff Security instructions you received separately when you purchased the Cornerstone program.

Step 4–Set Documents Defaults

The Documents defaults allow you to set preferences for medical note options and specify if document invoice items should be included when printing. In addition, the Ask for weight if last entry is older than __ days field determines whether staff members are prompted to enter the patient’s weight upon starting or opening a medical note. See “Documents Defaults” on page 100 for more information.

Step 5–Set Up Template Categories

The Document Template Categories List (Lists > Documents > Template Categories) allows you to set up categories that can be used for medical notes and/or correspondence documents.
Step 6–(Optional) Set Up a Signature Capture Device

If desired, you can set up compatible signature capture devices to allow staff members and clients to sign documents electronically. See “Setting Up a Signature Capture Device” on page 16 for information. (Note: Electronic signatures are not available with text-only templates.)

Note: You can create an electronic signature for a staff member and store it for later use using the Staff Information Signature tab (on the Lists menu, select Staff, select a staff member and click Update, and click the Signature tab). See “Adding Electronic Signatures for Staff” on page 60 for more information.

Cornerstone Editor–Template Setup/Update Window

Note: When creating a text-only template (versus an enhanced document template), the menus, toolbar buttons and right-click menus available in the Cornerstone Editor are limited to those options that pertain to text-based data entry. Throughout this section, those features not available in text-only mode will be marked with an "(Enhanced templates only)" designation.

Properties Banner (Template Properties)

The information that appears in the Properties Banner is specified in the Template Properties dialog box. Click the Edit Properties button to access these settings.

Note: The Template Properties dialog box also appears automatically if you click Save for the first time, if you click OK without first setting the properties, or if you click Save As.
The Template Properties include:

- **Name**—Type a brief name to identify the template.
- **Type**—Set the template type as **Medical Note**, **Print Only**, or **Correspondence**.
- **Save**—If Correspondence is selected as the document type, specify how the document will be saved. **Title only** saves only the title in patient history and **Document** saves the entire document in patient history so it can be referred to later if needed.
- **Show past & future uses of this template…**—If you are creating a Correspondence template, select this check box if you want documents created from this template to show on the Patient Clipboard Patient History area Medical Notes tab, Daily Planner, Check-in Report and Patient History Report. (See “Showing Correspondence with Medical Notes in History” on page 341 for more information on this option.)
- **Category**—Select a category for the new template. Categories are optional but recommended for easier searching so you can quickly locate the template later.
- **Show in Practice Favorites**—Select this check box if you want to flag the template as a Practice Favorite.

**Default Settings** (can be changed or added by staff at time of use)

- **Hx description**—Type a brief description to be used for a document created from this template. This is the description that is recorded in the patient’s medical history.
- **Hx Alert**—Select this check box if you want medical notes created from this template to stand out in history (line displays in history as white text on a bright red background).
- **Autofinalize in ___ days**—If you want medical notes created from this template to automatically finalize at End of Day after a certain number of days, select the **Autofinalize in** check box and enter the number of days. This default can be set in Documents defaults (see “Documents Defaults” on page 100).
- **Printer**—Select a default printer for printing documents created from this template. If documents created from this template should print to a specific printer (different from the printer selected in Printer Setup), select it here.
Editor Menu Bar

The Editor menu bar includes the File, Edit, View, Insert, Font, Paragraph, Table and Other menus. (The menu bar is located within the Cornerstone Editor window, separate from the main Cornerstone menus.)

Note: When using the Cornerstone Editor in text-only mode, the menu options available are limited to those options that pertain to text-based data entry.

Editor Toolbar

The Editor toolbar buttons provide quick access to commonly used functions within the Cornerstone Editor. (The Editor toolbar is located within the Cornerstone Editor window, separate from the main Cornerstone toolbar.)

- Print preview
- Print
- Send email
- Client signature†
- Undo
- Redo
- Cut
- Copy
- Paste
- Select all
- Search
- Bookmark
- Picture
- Table
- Spell check
- Zoom
- Insert date and time
- Lock/Unlock document

† Not available during template setup; available only at the time of use.

Note: When using the Cornerstone Editor in text-only mode, the toolbar buttons available are limited to those options that pertain to text-based data entry. text-only mode also offers a Color All Text button that allows you to apply a single color to all text in the template or document.

Toolbars

(Enhanced templates only)

The toolbars include options for frequently used document elements, display settings, style settings and formatting tools. The toolbar can be turned on/off using the View menu > Tool Bars option.

<table>
<thead>
<tr>
<th>Toolbars</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Insert date/time, page number or number of pages, and show/hide non-printing characters such as returns, tabs and spaces</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Specify the magnification level for viewing the current template</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Set the paragraph style, font, font size and effect of selected text (bold, italics, underline)</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Set the justification of the paragraph (align left, center, align right, justify)</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Format selected text as a numbered/bulleted list, increase/decrease the indent, and set the text color</td>
</tr>
</tbody>
</table>

Editor Pane

The Editor pane is the template “page” where you add your desired text, pictures, tables and other elements. You can add elements within the Editor pane area using the menu bar, Editor toolbar or right-click menu.
Splitter Bar

You can drag the adjustable splitter bar up or down to increase or decrease the visible area of the Editor pane and Invoice Items pane. While editing a template, in most cases you would want the splitter bar at a lower position so that more editing space is available in the Editor pane. If you need to work in the Invoice Items pane, simply drag the splitter bar upward as needed to increase the working area of the Invoice Items pane while you are inserting or editing the template’s default items.

Invoice Items Pane

You can easily add default invoice items to a template using the Invoice Items pane located at the bottom of the Cornerstone Editor window. In the Cornerstone Editor, all invoice items reside in the Invoice Items pane, not in the body text of the template.

IMPORTANT: Default invoice items cannot be placed on a template designated as a special action that prints after an invoice is posted.

Notes:
- The Invoice Items pane does not display for Print Only templates.
- If you are converting from Classic to enhanced medical notes, note that both Consult items and invoice items from the Classic template are transferred to the Invoice Items pane in the enhanced template and marked as Accepted.

To add default invoice items to a document template:

1. In the Invoice Items pane, double-click or press F2 in any blank Item ID row to open the Invoice Item list, allowing you to search for and select the desired item. An empty “add item” row always appears below the existing item rows.

2. After adding an item, you can use the ▼ and ► arrow buttons to rearrange the order of the item lines as needed. (Note: You cannot rearrange the order of item lines that are part of a group code.)

3. You can also change the item status by clicking on the gray box to the left of each item row. Item status options during template setup include:
   - Blank—An item assigned a Blank status can be thought of as “sitting dormant” until you decide to utilize it, which means it will not be sent to the Patient Visit List. In some cases, you may want to add items to the template with a Blank status and let the staff member decide at the time of use whether to change the status.
   - Recommended—This item or service has been recommended for purchase by the client.
   - Accepted—The client has accepted the item (wants to purchase the service or item).
   - Performed—The item has been dispensed or the service has been performed.

Note: The Declined or Declined to history statuses are not available when setting up default invoice items in the template.
Page Setup and Formatting Tools

**Tip:** For a list of keyboard shortcuts available for use in the Cornerstone Editor, see “Chapter 17: Using Medical Notes and Correspondence” in the *Cornerstone User’s Manual*.

**Ruler Bars**

Select **View > Horizontal Ruler** or **Vertical Ruler** to turn on/off the ruler display. The horizontal ruler includes indicators for indent settings and tab stops, and allows you to quickly change these settings directly on the ruler. The vertical ruler includes a tab selector icon that you can click to change the tab type.

See the “Tab Stops” section that follows for information on setting tab stops on the ruler.

**Page Setup Options**

*(Enhanced templates only)*

Use **File > Page Setup** to set up options such as columns, text flow direction, page orientation (Portrait or Landscape), paper size, and paper source.

Tab Stops

The Cornerstone Editor supports left, right, center and decimal tab stops. The tab stops can be set for the current paragraph or all lines in a highlighted block of text.
**To set/clear tab stops using the rulers:**

**Tip:** To easily set the tab type and add tab stops directly on the rulers, you will need to display both the horizontal and vertical rulers (the tab selector icon appears at the top of the vertical ruler only when both rulers are displayed).

<table>
<thead>
<tr>
<th>To add this type of tab</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Left tab                | Click the left mouse button on the ruler at the desired location  
  OR Click the tab selector until it shows and then click the left mouse button on the ruler at the desired location |
| Right tab               | Click the right mouse button on the ruler at the desired location  
  OR Click the tab selector until it shows and then click the left mouse button on the ruler at the desired location |
| Center tab              | Hold the SHIFT key, and click the left mouse button on the ruler at the desired location  
  OR Click the tab selector until it shows and then click the left mouse button on the ruler at the desired location |
| Decimal tab             | Hold the SHIFT key, and click the right mouse button on the ruler at the desired location  
  OR Click the tab selector until it shows and then click the left mouse button on the ruler at the desired location |

**To move a tab stop using the rulers:**

➢ On the ruler, click on the tab indicator and drag it to the desired location on the ruler.

**To clear a tab stop using the rulers:**

➢ On the ruler, click on the tab indicator and drag it downward off the ruler.

**To set tab stops using the Paragraph menu:**

1. On the Paragraph menu, select Set Tab. The Set a Tab Position dialog box appears.

![Set a Tab Position dialog box](attachment:image.png)

2. Specify the Tab Type (left, right, center, decimal).
3. If desired, select a Tab Leader (dot, hyphen, or underline).
4. Click OK.
To clear tab stops using the Paragraph menu:
➢ On the Paragraph menu, select **Clear All Tabs**.

**Page Margins**

*(Enhanced templates/documents only)*

Use **File > Page Margins** or set as you go by moving the margin indicators on the horizontal ruler (select **View > Horizontal Ruler** to turn on/off the ruler display).

**Document Template Setup Tools**
**Note:** When creating a text-only template (versus an enhanced document template), the menus, toolbar buttons and right-click menus available in the Cornerstone Editor are limited to those options that pertain to text-based data entry. Throughout this section, those features not available in text-only mode will be marked with an *(Enhanced templates only)* designation.

**Note:** The Cornerstone Editor window varies slightly depending on if you are in setup or use mode. Note that some features covered in this section are available during both template setup and document use. Additional Cornerstone Editor features are covered in “Chapter 17: Using Medical Notes and Correspondence” in the *Cornerstone User’s Manual*.

**Note:** The Insert menu > OLE Object option is not supported at this time. Although advanced users may find specific uses for it in certain types of complex documents, it is not recommended for general use in Cornerstone.

**Adding or Editing a Header/Footer**
*(Enhanced templates only)*

You can use the Insert menu > Header/Footer options to insert text, logos, page numbers, etc. at the top (header) or bottom (footer) of a page to display on each page of the document. For example, you could add a Header for letterhead-type information, including the practice logo and contact information. The Footer area could be used for the page number, date or client/patient names and IDs.

**Note:** All new document templates and converted Classic templates are created using the default setup document template, which includes a header and footer containing bookmarks for standard information (clinic information, client information, patient information, date, etc.). See “Customizing the Default Setup Document Template” on page 335 for more information on changing the default template.

**To add, edit or delete header/footer information:**

- **To add a header/footer**– On the Insert menu, select Header/Footer > Insert Header or Insert Footer. A dotted line displays to show the boundary of the header/footer on the page. Click within the header/footer area and add text, bookmarks, graphics or other elements as needed.

- **To edit a header/footer**– On the Insert menu, select Header/Footer > Edit Header Footer. A dotted line displays to show the boundary of the header/footer on the page. Click within the header/footer area and make any modifications as needed.

- **To delete a header/footer**– On the Insert menu, select Header/Footer > Delete Header or Delete Footer.

**Inserting Bookmarks**

Bookmarks for Cornerstone data can be included in document templates. At the time of use, when a document with bookmarks is printed, the bookmarks are replaced with the applicable data. For example, if the client FullName bookmark is included in the template, the client’s name replaces the bookmark in the document at the time of use.

See “Cornerstone Bookmarks Available for Use in the Cornerstone Editor” on page 326 for a complete listing of all bookmarks available when creating a document template in the Cornerstone Editor.

**Note:** If the Cornerstone data that a field requests is not available (such as a client missing an address), *nothing* appears in that space when you print the document.
Chapter 17: Setting Up Medical Notes and Correspondence

Select Bookmark dialog box

Note: If you convert a Classic medical note to an enhanced medical note, any data fields that were contained in the Classic medical note will convert to Question bookmarks in the enhanced medical note. See “Conversion of Existing Data Fields in Classic Template” on page 344 for more information.

**Important Guidelines for Inserting Bookmarks**

- When adding multiple bookmarks in succession, **always add a space** between the bookmarks to separate them and avoid placement issues later (you cannot click between two touching bookmarks and insert text or punctuation).

- Any bookmarks that are copied from one template and pasted into another template will lose their functionality and these bookmarks will not work (if pasted into another document template they will display normally, but they will not function). To reuse bookmarks you must either use the Document Template List **Copy** button to create a copy of the template containing the bookmarks or use **Save As** to save the template with a different name.

- Depending on their intended use, Question bookmarks added in previous versions of correspondence may better suit your needs as Text Input Fields. They can be easily identified within a document and can be filled in at any time while completing the document. See “Inserting Text Input Fields” on page 330 for more information.

- When adding bookmarks to a text-only template, only text-based bookmarks can be used (image- or table-based bookmarks are not available for selection).

**To insert a bookmark in a document template:**

**Note:** See the “Cornerstone Bookmarks Available for Use in the Cornerstone Editor” section that follows for information on the bookmarks available when creating a document template in the Cornerstone Editor. This section also includes information on specific steps required to set up special types of bookmarks (Medical Notes, Question, Vaccination and Signature bookmarks).

1. Right-click in the document template where you want to insert a bookmark and select **Insert > Bookmark**. Alternatively, you can click the **Bookmark** button on the editor toolbar or select **Bookmark** from the **Insert** menu. The Select Bookmark dialog box appears.

**Note:** The right-click option is not available when inserting a bookmark within a table.

2. In the **File Description** drop-down list, select the type of Cornerstone file to use to create the bookmark (e.g., Client, Invoice Items, Patient, etc.).
3. In the **Text box Description** drop-down list, select the type of text box data to pull from the selected file (e.g., Full Name, Patient ID, Rabies Tag Number, etc.). The corresponding bookmark displays in the **Bookmark** text box.

4. Click **Add Bookmark**. Cornerstone inserts the bookmark into the document template.

5. Click **Close** to close the Select Bookmark dialog box and return to the document template.

**Cornerstone Bookmarks Available for Use in the Cornerstone Editor**

**Note:** When adding bookmarks to a text-only template, only text-based bookmarks can be used (image- or table-based bookmarks are not available for selection).

**Boarding**

These bookmarks can be used only if your practice has purchased Cornerstone Boarding and Grooming module.

- **Arrival Date**
- **Cage Number**
- **Departure Time**
- **Arrival Time**
- **Cage Type**
- **Patient Information**
- **Boarding Status**
- **Departure Date**

**Choice**

- **our/your**
- **us/you**
- **we/you**

**Client**

- **Address 1**
- **Full Name**
- **Note**
- **Referred Post Address**
- **Address 2**
- **ID**
- **Outstanding Balance**
- **Referred State**
- **All Phones**
- **Last Month A/R**
- **Overdue Balance**
- **Secondary Name**
- **City**
- **Last Name**
- **Phone Description**
- **Sixty Days A/R**
- **Classification**
- **Last Payment Amount**
- **Phone Extension**
- **State**
- **Client Signature**
- **Last Payment Date**
- **Phone Number**
- **Status**
- **Credit Code**
- **LY Sales - Inventory**
- **Postal Code**
- **Thirty Days A/R**
- **Current A/R**
- **LY Sales - Services**
- **Referred Address 1**
- **Title**
- **Date Client Entered**
- **LY Visits**
- **Referred Address 2**
- **YTD Sales - Inventory**
- **Email Address**
- **Middle Initial**
- **Referred By Name**
- **YTD Sales - Services**
- **Finance Charges A/R**
- **Ninety Days A/R**
- **Referred City**
- **YTD Visits**

**Note:** A/R totals do not include current invoices. Use **Current A/R** or **Outstanding Balance** text boxes to include amounts not yet included in an end-of-day processing.

**Imaging**

- **Image**
- **Patient Picture**

**Invoice Items**

Choose any invoice item from the Invoice Item List.
Chapter 17: Setting Up Medical Notes and Correspondence

Lab

These bookmarks can be used only if your practice has purchased the Laboratory module.

Lab results

Medical History

Abnormal exam observations only  All exam observations
Departing instructions  Patient diagnosis

Medical Notes

If desired, medical notes can be inserted into a document template (typically a correspondence template) using a Medical Notes bookmark.

IMPORTANT: When selecting the medical notes to include in the template, note the save status of the document (Draft, Tentative or Final). This save status is important to note, as you would not want to include a Draft medical note in a referral letter or client handout.

Note: The option to display only part of a medical note in correspondence applies only with Classic medical notes. You cannot include part of a medical note in a correspondence document with enhanced medical notes; with enhanced medical notes the entire document is included. You can then select and delete any included content that is not applicable.

Miscellaneous

Current Date

Patient (Includes Rabies Tag)

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Bookmark Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age</td>
<td>Current Weight Unit Date</td>
</tr>
<tr>
<td>Birth Date</td>
<td>Date Current Weight</td>
</tr>
<tr>
<td>Breed</td>
<td>Date Patient Entered</td>
</tr>
<tr>
<td>Check In Date (last)</td>
<td>Deceased Date</td>
</tr>
<tr>
<td>Check In Time (last)</td>
<td>Manner of Injection</td>
</tr>
<tr>
<td>Check Out Date (last)</td>
<td>Markings</td>
</tr>
<tr>
<td>Check Out Time (last)</td>
<td>Name</td>
</tr>
<tr>
<td>Color</td>
<td>Microchip ID</td>
</tr>
<tr>
<td>Current Weight</td>
<td>Number of Years</td>
</tr>
<tr>
<td></td>
<td>Patient Classification</td>
</tr>
<tr>
<td></td>
<td>Patient ID</td>
</tr>
<tr>
<td></td>
<td>Patient Note</td>
</tr>
<tr>
<td></td>
<td>Patient Status</td>
</tr>
<tr>
<td></td>
<td>Rabies Expiration Date</td>
</tr>
<tr>
<td></td>
<td>Rabies Tag Date</td>
</tr>
<tr>
<td></td>
<td>Rabies Tag Number</td>
</tr>
<tr>
<td></td>
<td>Registration Number</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Bookmark Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sex</td>
<td>Species</td>
</tr>
<tr>
<td></td>
<td>Vaccine Amount</td>
</tr>
<tr>
<td></td>
<td>Vaccine Expiration</td>
</tr>
<tr>
<td></td>
<td>Vaccine Lot Number</td>
</tr>
<tr>
<td></td>
<td>Vaccine Name</td>
</tr>
<tr>
<td></td>
<td>Vaccine Producer</td>
</tr>
<tr>
<td></td>
<td>Vaccine Type</td>
</tr>
</tbody>
</table>
Chapter 17: Setting Up Medical Notes and Correspondence

Practice

<table>
<thead>
<tr>
<th>All Phones</th>
<th>Clinic City</th>
<th>Clinic Name 2</th>
<th>Clinic Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clinic Address 1</td>
<td>Clinic Name</td>
<td>Clinic Phone</td>
<td>Clinic State</td>
</tr>
<tr>
<td>Clinic Address 2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Prescription Instructions

Choose any prescription instruction from the Prescription Instruction List.

Question

You can use Question bookmarks to prompt staff to answer questions when the document is added to a patient’s record at the time of use.

Cornerstone uses the text you enter for your merge question as the name of the question bookmark that appears in the document template. If desired, you can change the name of the bookmark to make it more meaningful. A bookmark can be up to 40 characters with no spaces.

![Question bookmark](image)

When you select a document template at the time of use, the document opens in the Cornerstone Editor and you are immediately prompted to answer all of the questions (Question bookmark prompts) in that document. The questions are asked in the order they appear in the document. The answer you type is printed in the document. To leave a question unanswered in the document, type a space or simply click **Cancel**.

Referral Doctor

<table>
<thead>
<tr>
<th>All Phones</th>
<th>Ref. Doctor Last Name</th>
<th>Ref. Doctor Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ref. Doctor Address 1</td>
<td>Ref. Doctor City</td>
<td>Ref. Doctor State</td>
</tr>
<tr>
<td>Ref. Doctor Address 2</td>
<td>Ref. Doctor Email</td>
<td>Ref. Doctor Title</td>
</tr>
<tr>
<td>Ref. Doctor First Name</td>
<td>Ref. Doctor Fax</td>
<td>Ref. Doctor Phone Number</td>
</tr>
<tr>
<td>Ref. Doctor Full Name</td>
<td>Ref. Doctor License</td>
<td>Ref. Doctor Phone Desc.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ref. Doctor Phone Extension</td>
</tr>
</tbody>
</table>

Referral Hospital

<table>
<thead>
<tr>
<th>All Phones</th>
<th>Ref. Hospital City</th>
<th>Ref. Hospital Fax</th>
<th>Ref. Hospital Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ref. Hospital Address 1</td>
<td>Ref. Hospital Email</td>
<td>Ref. Hospital Name</td>
<td>Ref. Hospital State</td>
</tr>
<tr>
<td>Ref. Hospital Address 2</td>
<td>Ref. Hospital Phone Number</td>
<td>Ref. Hospital Phone Desc.</td>
<td>Ref. Hospital Phone Extension</td>
</tr>
</tbody>
</table>
Reminder Info

After you select the Invoice Item, the Reminder Information choices display. Specify whether you want to enter the Description–Reminder Due, Description–Reminder Given, Given Date, Due Date or Use Pattern.

Staff

<table>
<thead>
<tr>
<th>All Phones</th>
<th>Staff Extension</th>
<th>Staff License Number</th>
<th>Staff Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staff Address 1</td>
<td>Staff First Name</td>
<td>Staff Middle Initial</td>
<td>Staff State</td>
</tr>
<tr>
<td>Staff Address 2</td>
<td>Staff Full Name</td>
<td>Staff Note</td>
<td>Staff Status</td>
</tr>
<tr>
<td>Staff City</td>
<td>Staff ID</td>
<td>Staff Phone Description</td>
<td>Staff Title</td>
</tr>
<tr>
<td>Staff Classification</td>
<td>Staff Last Name</td>
<td>Staff Phone Number</td>
<td>Signature</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Signature w/Pwd</td>
</tr>
</tbody>
</table>

**Note:** In order to use a Staff Signature bookmark (or a Signature w/Pwd bookmark), you must first set up your system to use a supported signature capture device. See “Setting Up a Signature Capture Device” on page 16 for more information.

User-Defined Client and Patient Prompts

You can place the answer to a client or patient prompt in the document. The client or patient prompts that appear as field descriptions are the same prompts that are currently set up in Cornerstone.

Vaccinations

Vaccinations work in the same way as reminder information. Using vaccination bookmarks (Description - Reminder Due, Description–Reminder Given, Given Date, Due Date), you can create health and vaccination certificates.

Before inserting vaccination bookmarks in a template, you must first set up your Vaccination Bookmarks defaults (see “Vaccination Bookmarks Defaults” on page 138).

After vaccination preferences and pattern have been selected, bookmarks for the selected vaccinations can be included in documents. To include vaccination preferences in a document, select the **Use preferences** check box when setting up the bookmark.

![Vaccinations bookmark](image)

When documents with the bookmarks are printed, the bookmarks are replaced by vaccination information from the selected patient’s record.
**Inserting Text Input Fields**

When setting up a document template, you can insert Text Input Fields that allow you to create preset form fields. These fields can be filled in or “answered” by the staff member at the time the medical note or correspondence document is added for a patient.

**Tip:** All Text Input Fields display with a light gray background so they are easily identified at a glance within the document.

Once the Text Input Fields are set up, you then have the option of locking the document so that at the time of use the staff member can easily tab from field to field to fill in the patient-specific data or accept the default data.

**Tips for Inserting Text Input Fields:**

- If it is a patient-specific field and does not have a commonly used answer, you may want to enter a prompt as the Initial Data placeholder text (e.g., [enter Hx here]). If the field needs to be limited to a small number of characters, you may want to enter XX or something similar (e.g., if the answer needs to be a 2-digit number, you could enter ## for the Initial Data).

- If your default data (Initial Data) is a paragraph of text, you can insert a placeholder word in the Initial Data box in the Input Field Parameters dialog box. Then, after clicking **OK** to create the field, you can click within it and add additional text or copy/paste text into the field.

- For some form fields where the “answer” is a choice between two or three possible answers, you may want to insert all possible answers as the Initial Data. At the time of use, the staff member can leave the chosen answer and delete the unwanted answers. For example, if the answer is either Left or Right, use “Left/Right” as the Initial Data, and, at time of use, instead of typing one or the other, you can simply delete the unwanted one.

**To insert a Text Input Field in a document template:**

1. When setting up or updating a document template, in the Cornerstone Editor, right-click and select **Insert > Text Input Field**. The Input Field Parameters dialog box appears.
2. In the **Field Name** box, type a name by which to identify this field.

3. In the **Initial Data** box, type the default “answer” text to appear in the field. In most cases, you would want to enter the most commonly used answer so that, at the time of use, the staff member can simply press **TAB** to accept the default data and move to the next field.

   **Note:** If you do not provide Initial Data to serve as the placeholder text, the document will display underscore characters “__” for this field at the time of use.

4. In the **Maximum Field Length** box, type the maximum number of characters to accept in this field.

   **Tip:** In many cases you may want to leave the **Maximum Field Length** blank to allow text entry in the template at the time of use.

5. If you want to specify a particular font for the field (e.g., a font that stands out from the other text on the page), click the **Font** button to select a font, style, size, color and effects.

6. Click **OK**.

7. When you are finished with the template setup, if you want to “lock” the document to allow for quick tab-through data entry at the time of use, click the **Lock/Unlock document** button.

   **Note:** The **Lock/Unlock** setting can be turned on or off at use time if desired.

### Inserting Check Boxes

*(Enhanced templates only)*

You can easily insert a check box that changes state when clicked—click once to place a check mark in the box, click again to clear the check mark.

**To insert a check box:**

- Right-click within the editor pane and select **Insert > Check Box**. The check box is added at the current cursor location.

**Tip:** To get check boxes to line up nicely into straight vertical columns, use a fixed-size font (e.g., Courier, Lucida Console, etc.) or use tabs.

### Inserting Tables

*(Enhanced templates only)*

The Cornerstone Editor makes it easy to add simple or complex tables. Tables can be used to organize or group categories of information within a document, or can be used to provide a cleaner layout for content-heavy documents.

The standard **Table** option inserts a simple table based on the number of rows and columns you specify. You can then right-click within the table to insert rows or columns, or to apply formatting like borders and shading. You can also use the **Table** menu options to apply detailed table formatting options for cell positioning, flow, color, rotation, etc.

---

Cornerstone Administrator's Manual
Chapter 17: Setting Up Medical Notes and Correspondence

Cornerstone Administrator's Manual

Note: When working within a table, the right-click options available are specific to table-related tasks. To insert elements within a table cell you must use the menus or toolbar buttons.

To insert a table:
1. Right-click in the document template where you want to insert a table and select Insert > Table. Alternatively, you can click the Table button on the editor toolbar or select Insert Table from the Table menu. The New Table Parameters dialog box appears.
2. Specify the number of rows and columns, and then click OK. The table is inserted at the current cursor location.
3. To move from one cell to another within the table, press TAB.
4. To insert a new line within a cell, press SHIFT+ENTER.
5. To apply formatting or adjust positioning within the table, right-click within the table to access a shortcut menu of frequently used table editing commands. Alternatively, you can choose from an extensive list of table editing commands in the Table menu.

Inserting a Problem Description Prompt or Problem Details Prompt
(Enhanced templates only)

In the Cornerstone Editor, problem prompts can be added during template setup, and then at use time the staff member can simply click on the prompt link to select the problems. (Or, if needed, a problem can be added at use time even if a problem prompt is not added during setup.)

Problems can be documented in two different formats (both display as underlined links during setup):

- **Problem description** inserts the problem description text into the body of your text or paragraph. If multiple problem descriptions are selected, they display separated by commas (example shown below). In most cases, this is the format you would want to use within a document, inserting the problem text within the text of a predefined paragraph.

  Example:

  Abdominal Enlargement, Abdominal Pain

- **Problem details** inserts a "detail block" table that includes all information associated with the problem (Description, Severity, State, Staff, Date, Modified Date). If multiple problem details are selected, they display as separate rows in the detail block (example shown below). This format is typically used for inserting at the end of a medical note, or for a document being sent to a referring doctor.

<table>
<thead>
<tr>
<th>Name: James Smith</th>
<th>Animal: MAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address: 81 27th Street NW, Eau Claire, WI</td>
<td>Age: 7 yrs. 11 mos.</td>
</tr>
<tr>
<td>Phone: (715) 734-5631</td>
<td>Color: Black/Tan</td>
</tr>
<tr>
<td>Email:</td>
<td>Breed: DOBERMAN</td>
</tr>
<tr>
<td>Date: 5/5/2009</td>
<td>Sex: Neuter</td>
</tr>
<tr>
<td>05-05-09</td>
<td>03 May, 2009</td>
</tr>
</tbody>
</table>

| Note: When working within a table, the right-click options available are specific to table-related tasks. To insert elements within a table cell you must use the menus or toolbar buttons. |
Example:

<table>
<thead>
<tr>
<th>Diagnosis Description</th>
<th>Severity</th>
<th>State</th>
<th>Create Staff</th>
<th>Create Date</th>
<th>Modified Date</th>
</tr>
</thead>
</table>

To insert a problem description prompt/problem details prompt in a template:

- Place your cursor in the desired location, right-click and select Insert > Add problem description prompt (or Add problem details prompt).

  The prompt displays in the template as an underlined link. At use time the staff member can simply click on the link to access the Problems dialog box and specify the problems to add to the document.

**Inserting a Diagnosis Description Prompt or a Diagnosis Details Prompt**

*(Enhanced templates only)*

In the Cornerstone Editor, diagnosis prompts can be added during template setup, and then at use time the staff member can simply click on the prompt link to select the diagnoses. (Or, if needed, a diagnosis can be added at use time even if a diagnosis prompt is not added during setup.)

**Note:** Diagnoses added to a document (medical note or correspondence document), do not finalize automatically.

Diagnoses can be documented in two different formats (both display as underlined links during setup):

- **Diagnosis description** inserts the diagnosis description text as it is defined in Cornerstone. If multiple diagnosis descriptions are selected, they display separated by commas (example shown below). In most cases, this is the format you would want to add to a document.

  Example:

  **Gastric Dilatation and Volvulus, Gastritis: Acute**

- **Diagnosis details** inserts a “detail block” table that includes all information associated with the diagnosis (Code, Diagnosis, Date, Status, Staff). If multiple diagnosis details are selected, they display as separate rows in a diagnosis details table (example shown below). This format is typically used for sending documents to a referring doctor.

  Example:

<table>
<thead>
<tr>
<th>Code</th>
<th>Diagnosis Description</th>
<th>Date</th>
<th>Status</th>
<th>Staff</th>
</tr>
</thead>
<tbody>
<tr>
<td>12951</td>
<td>Gastric Dilatation and Volvulus</td>
<td>5/13/2009</td>
<td>Tentative</td>
<td>Mark Fiala DVM</td>
</tr>
<tr>
<td>12959</td>
<td>Gastritis: Acute</td>
<td>5/13/2009</td>
<td>Ruled out</td>
<td>Mark Fiala DVM</td>
</tr>
</tbody>
</table>

To insert a diagnosis description prompt/diagnosis details prompt in a template:

- Place your cursor in the desired location, right-click and select Insert > Add diagnosis description prompt (or Add diagnosis details prompt).
The prompt displays in the template as an underlined link. At use time the staff member can click on the link to access the Patient Diagnosis dialog box and specify the diagnoses to add to the document.

**Inserting a Vital Signs Prompt**

*(Enhanced templates only)*

In the Cornerstone Editor, a vital signs prompt can be added during template setup. With the prompt in place, at the time of use the staff member can simply click on the prompt link and select the patient’s vital signs information to insert in the document.

Example:

<table>
<thead>
<tr>
<th>Vital Sign</th>
<th>CS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>45 pounds</td>
</tr>
<tr>
<td>Body Score</td>
<td>3 - Optimal</td>
</tr>
<tr>
<td>Temp</td>
<td>99.2</td>
</tr>
<tr>
<td>Pulse</td>
<td>80</td>
</tr>
<tr>
<td>Resp</td>
<td>48</td>
</tr>
<tr>
<td>Muc Membr</td>
<td>Pink &amp; Healthy</td>
</tr>
<tr>
<td>Cap</td>
<td>2 sec</td>
</tr>
<tr>
<td>Pain Scale</td>
<td>2 - Mild Pain</td>
</tr>
</tbody>
</table>

**To insert a vital signs prompt in a template:**

- Place your cursor in the desired location, right-click and select **Insert > Vital Signs Prompt**.

  The prompt displays in the template as an underlined link. At use time the staff member can click on the link to access the Vital Signs selection window and select the patient’s vital signs information to insert in the document.

**Additional Cornerstone Editor Tools**

Several additional tools are available for enhanced templates/documents both at the time of setup and at the time of use:

- Text and paragraph formatting options
- Pictures and graphics

These tools are most often used at the time of use when adding a document to a patient record. For information on these tools, see “Chapter 17: Using Medical Notes and Correspondence” in the Cornerstone User's Manual.

**Cornerstone Editor Features and Limitations in Text-Only Mode**

When setting up a text-only template or adding a text-only medical note, the Cornerstone Editor displays in “text-only mode,” which has the following differences from the standard editor:

- A **Color All Text** button is available. This text-only option allows you to apply a single color to all text in the template or document. (Note: If the **Color All Text** option is used, the history description and document text will display in the selected color in patient history.)

- The menus, toolbar buttons and right-click menus available are limited to those options that pertain to text-based data entry.

- Only text-based bookmarks can be used (image- or table-based bookmarks are not available for selection).
• In the event that a text-only document is saved for the first time with its Hx description field left blank, if there is text in the first line of the document, that text will be used as the history description.

Note: If you copy and paste content into a text-only template or document, only plain text is pasted. Any font properties, formatting, tables, graphics, check boxes, etc. copied from an enhanced document will not be included when pasted in a text-only document.

**Customizing the Default Setup Document Template**

*(Enhanced templates only)*

The template designated as the default setup document template (set in Documents defaults) is used for creating a new enhanced document template and for converting to an enhanced template. The “Header and Footer (w/ fonts)” template is automatically set up as the default setup document template in Cornerstone. The “Header and Footer (w/ fonts)” template includes a header and footer containing bookmarks for clinic information, client information, patient information, date, etc. Unless you opt to designate a different default template in Documents defaults, the “Header and Footer (w/fonts)” template will be used every time you create a new document template or convert to an enhanced template.

Note: Although you do have the option to remove the predesigned header and footer bookmarks from the default template, we do not recommend removing this information. The predesigned header and footer contain key identifying information that should be included when printing most types of medical notes and correspondence. If you remove the bookmarks, then documents printed from your templates will not have any identifying information unless you include it separately in the body text.

Tip: The header and/or footer can be turned off for printing at the time of use from the Print Options dialog box, if desired.

**To set up your own default setup document template:**


2. With all templates displayed in the list (no category or favorites selected), in the Title or ID text box, type the word header.
Chapter 17: Setting Up Medical Notes and Correspondence

3. Select the **Header and Footer (w/fonts)** template and click **Update**.

The template opens in the Cornerstone Editor. It includes the header and footer bookmarks (text with gray background), along with temporary "IMPORTANT: PLEASE READ" instruction text in the body of the template.

4. Click **Save As**. The Template Properties dialog box appears.
5. Type a template name and select other desired settings in the Template Properties dialog box and click OK when finished. (See “Properties Banner” on page 317 for information on template properties.)

6. To remove the temporary instruction text from the body of the template, highlight the lines of text and press DELETE. (Do not do a CTRL+A to select all text, as this will also select the header/footer text.)

7. To make changes to the header or footer, select Insert > Header Footer > Edit Header Footer to turn on header/footer editing ability. Click within the header or footer and make any necessary changes.

8. Insert any other elements that you want to be included in every new document template (and converted Classic medical note) that you create.

9. Click OK to save your changes and close the Cornerstone Editor.

10. On the Controls menu, select Defaults > Practice and Workstation, and then select Documents in the navigation pane on the left. In the For new templates use: Medical Note ID field, press F2 (or double-click) and use the Document Template List to select the template you want to use as the default setup document template.

11. Click OK on the Practice and Workstation Defaults window to save your changes.

    When you create a new document template (or convert to an enhanced template), the newly designated default setup document template will be used.

**Designating the Text-Only Template to Use for Adding Quick Text Medical Notes**

The Medical Note Quick Text feature offers a simpler, faster option for adding information to a patient’s medical record. Similar to the “None” Classic medical note template available in Cornerstone 7.6 and earlier versions, the Medical Note Quick Text feature allows you to simply right-click on the Patient Clipboard and select Medical Note Quick Text, enter your staff ID, and immediately start typing your notes in the Cornerstone Editor.

You can get started immediately with no setup required by using the default Medical Note Quick Text template (the “Sample- Quick Text Blank” template). If you don’t want to use the blank default template, you can create your own text-only template (in Lists > Documents > Templates) and then assign your template as the “Medical Note Quick Text document” in Documents defaults.
Creating a New Document Template for Medical Notes or Correspondence

Tip: Sample templates are available in the “Samples” category. You can easily create a copy of one of these templates and modify it to meet the needs of your practice. See “Creating a Copy of an Existing Document Template” on page 340 for more information. You can also download new sample templates and import them into Cornerstone. See “Importing a Document Template” on page 340 for more information.

To create a new document template (enhanced or text only):
2. Click the New button to display a pop-up menu of template creation options.
3. From the **New** button’s pop-up menu, select **Document template** or **Text only template**. The Cornerstone Editor opens.

   **Note:** If you select **Text only template**, the Cornerstone Editor will display in text-only mode, which means that the menus, toolbar buttons and right-click menus available are limited to those options that pertain to text-based data entry.

   **Tip:** Use the **Zoom (100%)** drop-down list to select or enter a lower magnification level (like 75%) that allows you to increase the amount of the page you can see on screen.

4. Click **Edit Properties**. The Template Properties dialog box appears.

5. Specify the desired template settings in the Template Properties dialog box and click **OK** when finished. (See “Properties Banner” on page 317 for more information on template properties.)

6. Create the template as desired using the tools available in the Cornerstone Editor—Template Setup window. (See “Document Template Setup Tools” on page 323 for more information.)

7. To add invoice items to the template, in the Invoice Items pane, double-click or press F2 in any blank Item ID row to open the Invoice Item list, allowing you to search for and select the desired item. (See “Invoice Items Pane” on page 320 for more information on adding invoice items to a template.)

   **Note:** Items can be deleted later by staff when creating a document based on the template.

8. When you are finished setting up the template, do one of the following:

   - If you want to save the template and close the Cornerstone Editor, click **OK**. If any changes have been made to the template since it was last saved, the Template Properties dialog box appears. Click **OK** on the Template Properties dialog box to save changes and close the Cornerstone Editor.

   - If you want to save the template and remain in the Cornerstone Editor so that you can continue working on the template, click **Save**. (If this is the first time the template has been saved, the Template Properties dialog box appears.)

   - If you want to save the template with a new name (and optionally change the template type), click **Save As**. The Template Properties dialog box appears. Type a new name for the template.
and click OK to save changes and continue working on the newly saved template in the Cornerstone Editor.

- If you want to close the Cornerstone Editor without saving the template, click Cancel.

Importing a Document Template

Many sample document templates for medical notes and correspondence are available in the “Samples” category in Cornerstone. You can also download sample templates and import them into Cornerstone.

To download and import a document template:

2. If you have not already downloaded the document template to import, click the download link and download the desired template file to the Downloads folder in your Cornerstone directory (e.g., C:\Cstone\Downloads).
3. On the Import Document Template dialog box, click Browse and select the desired document template (.csz file) to import.
   
   Note: If a template with the same name already exists on your system, a message asks if you want to continue with the import. If you click Yes, a number is appended to the new template name (e.g., “Eye Exam” will be changed to “Eye Exam (1)”). If you click No, the currently selected template will not be imported. Click Browse to select a different template or click Cancel to close the Import Document Template dialog box without importing a template.
4. Click Import Template. A message displays to inform you that the import was successful.
   
   The next time you access the Document Template List window, the imported template will be available for selection in the Samples category.
   
   Note: If the Document Template List window is open while you import the template, you will need to close the Document Template List window and reopen it in order to see the new template in the list.

Creating a Copy of an Existing Document Template

You can create a copy of an existing template and assign a new name to the copied (new) template. The new template will contain all elements from the original (copied) template and any bookmarks will retain their functionality.

Note: You can use copy (CTRL+C) and paste (CTRL+V) to copy portions of text, graphics, tables and other elements from one template to another. It is important to note, however, that bookmarks will not retain their functionality when copied in this way. New bookmarks must be inserted in the document or you must create a copy of the entire template using the Document Template List Copy button method described below.

Tip: Sample templates for enhanced medical notes are available in the “Samples” category. You can easily create a copy of one of these templates and modify it to meet the needs of your practice.

To create a copy of an existing template:

1. On the Lists menu, select Documents > Templates.
2. Select the template to copy and click Copy.
3. Enter a new description (name) for the template and click OK.
Using “Save As” to Save an Existing Template as a Different Template Type

You can use Save As to save a correspondence template as a medical note template, or vice versa.

**To save an existing document template as a different template type:**

1. On the Lists menu, select Documents > Templates.
2. Select the applicable enhanced medical note or correspondence template and click Update.
3. On the Template Update window, click Save As. The Template Properties dialog box appears.
4. In the Name text box, type a unique name to use for this template (must be different from the name of the existing template).
5. In the Type drop-down list, select a different template type (Print Only, Correspondence or Medical Note).
6. Click OK to close the Template Properties dialog box.
7. Click OK to close the Cornerstone Editor.

Showing Correspondence with Medical Notes in History

The Show past and future uses of this template on the Medical Notes tab, Daily Planner, Check-in Report, Patient History Report option is available when setting up the properties of a new document template. You may want to use this option if:

- You are a referral practice and you would like referral documents to serve a dual purpose as medical notes and referral documents.
- In previous versions of Cornerstone you used correspondence to add medical notes to a patient record and you wish to continue this practice. Using this option you can set the correspondence template to appear in history with medical notes.
- In previous versions of Cornerstone you used correspondence to add medical notes because of their flexibility/formatting options but now want to change them to medical notes for future use. In this case, select the Show past and future uses... check box in the correspondence document’s properties so that old uses of the template show with medical notes, and then use Save As to save as an enhanced medical note template.

**To set a correspondence template to appear in history with medical notes:**

1. On the Lists menu, select Documents > Templates.
2. Select the applicable correspondence template and click Update.
3. On the Cornerstone Editor’s Template Update window, click Edit Properties.
4. Select the Show past and future uses of this template on the Medical Notes tab, Daily Planner, Check-in Report, Patient History Report check box.
5. Click OK.
6. Click Save.
Converting Medical Note Templates

On the Document Template List window, select a template in the list and then click **Convert**. The conversion options available depend on the type of template you selected to convert.

Conversion options include:

- **Enhanced converted to Text Only**–Converts the template and opens it for editing in the Cornerstone Editor (in text-only mode). The template retains only text from the enhanced template; tables, images, check boxes, etc. will be removed.
- **Text Only converted to Enhanced**–Converts the template and opens it for editing in the Cornerstone Editor.
- **Classic converted to Enhanced**–Converts the template and opens it for editing in the Cornerstone Editor.
- **Classic converted to Text Only**–Converts the template and opens it for editing in the Cornerstone Editor (in text-only mode).

**Conversion notes:**

- When you convert a template, the original template is saved but inactivated. Even if you cancel before saving the converted template, the conversion will still occur.
- Once a template is converted and automatically inactivated, you can activate it again if necessary. Note, however, that you cannot convert that same template a second time.
- Bookmarks and invoice items are retained in the conversion, but note that when converting to a text-only template, any non-text bookmarks will be removed.
- When you convert a Classic template to an enhanced template, any standard data field prompts (Patient ID, Patient Name, Birthdate, Breed, etc.) in the Classic template will automatically be changed to the matching bookmark type in the converted medical note. See “Conversion of Existing Data Fields in Classic Templates” on page 344 for information.
- When you convert a Classic template, all invoice items are moved to the Invoice Items pane in the enhanced medical note template and are marked as Accepted.
- When you convert a Classic template, if you have invoice items included in the body of the template, these items will not remain in the body text but will be moved to the Invoice Items pane in the converted template.

**To convert a template:**

1. On the Lists menu, select **Documents > Templates**. The Document Templates List dialog box appears.
2. Select the template you want to convert and click the **Convert** button. A Convert message displays information on the type of conversion you are about to perform.
3. To continue with the conversion, click **OK**. The template is converted and opens in the Cornerstone Editor’s Template Update window.
4. Click **Edit Properties**. The Template Properties dialog box appears.

**Note:** The Template Properties dialog box also appears automatically if you click **Save** for the first time, if you click **OK** without first setting the properties, or if you click **Save As**.
5. Specify the desired template settings in the Template Properties dialog box and click **OK** when finished. Note that the **Name** must be different from the name of the template you are converting. (See “Properties Banner” on page 317 for information on template properties.)

6. Edit the converted template as desired using the object creation and formatting tools available in the Cornerstone Editor–Template Update window. (See “Document Template Setup Tools” on page 323 for more information.)

   **Tip:** When creating or updating a template, both bookmarks and Text Input Fields appear with a gray background, but bookmarks are easily distinguishable by the brackets `{ }` that appear around them.

7. To add invoice items to the template, in the Invoice Items pane, double-click or press F2 in any blank Item ID row to open the Invoice Item list, allowing you to search for and select the desired item. (See “Invoice Items Pane” on page 320 for more information on adding invoice items to a template.)

   **Note:** Items can be deleted later by staff at the time of use when creating a document based on the template.

8. When you are finished setting up the template, do one of the following:

   - If you want to save the template and close the Cornerstone Editor, click **OK**. If any changes have been made to the template since it was last saved, the Template Properties dialog box appears. Click **OK** on the Template Properties dialog box to save changes and close the Cornerstone Editor.
   - If you want to save the template and remain in the Cornerstone Editor so that you can continue working on the template, click **Save**. (If this is the first time the template has been saved, the Template Properties dialog box appears.)
   - If you want to save the template with a new name (and optionally change the template type), click **Save As**. The Template Properties dialog box appears. Type a new name for the template and click **OK** to save changes and continue working on the newly saved template in the Cornerstone Editor.
   - If you want to close the Cornerstone Editor without saving the template, click **Cancel**. (Remember, even if you cancel before saving the converted template, the conversion will still occur.)
Conversion of Existing Data Fields in Classic Templates

When you convert a Classic medical note template, any standard data field prompts (Patient ID, Patient Name, Birthdate, Breed, etc.) in the Classic template will automatically be changed to the matching bookmark type in the converted medical note. For example, a [PATIENT ID] data field in the Classic template will be changed to a {PATIENTID} bookmark in the converted template. For more information on bookmarks in the Cornerstone Editor, see “Inserting Bookmarks” on page 324.

Conversion of data fields from a Classic template to an Enhanced template

For any custom data fields in the Classic template that do not have a matching bookmark in the enhanced template, Cornerstone will convert them as shown in the following table.

<table>
<thead>
<tr>
<th>Classic Template–Custom Data Field</th>
<th>Converts to…</th>
</tr>
</thead>
</table>
| [CHAR]                            | Text Input Field if it contains any default data  
                          | Question bookmark if it does not contain any default data |
| [CONSULT ITEM]                    | Item will be added to the Invoice Items tab with Accepted status |
| [DIAGNOSIS]                       | “Add_Diagnosis_Description” link |
| [IMAGE #]                         | Text Input Field if it contains any default data  
                          | Question bookmark if it does not contain any default data |
| [INVOICE ITEM]                    | Item will be added to the Invoice Items tab with Accepted status |
| [NUMERIC]                         | Text Input Field if it contains any default data  
                          | Question bookmark if it does not contain any default data |
| [PROBLEMS]                        | “Add_Problems_Description” link |
| [REMARKS]                         | Text Input Field if it contains any default data  
                          | Question bookmark if it does not contain any default data |

All other custom predefined fields  | Text Input Field if it contains any default data  
                          | Question bookmark if it does not contain any default data |

Tip: If you end up with Question bookmarks for data that is not known upon starting a medical note for a patient (which is when the pop-up question appears), this may pose a problem because although the bookmarks are still there, you cannot easily determine where they are located within a document. To avoid this issue, you may want to redo these Question bookmarks as Text Input Fields. Text Input Fields
are easily visible with a gray background and these fields can be filled in at any time when creating the
document. See “Inserting Text Input Fields” on page 330 for more information.

**Inactivating a Document Template**

You can flag a medical note or correspondence template as inactive so it will not appear by default
when searching the template list.

**To inactivate a template:**

1. On the Lists menu, select Documents > Templates.
2. Select the applicable template and click Update.
3. On the Template Update window, click Edit Properties. The Template Properties dialog box
   appears.
4. Select the Inactive check box.
5. Click OK to close the Template Properties dialog box.
6. Click OK to close the Cornerstone Editor.

**Setting Up a Special Action to Associate a Document Template with an Invoice Item**

Using the Print Document special action, you can associate a particular document template with an
invoice item so that the document automatically opens in the Cornerstone Editor when the designated
“When to apply” action takes place. At that point, staff can add information to the document and save it
in patient history (and optionally print the document, if desired).

**To set up a Print Document special action for an invoice item:**

1. On the Lists menu, select Invoice Item. The Invoice Item List appears.
2. Select the item that you want to link a document to and click Update. The item information displays
   in the Invoice Item Information window.
3. Click the Spec. Actions tab.
4. In the **Special action** field, select **Print Document**. (Note: Select this option even if you do not plan to actually *print* the document. This option also applies for viewing a document and updating/saving a document in patient history.)

5. In the **When to apply** field, select one of the following options to specify when to open the document in the Cornerstone Editor:
   - Optional on invoice (you can click the **Special** button and process the special action at any time during invoicing, or you can wait until the invoice is saved or posted, at which time the Special Action box automatically appears)
   - Before invoice is posted
   - Immediately on invoice/PVL (the Special Action dialog box appears when the item is added or moved to the invoice or Patient Visit List)
   - Print after invoice posted
   **Note:** If the document template you are linking to contains default invoice items, it cannot be set up to print after the invoice is posted.

6. In the **Doc ID** field, type a document ID or press F2 to use the Document Template List to choose a document template.
   **IMPORTANT:** Make sure the selected document template does not contain this item (the item you are linking the special action to) as a default invoice item, as this would create a perpetual loop.

7. Click **OK** to save your changes.

**Example:**

A practice has set up a CRUCIATE SURGERY service item with a **Print Document** special action set to display the “Anterior Cruciate Ligament Surgery Report” document when the item is sent to an invoice or to the Patient Visit List (PVL). With this type of special action setup in place, when a CRUCIATE SURGERY service is completed on the invoice or PVL (or on the Whiteboard Patient Treatments window), the surgery report immediately displays in the Cornerstone Editor. At that time, staff can add information to the document and save it in patient history (and optionally print the document, if desired).

**Customizing Document Templates for PetDetect® Collars**

Cornerstone includes a variety of size options for PetDetect Collars that you can print from the Cornerstone Editor. These animal identification and tracking collars can be easily printed upon check-in and used to help hospital staff with immediate and positive identification of pets and their belongings.

**Note:** The collars work best for dogs; they are too wide for most cats.

All fields and information included on the collars can be modified and customized using bookmarks in the Cornerstone Editor.

**Note:** This feature requires the PetDetect PD-700 label printer. To order a PetDetect printer, call 1-800-283-8386.

**To customize a Sample PetDetect Collar template:**

1. On the **Lists** menu, select **Documents > Templates**.
2. On the Document Template List window, in the **Category** drop-down list, select **Samples**.
3. Check to make sure the **Print Only** check box is selected for the template type.
4. With the **Search for word** option selected, in the **Title or ID** box, type **petdetect**.
5. Select the Sample PetDetect Collar to be modified.

6. Click **Update**. The selected collar label opens in the Cornerstone Editor.

7. Use the Cornerstone Editor tools to modify the bookmarks and other information on the collar.

8. When finished, click **Save As**. The Template Properties dialog box appears.

9. Use the Template Properties settings to specify a **Name** and **Category**.

10. In the **Default Settings** area, click the **Printer** drop-down list and select the **PetDetect PD-700 label printer** as the default printer.

11. Click **OK**.

12. Click **OK** to close the Cornerstone Editor.

**Customizing Document Templates for ID Cards**

Three Sample ID Cards are available for printing from the Cornerstone Editor. These wallet-sized cards can be easily printed and provided to clients when they bring in a new patient. Then at the next visit, the staff member would simply need to scan the barcode on the card and Cornerstone will automatically display the client/patient information (the information displayed depends on the type of information you chose to encode in the barcode when the card was created).
Choose from three ID card samples:

- **Sample ID Card–Two Sided**: Print both front and back sides
- **Sample ID Card–Pet Info Only**: Print only the back side with clinic name/address on top
- **Sample ID Card–Clinic Info Only**: Print only the front side with clinic information

**Note**: This feature requires the Zebra P110i ID printer.

![Sample ID Card](image1)

**Note**: To print the two-sided ID card, load a single card into the feeder and print side 1. Then reinsert the card with the printed side down so that page 2 prints on the opposite side.

All fields and information included on both sides of the card can be modified and customized using bookmarks in the Cornerstone Editor. For example, the Client ID or Patient ID (or both) could be encoded in a barcode.

**To customize a Sample ID Card template:**

1. On the Lists menu, select Documents > Templates.
2. On the Document Template List window, in the Category drop-down list, select Samples.
3. Check to make sure the Print Only check box is selected for the template type.
4. With the Search for word option selected, in the Title or ID box, type card.
5. Select the Sample ID Card to be modified.

6. Click Update. The selected card template opens in the Cornerstone Editor.

7. Use the Cornerstone Editor tools to modify the bookmarks and other information on the card.
   
   **Note:** If you have a long practice name, you may need to decrease the font size used for the \{CLINICNAME\} bookmark to ensure that it does not wrap to a second line when the ID card prints.

8. When finished, click Save As.

9. Use the Template Properties settings to specify a Name and Category.

10. In the Default Settings area, click the Printer drop-down list and select the Zebra P110i ID printer as the default printer.

11. Click OK.

12. Click OK to close the Cornerstone Editor.

**LifeLearn® ClientEd Online™ Integration with Cornerstone**


**Loading LifeLearn® CD Documents in Cornerstone**

LifeLearn® client education documents on CD can be used in Cornerstone software. After an initial setup procedure in Cornerstone, LifeLearn documents appear in the Start New Document window documents list and can be selected for printing. LifeLearn documents can also be linked to invoice items as special action documents.

LifeLearn documents printed from Cornerstone include your practice information (name, address, phone number) and patient information.

**Note:** Microsoft® Word is needed to print LifeLearn documents.

**To load LifeLearn documents in Cornerstone:**

1. If you have not previously loaded the LifeLearn files, insert the LifeLearn CD into the CD drive and install them.

2. In Cornerstone, from the Tools menu, select Load LifeLearn Documents and then select the type of documents (Behavior, Canine, Feline, etc.) that you purchased.

   **Note:** The first time you add a set of LifeLearn documents to Cornerstone, if the New Letterhead Not Assigned dialog box appears, click OK. When the Locating LifeLearn letterhead file message appears, click C:\LifeLearn and click OK.
3. If the *Duplicate Documents* message appears, click **Yes** to replace existing Cornerstone documents with any LifeLearn documents that have the same name, or click **No** and the LifeLearn document with the same name will not replace the Cornerstone document.

4. When the *LifeLearn bookmarks added* message appears, click **OK**. The documents in the selected document type have been added successfully to Cornerstone.

5. Repeat steps 2–4 to add documents for another LifeLearn document type (Behavior, Canine, Feline, etc.).

   Once the LifeLearn documents have been loaded successfully, they will be available for selection in the Start New Document window.

   **Note:** LifeLearn documents do not display in the Preview pane like other document templates because LifeLearn documents are Microsoft Word documents.
Chapter 18: Setting Up Classic Medical Notes

This chapter covers the steps required to set up a Classic medical note template in the IDEXX Cornerstone* Practice Management System. For information on adding a Classic medical note to a patient record, see “Chapter 18: Using Classic Medical Notes” in the Cornerstone User’s Manual.

Overview

Classic medical notes are the “old style” of medical notes used in IDEXX Cornerstone* Practice Management System 7.6 and earlier versions. If you are new to Cornerstone (or new to using medical notes in Cornerstone), you should use the newer style of enhanced medical notes introduced in Cornerstone 8.0.

If you are an existing user of Classic medical notes in Cornerstone, you can continue to use Classic medical notes or you can convert your Classic medical note templates to enhanced medical note templates.

See “Chapter 17: Setting Up Medical Notes and Correspondence” beginning on page 312 for information on creating enhanced medical notes and converting Classic medical notes.

IMPORTANT: You will need to use Classic medical note templates for surgery/anesthesia logs. Enhanced medical notes do not support this feature at this time.

About Classic Medical Note Templates

Cornerstone comes with predefined Classic medical note templates. These templates can be changed or new templates can be created.

You can create Classic medical note templates that can help you enter information in the patient’s medical record. Types of information you might enter in the templates include the following:

- Routine “form” information (such as temperature, results of lab tests, a SOAP outline, etc.)
- Statements or recommendations that you frequently enter for specific types of visits (such as an annual visit)

Medical note templates help the medical staff enter information in the Classic Medical Notes window and give the notes a unified and consistent look. They guide you to include all the information and to enter it in the same order, so the opportunities for missed information are greatly reduced. Information in a medical note can be edited until it is finalized. After the information is finalized it cannot be changed, but an addendum can be added to a finalized Classic medical note.

Types of Information that Can Be Added to a Classic Medical Note Template

There are several different types of information that can be added to a Classic medical note template:

- Static text—This is body text and text labels that you manually type in the Template text box. This static text appears and prints in the Classic medical note as it’s typed here. For example, you might add a static text line at the top of the template to further identify the template (such as “Canine Neuter”), or you might add text labels at the beginning of each line to identify the information that follows (such as “Patient Information:” or “Attending Technician:”).
Chapter 18: Setting Up Classic Medical Notes

- **Fields in which you must manually enter data**—These fields are typically set up as prompts in which the staff member will be required to enter the specified type of data (character, date, numeric or time). For example, you might set up a TEMP field entry name, set its field type to Numeric and use an entry description (user prompt) of “Enter temp.” Fields added using Field Setup appear in all caps within brackets (e.g., [RESPIRATION]) to easily distinguish them from static text in the template.

- **Fields that are automatically populated with data from Cornerstone**—These fields will be automatically populated when the template is used to add a medical note to a patient’s record. These fields include: date, time, problems, invoice item, staff, tech, patient ID, patient name, birth date, breed, class, color, consult item, deceased date, diagnosis, image number, markings, microchip ID, patient notes, rabies tag, registration number, remarks, sex, species, status and weight. Fields added using Field Setup appear in all caps within brackets (e.g., [WEIGHT]) to easily distinguish them from static text in the template.

  **Note:** Invoice items that are added in medical notes will transfer to the Patient Visit List. Items entered in an Invoice Item data entry field will appear in the note text. If you want to add items to the invoice while in a comment template and you do not want them to appear in the text of the template, set the invoice item as a consult item. Items entered in a Consult Item data entry field will not appear in the text, but will display in the lower left area of the Classic Medical Note window.

  **Tip:** When setting up your template, place the fields in which you must manually enter data at the top of the template. Place the fields that have defaulted values at the bottom of the template. With this type of setup, when you use the template to create a medical note, you will not have to tab through all the defaulted fields to get to the manual data entry section of the medical note.

### Creating a New Classic Medical Note Template

**To create a new Classic medical note template:**

1. On the **Lists** menu, select **Documents > Templates**. The Document Templates List dialog box appears.

2. Click **New**, and then from the pop-up menu, select **Classic medical note template**. The Classic Template Setup dialog box appears.

  **Tip:** If the template you want to add is similar to an existing one, select the similar template, click the **Copy** button and make changes as needed. See the “Creating a New Classic Medical Note Template Based on an Existing Template” section that follows for more information.

3. In the **Description** text box, type a brief identifying name for the template. (This description appears in the **Template** drop-down list when selecting a template in the medical notes.)
4. If you want this template to be automatically finalized, click the **Auto finalize after** check box and enter the number of days after which this template will be marked as final.

**Note:** The medical note can be manually finalized from within the Classic Medical Notes dialog box at any time prior to when it is auto-finalized by selecting the **Final** check box.

5. Click within the **Template** area and type the body text and text labels for the template.

**Note:** To insert a TAB (to “tab over”) within the **Template** area, press CTRL+TAB.

6. To add a field within the **Template** area:
   a. Place the cursor in the desired position and click the **Field Setup** button (or press F6). The Classic Medical Note Templates Field Setup dialog box appears.

   ![Classic Medical Note Templates Field Setup dialog box]

   b. In the **Entry Name** drop-down list, select a data entry field name to specify the type of information to use on the template line. The corresponding **Field Type** is automatically selected based on the Entry Name.

   **Note:** The entry names (or field types) selected during field setup do not show or print on the medical note.

   c. In the **Default Item ID** field, if this is an invoice item or diagnosis type, you can select a default ID.

   d. In the **Default Value** field, enter a value that is most often used, if applicable, and then press TAB. Using default values saves you from entering information repetitiously.

   e. In the **Entry Description** field, enter a description of the information you require. This field displays when the template is used to prompt the user for an answer.

   f. If you want to include only certain fields from a Classic medical note in correspondence (instead of the complete contents of the note), select the **Display partial medical note in correspondence (classic only)** check box in Documents defaults. With this option selected, the **Include in corres** field appears on the right side in the Classic Medical Note Templates Field Setup dialog box. Select the **Include in corres** check box for each field you want to include in correspondence.

   g. To add another field, click **Add**.

   h. To delete a field, click within the line and then click **Delete**.

   **Note:** If you are updating a template that is already in use, you cannot delete a template field if it is already used in patient history.

   i. To review your fields for spelling errors, click **Spell Check**.
Chapter 18: Setting Up Classic Medical Notes

j. To move a field up or down in the template, click the field’s entry name and then click the up or down arrow button.

k. When finished, click OK to close the Field Setup dialog box.

7. Continue with your template layout and content entry in the Template area, and click the Field Setup button as needed to insert fields throughout the template.

![Classic Template Setup example]

**Tip:** If necessary you can cut (CTRL+X) and paste (CTRL+V) a selected field from one place to another within the Template area.

8. To review your template for spelling errors, click Spell Check.

9. Click OK to save your changes.

**To find and preview a Classic medical note template in the Document Templates List:**


![Document Templates List dialog box]
2. To locate a Classic medical note template by title:
   - If you know any of the words included in the template title, with the Search for word check box selected, type the word or words in the Title or ID field.
   - If you know the first word in the template title, clear the Search for word check box and then type the word in the Title or ID field.

3. To locate a template by category, in the Category drop-down list, select *Classic medical note.
   (To keep them separate from Enhanced medical notes, all Classic medical note templates are in the *Classic medical note category. This category cannot be changed.)

4. To locate a template by type, in the Type area, select the Medical note check box and clear the Correspondence and Print Only check boxes.

5. To include inactives in your search, select the Include inactives check box.

6. To sort the template list by the column, click on a column heading.

7. To see a preview of a template, click on the template in the list. A preview of the template will display in the preview area below the list.

Creating a New Classic Medical Note Template Based on an Existing Template

To create a new Classic medical note template based on an existing template:
2. In the template list, click the medical note template on which you want to base the new template.
3. Click the Copy button. The Copy template dialog box appears.
4. Enter a description for the new template and click OK.
5. Click the Update button to customize the new template and make necessary changes. See “Creating a New Classic Medical Note Template” on page 352 for information on creating a Classic medical note template.
6. When finished, click OK.

Note: Custom Classic medical note templates based on existing templates are included on template logs. For example, a custom Classic template based on the Cornerstone Surgery Template prints on the Surgery/Anesthesia Log.

Inactivating a Classic Medical Note Template

To mark a Classic medical note template as inactive:
2. In the template list, click the medical note template to mark inactive and click Update. The template appears in the Template Setup dialog box.
3. Click the Inactive check box.
4. Click OK to save your changes.
Overview

In the IDEXX Cornerstone* Practice Management System version 7.6 or earlier, many practices used Microsoft® Word for creating correspondence documents because of the advanced editing and formatting options it offers. With the enhanced Cornerstone Editor that was introduced in Cornerstone 8.0, many of these same advanced features (check boxes, text input fields, etc.) are now available in Cornerstone, and it is no longer necessary to create these types of documents in Word. However, if your practice already has many correspondence documents set up in Word, you can continue to use your existing files by following the steps included in this chapter.

When using Microsoft Word to create correspondence, the Cornerstone data available for use in Word bookmarks is rather limited (as compared to the data available when using the Cornerstone Editor to create the correspondence). Also, if you want to use bookmarks with Word documents, you must first go through the added step of linking them with the applicable Cornerstone merge fields.

Note: For information on merging Cornerstone data with a Word document at the time of use, see “Chapter 17: Using Medical Notes and Correspondence” in the Cornerstone User’s Manual.

Note: Depending on the version of Microsoft Word you are using, the Word functions and dialog boxes referenced in this chapter may vary slightly from your version of Word. Refer to the Microsoft Word online Help for instructions specific to your version.

Adding Bookmarks to a Microsoft Word Document

You can create Word documents that can be used in Cornerstone to create a personalized document for a single selected client and/or patient. Bookmarks created in Microsoft Word must be linked to Cornerstone data items.

When a document with bookmarks is printed, the bookmarks are replaced with the applicable data. For example, if the client name bookmark is included in the document, the client’s name replaces the bookmark.

Note: If you want to merge a Cornerstone data file with a Word document to do mass mailings from Word, use Word merge codes instead of bookmarks.
### Cornerstone Bookmarks Available for Use with Microsoft Word

#### Client

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>Full Name</td>
</tr>
<tr>
<td>Address 2</td>
<td>ID</td>
</tr>
<tr>
<td>All Phones</td>
<td>Last Month A/R</td>
</tr>
<tr>
<td>City</td>
<td>Classification Last Payment Amount</td>
</tr>
<tr>
<td>Classification</td>
<td>Phone Extension</td>
</tr>
<tr>
<td>Client Signature</td>
<td>Last Payment Date</td>
</tr>
<tr>
<td>Client Signature</td>
<td>Phone Description</td>
</tr>
<tr>
<td>Credit Code</td>
<td>LY Sales - Inventory</td>
</tr>
<tr>
<td>Current A/R</td>
<td>LY Sales - Services</td>
</tr>
<tr>
<td>Date Client Entered</td>
<td>LY Visits</td>
</tr>
<tr>
<td>Email Address</td>
<td>Middle Initial</td>
</tr>
<tr>
<td>Finance Charges A/R</td>
<td>Ninety Days A/R</td>
</tr>
<tr>
<td>First Name</td>
<td>Note</td>
</tr>
</tbody>
</table>

**Note:** A/R totals do not include current invoices. Use **Current A/R** or **Outstanding Balance** fields to include amounts not yet included in an end-of-day processing.

#### Miscellaneous

Current Date

#### Patient (includes Rabies Tag)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age</td>
<td>Current Weight</td>
</tr>
<tr>
<td>Birth Date</td>
<td>Date Current Weight</td>
</tr>
<tr>
<td>Breed</td>
<td>Date Patient Entered</td>
</tr>
<tr>
<td>Check In Date (last)</td>
<td>Deceased Date</td>
</tr>
<tr>
<td>Check In Time (last)</td>
<td>Manner of Injection</td>
</tr>
<tr>
<td>Check Out Date (last)</td>
<td>Markings</td>
</tr>
<tr>
<td>Check Out Time (last)</td>
<td>Microchip ID</td>
</tr>
<tr>
<td>Color</td>
<td>Name</td>
</tr>
<tr>
<td>Current Weight (last)</td>
<td>Number of Years</td>
</tr>
<tr>
<td>Patient Classification</td>
<td>Patient Classification</td>
</tr>
<tr>
<td>Sex</td>
<td>Patient ID</td>
</tr>
<tr>
<td>Species</td>
<td>Patient Note</td>
</tr>
<tr>
<td>Vaccine Amount</td>
<td>Patient Status</td>
</tr>
<tr>
<td>Vaccine Expiration</td>
<td>Rabies Expiration Date</td>
</tr>
<tr>
<td>Vaccine Lot Number</td>
<td>Rabies Tag Date</td>
</tr>
<tr>
<td>Vaccine Name</td>
<td>Rabies Tag Number</td>
</tr>
<tr>
<td>Vaccine Producer</td>
<td>Registration Number</td>
</tr>
<tr>
<td>Vaccine Type</td>
<td>Signature</td>
</tr>
</tbody>
</table>

#### Practice

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Phones</td>
<td>Clinic City</td>
</tr>
<tr>
<td>Clinic Address 1</td>
<td>Clinic Name</td>
</tr>
<tr>
<td>Clinic Address 2</td>
<td>Clinic Phone</td>
</tr>
<tr>
<td>Clinic Postal Code</td>
<td>Clinic State</td>
</tr>
</tbody>
</table>

#### Staff

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Phones</td>
<td>Staff Extension</td>
</tr>
<tr>
<td>Staff Address 1</td>
<td>Staff First Name</td>
</tr>
<tr>
<td>Staff Address 2</td>
<td>Staff Full Name</td>
</tr>
<tr>
<td>Staff City</td>
<td>Staff ID</td>
</tr>
<tr>
<td>Staff Classification</td>
<td>Staff Last Name</td>
</tr>
</tbody>
</table>

**Note:** A/R totals do not include current invoices. Use **Current A/R** or **Outstanding Balance** fields to include amounts not yet included in an end-of-day processing.
Chapter 19: Setting Up Correspondence in Microsoft® Word

Tips for adding bookmarks in Microsoft Word:

- To see a list of the bookmarks currently set up in a Word document, select **Insert > Bookmark** and scroll through the list. Note that if you use a bookmark that is already in the document, it replaces the old bookmark without a warning.
- To set your view options to display bookmarks within your Word document, select **Tools > Options > View** tab, and select the **Bookmarks** check box.
- To make sure that your information lines up correctly, insert a two-column table in your Word document. Type text in the first column and insert bookmarks in the adjacent cells in the second column.
- Keep accurate records of the bookmark names you use so that you can easily set up the Cornerstone correspondence.

**Before You Begin**

- Open Cornerstone and Microsoft Word so you can refer to both programs. Use the ALT+TAB function to toggle back and forth between programs as needed.

**To add the bookmarks in Microsoft Word:**

1. Open an existing Microsoft Word document or create a new document.
2. Type the text for the correspondence or modify existing text as needed.
3. When you reach a location where you want to insert Cornerstone data, select **Insert > Bookmark**. (In some versions of Word, **Bookmark** is on the **Edit** menu.) The Bookmark dialog box appears.

![Bookmark dialog box](image)

4. Enter a **Bookmark** name. Because the Word bookmark and the Cornerstone bookmark must be identical, it is easiest if you name the Word bookmark the same name that Cornerstone automatically generates for that field. The names are case sensitive. See “Cornerstone Bookmarks Available for Use with Microsoft Word” on page 357.

**IMPORTANT:** Each bookmark must have a unique name. For example, if you have already used the bookmark Title in the document, use Title1 for the next occurrence of the title field, Title2 for the next one, and so on.

5. Click **Add** to place the bookmark into the Word document.

**Tip:** To see where a specific bookmark is located in the document, highlight the bookmark in the list and click **Go To**.
6. Repeat steps 3–5 until you have finished adding bookmarks to your document.
7. Save the Word document.

Linking Microsoft Word Documents to Cornerstone Data

When you have finished setting up the Microsoft® Word document, you are ready to set up the Cornerstone* fields that correspond to the Word bookmarks. Cornerstone uses meaningful bookmarks to describe the fields the bookmarks represent. The client’s last name becomes LastName (and subsequently LastName1, LastName2, and so on, as it is used in the document), although you can change the bookmark names in Cornerstone to match the bookmark names in the Word document.

IMPORTANT: Each Word bookmark name must match the corresponding Cornerstone bookmark name. You do not have to use the Cornerstone default bookmark names, although this may be easiest.

Note: Unless you access Word documents over a network, they can only be accessed on the computer where they are stored. However, you can copy the Word documents to your other computers.

Before You Begin

- Review the Cornerstone data field tables to become familiar with the bookmark names that Cornerstone will automatically generate.
- Open Cornerstone and Microsoft Word so you can refer to both programs. Use the ALT+TAB function to toggle back and forth between programs as needed.

To set up a new document link:

1. In Cornerstone, on the Lists menu, select Documents > Templates. The Document Template List window appears.
2. Click New, and then from the pop-up menu, select MS Word document. The Document Setup dialog box appears.

3. In the ID field, enter an ID for the document or press TAB to accept the document ID that Cornerstone assigns.
4. In the Name field, enter a meaningful name for the document.
5. Click Browse to find and select the Word document that you want to link. Click OK to return to the Document Setup dialog box.
6. In the Bookmarks table, from the File Description drop-down list, select the Cornerstone database category (client, miscellaneous, patient, practice or staff).
7. From the Field Description drop-down list, select the Cornerstone bookmark field name. The corresponding Cornerstone bookmark appears in the Bookmark field.

8. In the Bookmark field, if the Cornerstone bookmark name displayed is not the same name as the bookmark name in your Word document, type the name of Word bookmark so that the Word bookmark is linked to the Cornerstone bookmark.

   **Note:** When a field is used more than once, subsequent bookmarks are consecutively numbered. You cannot have duplicate bookmark names.

9. Repeat steps 7–9 as needed to continue linking Cornerstone fields and the Word bookmarks.

10. When finished, click OK to save and return to the Document Template List window.

**To modify a document link:**


   **Tip:** All Microsoft Word documents have “ - MS Word” after the title.

2. Select the document to change and click Update. The Document Setup dialog box appears.

3. Make changes to the document information and bookmarks, as desired.

4. To delete a row, place the cursor in the row to delete and press CTRL + D.

5. When finished, click OK to save and return to the Document Template List window.

**To delete a document link:**


   **Tip:** All Microsoft Word documents have “ - MS Word” after the title.

2. Select the document to delete and click Delete. You are prompted to confirm the deletion. Click Yes.

   **Note:** For information on merging Cornerstone data with a Word document at the time of use, see “Chapter 17: Using Medical Notes and Correspondence” in the Cornerstone User’s Manual.
Section 6–End of Period Processing

Chapter 20: End of Day Processing
章 21: End of Month Processing
Chapter 22: End of Year Processing
Chapter 20: End of Day Processing

Overview

When you process End of Day (EOD), the IDEXX Cornerstone* Practice Management System:

- Processes your records for the day.
- Totals the records for the daily period.
- Transfers the daily totals to the current monthly totals.
- Resets the current daily period to zero.

It is easy to track EOD periods because Cornerstone* records the date and time with each closing.

Tip: You can set up your Cornerstone system to automatically process End of Day or End of Month. See “Unattended End of Period (EOP) Defaults” on page 135 for more information.

IMPORTANT: It is imperative for your practice to have a good backup procedure in place. Backups provide security against the unlikely chance that files are lost or destroyed. As an added safety precaution, you should remove the most recent backup from the practice or place it in a DATA-Rated fireproof safe.

Depending on the backup procedure at your practice, you can manually back up before completing End of Day processing or automatically as set up by IDEXX Computer Systems. For backup instructions, see the original documentation that came with your backup software.

If you have questions about your backup procedure or how to verify that your backup was successful, contact Cornerstone Support at 1-800-695-2877. Do not take chances with your practice data.

Note: If your practice uses compatible backup software, you can set up Cornerstone to automatically verify your backup using the Cornerstone Backup Verification Assistant. (See “Chapter 28: Using the Backup Verification Assistant” beginning on page 446 for more information.)

Notes on End of Day processing:

- You can perform End of Day processing after every shift, if necessary, not only at the actual end of the day. The important thing is to maintain a consistent pattern of daily closing periods.
- Printing reports does not close or process the totals for the day.
- When you close a daily period, all transactions from the previous daily closing up through the current daily closing are included.
- You do not need exclusive use to process End of Day. However, staff will not be able to post invoices or save changes to any window that modifies a client’s account. If a user tries to modify a client’s account, a message warns the user to wait until the EOD processing is finished. Once the EOD processing is complete, the user can continue.
Performing End of Day Processes

Before You Begin

- Follow your normal backup procedures to perform your daily Cornerstone backup. For backup instructions, see the original documentation that came with your backup software, or contact Cornerstone Support at 1-800-695-2877. If a backup is performed before processing End of Day, information can be restored, if necessary.
- Ensure that EOD defaults have been set up (see “End of Period Defaults” on page 102).

To balance your cash drawer (recommended):
2. In the Reports list, click the plus sign to the left of End of Day, and then select the Daily Deposit Report. (See “Daily Deposit Report” on page 367 for more information on this report.)
3. Click Create report. The Daily Reports dialog box appears.
4. Under Daily periods, select the Current period.
5. Click Preview or Print.
6. Make any corrections necessary to balance your cash drawer before proceeding.
Tip: The Daily Payment Register by Payment Type Report is helpful for locating balancing errors.

To process End of Day:
1. On the Activities menu, select End of Period > End of Day.
2. A message box may appear to remind you to back up your data. Click Cancel to stop performing End of Day and backup the Cornerstone database, or click OK to continue processing End of Day.
   Note: To prevent the message from displaying, clear the Show message check box.
   The Daily Period Closing dialog box appears.
3. In the Note box, type any notes concerning this daily period closing or type your initials, and click OK. (If notes exist for a daily closing period, you can click the Details button in the Daily Reports dialog box to view the notes.)
4. Click OK. You are prompted to confirm the decision.
5. Click Yes.
6. When End of Day has finished processing, click OK on the Daily Period Closing dialog box.
   Note: If you are processing End of Month, immediately start your End of Month procedures. See “Performing End of Month Processes” on page 381.

Printing End of Day Reports
Cornerstone includes many daily reports that help you keep records of your valuable information. At a minimum, you should print the Daily Deposit Report and Itemized Audit Trail Report each day. In addition to helping you balance the cash drawer, these reports contain valuable information that you would need if your computer fails and you don’t have a good backup. You should also print a Daily Summary Report and the Daily Payment Register by Payment Type.

Tips for End of Day reports:
- Set up a binder for the current month’s daily reports. Keep End of Day reports until End of Month has been processed and balanced.
Chapter 20: End of Day Processing

- Always run the daily Itemized Audit Trail Report. Among other uses, you can reenter information from this report if the system fails and you do not have a timely backup.

- Use the Daily Deposit Report to balance your drawer. Other common reports printed daily include: the Deposit Report - Checks, the Daily Payment Register, and the Daily Summary Report. You may wish to spot-check the Standard Fee Exception Report. Analyze the reports to verify that they match your drawer and daily totals.

When to Print End of Day Reports

EOD reports can be printed at any time. However, for totals that reflect the EOD amounts, they should be printed after you have processed End of Day.

Note: Some daily reports are not available until after EOD processing is complete.

Performing monthly activities creates a second EOD closing. These totals include added finance charges, billing charges and open invoices that were closed as part of End of Month (EOM) processing. For the last EOD of the month, print the EOD reports again after processing End of Month so the reports will include the information for the second EOD closing.

Before You Begin

- Set your End of Period defaults to select the reports you want Cornerstone to automatically select for you in the Daily Reports dialog box (see “End of Period Defaults” on page 102).

- Assign the printer to print the reports (File > Printer Assignment > End of Day, and then select the reports you want to print on each printer).

- Finish your End of Day processing.

To print all selected EOD reports at once:


2. Under Daily Periods, select the period you want the reports to reflect. For most reports, you can print information for more than one continuous period. To do this, click the earliest period and then press...
and hold the SHIFT key, click the down arrow until you see the last period and then click the last period. All of the periods in between are highlighted.

**Note:** When you select a beginning date range, your End of Period reports include all data in the date range from one minute prior to the beginning date selected through the ending date selected.

3. In the Report list, reports you have selected in End of Period defaults are highlighted. If needed, do the following to select additional reports:
   - To select a consecutive group of reports, click the first report, hold down the SHIFT key, and then click the last report.
   - To select nonconsecutive reports, hold down CTRL, and then click each report you want to select.

4. Click Print. The reports print on the printer assigned to each report (or the default printer if no printer has been assigned).

**To preview, print and/or save a specific EOD report:**

2. In the Reports list, click the plus sign to the left of End of Day, and then select the desired report.
3. With the desired report highlighted in the End of Day report group, click Create report. The Daily Reports dialog box appears.
4. Under Daily periods, select the period you want the report to reflect. For most reports, you can print information for more than one continuous period. To do this, click the earliest period and then press and hold the SHIFT key while you click the last period. All of the periods in between are highlighted.
   **Note:** When you select a beginning date range, your End of Period reports include all data in the date range from one minute prior to the beginning date selected through the ending date selected.
5. Click Preview. The Reports Preview window appears.

6. On the Reports Preview window, click Print to print the report, click Save to save the report data to a file, or click Cancel to close the window.
End of Day Reports

Charged on Account Report

Use the Charged on Account Report to view clients who charged amounts on their accounts. The account balance on the report is the current balance at the time the report was printed.

Net Total = Invoice total - manual discounts
Net Charged = Net total - amount paid

Current Activity Report

The Current Activity Report shows the totals of sales and revenue collected since the last EOD processing. This report includes the number of new clients, number of patient visits, number of invoices, gross sales, net sales, taxes, net service and inventory revenue, total payments, refunds, total deposits and other adjustments to income.

Note: The Current Activity Report can be run only for the Current daily period.

Daily Audit Trail Report

The Daily Audit Trail Report shows every invoicing and payment transaction within the selected daily period. We recommend that you print the Daily Audit Trail Report every time you process End of Day.

In the report’s Transaction Type column, you will find a listing of each invoice (and whether the invoice is open or closed), each payment received (and the type of payment), each adjustment to a client’s account, and each instance of change given or cash refund.
Daily Deposit Report

The Daily Deposit Report provides separate totals of each payment type received and totals these payments. This report displays the amount of cash you should have accepted and the amount of each payment type received.

Use this report in combination with the Deposit Report - Checks to help balance your cash drawer. We recommend that you print the Daily Deposit Report every time you process End of Day. Preview this report before processing End of Day so that you can correct any errors before closing.

Note: This report is also available as an End of Month report.

Daily Discount Report - By Discount

The Daily Discount Report - By Discount includes all predefined discounts given during the daily period. When this report is run, the Daily Manual Discount Report - By Client is also automatically run (includes all manual discounts given during the daily period).
Daily Discount Report - By Staff

This report includes all predefined discounts given by staff during the daily period. When you run this report, the Daily Manual Discount Report - By Staff is also automatically run (includes all manual discounts given by staff during the daily period).

### Daily Discount Report - By Staff

**Wednesday, January 31, 2007 07:12 pm through Wednesday, February 28, 2007 07:12 pm**

Data from this period has been purged. Some data may be missing.

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Staff ID</th>
<th>Staff Name</th>
<th>Reason</th>
<th>Discount</th>
<th>Total Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>29030</td>
<td>2106</td>
<td>FELINE LEUKAEMIA = FIV/COI Preferred</td>
<td>5.00</td>
<td>$92.01</td>
<td>$92.01</td>
</tr>
</tbody>
</table>

Daily Inv. and PVL Entries Report and Daily Inv. And PVL Totals Report

These reports enable your practice to track all changes, additions and deletions of billed lines on invoices or the Patient Visit List, including all lines on open or closed invoices and the user ID of the person who is logged in.

To select what you want to track on the reports, see “Daily Entries Report Defaults” on page 98.

**Note:** For practices using the Mobile Computing module, changes and deletions performed on a mobile computer will not display on these reports. When synchronization is run, the entries will display as additions to the reports.

### Daily Invoicing and Patient Visit List Entries

**Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:20 pm**

### Daily Invoicing Entries

The Daily Invoicing Entries Report enables your practice to track all changes, additions and deletions of billed lines on invoices. To select what you want to track on the reports, see “Daily Entries Report Defaults” on page 98.
Daily Manual Discount Report - By Client or By Staff

The Daily Manual Discount Report includes all manual discounts given during the daily period.

Daily Patient Visit List Entries Report

The Daily Patient Visit List Entries Report enables your practice to track all changes, additions and deletions of billed lines on the Patient Visit List. To select what you want to track on the reports, see “Daily Entries Report Defaults” on page 98.

Daily Payment Register - By Cashier ID by Client ID or By Cashier by Payment Type

The Daily Payment Register provides a list of the payments received in the daily period.

Daily Payment Register - By Client Last Name

The Daily Payment Register - By Client Last Name Report lists each client who made a payment during the day. For each client who made a payment during this period, the report shows the payment type, payment amount and the client’s balance due. If your practice uses cashier codes, the cashier code will also display.

Use this report to review your daily business and see a recap of client visits, payments and balances due.
Daily Payment Register–Credit/Debit Payment Transactions

The Daily Payment Register–Credit/Debit Payment Transactions report allows you to review your daily credit/debit card transactions (payments, voids and refunds). The report groups transactions according to payment card type and sorts them in ascending date/time order.

Note: This report lists only those transactions performed using the Credit Card Payment and/or Debit Card Payment payment types, as these are the only payment types that allow card processing initiated from Cornerstone.

Daily Payment Register – By Payment Type

The Daily Payment Register – By Payment Type report lists each client who made a payment during the daily period, categorized and subtotaled by Payment Type. Like the Daily Payment Register – By Client Last Name report, you can use the Daily Payment Report – By Payment Type report to review your daily business and see a recap of client visits, payments and balances due, with each payment categorized under a Payment Type heading.

This report is a useful tool when you are filling out your bank deposit slip.
Daily Payment Register - By Practice

The Daily Payment Register - By Practice report is available for those practices with the Multi-Location/Single Database option enabled. This report is split out by practice based on the logged in practice when the payment was made. It lists each client who made a payment during the daily period, sorted by Practice by Payment Type.

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name</th>
<th>Payment Type</th>
<th>Cash</th>
<th>Balance Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>12305</td>
<td>Akins David</td>
<td>Cash</td>
<td>$10.50</td>
<td>$0.00</td>
</tr>
<tr>
<td>14912</td>
<td>Allow,Jasen</td>
<td>Cash</td>
<td>$17.92</td>
<td>$0.00</td>
</tr>
<tr>
<td>13912</td>
<td>Allow, Jason</td>
<td>Cash</td>
<td>$13.38</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Daily Revenue Report

The Daily Revenue Report summarizes credits and debits in balance sheet form. This report should always balance.

<table>
<thead>
<tr>
<th>Debits</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>$50.04</td>
</tr>
<tr>
<td>Cash</td>
<td>$100.00</td>
</tr>
<tr>
<td>Change Order</td>
<td>$0.00</td>
</tr>
<tr>
<td>Net Change to Arrt</td>
<td>$0.00</td>
</tr>
<tr>
<td>Manual Deposits</td>
<td>$0.00</td>
</tr>
<tr>
<td>Prest End Bmtt</td>
<td>$0.00</td>
</tr>
<tr>
<td>Cash Refunds</td>
<td>$0.00</td>
</tr>
<tr>
<td>Adjustments</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total Debits</td>
<td>$1,003.50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Credits</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Tangible Revenue</td>
<td>$1,125.74</td>
</tr>
<tr>
<td>Gross Tangible Revenue</td>
<td>$221.77</td>
</tr>
<tr>
<td>Gross Tangible Revenue</td>
<td>$0.00</td>
</tr>
<tr>
<td>Gross Tangible Revenue</td>
<td>$0.00</td>
</tr>
<tr>
<td>Net Tangible</td>
<td>$0.00</td>
</tr>
<tr>
<td>State Sales Tax</td>
<td>$0.00</td>
</tr>
<tr>
<td>Returns Checks</td>
<td>$0.00</td>
</tr>
<tr>
<td>Service Charges</td>
<td>$0.00</td>
</tr>
<tr>
<td>Billing Charges</td>
<td>$0.00</td>
</tr>
<tr>
<td>Finance Charges</td>
<td>$0.00</td>
</tr>
<tr>
<td>Resub Offs</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total Credits</td>
<td>$1,003.50</td>
</tr>
<tr>
<td>Balance</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
Daily Staff Commission Detail Report - Gross or Net

The Daily Staff Commission Detail Report shows the commission for staff members by invoice item by item classification.

### Daily Staff Commission Detail Report - Gross

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Item Description</th>
<th>Quantity</th>
<th>Sale Amount</th>
<th>Commission</th>
</tr>
</thead>
<tbody>
<tr>
<td>1049</td>
<td>ICADURINE ANESTHESA</td>
<td>2</td>
<td>$85.40</td>
<td>$17.08</td>
</tr>
<tr>
<td>1053</td>
<td>PROTOCOL</td>
<td>1.60</td>
<td>$22.58</td>
<td>$4.12</td>
</tr>
<tr>
<td></td>
<td><strong>Total for ANESTHESA</strong></td>
<td>3.60</td>
<td><strong>$108.08</strong></td>
<td><strong>$21.20</strong></td>
</tr>
<tr>
<td>11035</td>
<td>Anexadina 50 mg</td>
<td>1.60</td>
<td>$15.25</td>
<td>$2.50</td>
</tr>
</tbody>
</table>

Daily Staff Commission Summary Report - Gross or Net

The Daily Staff Commission Summary Report shows the commission for staff members summarized according to invoice item classification. These totals are not paid totals; they are the totals for today’s sales.

### Daily Staff Commission Summary Report - Gross

<table>
<thead>
<tr>
<th>Staff ID and Name</th>
<th>Item Classification</th>
<th>Quantity</th>
<th>Sale Amount</th>
<th>Commission</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXV Frano DVM, Mark J</td>
<td>ANESTHESA</td>
<td>0</td>
<td>$194.92</td>
<td>$31.90</td>
</tr>
<tr>
<td></td>
<td>Anexadina</td>
<td>100</td>
<td>$12.23</td>
<td>$2.05</td>
</tr>
<tr>
<td></td>
<td>Anexadina/Analgesic</td>
<td>100</td>
<td>$14.25</td>
<td>$2.44</td>
</tr>
<tr>
<td></td>
<td>DENTAL</td>
<td>6</td>
<td>$42.41</td>
<td>$7.00</td>
</tr>
<tr>
<td></td>
<td>Fluntrax</td>
<td>2</td>
<td>$111.30</td>
<td>$22.65</td>
</tr>
<tr>
<td></td>
<td>Oxytetracycline</td>
<td>4</td>
<td>$95.40</td>
<td>$15.90</td>
</tr>
<tr>
<td></td>
<td>HOSPITALIZATION</td>
<td>0</td>
<td>$190.20</td>
<td>$32.84</td>
</tr>
<tr>
<td></td>
<td>LABORATORY</td>
<td>6</td>
<td>$230.24</td>
<td>$40.04</td>
</tr>
</tbody>
</table>

Daily Staff Commission Totals Report - Gross or Net

The Daily Staff Commission Totals Report shows the total amount of sales and total amount of commission credited to each provider.

### Daily Staff Commission Totals Report - Gross

<table>
<thead>
<tr>
<th>Staff ID and Name</th>
<th>Quantity</th>
<th>Sale Amount</th>
<th>Commission</th>
</tr>
</thead>
<tbody>
<tr>
<td>KGT, Dearle CVT, Katie M.</td>
<td>0</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>LC, Delia Lynne H</td>
<td>0</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>LPN, Julie MUR, Linda B</td>
<td>0</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>MXV, Frano DVM, Mark J</td>
<td>0</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>ELL, Aquea CVT, James F.</td>
<td>43</td>
<td>$1,821.78</td>
<td>$278.33</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
Daily Summary Report

Use the Daily Summary Report to track the health of your practice by looking at a summary that includes daily, month-to-date, and year-to-date statistics. We recommend that you print the Daily Summary Report after every End of Day processing.

### Daily Summary Report

**Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:20 pm**

<table>
<thead>
<tr>
<th>Description</th>
<th>Today</th>
<th>Month To Date</th>
<th>Year To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Clients</td>
<td>39</td>
<td>266</td>
<td></td>
</tr>
<tr>
<td>Patients Visits</td>
<td>64</td>
<td>523</td>
<td></td>
</tr>
<tr>
<td>No. Of Insurance</td>
<td>5</td>
<td>20</td>
<td>0</td>
</tr>
<tr>
<td>Gross Sales</td>
<td>$1,556.60</td>
<td>$8,003.52</td>
<td>$55,638.25</td>
</tr>
<tr>
<td>Avg. Gross per Visit</td>
<td>$91.16</td>
<td>$470.68</td>
<td>$1,403.57</td>
</tr>
<tr>
<td>Minus Manual Discount</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($704.48)</td>
</tr>
<tr>
<td>Minus Percent Discount</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($19,064.04)</td>
</tr>
<tr>
<td>Net Sales</td>
<td>$1,596.60</td>
<td>$8,503.52</td>
<td>$539,709.84</td>
</tr>
<tr>
<td>Avg. Net per Visit</td>
<td>$33.16</td>
<td>$470.68</td>
<td>$1,255.77</td>
</tr>
<tr>
<td>Total Potential Collections</td>
<td>$1,596.60</td>
<td>$8,503.52</td>
<td>$539,709.84</td>
</tr>
<tr>
<td>Net Service Revenues</td>
<td>$1,596.60</td>
<td>$8,503.52</td>
<td>$539,709.84</td>
</tr>
<tr>
<td>Net Inventory Revenues</td>
<td>$200.00</td>
<td>$1,152.03</td>
<td>$195,228.77</td>
</tr>
<tr>
<td>Total Revenues</td>
<td>$1,796.60</td>
<td>$9,655.55</td>
<td>$555,938.61</td>
</tr>
<tr>
<td>New Receivables</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$55,151.18</td>
</tr>
<tr>
<td>Old Receivables Paid</td>
<td>$0.00</td>
<td>($196.74)</td>
<td>($57,209.03)</td>
</tr>
<tr>
<td>Net Change</td>
<td>$0.00</td>
<td>($196.74)</td>
<td>($57,209.03)</td>
</tr>
<tr>
<td>Total Payments</td>
<td>$1,596.60</td>
<td>$8,503.52</td>
<td>$539,709.84</td>
</tr>
<tr>
<td>Cash Taken</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total Deposits</td>
<td>$1,596.60</td>
<td>$8,503.52</td>
<td>$539,709.84</td>
</tr>
<tr>
<td>Refunds Provided</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$441.67</td>
</tr>
<tr>
<td>Service Charges</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$33,630.05</td>
</tr>
<tr>
<td>Adjustments</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($340,039.49)</td>
</tr>
<tr>
<td>Write Off</td>
<td>$0.00</td>
<td>$0.00</td>
<td>($2,079.90)</td>
</tr>
</tbody>
</table>

### Daily Summary Report - By Practice

The Daily Summary Report - By Practice is available for those practices with the Multi-Location/Single Database option enabled. This report lets you track financial health by breaking out the daily, month-to-date, and year-to-date statistics for each practice.
**Daily Summary Tax Report**

Use the Daily Summary Tax Report to list sales tax by tax type. This is useful to see how much tax is owed on a daily basis.

<table>
<thead>
<tr>
<th>Description</th>
<th>Today</th>
<th>Month To Date</th>
<th>Year To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Taxable</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>State Sales Tax</td>
<td>14.00</td>
<td>108.70</td>
<td>122.206.30</td>
</tr>
<tr>
<td>Adams County Tax</td>
<td>3.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Washington County Tax</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total Taxes</strong></td>
<td>17.00</td>
<td>108.70</td>
<td>122.206.30</td>
</tr>
</tbody>
</table>

**Daily Voided Invoices Report - By Client ID, Date or Staff**

The Daily Voided Invoices Report provides a list of invoices voided during a specified period. The report can be printed by client ID, by date or by staff.

**Deposit Report - Checks - By Check No./Answer, By Client ID or By Client Last Name**

The Deposit Report - Checks lists all of the checks entered as payments. You can use this report as part of the deposit record at your practice’s bank.

For each check payment you received, the Deposit Report - Checks lists each check, check number and check amount. Depending on which deposit report you selected, the report is sorted by check number (or prompt answer), client ID or client last name.
Chapter 20: End of Day Processing

GL Batch Report
Used only if your practice utilizes the General Ledger (GL) Interface, the GL Batch Report provides a summary of the data extracted to the file.

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Description</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000</td>
<td>Sales - ANESTHESIA</td>
<td>0.59</td>
<td>415.20</td>
</tr>
<tr>
<td>1000</td>
<td>Sales - Ambulatory</td>
<td>0.59</td>
<td>16.70</td>
</tr>
<tr>
<td>1000</td>
<td>Sales - Ambulatory</td>
<td>0.59</td>
<td>50.48</td>
</tr>
<tr>
<td>Cash</td>
<td>Payments - Cash</td>
<td>15.19</td>
<td>0.00</td>
</tr>
<tr>
<td>Check</td>
<td>Payments - Check</td>
<td>181.89</td>
<td>0.00</td>
</tr>
<tr>
<td>DENTAL</td>
<td>Sales - DENTAL</td>
<td>0.59</td>
<td>273.91</td>
</tr>
</tbody>
</table>

Invoice Register - Closed Invoices or Invoice Register - Open Invoices
The Invoice Register Report lists basic information for each invoice closed (or still open) during the selected daily period(s). The report is sorted by invoice number.

<table>
<thead>
<tr>
<th>Invoice #</th>
<th>Client ID</th>
<th>Client Name</th>
<th>Sales Amount</th>
<th>Sales Tax</th>
<th>Manual Disc</th>
<th>Other Disc</th>
<th>Cash Refund</th>
<th>Total Income</th>
</tr>
</thead>
<tbody>
<tr>
<td>242763</td>
<td>23924</td>
<td>Rajada, John Jr</td>
<td>$107.72</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$107.72</td>
</tr>
<tr>
<td>242764</td>
<td>23947</td>
<td>Rajada, Robert</td>
<td>$307.14</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$307.14</td>
</tr>
<tr>
<td>242765</td>
<td>9271</td>
<td>Rajada, Simon</td>
<td>$560.85</td>
<td>$2.96</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$563.84</td>
</tr>
<tr>
<td>242766</td>
<td>9660</td>
<td>Rajada, Michael</td>
<td>$204.43</td>
<td>$1.23</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$205.66</td>
</tr>
<tr>
<td>242767</td>
<td>20310</td>
<td>Rajada, Robert</td>
<td>$240.33</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$240.33</td>
</tr>
</tbody>
</table>

Total: $1,659.60 | $4.00 | $0.00 | ($0.00) | $0.00 | $1,662.60

Itemized Audit Trail
The Itemized Audit Trail Report details each transaction entered during the daily period. Transactions are displayed in the order they were entered. This report is useful if you have to reenter any data.

<table>
<thead>
<tr>
<th>Report ID</th>
<th>Client ID</th>
<th>Client Name</th>
<th>Invoice Type</th>
<th>Description</th>
<th>Start Date</th>
<th>Revenue Center</th>
<th>Type</th>
<th>Form No.</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>23923</td>
<td>23923</td>
<td>Rajada, John Jr</td>
<td>Itemized</td>
<td>242763 - Closed</td>
<td>04/29/2010</td>
<td>242763</td>
<td>Item</td>
<td></td>
<td>$107.72</td>
</tr>
<tr>
<td>23924</td>
<td>23947</td>
<td>Rajada, Robert</td>
<td>Itemized</td>
<td>242764 - Closed</td>
<td>04/29/2010</td>
<td>242764</td>
<td>Item</td>
<td></td>
<td>$307.14</td>
</tr>
<tr>
<td>23925</td>
<td>9271</td>
<td>Rajada, Simon</td>
<td>Itemized</td>
<td>242765 - Closed</td>
<td>04/29/2010</td>
<td>9271</td>
<td>Item</td>
<td></td>
<td>$563.84</td>
</tr>
<tr>
<td>23926</td>
<td>9660</td>
<td>Rajada, Michael</td>
<td>Itemized</td>
<td>242766 - Closed</td>
<td>04/29/2010</td>
<td>9660</td>
<td>Item</td>
<td></td>
<td>$205.66</td>
</tr>
<tr>
<td>23927</td>
<td>20310</td>
<td>Rajada, Robert</td>
<td>Itemized</td>
<td>242767 - Closed</td>
<td>04/29/2010</td>
<td>20310</td>
<td>Item</td>
<td></td>
<td>$240.33</td>
</tr>
</tbody>
</table>

Other types of transactions which appear on this report include: cash refunds, manual discounts, adjustments, write offs and reinstatements, returned checks and returned check service charges.

Itemized Audit Trail for Revenue Center
The Itemized Audit Trail by Revenue Center Report allows you to print a trail of all invoices for a specified revenue center. Only one revenue center may be selected each time you print the report. For example, you can print a report of all invoices with at least one item attributed to the selected revenue center. You
can also choose to print this report by revenue center for an individual cashier ID or for a range of cashier IDs.

<table>
<thead>
<tr>
<th>Itemized Audit Trail Report for Revenue Center</th>
<th>Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:32 pm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Client Name</td>
</tr>
<tr>
<td>127-1</td>
<td>Gregor, Jennifer</td>
</tr>
<tr>
<td>127-1</td>
<td>127-1</td>
</tr>
<tr>
<td>127-1</td>
<td>127-1</td>
</tr>
<tr>
<td>127-1</td>
<td>127-1</td>
</tr>
<tr>
<td>127-1</td>
<td>127-1</td>
</tr>
</tbody>
</table>

New Client Report - By Client ID or By Client Last Name

The New Client Report shows all of the new clients entered into Cornerstone during the selected daily period(s). This report can be sorted by client ID or last name.

You can save data from this report (using the Save As feature) to create mailing labels to send client satisfaction surveys or other marketing materials.

Note: This report is also available as an End of Month report and End of Year report.

<table>
<thead>
<tr>
<th>New Client Report - Sorted By Client ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:32 pm</td>
</tr>
<tr>
<td>Client ID</td>
</tr>
<tr>
<td>20047</td>
</tr>
<tr>
<td>713-5279-0093</td>
</tr>
</tbody>
</table>

New Client Report - By Practice, Client ID or By Practice, Client Last Name

For those practices with the Multi-Location/Single Database option enabled, the New Client Report - By Practice shows all of the new clients entered into Cornerstone by practice during the selected daily period(s) based on the client home practice. This report can be sorted by client ID or last name.

You can save data from this report (using the Save As feature) to create mailing labels to send client satisfaction surveys or other marketing materials.

Note: This report is also available as an End of Month report and End of Year report.

Patient Documents Finalized by EOD

The Patient Documents Finalized by EOD Report lists all medical notes, correspondence and Classic medical notes that were automatically finalized during End of Day processing. If items were moved to the Patient Visit List, asterisks (*) are included on the report line.
Patient Visit List By Date or Patient Visit List By Type
The Patient Visit List Report shows all of the items that currently exist in the Patient Visit List for all patients.

Note: The Patient Visit List Report can be run only for the Current daily period.

<table>
<thead>
<tr>
<th>Date</th>
<th>Type</th>
<th>Item ID</th>
<th>Description</th>
<th>Quantity</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>18953</td>
<td>1</td>
<td>1305</td>
<td>Patient: 18953-26</td>
<td>1</td>
<td>$72.59</td>
</tr>
<tr>
<td>07/22/2009</td>
<td>X</td>
<td>3310</td>
<td>Tresiba Solution 15 ml</td>
<td>102.11</td>
<td></td>
</tr>
</tbody>
</table>

Returned Check Report - By Client ID or By Client Last Name
The Returned Check Report shows the returned checks recorded in Cornerstone during the daily period.

Note: This report is also available as an End of Month report.

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name</th>
<th>Return Check Number</th>
<th>Check Amount</th>
<th>Fee Charge</th>
</tr>
</thead>
</table>

Sales Tax Summary - By Revenue Center (Daily)
The Sales Tax Summary by Revenue Center Report shows how much sales tax was collected during the day by revenue centers. The tax description, current tax rate, taxable sales and total tax amounts are shown for each revenue center at your practice.

<table>
<thead>
<tr>
<th>Tax Description</th>
<th>Current Tax Rate</th>
<th>Taxable Sales</th>
<th>Total Tax Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>$0</td>
<td>($88.07)</td>
<td>$0.00</td>
</tr>
<tr>
<td>Hospital</td>
<td>$0</td>
<td>$92.64</td>
<td>$0.00</td>
</tr>
<tr>
<td>Laboratory</td>
<td>$0</td>
<td>$192.42</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
Serv. and Inv. Sales - Closed Invoices - By Class Desc., By Class ID, By Staff ID, or By Staff Name

The Service and Inventory Sales Report shows daily period gross sales categorized by classifications of products and services.

<table>
<thead>
<tr>
<th>Serv. and Inv. Sales Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily - Closed Invoices - By Staff ID</td>
</tr>
<tr>
<td>Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:20 pm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class ID</th>
<th>Class Description</th>
<th>Subclass ID</th>
<th>Subclass Description</th>
<th>Quantity</th>
<th>AVG Sales Price</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>675</td>
<td>DENTAL</td>
<td></td>
<td></td>
<td>2.00</td>
<td>$99.00</td>
<td>$198.00</td>
</tr>
<tr>
<td>675</td>
<td>DENTAL</td>
<td></td>
<td></td>
<td>0.50</td>
<td>$19.00</td>
<td>$9.50</td>
</tr>
<tr>
<td></td>
<td>DENTAL</td>
<td></td>
<td></td>
<td>3.50</td>
<td>$28.00</td>
<td>$98.00</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td>6.50</td>
<td>$55.00</td>
<td>$358.00</td>
</tr>
</tbody>
</table>

Serv. And Inv. Sales by Revenue Center - By Class Desc., By Class ID, By Staff ID or By Staff Last Name

The Service and Inventory Sales by Revenue Center Report shows daily gross sales broken down by revenue center.

<table>
<thead>
<tr>
<th>Service and Inventory Sales by Revenue Center Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily - Closed Invoices - By Class Desc.</td>
</tr>
<tr>
<td>Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:20 pm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Class ID</th>
<th>Class Description</th>
<th>Subclass ID</th>
<th>Subclass Description</th>
<th>Quantity</th>
<th>AVG Sales Price</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>675</td>
<td>DENTAL</td>
<td></td>
<td></td>
<td>2.00</td>
<td>$39.00</td>
<td>$78.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td>$67.00</td>
<td>$67.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td>$67.01</td>
<td>$67.01</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td>4.00</td>
<td>$55.91</td>
<td>$223.64</td>
</tr>
</tbody>
</table>

Standard Fee Exception Report - By Item Description or By Item ID

The Standard Fee Exception Report lists the clients and patients invoiced for an item at a price other than the standard price and shows the staff member who gave the deviated price. This report calls attention to how much money is lost each day by changing prices.

Standard Fee Exception Summary

The Standard Fee Exception Summary Report shows how much each staff member has invoiced at a price variance within the selected daily period(s).

<table>
<thead>
<tr>
<th>Standard Fee Exception Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorted By Staff Last Name</td>
</tr>
<tr>
<td>Friday, March 18, 2001 04:56 pm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Staff ID</th>
<th>Staff Name</th>
<th>Invoice Amount</th>
<th>Standard Amount</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dr. John M. James</td>
<td>$30.00</td>
<td>$10.00</td>
<td>$20.00</td>
</tr>
</tbody>
</table>
Statistics By Species - Closed Invoices

The Statistics By Species Report shows the number of invoices and the total gross sales taken in for the day to show the financial return from different species.

Note: This report is also available as an End of Month report and End of Year report.

Statistics By Species Report

Daily - Closed Invoices - By Species Name

Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:20 pm

<table>
<thead>
<tr>
<th>Species ID</th>
<th>CAN</th>
<th>CARNIVORE</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. Visitors</td>
<td>4.00</td>
<td>80.00%</td>
</tr>
<tr>
<td>Serv. Sales</td>
<td>26.00</td>
<td>78.79%</td>
</tr>
<tr>
<td>Inventory</td>
<td>8.00</td>
<td>66.67%</td>
</tr>
</tbody>
</table>

Species ID: FEL | FELINE

| No. Visitors | 1.00 | 20.00% | $250.43 | 16.00% | $250.43 |
| Serv. Sales | 7.00 | 21.26% | $202.43 | 14.00% | $28.92 |
| Inventory | 3.00 | 33.33% | $48.01 | 32.69% | $16.00 |

Total For All Species

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>% of Total</td>
</tr>
<tr>
<td>No. Visitors</td>
<td>5.00</td>
</tr>
<tr>
<td>Serv. Sales</td>
<td>33.00</td>
</tr>
<tr>
<td>Inventory</td>
<td>9.00</td>
</tr>
</tbody>
</table>

Statistics By Staff - Closed Invoices

The Statistics By Staff Report shows each staff member’s productivity by providing the number of invoices and the total gross sales taken in for the day.

Note: This report is also available as an End of Month report and End of Year report.

Statistics By Staff Report

Daily - Closed Invoices - By Staff Last Name

Thursday, October 18, 2007 04:52 pm through Friday, October 19, 2007 03:20 pm

<table>
<thead>
<tr>
<th>Staff ID</th>
<th>MW</th>
<th>Dr. Mark J. Fiala DVM</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. Visitors</td>
<td>4.00</td>
<td>100.00%</td>
</tr>
<tr>
<td>Serv. Sales</td>
<td>30.00</td>
<td>98.71%</td>
</tr>
<tr>
<td>Inventory</td>
<td>9.00</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

Staff ID: EVE | Evelyn Vander Pal DVM

| No. Visitors | 1.00 | 29.90% | $167.72 | 10.76% | $167.72 |
| Serv. Sales | 3.00 | 9.00% | $167.72 | 12.35% | $55.91 |
| Inventory | 0.00 | 0.00% | $0.00 | 0.00% | $0.00 |

Total For All Staff

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>% of Total</td>
</tr>
<tr>
<td>No. Visitors</td>
<td>5.00</td>
</tr>
<tr>
<td>Serv. Sales</td>
<td>20.00</td>
</tr>
<tr>
<td>Inventory</td>
<td>9.00</td>
</tr>
</tbody>
</table>
Chapter 21: End of Month Processing

Overview

When you process End of Month (EOM), the IDEXX Cornerstone* Practice Management System:

- Processes your records for the monthly period.
- Totals the daily records to create the monthly totals.
- Transfers the monthly totals to the current yearly totals.
- Resets the current monthly period to zero.

It is easy to track EOM periods because Cornerstone* records the date and time with each closing.

Tip: You can set up your Cornerstone system to automatically process End of Day or End of Month. See “Unattended End of Period (EOP) Defaults” on page 135 for more information.

IMPORTANT: It is imperative for your practice to have a good backup procedure in place. Backups provide security against the unlikely chance that files are lost or destroyed. As an added safety precaution, you should remove the most recent backup from the practice or place it in a DATA-Rated fireproof safe.

Depending on the backup procedure at your practice, you can do a manual backup before completing End of Month processing or automatically as set up by IDEXX Computer Systems. For backup instructions, see the original documentation that came with your backup software.

If you have questions about your backup procedure or how to verify that your backup was successful, contact Cornerstone Support at 1-800-695-2877. Do not take chances with your practice data.

Note: If your practice uses compatible backup software, you can set up Cornerstone to automatically verify your backup using the Cornerstone Backup Verification Assistant. (See “Chapter 28: Using the Backup Verification Assistant” beginning on page 446 for more information.)

Notes on End of Month processing:

- You can perform End of Month processing on any day of the month, if necessary, not only on the last calendar day of the month. The important thing is to maintain a consistent pattern of closing periods.

- When you close a monthly period, all transactions from the previous monthly closing up through the current monthly closing are included.

- End of Month ages accounts. This adds finance charges if they have been set up.

- Performing monthly activities creates a second EOD closing. These totals include added finance charges, billing charges and open invoices that were closed as part of EOM processing. For the last EOD of the month, print the EOD reports after processing EOM so the reports will include the accurate information.

- Once End of Month has been processed, billing charges cannot be added to accounts for the closed month. (Billing charges can be applied to accounts by printing the Monthly Invoices and Statements Report and selecting Current for the monthly period. However, this billing charge will be applied toward the next monthly period.)
Chapter 21: End of Month Processing

- You do not need exclusive use to process End of Month. However, staff will not be able to post invoices or save changes to any window that modifies a client’s account. If a user tries to modify a client’s account, a message warns the user to wait until the End of Month processing is finished. Once the End of Month processing is complete, the user can continue.

Performing End of Month Processes

Before You Begin
- Process End of Day immediately before processing End of Month.
- Follow your normal backup procedures to perform a monthly backup. For backup instructions, see the original documentation that came with your backup software, or contact Cornerstone Support at 1-800-695-2877. If a backup is performed before processing End of Month, information can be restored, if necessary.
- Ensure that EOM defaults have been set up (see “End of Period Defaults” on page 102).
- Make sure the appropriate clients are set up to receive finance charges and billing charges (Lists > Clients > Update > A/R Information tab).
- If a large number of open invoices is anticipated, preview and/or print the Monthly Client Open Invoices–By Client ID Report. If only a small number is anticipated, preview the Daily Planner’s Invoices tab.

IMPORTANT: Because End of Month involves totals from the daily records, you must run End of Day immediately before processing End of Month.

To check for open invoices (recommended):
2. In the Reports list, click the plus sign to the left of End of Month, and then select the Monthly Clients with Open Invoices–By Client ID report.
3. Click Create report. The Daily Reports dialog box appears.
4. Under Monthly periods, select the Current period
5. Preview the report to determine which invoices to close.
6. Close the report.

To preview and close open invoices (recommended)
1. Click the Daily Planner toolbar button.
2. Enter your staff information and select the Invoices tab.
3. Double click the invoices to be closed.
   Note: If all consumption information has not been filled in, you will need to enter the information before the invoice will close.
4. Click Post.
5. In the Post Invoice window, you can clear the check boxes for Apply payment and Print invoice, as this balance will be applied to the client’s account.
   Note: Cornerstone has the ability to automatically close invoices based on the invoice type.
   When an invoice is closed, the invoice becomes part of the client’s accounts receivable balance and the client will receive a statement inclusive of all charges.
To process End of Month:

IMPORTANT: Processing End of Month (EOM) ages the accounts receivable and applies finance charges and/or billing charges. Even if you cancel out of processing End of Month, the finance and billing charges will still be applied. If you make a backup prior to performing this function, you can restore the information, should the need arise.

1. On the Activities menu, select **End of Period > End of Month**.

2. An End of Period warning message appears. Read the message and click **OK**. (To prevent this message from appearing in the future, clear the **Show Message** check box.)

   The Monthly Period Closing dialog box appears.

3. Verify that the **Monthly finance charge**, **Minimum finance change**, **Billing charge** and **Billing threshold** are all set to the appropriate amounts. (These amounts may have already been defined in the End of Period defaults **Monthly Closing** settings. See “End of Period Defaults” on page 102 for more information on these settings.)

   **Note:** Cornerstone adds a finance charge only to clients who are set up to receive a finance charge with a balance over 30 days.

4. Select the **Apply billing charge** check box if you want a billing charge to be applied to all accounts that will receive a bill at EOM closing.

   **Tip:** If you would like a billing charge to be applied only to accounts 30 days and over, we suggest you put the charge amount in the **Minimum finance charge** field instead.

5. In the **Notes** text box, enter any details for this EOM closing and include your name or initials. (You can view the notes later by clicking **Details** in the Monthly Reports dialog box.)

6. In the **Open invoices** area, verify that any open invoices you want to close are marked as **Yes**. If you do not want an invoice closed, click on **Yes** to change it to **No**.

   **Note:** Open invoices are not included on monthly statements.

7. Click **OK**.

8. In the confirmation window, click **Yes** to process End of Month.

9. When processing is complete, click **OK** in the notification window.
Note: If you are processing End of Year, immediately start your End of Year procedures. See “Performing End of Year Processes” on page 405.

Printing End of Month Reports
Cornerstone includes many monthly reports that help you keep records of your valuable information. These reports are an important part of standard bookkeeping and are useful for tracking business trends.

Some commonly printed monthly reports include:
- **Sales Tax Summary/Income Reconciliation Report**—Breaks down all of your practice’s sales, taxes, discounts and other items that impact revenue and displays the total income for the monthly period(s).
- **Accounts Receivable Report**—Displays all of the clients that owe you money.

Tips for End of Month reports:
- The first time you process End of Month, print every report. From these, decide which information you want each month and make a list of reports to run monthly. (You may want to show the reports to people like your accountant and office manager before deciding which to run monthly.) Include these reports in your reports binder and select them as your default reports.
- After End of Month has been processed and balanced, discard (or file) the End of Day reports that were in your binder.
- Statements are found on the End of Month Report List. Each time statements are printed, billing charges are added (if applicable). Finance charges are added to account balances over 30 days when the monthly period is closed (when Cornerstone ages accounts).

IMPORTANT: Selecting the option to apply a billing charge when printing a statement in the current monthly period will apply a billing charge each time you choose to print. Once you have chosen to print the monthly statements, even if you cancel the print job, any billing charges are still applied.

Before You Begin
- Set your End of Period defaults to select the reports you want Cornerstone to automatically select for you in the Monthly Reports dialog box (see “End of Period Defaults” on page 102).
- Assign the printer to print the reports (File > Printer Assignment > End of Month, and select the reports you want to print on each printer).
- Finish your End of Month processing.

To print all selected EOM reports:
2. Under *Monthly periods*, select the period you want the reports to reflect. For most reports, you can print information for more than one *continuous* period; click the earliest period and then press and hold the SHIFT key, click the down arrow until you see the last period and then click the last period. All of the periods in between are highlighted.

**Note:** When you select a beginning date range, your End of Period reports include all data in the date range from one minute prior to the beginning date selected through the ending date selected.

3. In the *Report list*, reports you have selected in End of Period defaults are highlighted. If needed, do the following to select additional reports:

   - To select a consecutive group of reports, click the first report, hold down the SHIFT key, and then click the last report.
   - To select nonconsecutive reports, hold down CTRL, and then click each report you want to select.

4. Click *Print*. The reports print on the printer assigned for each report (or the default printer if no printer has been assigned).

**To preview, print and/or save a specific EOM report:**

2. In the Reports list, click the plus sign to the left of *End of Month*, and then select the desired report.
3. With the desired report highlighted in the *End of Month* report group, click *Create report*. The Monthly Reports dialog box appears.
4. Under *Monthly periods*, select the period you want the report to reflect. For most reports, you can print information for more than one *continuous* period; click the earliest period and then press and hold the SHIFT key while you click the last period. All of the periods in between are highlighted.

   **Note:** When you select a beginning date range, your End of Period reports include all data in the date range from one minute prior to the beginning date selected through the ending date selected.

5. In the *Report list*, select the report to preview. (You can only preview one report at a time.)
Note: You may have to deselect any reports that Cornerstone has automatically selected (based on End of Period defaults).

6. Click **Preview**. The Reports Preview window appears.

7. Click **Print** to print the report, click **Save** to save the report data to a file or click **Cancel** to return to the Monthly Reports dialog box.

**End of Month Reports**

**Accounts Receivable Report - By Client ID or By Client Name**

The Accounts Receivable Report displays all clients who owe your practice money and how much is owed. You can choose what type of accounts receivable balance you want to include the following:

- All clients with an accounts receivable balance
- Clients with account receivable balances that are 30 days or more overdue
- Clients with account receivable balances that are 60 days or more overdue
- Clients with account receivable balances that are 90 days or more overdue
- Only clients who have a credit balance

The date reflects the monthly period closing covered by the report. Do not run this report for multiple monthly period closings.
Accounts Receivable Report - By Practice, Client ID or By Practice, Client Name
For those practices with the Multi-Location/Single Database option enabled, the Accounts Receivable Report—By Practice shows all clients who owe money and how much is owed, broken down by practice based on the client home practice.

Accounts Receivable Status Report - Closed Invoices
The Accounts Receivable Status Report gives you a quick summary of account activity during the selected monthly period(s).

Note: This report is not available for the Current monthly period.

Aged Accounts Receivable Report by Staff
The Aged Accounts Receivable Report by Staff should be used only by practices that pay providers based on collected accounts receivable. It tracks the uncollected portion of each provider’s production (what’s owed a provider) and may be used to help calculate providers’ commissions.

This report is updated by invoicing. It will not balance with other EOM reports if any invoicing has been done between EOM processing and the printing of this report. The Balance Due amounts in the Totals section will not balance if there are open invoices with payments.

You must set up your system to run this report. See “Invoice Defaults” on page 112 for more information on setting your system to run this report.

Note: The Aged Accounts Receivable Report by Staff can be run only for the Current monthly period.
Cost of Goods Sold Report

The Cost of Goods Sold report shows cost and profit based on sales for items that are set up to track Quantity on Hand. It includes only those inventory items that are sold in the selected time frame (you can select multiple periods and/or the current period). The report provides subtotals by class and revenue center, with grand totals of net sales (after discounts and before taxes), cost and profit. (Included subtotals and grand totals will vary depending on how the report is sorted.)

You can select from four different variations of the report, depending on your sorting preference:

- Sorted by Revenue Center, Class ID, Item ID
- Sorted by Revenue Center, Inv. Location, Class ID, Item ID
- Sorted by Class ID, Item ID
- Sorted by Inv. Location, Class ID, Item ID
Finance Charge Report - By Client ID or By Client Last Name

The Finance Charge Report shows you the finance charges added to each client’s account during the selected monthly period(s).

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name</th>
<th>Current</th>
<th>30 Days</th>
<th>60 Days</th>
<th>90 Days</th>
<th>Finance Charge</th>
<th>Balance Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>12000</td>
<td>Watson, Char</td>
<td>$10.00</td>
<td>$10.00</td>
<td>$10.00</td>
<td>$10.00</td>
<td>$10.00</td>
<td>$10.00</td>
</tr>
<tr>
<td>12010</td>
<td>Foster, Ken</td>
<td>$15.00</td>
<td>$15.00</td>
<td>$15.00</td>
<td>$15.00</td>
<td>$15.00</td>
<td>$15.00</td>
</tr>
<tr>
<td>12020</td>
<td>Smith, John</td>
<td>$20.00</td>
<td>$20.00</td>
<td>$20.00</td>
<td>$20.00</td>
<td>$20.00</td>
<td>$20.00</td>
</tr>
</tbody>
</table>

GL Batch Report

Used only if your practice utilizes the General Ledger (GL) Interface, the GL Batch Report provides a summary of the data extracted to the file.

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Cornerstone Account</th>
<th>Credit/Debit</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000</td>
<td>Sales - INGESTED</td>
<td>0.00</td>
</tr>
<tr>
<td>10100</td>
<td>Accounts Receivable</td>
<td>0.00</td>
</tr>
<tr>
<td>10200</td>
<td>Inventory - Animal</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Inventory Sales Report - Closed Invoices - By Class By Desc. or By Class By ID

The Inventory Sales Report displays both the percent and dollar amounts of revenue for each inventory subclass. Use this report for a quick summary of the items with the highest sales in the selected monthly period(s). You can track seasonal and promotional items easily.

Because the Inventory Sales Report can be a very large report, Cornerstone displays the End of Period Filters dialog box so you can enter a range of information to print. For more information on filtering information in reports, see “Chapter 5: Reports” in the Cornerstone User’s Manual.

Note: This report is also available as an End of Year report.

<table>
<thead>
<tr>
<th>Item ID and Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>4.00</td>
<td>$128.52</td>
<td>11.42%</td>
</tr>
<tr>
<td>1020</td>
<td>2.00</td>
<td>$78.20</td>
<td>6.77%</td>
</tr>
<tr>
<td>1010</td>
<td>0.00</td>
<td>$95.05</td>
<td>8.11%</td>
</tr>
<tr>
<td>1020</td>
<td>3.00</td>
<td>$94.05</td>
<td>8.11%</td>
</tr>
<tr>
<td>1030</td>
<td>4.00</td>
<td>$78.35</td>
<td>6.66%</td>
</tr>
<tr>
<td>1040</td>
<td>0.00</td>
<td>$78.00</td>
<td>6.61%</td>
</tr>
</tbody>
</table>

The last page of the report displays the grand total for the quantity and sales revenue.
Inventory Sales Report by Revenue Center - By Class by Desc or By Class by ID

The Inventory Sales Report by Revenue Center shows the sales of inventory divided into revenue centers.

<table>
<thead>
<tr>
<th>Item ID and Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>O/D Canine Day 46 lbs</td>
<td>1.00</td>
<td>$52.99</td>
<td>4.51%</td>
</tr>
<tr>
<td>H/D Canine Day 65</td>
<td>1.00</td>
<td>$15.55</td>
<td>0.13%</td>
</tr>
<tr>
<td>T/G Canine Day 5 lbs</td>
<td>2.00</td>
<td>$24.10</td>
<td>2.02%</td>
</tr>
<tr>
<td><strong>Subclass Total</strong></td>
<td>4.00</td>
<td><strong>$79.62</strong></td>
<td><strong>6.66%</strong></td>
</tr>
<tr>
<td><strong>Revenue Center - F Prescription Diets Nutrition Total</strong></td>
<td>4.00</td>
<td>$79.62</td>
<td>6.66%</td>
</tr>
</tbody>
</table>

Monthly Adjustment Summary - By Client ID or By Client Last Name

The Monthly Adjustment Summary report displays all adjustments made in the selected periods, with the comment and staff ID of the person making the adjustment.

| Client ID | Client Name | Description | Date       | Amount |

Monthly Clients With Open Invoices - By Client ID or By Invoice No.

You can use the Monthly Clients With Open Invoices report to help you decide which invoices to close before you start the End of Month process.

**Note:** The Monthly Clients With Open Invoices report can be run only for the Current monthly period.
Monthly Deposit Report
The Monthly Deposit Report helps you see your client cash flow for the month.

### Monthly Deposit Report

**Wednesday, October 31, 2007 02:35 pm through Friday, November 30, 2007 05:47 pm**

<table>
<thead>
<tr>
<th>Payment Type</th>
<th>Deposit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASH</td>
<td>$661.03</td>
</tr>
<tr>
<td>Net Cash</td>
<td>$661.03</td>
</tr>
<tr>
<td>Cash/Check</td>
<td>$4,220.82</td>
</tr>
<tr>
<td>Check</td>
<td>$100.00</td>
</tr>
<tr>
<td>Visa</td>
<td>$1,000.41</td>
</tr>
</tbody>
</table>

**Total Monthly Receipts:** $7,082.26

Monthly Discount Report – By Discount
The Monthly Discount Report - By Discount includes all predefined discounts given during the month. When this report is run, the Monthly Manual Discount Report - By Client is also automatically run. It includes all the manual discounts given during the month.

### Monthly Discount Report

**Wednesday, November 30, 2005 02:26 pm through Saturday, December 31, 2005 03:28 pm**

<table>
<thead>
<tr>
<th>Invoice ID</th>
<th>Patient</th>
<th>Item</th>
<th>Staff</th>
<th>Price</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>9110</td>
<td>4100</td>
<td>CBC (1st)</td>
<td>Jan Broker</td>
<td>$37.00</td>
<td>$6.75</td>
</tr>
<tr>
<td>0010</td>
<td>ELECTROLYTES</td>
<td>4100</td>
<td>Jan Broker</td>
<td>$20.00</td>
<td>$8.00</td>
</tr>
<tr>
<td>103660</td>
<td>EXPEND. 14</td>
<td>4100</td>
<td>Jan Broker</td>
<td>$10.00</td>
<td>$10.00</td>
</tr>
<tr>
<td>103671</td>
<td>EXPEND. 14</td>
<td>4100</td>
<td>Jan Broker</td>
<td>$25.75</td>
<td>$25.75</td>
</tr>
<tr>
<td>2509</td>
<td>2004 ANNUAL PHYSICAL</td>
<td>4100</td>
<td>Jan Broker</td>
<td>$35.00</td>
<td>$35.00</td>
</tr>
</tbody>
</table>

**Client Total:** $177.97

**BHP Program Total:** $47.97

Monthly Discount Report - By Staff
The Monthly Discount Report - By Staff displays all uses of predefined discounts given by staff during the month. When you run this report, the Monthly Manual Discount Report - By Staff is also automatically run. It includes all manual discounts given by staff during the month.

### Monthly Manual Discount Report

**Monday, July 31, 2006 08:19 pm through Thursday, August 31, 2006 07:27 pm**

<table>
<thead>
<tr>
<th>Invoice ID</th>
<th>Patient</th>
<th>Item</th>
<th>Staff</th>
<th>Discount</th>
<th>Price</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>MW</td>
<td>MARK HARRIS DVM</td>
<td>MW</td>
<td>2001</td>
<td>$105.90</td>
<td>$62.50</td>
</tr>
<tr>
<td>2002</td>
<td>MW</td>
<td>MARK HARRIS DVM</td>
<td>MW</td>
<td>2002</td>
<td>$19.00</td>
<td>$9.45</td>
</tr>
<tr>
<td>1003</td>
<td>MW</td>
<td>MARK 2 YEAR BOOSTER</td>
<td>Mark</td>
<td>$12.95</td>
<td>$8.45</td>
<td></td>
</tr>
<tr>
<td>1004</td>
<td>MW</td>
<td>MARK 2 YEAR BOOSTER</td>
<td>Mark</td>
<td>$12.95</td>
<td>$8.45</td>
<td></td>
</tr>
<tr>
<td>1005</td>
<td>MW</td>
<td>MARK 2 YEAR BOOSTER</td>
<td>Mark</td>
<td>$12.95</td>
<td>$8.45</td>
<td></td>
</tr>
</tbody>
</table>

**Client Total:** $40.98

**MW Mark Harris DVM Total:** $40.98
### Monthly Invoices and Statements

For information on the Monthly Invoices and Statements report option, see "Printing Monthly Invoices and Statements" on page 400 for more information.

**Sample Normal Statement**

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/3/05</td>
<td>ECM: Finance Charge</td>
<td>$5.00</td>
</tr>
<tr>
<td>11/3/05</td>
<td>ECM: Billing Charge</td>
<td>$5.00</td>
</tr>
</tbody>
</table>

**Balance Due:** $168.50

The standard statement for preprinted paper is formatted so that you can fit the statement in an open window envelope.

**Tip:** To change the placement of the client address or practice address on monthly statements, see "Statement Print Options Defaults" on page 132. To change the placement of the client address or practice address on invoices, see "Invoice Address Defaults" on page 114.
Sample Detailed Statement

Your Veterinary Practice  
1010 Main Street  
You Town, WI 54521  
(900) 283-8386

Date: 1/2/06  
Client ID: 1042

Date  Description  Amount

1/2/06  Previous Balance:  $52.50

1/2/06  Invoice # 326 - Closed  

Patient ID: 111  
Species: CANINE  
Weight: 45 lb  
Sex: Male  

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Staff Name</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2/06</td>
<td>EXAMINATION</td>
<td>Dr. Anne Carson, DVM</td>
<td>1.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>1/2/06</td>
<td>BATH &amp; GROOMING</td>
<td></td>
<td>1.00</td>
<td>$20.00</td>
</tr>
</tbody>
</table>

Patient Subtotal:  $45.00

Invoice Total #326:  $45.00

Balance Due:  $47.50

Monthly Sales Summary

The Monthly Sales Summary displays sales information for each daily closing period. You can see total sales as well as inventory and service item sales. The report also shows the sales tax collected in each daily closing period.

Monthly Sales Summary

Thursday, May 31, 2007 12:52 pm through Friday, June 29, 2007 10:21 am

<table>
<thead>
<tr>
<th>Date</th>
<th>Main Sale Date</th>
<th>Total Sales</th>
<th>Sales Tax</th>
<th>Total Discount</th>
<th>Return</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>6/30</td>
<td>6</td>
<td>10</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>6/29</td>
<td>6</td>
<td>3</td>
<td>$15.50</td>
<td>$0.25</td>
<td>$0.00</td>
<td>$15.25</td>
</tr>
</tbody>
</table>

There is a 1.5% finance charge applied to all balances over 30 days.
Monthly Sales Summary–By Practice

The Monthly Sales Summary–By Practice is available for those practices with the Multi-Location/Single Database option enabled. This report is split out by practice and displays sales information for each daily closing period. You can see total sales as well as inventory and service item sales. The report also shows the sales tax collected in each daily closing period.

Monthly Staff Commission Detail Report–Gross or Net

The Monthly Staff Commission Detail Report shows the commission for staff members in detail by item classification.

<table>
<thead>
<tr>
<th>Staff ID and Name</th>
<th>Item Classification</th>
<th>Quantity</th>
<th>Sale Amount</th>
<th>Commission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANESTHESIA</td>
<td>4110 ISOFLURANE ANESTHESIA</td>
<td>1.00</td>
<td>$62.20</td>
<td>$0.00</td>
</tr>
<tr>
<td></td>
<td>4100 INTRAVENOUS ANESTHESIA</td>
<td>1.00</td>
<td>$59.85</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total for ANESTHESIA</td>
<td></td>
<td>2.00</td>
<td>$122.05</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Monthly Staff Commission Summary Report–Gross or Net

The Monthly Staff Commission Summary Report shows the commission for staff members summarized according to item classification.

<table>
<thead>
<tr>
<th>Staff ID and Name</th>
<th>Item Classification</th>
<th>Quantity</th>
<th>Sale Amount</th>
<th>Commission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANESTHESIA</td>
<td></td>
<td>2.00</td>
<td>$122.05</td>
<td>$0.00</td>
</tr>
<tr>
<td>Anesthetic/Intravenous</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Opioids</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Sedatives</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Controlled Substances</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Fixed &amp; Tool Fee</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Fixed &amp; Prescription Drugs</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Equipment</td>
<td></td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Monthly Staff Commission Totals Report–Gross or Net

The Monthly Staff Commission Totals Report shows the total amount of sales and total amount of commission credited to each provider.

<table>
<thead>
<tr>
<th>Staff ID and Name</th>
<th>Quantity</th>
<th>Sale Amount</th>
<th>Commission</th>
</tr>
</thead>
<tbody>
<tr>
<td>MV</td>
<td>317.00</td>
<td>$3,255.98</td>
<td>$0.00</td>
</tr>
<tr>
<td>ELL</td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>BR</td>
<td>0.00</td>
<td>$1,229.19</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
Monthly Voided Invoice Report–By Client ID, By Date or By Staff

This report lists invoices voided in a specific monthly period.

<table>
<thead>
<tr>
<th>Monthly Voided Invoices Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorted by Staff ID</td>
</tr>
<tr>
<td>Monday, August 8, 2006 09:00 am through Wednesday, August 31, 2006 09:54 am</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voided By</th>
<th>Void Invoice Date</th>
<th>Original Invoice Number</th>
<th>Void Invoice Number</th>
<th>Invoice Client Amount</th>
<th>Client Name</th>
<th>Patient ID</th>
<th>Patient Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>09/06/2005</td>
<td>88857</td>
<td>60088</td>
<td>(570) 752-22830</td>
<td>Conlet Quinley</td>
<td>32300-1</td>
<td>Renee</td>
</tr>
</tbody>
</table>

New Client Report–By Client ID or By Client Last Name

The New Client Report shows all of the new clients entered into Cornerstone during the selected monthly period(s). This report can be sorted by client ID or last name.

You can save data from this report (using the Save As feature) to create mailing labels to send client satisfaction surveys or other marketing materials.

Note: This report is also available as an End of Day report and End of Year report.

<table>
<thead>
<tr>
<th>New Client Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorted By Client ID</td>
</tr>
<tr>
<td>Sunday, September 30, 2007 10:04 am through Wednesday, October 31, 2007 02:34 pm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name and Phone No.</th>
<th>Mailing Address</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>22640</td>
<td>Robert Johnson (716) 945-7630</td>
<td>2222 E. PARK ST</td>
<td>10/19/2007</td>
</tr>
</tbody>
</table>

Along with the information on the EOD New Client Report, the EOM New Client Report shows the date the client was entered into Cornerstone.

New Client Report–By Practice, Client ID or By Practice, Client Last Name

For those practices with the Multi-Location/Single Database option enabled, the New Client Report–By Practice shows all of the new clients entered into Cornerstone by practice during the selected period(s) based on the client home practice. This report can be sorted by client ID or last name.

You can save data from this report (using the Save As feature) to create mailing labels to send client satisfaction surveys or other marketing materials.

Note: This report is also available as an End of Day report and End of Year report.
Productivity by Staff Report

The Productivity by Staff report contains the sales totals for the month and each provider's paid sales total. In order for this report to print with accurate information, you must run your End of Month processing before printing. You must set the A/R by provider settings in Invoice defaults in order to see/run this report. For more information, see “Invoice Defaults” on page 112.

Referral Report–by Staff

The Referral Report shows the work done by a staff member of your practice for another hospital.

Referral Report–Doctor by Hospital or Hospital by Doctor

The Referral (Revenue) Report shows the work done by your practice for another hospital, separated by client.

Referral Summary–by Doctor

The Referral Summary–by Doctor report lists referral doctors and shows the amount of work and sales each referral doctor generated for your practice.
Chapter 21: End of Month Processing

Referral Summary—by Hospital

The Referral Summary—by Hospital report lists referral hospitals and shows the amount of work and sales each referral hospital generated for your practice.

<table>
<thead>
<tr>
<th>Referral Hospital</th>
<th>New</th>
<th>Rechecks</th>
<th>Total</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referral Hospital</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>EN 714</td>
</tr>
<tr>
<td>Referral Hospital</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Referral Summary—Doctor by Hospital or Hospital by Doctor

The Referral Summary report shows the total amount of work done for another hospital by your practice. This report can be sorted by staff class or staff ID.

<table>
<thead>
<tr>
<th>Referral Doctor</th>
<th>Referral Hospital</th>
<th>New</th>
<th>Rechecks</th>
<th>Total</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doctor Name</td>
<td>Referral Hospital</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>EN 714</td>
</tr>
<tr>
<td>Doctor Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returned Check Summary

Use the Returned Check Summary to follow up on amounts that need to be recovered.

Sales Tax Summary by Revenue Center

This report shows how much sales tax was collected during the month by revenue centers. Sale tax amounts display for each revenue center at your practice.

<table>
<thead>
<tr>
<th>Tax Description</th>
<th>Current Tax Rate</th>
<th>Taxable Sales</th>
<th>Total Tax Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annual Examination</td>
<td>0.000000</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Sales Tax</td>
<td>7.000000</td>
<td>$200.02</td>
<td>$200.02</td>
</tr>
</tbody>
</table>

Total: $200.02
Sales Tax Summary/Income Reconciliation–Closed Invoices

The Sales Tax/Income Reconciliation report gives you a quick summary of your income for the selected monthly period(s). Sales are broken out into taxable sales and nontaxable sales.

Note: This report is also available as an End of Year report.

---

Serv. and Inv. Sales - Closed Inv.–By Class Desc. or By Class ID or By Staff ID or By Staff Last Name

The Service and Inventory Sales report quickly shows you the most common procedures performed, the top medications sold and the supplies used in your practice during the selected monthly period(s).

Because the Service and Inventory Sales report can be a very large report, Cornerstone displays the End of Period Filters dialog box so you can enter a range of information to print. You can print a range by class ID and subclass ID. If you are sorting by staff ID or staff last name, you can also use the range staff ID. For more information on filtering information in reports, see "Chapter 5: Reports" in the Cornerstone User’s Manual.

Note: This report is also available as an End of Day report.
Chapter 21: End of Month Processing

**Serv. And Inv. Sales by Revenue Center–By Class Desc. or By Class ID or By Staff ID or By Staff Last Name**

The Service and Inventory Sales by Revenue Center report shows the monthly sales broken down by revenue center.

**Serv. Sales Report–Closed Invoices–By Class By Desc. or By Class By ID**

The Service Sales Report shows the sales revenue from service items. Use this report to see which service items are generating the most sales.

Like the Service and Inventory Sales report, the Service Sales Report can also be a very large report; Cornerstone displays the End of Period Filters dialog box so you can enter a range of information to print. You can print a range by class ID, invoice item description, invoice item ID and subclass ID. For more information on filtering information in reports, see “Chapter 5: Reports” in the *Cornerstone User’s Manual*.

**Note:** This report is also available as an End of Year report.

**Service Sales Report**

*Monthly - By Class By Item ID*

<table>
<thead>
<tr>
<th>Item ID and Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>10051 COUNTRY TAX</td>
<td>1.00</td>
<td>$1.00</td>
<td>0.00%</td>
</tr>
<tr>
<td>2000 BLOOD PRESSURE CHECK</td>
<td>5.00</td>
<td>$100.00</td>
<td>0.00%</td>
</tr>
<tr>
<td>2020 BANDAGE APPLICATION</td>
<td>0.00</td>
<td>$0.00</td>
<td>0.00%</td>
</tr>
<tr>
<td>2150 CATHETERIZATION IV</td>
<td>4.00</td>
<td>$140.00</td>
<td>0.00%</td>
</tr>
</tbody>
</table>

---

**Service and Inventory Sales Report**

*Monthly - Closed Invoices - By Class Desc.*

**Sunday, September 30, 2007 10:04 am through Wednesday, October 31, 2007 02:34 pm**

<table>
<thead>
<tr>
<th>Class ID</th>
<th>Description</th>
<th>Class ID</th>
<th>Description</th>
<th>Subclass ID</th>
<th>Subclass Description</th>
<th>Sold</th>
<th>AVG Sales</th>
<th>Price</th>
<th>Total Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>075</td>
<td>DENTAL</td>
<td>006</td>
<td>GROUP</td>
<td>006</td>
<td></td>
<td>8.00</td>
<td>$0.90</td>
<td>$0.90</td>
<td>$7.20</td>
</tr>
<tr>
<td>001</td>
<td>OPHTHALMICS</td>
<td>020</td>
<td>PROFESSIONAL SERVICES</td>
<td>020</td>
<td></td>
<td>2.00</td>
<td>$0.90</td>
<td>$0.90</td>
<td>$1.80</td>
</tr>
<tr>
<td>002</td>
<td>SURGERY</td>
<td>010</td>
<td>VACCINATIONS</td>
<td>010</td>
<td></td>
<td>30.00</td>
<td>$0.90</td>
<td>$0.90</td>
<td>$27.00</td>
</tr>
<tr>
<td>040</td>
<td>ANESTHESIA</td>
<td>040</td>
<td>ANESTHESIA &amp; TRANQUILIZERS</td>
<td>040</td>
<td></td>
<td>6.00</td>
<td>$20.58</td>
<td>$123.48</td>
<td></td>
</tr>
<tr>
<td>051</td>
<td>ANTIHYPERTENSIVE</td>
<td>052</td>
<td>ANTIHYPERTENSIVE</td>
<td>052</td>
<td></td>
<td>2.00</td>
<td>$56.93</td>
<td>$113.86</td>
<td></td>
</tr>
<tr>
<td>053</td>
<td>ANTIBIOTICS</td>
<td>054</td>
<td>ANTIBIOTICS</td>
<td>054</td>
<td></td>
<td>34.00</td>
<td>$5.28</td>
<td>$179.44</td>
<td></td>
</tr>
</tbody>
</table>
**Serv. Sales Report by Revenue Center—By Class by Desc. or By Class by ID**

The Service Sales Report by Revenue Center shows the services performed during a monthly period broken down into your practice’s revenue centers.

<table>
<thead>
<tr>
<th>Item ID and Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Class - 006 PROFESSIONAL SERVICES</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wellness Exam</td>
<td>2.00</td>
<td>$59.60</td>
<td>0.05%</td>
</tr>
<tr>
<td>Subtotal</td>
<td>2.00</td>
<td>$59.60</td>
<td>0.05%</td>
</tr>
<tr>
<td>Revenue Center - All Annual Examination Total</td>
<td>2.00</td>
<td>$59.60</td>
<td>0.05%</td>
</tr>
</tbody>
</table>

**Split Invoices Report**

The Split Invoices Report shows a list of all invoices divided for split billing purposes during the month.

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Invoice ID</th>
<th>Amount</th>
<th>Date</th>
</tr>
</thead>
</table>

**Statistics By Species Report—Closed Invoices**

The Statistics By Species Report shows sales activity for each species invoiced during the selected monthly period(s).

**Note:** This report is also available as an End of Day report and End of Year report.
Statistics by Staff Report–Closed Invoices

The Statistics By Staff Report shows the sales activity for each staff member. This report is also available as an End of Day and End of Year report.

**Note:** This report is also available as an End of Day report and End of Year report.

### Statistics By Staff Report

**Monthly - Closed Invoices - By Staff Last Name**

<table>
<thead>
<tr>
<th>Staff ID</th>
<th>Dr. Mark J. Fields DVM</th>
<th>Number</th>
<th>% of Total</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>$9,076.49</td>
<td>9.06%</td>
<td>$372.70</td>
</tr>
<tr>
<td>New Sales</td>
<td></td>
<td>$10,438.53</td>
<td>10.38%</td>
<td>$51.14</td>
</tr>
<tr>
<td>Inventory</td>
<td></td>
<td>$131.09</td>
<td>1.31%</td>
<td>$11.27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Staff ID</th>
<th>HCL</th>
<th>Patrick K. Finch DVM</th>
<th>Number</th>
<th>% of Total</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>2.05</td>
<td>2.05%</td>
<td>$3,310.89</td>
</tr>
<tr>
<td>New Sales</td>
<td></td>
<td></td>
<td>111.09</td>
<td>11.11%</td>
<td>$3,310.89</td>
</tr>
</tbody>
</table>

---

**YTD Net Sales Analysis Report–By Revenue Center, Class, Staff, and Type**

This report prints your net sales by revenue center, class, staff (provider) and type with an option to print detail by invoice item. The report can be sorted by subclass and item ID. You can print the report by providers with each provider’s net sales printed on a separate page.

---

**Printing Monthly Invoices and Statements**

You can print monthly statements and copies of the invoices closed during the monthly period closing. Printing invoices is useful if you want to include newly closed invoices with the clients’ statements.

**IMPORTANT:** Selecting the option to apply a billing charge when printing a statement in the current monthly period will apply a billing charge each time you choose to print. Once you have chosen to print the monthly statements, even if you cancel the print job, any billing charges are still applied.

**Note:** Cornerstone does not automatically print statements for clients with credit balances. See “Printing Statements for Clients with Credit Balances” on page 402 for instructions on printing these statements.

**Before You Begin**

- Set End of Period defaults (see “End of Period Defaults” on page 102).
- Set Statement Print Options defaults (see “Statement Print Options Defaults” on page 132).
- Assign the printer to print the monthly invoices and statements (File > Printer Assignment > End of Month, and make sure Monthly Invoices and Statements is highlighted for the applicable printer).
• Make sure the appropriate clients are set up to receive finance charges and billing charges (Lists > Clients > Update > A/R Information tab).

**Tip:** Cornerstone allows you to change where the practice and client addresses print on the statement, which is helpful if you use window envelopes to mail statements. See “Statement Print Options Defaults” on page 132 for information on positioning the statement addresses.

**To print monthly invoices and/or statements for all applicable clients:**

2. In the Reports list, click the plus sign to the left of End of Month, and then select Monthly Invoices and Statements.
3. Click Create report. The Daily Reports dialog box appears.
4. Under Monthly periods, select the most recent month that was processed, or if you are processing mid-month statements, select Current. Cornerstone will create a statement for all accounts with balances greater than or equal to the billing threshold within this period.
5. Click Print. The Statements and Monthly Invoices dialog box appears.

6. If you plan to print monthly statements, select the Statements check box and specify the type of statement to print:
   - **Normal** prints a standard statement. Paper options include Regular Paper if you plan to print on blank paper, or Preprinted Statement Paper if you purchase special paper for statements (especially designed for open window envelopes).
   - **Detailed** prints the invoice details (provided services, prescribed drugs, etc.) and breaks out taxes by tax type. (Large animal practices may find this especially useful.) Printing options include By Invoice Number or By Invoice Date (prints the invoice details by the date the invoice was saved).

   **Note:** See “Monthly Invoices and Statements” on page 391 to view samples of Normal and Detailed statements.

   **Tip:** To change the placement of the client address or practice address on monthly statements, see “Statement Print Options Defaults” on page 132. To change the placement of the client address or practice address on invoices, see “Invoice Address Defaults” on page 114.
7. If you selected Normal statements, select the **Invoices** check box if you want to print the invoices that were closed by End of Month processing (the **Invoices** check box is available only if you are printing Normal statements).

8. If you selected the **Invoices** check box, specify whether you want to print **Closed** or **Open** invoices.  
   **Note:** Open invoices can be printed only for the current period.

9. **Multi-Location/Single Database configuration only:** In the **Range** area, select the applicable practice from the **Practice** drop-down list.

10. In the **Range** area, specify how you want to sort your statements. You can sort by **Client ID** or **Client Name**. You can also type a range of statements and invoices to print. Enter the range in the **From** and **To** text boxes.

11. In the **Billing information** area, set your practice’s billing preferences:
   a. If you want to add a billing charge for the current period (or when you close End of Month), select the **Apply Billing Charge** check box.
   b. If applicable, enter the applicable **Billing charge** and **Billing threshold**. (The Billing Threshold is the minimum balance an account must have before Cornerstone will print the statement.)
   c. If you want to omit voided invoices when printing monthly statements and invoices, select the **Omit voided invoices and payments on statements** check box. If this option is selected, note that a voided invoice will be omitted only if the original invoice is also part of the current statement. If the original invoice was included in a prior Month-End period that is not selected, the voided invoice will be included in the current statement (regardless of the **Omit voided invoices** setting).

12. Click **OK** to print your statements.

**To print monthly invoices and/or statements for a specific client:**

1. On the **Reports** menu, select **Find a Report**. The Report Search window appears.

2. In the Reports list, click the plus sign to the left of **End of Month**, and then select **Monthly Invoices and Statements**.

3. Click **Create report**. The Daily Reports dialog box appears.

4. Under **Monthly periods**, select the most recent month that was processed, or if you are processing mid-month statements, select the **Current** period.

5. Click **Preview**. The Statements and Monthly Invoices dialog box appears.

6. Follow steps 6–11 in the previous section to set your practice’s preferences for printing monthly statements and invoices.

7. When you have completed all settings on the Statements and Monthly Invoices dialog box, click **OK**. The EOM Invoices and Statements dialog box appears.

8. Select a client from the list and click **OK**. The Reports Preview window displays the statement for the selected client.

9. Click **Print** to print the statement, click **Save** to save the statement data to a file or click **Cancel** to return to the EOM Invoices and Statements dialog box.

**Printing Statements for Clients with Credit Balances**
Cornerstone does not automatically print statements for clients with credit balances. However, you can create a statement for a client with a credit balance using the following instructions.
Before You Begin

- Run your statements as usual, printing statements for clients who have a balance greater than $0. (Enter $0.00 as the Billing Threshold).

**To create statements for clients with credit balances:**

2. In the Reports list, click the plus sign to the left of **End of Month**, and then select **Accounts Receivable Report** (either By Client ID or By Client Name). The Accounts Receivable Report lists clients with credit balances.
3. Click **Create report**. The Daily Reports dialog box appears.
4. Under **Monthly periods**, select the applicable monthly period and click **Print**.
5. On the Accounts Receivable Report, note the client IDs of the clients with credit balances. The client IDs will be needed in order to print statements with credit balances.
6. On the Monthly Reports dialog box, under **Monthly periods**, again ensure that the appropriate monthly closing period is selected.
7. Select **Monthly Invoices and Statements**. Make sure this is the only highlighted report.
8. Click **Print**. The Statements and Monthly Invoices dialog box appears.
9. In the **Range** area, select **Client ID** from the **Sort by** drop-down list.
10. Enter the Client ID in the From and To text boxes.
11. Press the TAB key until the cursor is in the Billing Threshold text box and then type **-999**.
12. Press TAB.
13. Click **OK** to print a statement.
14. Repeat steps 9–13 for each statement you want to print.
Chapter 22: End of Year Processing

Overview

When End of Year (EOY) is processed, the IDEXX Cornerstone* Practice Management System:

- Processes the records for the yearly period.
- Totals the monthly records to create the yearly totals.
- Resets the current yearly period to zero.

It is easy to track EOY periods because the Cornerstone software records the date and time with each closing.

IMPORTANT: It is imperative for your practice to have a good backup procedure in place. Backups provide security against the unlikely chance that files are lost or destroyed. As an added safety precaution, you should remove the most recent backup from the practice or place it in a DATA-Rated fireproof safe.

We recommend performing a database backup before performing End of Year processing. For backup instructions, see the original documentation that came with your backup software.

If you have questions about your backup procedure or how to verify that your backup was successful, contact Cornerstone Support at 1-800-695-2877. Do not take chances with your practice data.

Note: If your practice uses compatible backup software, you can set up Cornerstone to automatically verify your backup using the Cornerstone Backup Verification Assistant. (See "Chapter 28: Using the Backup Verification Assistant" beginning on page 446 for more information.)

Notes on End of Year processing:

- You do not have to process End of Year on December 31. The important thing is to maintain a consistent pattern of closing periods.
- When End of Year is processed, all transactions since the previous End of Year up through the current date are included.
- Before processing End of Year, we suggest that you print the Inventory Cost Report. This report lists current quantity on hand and the current total cost (value) of your inventory. If your practice is not taking a physical inventory at the end of the year, we recommend that you print this report to obtain the value of your ending inventory.

Note: Because the Inventory Cost Report is a snapshot of the data at the time you print the report, you should print it before you start invoicing for the next yearly period. After that point, you will not be able to reprint the report showing the End of Year data (as the current year figures will be calculated with the previous year figures to give you the current cost of your inventory).

- You do not need exclusive use to process End of Year. However, staff will not be able to post invoices or save changes to any window that modifies a client’s account. If a user tries to modify a client’s account, a message warns the user to wait until the End of Year processing is finished. Once the End of Year processing is complete, the user can continue.
Performing End of Year Processes

Before You Begin

- Perform all invoicing for the year and process End of Day and End of Month as usual. Be sure to perform End of Month processing immediately before processing End of Year.
- Perform a yearly backup and store your backup in an off-site location for an extended period of time (for accounting purposes).
- Ensure that EOY defaults have been set up (see “End of Period Defaults” on page 102).
- Verify that the EOY reports are accurate, and fix any discrepancies prior to processing End of Year.

To process End of Year:
1. On the Activities menu, select End of Period > End of Year.
2. An End of Period warning message appears. Read the message and click OK. (To prevent this message from appearing in the future, clear the Show Message check box.)
   The Yearly Period Closing dialog box appears.
3. In the Notes text box, enter any details for this EOY closing and include your name or initials.
4. Click OK.
5. In the confirmation window, click Yes to process End of Year.
6. Depending on the version of Cornerstone installed, a Database Copy window may appear. If it does, click Yes.
7. When EOY processing is complete, click OK in the notification window.
   Note: EOY processing is normally very quick.

Printing End of Year Reports

Cornerstone includes many yearly reports that help you keep records of your valuable information. We recommend that you print all of the Cornerstone yearly reports.

Before You Begin

- Set your End of Period defaults to select the reports you want Cornerstone to automatically select for you in the Yearly Reports dialog box (see “End of Period Defaults” on page 102).
- Assign the printer to print the reports (File > Printer Assignment > End of Month, and select the reports you want to print on each printer).
- Finish your End of Year processing.

To print all selected EOY reports:
1. On the Reports menu, select End of Period > End of Year. The Yearly Reports dialog box appears.
Chapter 22: End of Year Processing

Yearly Reports dialog box

2. Under Yearly periods, select the period you want the reports to reflect. For most reports, you can print information for more than one continuous period; click the earliest period and then press and hold the SHIFT key, click the down arrow until you see the last period and then click the last period. All of the periods in between are highlighted.

   Note: When you select a beginning date range, your End of Period reports include all data in the date range from one minute prior to the beginning date selected through the ending date selected.

3. In the Report list, reports you have selected in End of Period defaults are highlighted. If needed, do the following to select additional reports:
   - To select a consecutive group of reports, click the first report, hold down the SHIFT key, and then click the last report.
   - To select nonconsecutive reports, hold down CTRL, and then click each report you want to select.

4. Click Print. The reports print on the printer assigned for each report (or the default printer if no printer has been assigned).

To preview, print and/or save a specific EOY report:

2. In the Reports list, click the plus sign to the left of End of Year, and then select the desired report.
3. With the desired report highlighted in the End of Year report group, click Create report. The Yearly Reports dialog box appears.
4. Under Yearly periods, select the period you want the report to reflect. For most reports, you can print information for more than one continuous period; click the earliest period and then press and hold the SHIFT key while you click the last period. All of the periods in between are highlighted.

   Note: When you select a beginning date range, your End of Period reports include all data in the date range from one minute prior to the beginning date selected through the ending date selected.
5. Click **Preview**. The Reports Preview window appears.

![Reports Preview window](image)

6. Click **Print** to print the report, click **Save** to save the report data to a file or click **Cancel** to return to the Yearly Reports dialog box.

**End of Year Reports**

**Account Write Off Report - By Client ID or By Client Last Name**

The Account Write Off Report shows all of the clients that have been written off during the yearly period, the amount written off and the reason why (in the note). This report can be sorted by client ID or last name.

![Account Write Off Report](image)

**Client Sales Report - Closed Invoices - By Client ID or By Client Name**

The Client Sales Report shows your best clients during the yearly period, and the sales compared with the previous yearly period’s sales. This report can be sorted by client ID or last name.

Because the Client Sales Report can be a very large report, Cornerstone displays the End of Period Filters dialog box so you can enter a range of information to print. For more information on filtering information in reports, see “Chapter 5: Reports” in the *Cornerstone User’s Manual*.
Chapter 22: End of Year Processing

Finance Charge Report - By Client ID or By Client Last Name

The Finance Charge Report is a quick way to determine how much your practice has generated through finance charges. This report can be sorted by client ID or last name.

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name</th>
<th>Service Sales</th>
<th>Inventory Sales</th>
<th>Sales This Year</th>
<th>Sales Last Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>11289</td>
<td>Ali-Khalil, William</td>
<td>$977.99</td>
<td>$0.00</td>
<td>$977.99</td>
<td>$941.26</td>
</tr>
<tr>
<td>16235</td>
<td>LeVeque, Jole and David</td>
<td>$299.30</td>
<td>$30.64</td>
<td>$329.94</td>
<td>$378.08</td>
</tr>
<tr>
<td>1253</td>
<td>Roy, Pamela</td>
<td>$930.99</td>
<td>$0.00</td>
<td>$930.99</td>
<td>$673.46</td>
</tr>
<tr>
<td>13960</td>
<td>Ludka, Juli</td>
<td>$1,950.90</td>
<td>$0.00</td>
<td>$1,950.90</td>
<td>$687.92</td>
</tr>
<tr>
<td>15209</td>
<td>Bussmann, Vido</td>
<td>$400.01</td>
<td>$174.67</td>
<td>$574.68</td>
<td>$273.16</td>
</tr>
</tbody>
</table>

High/Low Client Sales Report

This report lists the practice’s top clients by total sales, which can be useful for sending direct mailings to your best clients. This report can be sorted by dollar amount, 90-day balance, status or top clients. Because the High/Low Client Sales Report can be a very large report, Cornerstone displays the End of Period Filters dialog box so you can enter a range of information to print. For more information on filtering information in reports, see “Chapter 5: Reports” in the Cornerstone User’s Manual.

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019</td>
<td>Loveceott, Emma</td>
<td>$2,120.66</td>
</tr>
<tr>
<td>20505</td>
<td>Balsi, Halley</td>
<td>$5,050.05</td>
</tr>
<tr>
<td>20693</td>
<td>Kode, Toner &amp; Dentist</td>
<td>$5,179.01</td>
</tr>
<tr>
<td>20199</td>
<td>Danaher, Josh</td>
<td>$5,179.51</td>
</tr>
<tr>
<td>20503</td>
<td>Botka, Beth &amp; Chris</td>
<td>$5,107.60</td>
</tr>
</tbody>
</table>

Inventory Sales Report - Closed Invoices - By Class By Description or By Class By ID

The Inventory Sales Report shows which products are your best sellers. This report can be sorted by class by description or by class by ID.

Because the Inventory Sales Report can be a very large report, the End of Period Filters dialog box appears so you can enter a range of information to print (class ID, invoice item description, invoice item ID, subclass ID or combination). For more information on filtering information in reports, see “Chapter 5: Reports” in the Cornerstone User’s Manual.

Note: This report is also available as an End of Month report.
New Client Report - By Client ID or By Client Last Name

The New Client Report shows you all of the new clients entered into Cornerstone during the selected period(s). This report can be sorted by client ID or last name.

You can save data from this report (using the Save As feature) to create mailing labels to send client satisfaction surveys or other marketing materials.

Note: This report is also available as an End of Day report and End of Month report (without the date information).

---

### New Client Report - By Client ID or By Client Last Name

Sunday, December 31, 2006 05:10 am through Monday, December 31, 2007 06:04 pm

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>H103</td>
<td>Allergro 16 oz.</td>
<td>4.00</td>
<td>$41.26</td>
<td>0.41%</td>
</tr>
<tr>
<td>H104</td>
<td>Allergro 60z</td>
<td>4.00</td>
<td>$84.52</td>
<td>0.84%</td>
</tr>
<tr>
<td>K359</td>
<td>Chlorhexderm Shampoo 0% 12 oz</td>
<td>3.00</td>
<td>$153.06</td>
<td>1.53%</td>
</tr>
<tr>
<td>H840</td>
<td>Epi-Soothe Oatmeal Shampoo 16 oz</td>
<td>4.00</td>
<td>$75.76</td>
<td>0.76%</td>
</tr>
<tr>
<td>H642</td>
<td>Epi-Soothe Rinse Oatmeal 16 oz</td>
<td>2.00</td>
<td>$54.26</td>
<td>0.54%</td>
</tr>
<tr>
<td>K332</td>
<td>Frontline Plus I 2.34 fl. pack</td>
<td>152.21</td>
<td>$3,224.61</td>
<td>32.39%</td>
</tr>
<tr>
<td>K334</td>
<td>Frontline Plus 24.44 lb. (5 pack)</td>
<td>37.58</td>
<td>$843.66</td>
<td>8.43%</td>
</tr>
<tr>
<td>K338</td>
<td>Frontline Plus 45.99 lb. (5 pack)</td>
<td>197.02</td>
<td>$2,769.66</td>
<td>27.69%</td>
</tr>
<tr>
<td>K337</td>
<td>Frontline Plus 55-132 lb. (6 pack)</td>
<td>55.17</td>
<td>$803.46</td>
<td>8.03%</td>
</tr>
<tr>
<td>K335</td>
<td>Frontline Plus Feline (6 pack)</td>
<td>34.51</td>
<td>$763.63</td>
<td>7.63%</td>
</tr>
<tr>
<td>K345</td>
<td>Hartzwater Shampoo 8 oz</td>
<td>1.00</td>
<td>$12.34</td>
<td>0.12%</td>
</tr>
<tr>
<td>K321</td>
<td>Lyntarp 40z</td>
<td>9.00</td>
<td>($32.59)</td>
<td>-0.32%</td>
</tr>
<tr>
<td>H523</td>
<td>Proden Shampoo 15 oz</td>
<td>2.00</td>
<td>$33.78</td>
<td>0.33%</td>
</tr>
<tr>
<td>K317</td>
<td>Proden Shampoo 9 oz</td>
<td>1.00</td>
<td>$11.24</td>
<td>0.11%</td>
</tr>
<tr>
<td>K344</td>
<td>Relief Cream Rinse 6 oz</td>
<td>2.00</td>
<td>$24.66</td>
<td>0.25%</td>
</tr>
<tr>
<td>E204</td>
<td>Relief Shampoo 12 oz</td>
<td>1.00</td>
<td>$15.48</td>
<td>0.15%</td>
</tr>
<tr>
<td>H511</td>
<td>Rosacea Wash 3 pk</td>
<td>8.00</td>
<td>$136.64</td>
<td>1.37%</td>
</tr>
<tr>
<td>K346</td>
<td>Derbodur 16 oz</td>
<td>9.00</td>
<td>$163.26</td>
<td>1.63%</td>
</tr>
<tr>
<td>K316</td>
<td>Derbodur Rxt</td>
<td>6.00</td>
<td>$81.25</td>
<td>0.81%</td>
</tr>
</tbody>
</table>

Subclass Total: $525.59  $10,003.61  100.00%

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
</table>

Grand Total: $525.59  $10,003.61  100.00%

---

### New Client Report

#### Sorted By Client ID

Sunday, December 31, 2006 05:10 am through Monday, December 31, 2007 06:04 pm

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Client Name and Phone No.</th>
<th>Mailing Address</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>20755</td>
<td>Kent, Ren (718) 360-8049</td>
<td>2190 44th Ave N</td>
<td>1/1/2007</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edina, MN 55424</td>
<td></td>
</tr>
<tr>
<td>20766</td>
<td>Lenka, Euk &amp; Partners</td>
<td>5538 Finnell Dr</td>
<td>1/1/2007</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edina, MN 55424</td>
<td></td>
</tr>
</tbody>
</table>

---

New Client Report - By Practice, Client ID or By Practice, Client Last Name

For those practices with the Multi-Location/Single Database option enabled, the New Client Report - By Practice shows all of the new clients entered into Cornerstone by practice during the selected period(s) based on the client home practice. This report can be sorted by client ID or last name.

You can save data from this report (using the Save As feature) to create mailing labels to send client satisfaction surveys or other marketing materials.

Note: This report is also available as an End of Day report and End of Month report (without the date information).
Sales Tax Summary by Revenue Center (Yearly)
The Sales Tax Summary by Revenue Center report shows how much sales tax was collected during the year by revenue centers. The tax description, current tax rate, taxable sales and total tax amounts are shown for each revenue center at your practice.

<table>
<thead>
<tr>
<th>Tax Description</th>
<th>Current Tax Rate</th>
<th>Taxable Sales</th>
<th>Total Tax Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Braking</td>
<td>0</td>
<td>$965.75</td>
<td>$0.00</td>
</tr>
<tr>
<td>Sales Tax</td>
<td>7</td>
<td>$45,966.91</td>
<td>$10,195.44</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>$10,195.44</td>
</tr>
<tr>
<td>Dentistry</td>
<td>0</td>
<td>($4,599.91)</td>
<td>$0.00</td>
</tr>
<tr>
<td>Sales Tax</td>
<td>7</td>
<td>$447.34</td>
<td>$31.31</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>$31.31</td>
</tr>
</tbody>
</table>

Sales Tax Summary/Income Reconciliation - Closed Invoices
The Sales Tax/Income Reconciliation report gives you a quick summary of your income for the selected yearly period(s). Sales are broken out into taxable sales and nontaxable sales.

Note: This report is also available as an End of Month report.

Sales Tax Summary Report
Yearly - Closed Invoices
Sunday, December 31, 2006 05:13 pm through Monday, December 31, 2007 06:04 pm

<table>
<thead>
<tr>
<th>Tax Description</th>
<th>Rate</th>
<th>Taxable Sales</th>
<th>Total Tax Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Taxable</td>
<td>0</td>
<td>$111,669.16</td>
<td>$0.06</td>
</tr>
<tr>
<td>Sales Tax</td>
<td>7</td>
<td>$323,748.28</td>
<td>$22,063.72</td>
</tr>
<tr>
<td>Total Taxable Sales:</td>
<td>$435,357.44</td>
<td></td>
<td>$22,063.72</td>
</tr>
<tr>
<td>Non Taxable Sales:</td>
<td>$240,790.37</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Income:</td>
<td>$676,147.81</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Income Reconciliation
Service Income: $492,924.14
Inventory Income: $192,913.67
$676,147.81

Finance Charges: $2,909.55
Billing Charges: $0.00
Less Discounts: ($15,548.04)
Less Manual Discounts: ($704.47)
Taxes: $22,863.72
Adjustments: ($5,655.45)
Service Charges: $20.00

Net Income: $480,845.10
Service Sales Report - Closed Invoices - By Class By Description or By Class By ID

The Service Sales Report shows the sales revenue from service items. Use this report to see which service items are generating the most sales.

Because the Inventory Sales Report can be a very large report, the End of Period Filters dialog box appears so you can enter a range of information to print (class ID, invoice item description, invoice item ID, subclass ID or combination thereof). For more information on filtering information in reports, see “Chapter 5: Reports” in the Cornerstone User’s Manual.

**Note:** This report is also available as an End of Month report.

<table>
<thead>
<tr>
<th>Item ID and Description</th>
<th>Quantity</th>
<th>Sales Revenue</th>
<th>Percentage of Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISOFLURANE ANESTHESIA</td>
<td>244.00</td>
<td>$12,074.39</td>
<td>76.10%</td>
</tr>
<tr>
<td>INTRACEREBRAL ANESTHESIA</td>
<td>23.24</td>
<td>$569.19</td>
<td>3.74%</td>
</tr>
<tr>
<td>VALEVANESTERINE 500 ML</td>
<td>32.32</td>
<td>$5,330.34</td>
<td>18.90%</td>
</tr>
<tr>
<td>VALEVANESTERINE 250 ML</td>
<td>37.00</td>
<td>$6,075.09</td>
<td>2.22%</td>
</tr>
<tr>
<td><strong>Subclass Total:</strong></td>
<td>447.30</td>
<td>$18,091.03</td>
<td>100.00%</td>
</tr>
<tr>
<td><strong>Grand Total:</strong></td>
<td>447.30</td>
<td>$18,091.03</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

Statistics By Species Report - Closed Invoices

The Statistics By Species Report shows sales activity for each species invoiced during the selected yearly period(s).

**Note:** This report is also available as an End of Day and End of Month report.

<table>
<thead>
<tr>
<th>Species ID: CAN</th>
<th>CANINE</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. Visits</td>
<td>3,844.90</td>
</tr>
<tr>
<td>S. Visits</td>
<td>11,009.86</td>
</tr>
<tr>
<td>Inventory</td>
<td>45,605.86</td>
</tr>
</tbody>
</table>
Statistics By Staff Report - Closed Invoices
The Statistics By Staff Report shows the sales activity for each staff member.

Note: This report is also available as an End of Day and End of Month report.

<table>
<thead>
<tr>
<th>Staff ID:</th>
<th>LB</th>
<th>Laurel Harpke DVM</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Sales</td>
<td>102.59</td>
<td>2.27%</td>
</tr>
<tr>
<td>Labor Sales</td>
<td>426.55</td>
<td>9.34%</td>
</tr>
<tr>
<td>Inventory</td>
<td>1,298.29</td>
<td>2.71%</td>
</tr>
<tr>
<td>Total Sales</td>
<td>$24,194.43</td>
<td>3.58%</td>
</tr>
<tr>
<td>Average</td>
<td>$215.68</td>
<td></td>
</tr>
</tbody>
</table>

Yearly Clients With Open Invoices Report - By Client ID or By Invoice No.
You can print the Yearly Clients With Open Invoices report for the current period to see income you can expect in the next yearly period. This report can be sorted by client ID or invoice number.

Note: This report is also available as an End of Month report.

Yearly Sales Summary Report
The Yearly Sales Summary report displays sales information for each monthly closing period, as well as the total for the yearly period. You can see total sales as well as inventory and service item sales. The report also shows you the sales tax collected in each monthly closing period.

Note: This report is also available as an End of Month report (for each daily closing period).

Yearly Sales Summary - By Practice Report
The Yearly Sales Summary - By Practice report is available for those practices with the Multi-Location/Single Database option enabled. This report is split out by practice and displays sales information for each monthly closing period, as well as the total for the yearly period. You can see total sales as well as inventory and item sales. The report also shows you the sales tax collected in each monthly closing period.
Section 7–Other Management Tools and Tasks

Chapter 23: Setting Up Referral Relationship Management
Chapter 24: Setting Up Hill’s® Feeding Guide Software
Chapter 25: Using General Ledger
Chapter 26: Using the Compliance Assessment Tool*
Chapter 27: Using Cornerstone Performance Tracker
Chapter 28: Using the Backup Verification Assistant
Chapter 29: Purging Data from Cornerstone
Chapter 30: Using the Time Clock
Chapter 31: Setting Up the Mobile Computing Module
Overview

The Referral Relationship Management features in the IDEXX Cornerstone® Practice Management System allow you to track patients referred to your hospital and print reports showing sales received from those referrals. You can also generate a letter to the referring hospital and doctor (RDVM), thanking them for the referral and updating them on the patient’s care.

For information about using the Referral Relationship Management features, see “Chapter 29: Referral Relationship Management” in the Cornerstone User’s Manual or the help within Cornerstone.

Overview of the Referral Process

1. Set up Referral Relationship Management:
   - Add your referring hospitals.
   - Add your referring doctor classifications.
   - Add your referring doctors.
2. Set up the referral letter template.
3. Create a record for the client and patient, and assign a referring doctor and hospital to the patient.
4. After providing the needed care to the patient, use the referral letter template to record medical history. This letter can be retrieved and changed until it is marked as final.
5. Send the letter to the referring hospital and/or doctor using the method you set up in the hospital/doctor record.
6. Save the referral letter in the patient’s history; all referrals for this patient appear in the record as historical data.
7. Print Referral reports.

Setting Up Referring Hospitals

You must set up records in your software for those hospitals with which your practice has a referral relationship.

To add or edit a referring hospital:

1. On the Lists menu, select Referrals > Hospitals.
2. Click New to add a new hospital or double-click an existing hospital to update it. The Referring Hospital Information dialog box appears.
Chapter 23: Setting Up Referral Relationship Management

3. If adding a new hospital, in the **ID** text box, type the ID to be used by your practice to identify this hospital.

4. Type the hospital’s name in the **Name** text box.

5. The **Status** field defaults to Active for a new hospital. Do not change the status to Inactive unless you have ended your referral relationship with this hospital.

6. Click the **Information** tab.

7. Enter the **Name**, **Address**, **Postal Code**, **City** and **State/prov** information.

8. Enter the **Fax #** and **E-mail address** of the hospital.

9. Select the check boxes for each of the hospital’s communication preferences. Add or update information as necessary. To update or add a phone number, double-click a line in the **Phone** area. Click **Primary** to indicate the primary phone number.

10. Click the **Notes** tab and enter any notes about this hospital.

11. Click **OK** and then click **Close**.

To view a list of all referral hospitals set up in Cornerstone*, print the **Referral Hospital Master Report**.

To view a list of referring hospitals, the number of referrals, rechecks and sales each referring hospital generated, print the End of Month **Referral Summary - by Hospital Report**.
Setting Up Doctor Classifications
The classification field is defined by the user, allowing you to choose the best way to use this field for your practice. One possible use for this field is to enter the referring doctor’s specialty, for example, exotics or small animal.

To add or edit a doctor classification:
1. On the Lists menu, select Referrals > Classifications. The Doctor Classifications dialog box appears.
2. Click New to add a new classification or double-click an existing classification to update it. The Classification Setup for Doctor dialog box appears.
3. Enter the Description of the classification.
4. Click OK and then click Close.

Setting Up Referring Doctors
You must set up a record in your system for each referral doctor your practice works with. A doctor must be associated with a hospital. If you have a provider that is not associated with a hospital, you can set up a hospital in Cornerstone called "no affiliation." Doctors can also be associated with more than one hospital.

To add or edit a referring doctor:
1. On the Lists menu, select Referrals > Doctors. The Doctor List dialog box appears.
2. Click New to add a new doctor or double-click an existing doctor to update the information. The Doctor Referral Information dialog box appears.
3. If adding a new referring doctor, in the ID text box, type the ID to be used by your practice to identify this doctor.
4. Enter the doctor’s information in the Title and name fields.
5. The **Status** field defaults to Active for a new doctor. Do not change the status to Inactive unless you are not receiving referrals from this doctor.

6. Select the doctor’s classification from the **Classification** drop-down list.

7. If the doctor is associated with one of the referring hospitals you have set up in your system, on the **Hospitals** tab, enter that hospital’s ID number or press F2 to use the Hospital List to choose a hospital.
   
   **Note:** If there is not an address on the doctor’s record, Cornerstone will use the address on the associated hospital’s record. A doctor **must** be associated with a hospital.

8. Select the check boxes for each of the doctor’s communication preferences at this hospital. You can update the email, fax, and phone number. To update or add a phone number, double-click a line in the **Phone** area. Click **Primary** to indicate the primary phone number.

9. Click the **Personal Information** tab.

10. Under **Display the following information on the Patient Clipboard**, select **Personal preferences**, **Hospital related preferences**, or both.

11. Select the check boxes for each of the doctor’s personal communication preferences. You can update the email, fax, and phone number. To update or add a phone number, double-click a line in the **Phone** area. Click **Primary** to indicate the primary phone number.

12. Click the **Notes** tab and enter any notes about this doctor.

13. Click **OK** and then click **Close**.

   - To view a list of all referral doctors set up in Cornerstone, print the **Referral Doctor Master Report**.

   - To view a list of referring doctors, the number of referrals, rechecks and sales each referring doctor generated, print the End of Month **Referral Summary–by Doctor Report**.

**To delete a referring doctor:**

1. On the **Lists** menu, select **Referrals > Doctors**. The Doctor List dialog box appears.

2. Select the doctor to remove and click **Delete**.

3. On the confirmation message, click **OK**.

**Creating a Referral Letter Template**

Referral letters establish good communication with your referral providers. By using bookmarks to create your letter in the Cornerstone Editor, you can set up fields on the letter to automatically populate with the correct information from your Cornerstone database, as shown in the following sample referral letter template.
When setting up the properties for a referral letter, set the type to **Correspondence** so that a record of the document is saved in the patient’s history. Once the Correspondence type is selected, you must then specify how the document will be saved:

- **Title Only** saves only the title in patient history. Use this option when no patient findings, results, or other information is included in the letter. In this case, it is preferable to save just the title to record that you sent a referral letter. Saving as Title Only can help to conserve hard drive space on your system.

- **Document** saves the entire document in patient history. Use this option when patient findings, results, or other information is included in the letter. In this case, it is preferable to save the entire document so it can be referred to later if needed.

See “Chapter 17: Setting Up Medical Notes and Correspondence” on page 312 for information on creating document templates in the Cornerstone Editor.
Chapter 23: Setting Up Referral Relationship Management

Tracking Referral Sales
You can track the monthly sales history for a referral doctor or hospital. To do this:

1. On the Lists menu, select Referrals, and then select Doctors or Hospitals, depending on the type of data you want.
2. Click Update, and then click the Sales tab. The monthly sales history will display.

Referral Reports
In the Report Search window (Reports > Find a Report), a variety of referral reports are available in the Reports list under the Referral group and under the End of Month > Referral Reports group.

Referral reports:
- The Referral Doctor Master Report prints a list of all the referral doctors (by Doctor ID) you have set up in Cornerstone
- The Referral Hospital Master Report prints a list of all the referral hospitals (by Hospital ID) you have set up

End of Month > Referral reports:
- Referral Report–by Staff
- Referral Report–Doctor by Hospital
- Referral Report–Hospital by Doctor
- Referral Revenue Report–By Hospital
- Referral Revenue Report–By Doctor
- Referral Summary–by Doctor
- Referral Summary–by Hospital
- Referral Summary–Doctor by Hospital
- Referral Summary–Hospital by Doctor

See “End of Month Reports” on page 385 for more information.
This chapter covers the steps required to set up the Hill’s® Feeding Guide software in the IDEXX Cornerstone® Practice Management System. For information on daily usage tasks in the Hill’s Feeding Guide software, see “Chapter 26: Using Hill’s Feeding Guide Software” in the Cornerstone User’s Manual.

The Hill’s Feeding Guide Software is a tool designed to help you recommend the appropriate Hill’s pet food for each patient’s specific health condition.

**Setting Up the Feeding Guide Software**

**Before You Begin**

1. Enter Hill’s pet foods products as inventory invoice items.
2. Link the special action Feeding Guide Software to each invoice item. See “Setting Up Invoice Items to Initiate a Special Action” on page 202.

**To set up the Hill’s Feeding Guide Software:**


![Hill's Retail Prices window](image)

2. Click Species. The Link Species dialog box appears.
3. Type the ID you use for each species and click OK.
4. Using the drop-down list at the top of the Hill’s Retail Prices dialog box, select the type of Hill’s products to display.
5. In the price table Clinic ID column, type the invoice item ID you use for each product. (You can also press F2 to use the Invoice Item List to choose an item.) Repeat this process for each of the Hill’s dietary products your practice carries.
6. Click OK.
Learning about Hill’s Feeding Guide Software
2. Click About. The About Hill’s Feeding Guide dialog box appears with the text scrolling automatically.

![About Hill's Feeding Guide dialog box](image)

3. Click Pause to stop the text movement. Click Resume to continue scrolling the text. The Close button appears when the text is finished scrolling.

Viewing Storage and Handling Instructions for Hill’s Pet Food Products
2. To view Proper Storage and Handling Procedures, click Storage.
3. Click Close when you have finished viewing the information.
4. Click Close to close the Shelf Life Information dialog box.
Chapter 25: Using General Ledger

Overview
The General Ledger (GL) Interface allows you to transfer daily or monthly financial information from your IDEXX Cornerstone* Practice Management System to a file. This file can be imported into QuickBooks® or MYOB®, two commercial accounting software packages.

Information that can be imported from Cornerstone into QuickBooks or MYOB includes the following:
- Sales by class
- Tax
- Payments received
- Credit card service charges for the different credit cards accepted by your practice
- Changes to the accounts receivable account
- Discounts
- Refunds
- Adjustments
- Write-offs and reinstatements
- Billing, finance and service charges
- Returned checks
- Change given

Note: If you are using QuickBooks, you must have QuickBooks 2000 (or a later release) to use the General Ledger Interface.

Extract Data Using the General Ledger Interface
The General Ledger Interface allows you to extract data that can be imported into one of the commercial accounting packages. Data can be extracted automatically or manually. We recommend that you set up your system to automatically extract data at End of Day or End of Month for consistency.

To set up your software to automatically extract data:
1. On the Controls menu, select General Ledger > Setup. The GL Interface Setup window appears.
Chapter 25: Using General Ledger

2. Select a **Period** option to specify how frequently you want to automatically extract data (on a daily or monthly basis). If you don’t want to automatically extract data, select **None**.

3. Select the commercial accounting package from the **Extract to** drop-down list.

4. The **Work account** and **Error account** fields are used by QuickBooks to balance transactions. Do not change the default entries in these fields.

5. In the **A/R customer** field, assign a customer name (required by QuickBooks) to your accounts receivable. In the **A/P customer** field, assign a customer name (required by QuickBooks) to your accounts payable.

6. The **Directory** field contains the path where the extracted file will be saved. This may be changed if desired.

7. The **Memo** field contains a description that displays in the commercial accounting software, for example, “From Cornerstone,” which allows the user to know the origin of the data.

8. In the **Accounts** area, select the data to extract.

   **Note:** Cornerstone allows you to choose how detailed you want the data extraction to be. For example, you can extract all payment information added together in one sum or you can break down the information by payment type.

   - Under the Sales category, to extract all sales information as one amount, select **Yes** from the **One Entry** drop-down list. To break out your sales by class, select **No**. If you select **Yes**, the menu will condense.

   - The **Account Name** column (displays for an extraction to QuickBooks) allows you to give your data a meaningful name or number that will also be used in QuickBooks. The **Account Number** column (displays for an extraction to MYOB) allows you to give your data a meaningful number that will also be used in MYOB. You can enter this name on the setup windows also.
example, when you are setting up your tax information and you want to break out the information by tax type on your GL Batch Report, you will want to enter an account name.

**Note:** The GL Batch Report is sorted alphabetically. If you choose to separate lines in GL Setup, you may not have like information sorted together. For example, if you have the account names “city tax” and “sales tax,” city tax will print near the top of the report, and sales tax will print near the bottom of the report. If you want all your tax information grouped together on the GL Batch Report, we recommend an account name like “Taxes–City Tax” and “Taxes–State Tax.” This method allows you to have all your tax information in the same section of the report.

**Note:** Using colons between your account names allows you to set up subaccounts in QuickBooks. For example, using the account names “Taxes:City Tax” and “Taxes:State Tax” will cause State Tax and City Tax to be subaccounts of Taxes when you import your file into QuickBooks.

9. Click **OK** to save your changes.

**To manually extract data:**

You can also manually extract data for prior time periods.


2. Select whether you want to extract data from **End of Day** or **End of Month**.

3. Select the **Generate report** check box if you want to print a summary of the information saved in the extract file. (This is the GL Batch Report.)

4. If necessary, click the **File** button and modify the file name.

5. Click **OK** to generate the extract file (and print the report, if the **Generate report** option is selected).

6. Click **Close** to exit.

**To enter an account name from the setup windows:**

You can enter GL account information when you set up taxes, discounts, invoice item classifications and payment types.

1. On the **Controls** menu or **Lists** menu, select the desired control/list to set up in Cornerstone (for example, **Taxes**).

2. Highlight the control/list setting to modify and click **Update**.

3. Enter the account name in the **GL Account** field.

4. Click **OK** when finished.
GL Batch Report

The GL Batch Report provides a summary of the data extracted to the file. If your practice is set up to automatically extract data, you can set up your system to automatically generate this report.

See “GL Batch Report” on page 375 (End of Day) and on page 388 (End of Month) for an example of the report.

To set up your system to automatically print the GL Batch Report:
1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click End Of Period. The End Of Period configuration pane appears on the right side of the window.
3. Depending on whether you are extracting data daily or monthly, select the GL Batch Report from the Daily reports or Monthly reports box.
4. Click OK.

To print the report manually:
2. In the Reports list, click the plus sign to the left of End of Day or End of Month, depending on if you are extracting data daily or monthly.
4. Select the applicable daily or monthly periods.
5. Click Print or Preview.
Using the Batch File in QuickBooks

Note: Depending on the version of QuickBooks you are using, the steps provided below may vary slightly from your version. Refer to your QuickBooks documentation for instructions specific to your version.

To use the batch file in QuickBooks:
1. Select File from the menu bar.
2. Select Import.
3. Specify the path and file name for the batch file (e.g., C:\Cstone\glfiles).
4. Click OK when finished.

To set up a payment type to calculate charges:
1. On the Controls menu, select Payment Types.
2. Highlight the payment type to modify and click Update.
3. If you want to calculate a percentage, click the Percentage option and enter the percentage amount in the Amount field. If you want to calculate a flat amount, click the Amount option and enter the total in the Amount field. If you don’t want to calculate a service charge on this payment, click the None option.
4. Click OK when finished.

Note: This information is only available through the GL Batch Report. It does not appear on any other Cornerstone reports.
Chapter 26: Using the Compliance Assessment Tool*

Overview
The Compliance Assessment Tool* allows practices to identify missed opportunities for revenue. You can use the Compliance Assessment Tool to search for patients who visited the practice during a specified date range and check to see if they received recommended services based on species, age, weight or diagnosis.

Using Check-In Dates vs. Invoice Dates
The Compliance Assessment Tool will use either the check-in dates or invoice dates to determine when the patient was last seen in the practice.

- If your practice uses Check-in (Controls > Defaults > Practice and Workstation > Check-in > Use Check-in Date for Compliance check box selected), this is the preferred method for tracking compliance. This method of tracking compliance based on when patients were checked into the practice through the IDEXX Cornerstone* Practice Management System covers all patient visits, regardless of whether an invoice was generated during the visit.

- If your practice does NOT use Check-in, you can track compliance based on invoice dates. Note, however, that all patients who visit the practice in a specified date range are counted for compliance purposes. For example, if a client receives services in the practice but is not invoiced (e.g., suture removal), or if a client visits the practice but is not seen for an appointment (e.g., the owner stopped by to purchase pet food). These types of situations will adversely affect compliance results.

Compliance Comparison Types
The Compliance Assessment Tool allows you to run two types of compliance comparisons: a regular compliance search or an alternative compliance search.

Regular compliance search: Search for patients to see if they received recommended services based on species, age, weight or diagnosis. For example, you may want to search for all senior patients seen in the last six months to see which recommended services from your senior care protocol were not provided.

Alternative compliance search: Search for missing services based on other services provided. For example, you may want to search for all patients who received heartworm preventatives to see if they also received a heartworm test.
Chapter 26: Using the Compliance Assessment Tool*

Setting Up Protocols

Cornerstone provides predefined protocols (based on the chart shown below) set up by species, age and weight. A list of these predefined protocols can be viewed by selecting the **Display predefined IDEXX protocols** check box in the Protocol Setup Wizard and on the Compliance Results window.

Using the predefined protocols can save your practice time; however, note that you must assign your practice’s invoice items to the tests in the predefined protocols in order to receive valid results.

<table>
<thead>
<tr>
<th>age</th>
<th>0-20</th>
<th>20-50</th>
<th>50-90</th>
<th>&gt;90</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td>7</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>18</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>24</td>
<td>26</td>
</tr>
<tr>
<td>4</td>
<td>24</td>
<td>27</td>
<td>28</td>
<td>34</td>
</tr>
<tr>
<td>5</td>
<td>26</td>
<td>28</td>
<td>29</td>
<td>33</td>
</tr>
<tr>
<td>6</td>
<td>33</td>
<td>34</td>
<td>36</td>
<td>41</td>
</tr>
<tr>
<td>7</td>
<td>40</td>
<td>42</td>
<td>45</td>
<td>49</td>
</tr>
<tr>
<td>8</td>
<td>44</td>
<td>47</td>
<td>50</td>
<td>56</td>
</tr>
<tr>
<td>9</td>
<td>45</td>
<td>51</td>
<td>55</td>
<td>64</td>
</tr>
<tr>
<td>10</td>
<td>52</td>
<td>56</td>
<td>61</td>
<td>71</td>
</tr>
<tr>
<td>11</td>
<td>56</td>
<td>59</td>
<td>65</td>
<td>78</td>
</tr>
<tr>
<td>12</td>
<td>60</td>
<td>55</td>
<td>66</td>
<td>76</td>
</tr>
<tr>
<td>13</td>
<td>64</td>
<td>68</td>
<td>78</td>
<td>86</td>
</tr>
<tr>
<td>14</td>
<td>68</td>
<td>72</td>
<td>88</td>
<td>108</td>
</tr>
<tr>
<td>15</td>
<td>76</td>
<td>83</td>
<td>93</td>
<td>115</td>
</tr>
<tr>
<td>16</td>
<td>80</td>
<td>89</td>
<td>101</td>
<td>126</td>
</tr>
<tr>
<td>17</td>
<td>86</td>
<td>92</td>
<td>104</td>
<td>131</td>
</tr>
<tr>
<td>18</td>
<td>92</td>
<td>99</td>
<td>109</td>
<td>199</td>
</tr>
<tr>
<td>19</td>
<td>98</td>
<td>93</td>
<td>115</td>
<td>120</td>
</tr>
<tr>
<td>20</td>
<td>98</td>
<td>105</td>
<td>120</td>
<td>129</td>
</tr>
<tr>
<td>21</td>
<td>104</td>
<td>109</td>
<td>125</td>
<td>136</td>
</tr>
<tr>
<td>22</td>
<td>104</td>
<td>113</td>
<td>130</td>
<td>140</td>
</tr>
<tr>
<td>23</td>
<td>108</td>
<td>117</td>
<td>130</td>
<td>140</td>
</tr>
<tr>
<td>24</td>
<td>112</td>
<td>116</td>
<td>130</td>
<td>140</td>
</tr>
<tr>
<td>25</td>
<td>116</td>
<td>120</td>
<td>130</td>
<td>140</td>
</tr>
</tbody>
</table>

COLOR KEY

- **Green**: adult
- **Yellow**: senior
- **Red**: geriatric

Chart on which predefined protocols are based

Before You Begin

- If you want only to count compliance for patients that you check in using Cornerstone’s check-in feature, you must select the **Use check-in date for compliance** check box in Check-in defaults. (See “Check-in Defaults” on page 94.)

If this check box is not checked, all patients who visit the practice in a specified date range are counted for compliance purposes, even if they were not in the practice for an appointment (e.g., the owner stopped by to purchase pet food).

- If you want to set up your system to display an alert when a patient who needs a recommended service is seen, you must set up the alert in Compliance Alerts defaults. (See “Compliance Alerts Defaults” on page 87.)

To set up a compliance search protocol:

1. On the **Reports** menu, select **Compliance Assessment Tool > Protocol Setup Wizard**. The **Protocol selection/entry** window appears.
2. Click the **Display predefined IDEXX protocols** check box if you want to view the protocols set up by IDEXX. (If the single protocol is part of a protocol group, the group will display on the right.)

3. Do one of the following:
   - To customize a predefined IDEXX protocol or modify an existing protocol, in the **Protocols** list, select the protocol you want to modify and click **Next**.
   - To add a new protocol, enter a name for the protocol in the **New protocol** box and click **Add**. With the new protocol name selected in the **Protocols** list, click **Next**.

4. On the **Select species** window, select the species to assign to the protocol and click **Next**. **<All>** is selected by default.

5. On the **Select breeds** window, select the breed(s) to assign to the protocol and click **Next**. **<All>** is selected by default. (If breeds do not apply, click **Next** to continue to the next step.)

6. On the **Select age range** window, enter the ages that apply to this protocol. (If age does not apply, click **Next** to continue to the next step.) All ages are selected by default. To enter a specific range, enter the Age range in months or years and click the **Add age range** button. To apply this range to all selected species/breeds, select the **Apply to all species/breeds** check box. Click **Next** to continue.
7. On the Select weight range window, enter the weight ranges that apply to this protocol. (If a weight does not apply, click Next to continue to the next step.) All weights are selected by default. To enter a specific range, enter the Weight range, select the unit of measure (pounds, ounces, kilograms or grams) and click the Add weight range button. To apply a diagnosis to all species/breeds, click the Apply to all species/breeds check box. Click Next to continue.

8. On the Select diagnosis codes window, select the diagnoses that apply to this protocol and click the Add diagnosis button. (If a diagnosis does not apply, click Next to continue to the next step.) To apply a diagnosis to all species/breeds, click the Apply to all species/breeds check box. Click Next to continue.

9. The Select Services pop-up window appears. Select the type of compliance comparison (regular or alternative) that you want to set up, and click OK.
10. Do one of the following:
   - If you chose the regular compliance search, go to the “To complete the setup for a regular compliance search” section that follows.
   - If you chose the alternative search, go to the “To complete the setup for an alternative search” section on page 433.

**To complete the setup for a regular compliance search:**

1. Complete the steps in the “Setting Up Protocols” section.
2. On the Select services window, select the tests that apply to this protocol.
3. Click the **Add/update tests and services** button to add your invoice items to the test. (If the test you need is not in the list, you can also add a new test by clicking the **Add/update tests** button.) The wizard will display a smaller built-in wizard with two steps (See example below.)

   **Note:** To check patient compliance, Cornerstone searches your patient records for specified invoice items. You must assign invoice items to tests. If you have already added invoice items to the tests, click **Next** and skip to step 8.

   ![Example of selecting tests](image)

   Step one of the two-step process of adding invoice items to tests

4. Select the test to which you want to assign invoice items and click **Next**. The **Item setup** window appears.
Chapter 26: Using the Compliance Assessment Tool*

Step two of the two-step process of adding invoice items to tests

5. Select the invoice items used at your practice that correspond to this test. Any of these invoice items will be considered as compliant for this test. Enter all or part of the description in the **Search for descriptions containing** field. If you know your practice’s invoice item ID, press F2 in this field to select by ID. Your search results display. Click to select the items to assign to this test. To select more than one invoice item, press the CTRL key as you click the items to be selected.

6. The default number of months to search history is six. If you want to change the number of months to search history, in the **Hx Search** column, click the existing number of months and type the new number of months to search history. The Compliance Assessment Tool checks a patient’s history to determine if invoice items in the selected protocol are found in the patient’s history during the specified number of months prior to the specified date range.

7. Before you can see a potential dollar value for missed revenue, you must select a default invoice item for a test. The price of this default invoice item will be used to calculate the potential dollar amount. To select a default item, select the **Default item** check box next to the item. Only one default item can be selected per test.

8. Click **Finish** when you are done adding invoice items to the test. The Protocol Setup Wizard displays again. If needed, select additional tests to add to the protocol. Click **Next** when all tests are added.

9. The Protocol Summary appears. Review the details of the protocol and choose one of the following options:
   - To make changes, click the **Back** button to return to the previous window.
   - To set up another protocol, click **Protocol selection/entry** at the top of the navigation pane on the left side of the wizard.
   - If you are done setting up protocols, click **Finish** to save your changes.

10. After you click **Finish** on the Protocol Setup Wizard, Cornerstone asks if you want to generate compliance results. Click **Yes** to go to the Compliance Results window or click **No** to exit.
To complete the setup for an alternative search:
For this alternate type of compliance check, Cornerstone searches your patient records for missing services based on other services that were provided. So that Cornerstone can determine if a patient has complied with a service or is missing it, you must assign invoice items to the service.

1. Complete the steps in the “Setting Up Protocols” section.
2. On the Select services pop-up window (see step 9 in “To set up a compliance search protocol”), click the second check box for alternative searches and click OK.
3. Click the Maintain services/dependents button. An Alternative Search Wizard appears.

The first step of the five-step process of selecting services for the search

4. On the Service selection/entry window, do one of the following:
   - In the Services column, select the primary service to search for and click Next to go to the service setup step.
   - If the service you want is not shown in the services column, in the New service text box, enter a new service, click the Add button and click Next to go to the service setup step.

   **Note:** When entering a new service, enter any name you want for the service, preferably short and descriptive. It does not have to match the name of an invoice item in Cornerstone.
5. On the Service setup window, choose one of the following options:
   - If invoice items have been previously assigned to the service, review the items, change them if necessary, and click Next to move to the next step.
   - If this is a new service, select the invoice items in Cornerstone that corresponds to this service. Enter all or part of the description in the Search for descriptions containing field. If you know your practice’s invoice item ID, press F2 in this field to select by ID. Your search results display. Click to select the items to assign to this service. To select more than one invoice item, press the CTRL key as you click the items. Click Next to move to the next step.

6. On the Dependent selection/entry window, select the dependent service that the Compliance Assessment Tool will search for if the primary service is found on the patient record. If the service is not shown, enter the service and click the Add button. Click Next to move to the next step.

7. Select the invoice items that correspond to the dependent (second) service. Before you can see a potential dollar value for missed revenue, you must select a default invoice item for the service. The price of this default invoice item will be used to calculate the potential dollar amount. To select a default item, click the Default item check box next to the item. Only one default item can be selected. Click Next to move to the next step.

8. On the Assign dependents window, select the primary service to which you want to assign a dependent and then click to highlight the dependent to be assigned to the service.
9. Choose whether you want to search for the dependent service prior to or after the date you will select when you run compliance results.

10. If you want to change the number of months to search history, click the **Number of months** box and enter the number of months you want to use. The Compliance Assessment Tool checks a patient’s history to determine if invoice items in a selected protocol are found in the patient’s history during the specified number of months prior to or after the specified date range, depending on your selection. The default number of months is six.

11. Click **Finish** to close the mini-wizard and return to the Protocol Setup Wizard.

12. The Protocol Setup Wizard returns to the **Select services** window. Select the primary service for which you want to run an alternative search. Click **Next**.

13. The Protocol Summary appears. Review the details of the protocol and choose one of the following options:
   - To make changes, click the **Back** button to return to the previous window.
   - To set up another protocol, click **Protocol selection/entry** at the top of the navigation pane on the left side of the wizard.
   - If you are done setting up protocols, click **Finish** to save your changes.

14. After you click **Finish** on the Protocol Setup Wizard, Cornerstone asks if you want to generate compliance results. Click **Yes** to go to the Compliance Results window or click **No** to exit.

**Placing Protocols into Groups**

You can place related protocols into groups. Compliance results can be compiled by group or by individual protocol.

Why group protocols? Individual protocols can have only one weight and/or age range specified per species. If you want to develop a broader protocol (for example, a protocol for canine senior care), individual protocols based on weight and age can be placed in a group protocol.
All protocols in a group must have the same tests; however, the age and/or weight among the protocols are different. After the initial protocol is added to a group, only protocols with the same tests can be added.

**To put protocols into groups:**

1. On the **Reports** menu, select **Compliance Assessment Tool > Protocol Group Setup**. The **Group selection/entry window** appears.

2. Select the protocol group to which you want to add or remove protocols. If you want to create a new group, enter the name of the new group and click the **Add** button. The **Group setup window** appears. Click **Next**.

3. Select the protocols to add to the group. To clear the protocols from the group, click the **Reset** button.

4. Click **Finish** when you are done adding protocols to the group.
Extracting Compliance Results

After the setup process is complete, you can use the Compliance Assessment Tool to generate compliance results.

To generate compliance results:

1. On the Reports menu, select Compliance Assessment Tool > Generate Compliance Results. The Generate compliance results window appears.

![Compliance Assessment Tool - Generate compliance results](image)

2. On the navigation pane, click Compliance results to perform a regular compliance check or click Alternative Search to perform an alternative compliance check.

3. In the Protocol/Group list, select the protocol(s) to be included in the compliance check. If your practice has set up protocol groups, click on the group name to select all protocols in the group.

4. Enter the Date range for which you want to find compliance results.

5. In the Patient classification list, select the classes (referral only, family pet, etc.) that you want to include in the compliance assessment. Selected classes are highlighted/shaded. Initially, all classes are selected. Click the classes you do not want to include to deselect them.

6. In the Invoice item classification drop-down list, select a specific invoice item classification to narrow the search.

7. Under Display in, select one of the following:
   - Select Dollars to display results showing the potential dollar values for missed revenue, calculated based on the price of the invoice items. Results include Compliant patient percentages, Services billed and Missed Opportunity in terms of dollars.
   - Select Services to display results showing which services have been missed. Results include Percent of missed opportunity, Total services provided, and Total Services missed.

8. Click the Search button. The results display.

Note: Depending on the type of search that you are performing, it may take several minutes for the search to finish. Do not attempt to close the window or cancel the search during this time.
Compliance Reports

After compliance results are generated, a number of reports and graphs can be viewed or printed from the Compliance Assessment Tool.

- **Missing services**: This report lists eligible patients, patients’ owners, addresses and selected tests from which the patient did not receive at least one invoice item.

- **Services provided**: This report shows clients with patients who received invoice items from one or more of the selected protocol’s tests and lists the invoice items each patient received.

- **Future appointments**: This report lists pets who are scheduled for future appointments and are eligible for services in the selected protocol. It includes the pet owner’s name and address. The report prints the appointments for staff members in date order.

- **Dollars Sold by Staff**: This report shows the dollar value of the selected protocol’s services that were provided to eligible patients. The report prints in staff member order. To list the dollar value for an individual staff classification, under Classification, click the classification (doctor, groomer, receptionist, etc.) and click the Retrieve button.

- **Dollar Sold by Staff (graph)**: View the dollar value of the selected protocol’s services that were provided to eligible patients as a graph.

- **Services Sold by Staff**: This report shows services sold to eligible patients by staff members.

- **Service Sold by Staff (graph)**: View the services sold by staff member as a graph.

- **Missing Dependents (Alternative Search)**: This report lists eligible patients who received the primary service, but did not receive the dependent service. This report also list the dollar value of missing tests by doctor.

**Tip**: Print the Client List (Missing Services) Report and the Client List (Services Provided) Report for a complete comparison.

**To print or save the reports or graphs**:

1. In the navigation pane, under Details, click the type of compliance results detail (Missing services, Services provided, Missing dependents, etc.) to view in a report. Use the Next and Back buttons to go back and forth, selecting and viewing the applicable reports.

2. With the results report displayed in the pane on the right, click Print to print the report or Save to save the report data to a file.

Understanding Compliance Results

The type of compliance results that are generated by the Compliance Assessment Tool depends on the type of search (regular or alternative) that is performed.

**Regular Compliance Results Search–Dollars Display Option**

- **Total number of eligible patients**: Eligible patients are patients who satisfy the species, age, and weight requirements of the chosen species/age group and who have been invoiced for services during the chosen date range.

- **Eligible patients who received all services (Compliant)**: The number of eligible patients who were invoiced for at least one item in each of the protocol’s selected tests during the specified date range or in the patient’s history (if using the Hx-search feature). At least one of these items must be invoiced during the specified date range. The rest can be in the date range or in the patient’s history.
Eligible patients who received some services (partially compliant)
The number of eligible patients who were invoiced for items in at least one, but not all, of the protocol's selected tests during the specified date range or in the patient's history (if using the Hx search feature).

Eligible patients who received no services (non-compliant)
The number of eligible patients who were invoiced, but were not invoiced for any invoice items in the protocol's selected tests during the specified date range or in the patient history.

Total services billed
The total services billed amount only includes charges for items in the selected tests that were invoiced during the specified date range. Charges for other service and inventory items not in the selected tests that were invoiced during the date range are not included. In addition, because items in history are outside the specified date range, charges for history items are not included.

Missed opportunity
If no invoice item in a selected test is found in an eligible patient’s record during the specified date range or in history (if using the Hx search feature), the price of the selected test’s default item is added to the Missed Opportunity column.

Total opportunity
This is the sum of all missed opportunities.

Regular Compliance Results Search–Services Display Option

Percent of missed opportunity
Calculates the percentage of missed opportunities using the Total services provided and the Total services missed values.

Total services provided
Shows the number of times each service was provided.

Total services missed
Shows the number of times the service could have been provided but was missed.

Alternative Search

Eligible patients who received the service (primary)
This is the number of patients who received the primary service during the specified date range.

Eligible patients who received the dependent
This is the number of patients who received the primary service and the dependent service during the specified date range.

Note: If the eligible patient received the dependent service, but did not receive the primary service, they are not counted.

Eligible patients who received the service (primary) but not the dependent
This is the number of patients who received the primary service, but not the dependent service during the specified date range.
Missed opportunity
If no invoice item in the selected dependent service is found in an eligible patient’s record during the specified date range, the price of the dependent service’s default item is added to the Missed Opportunities column.

Total opportunity
This is the sum of all missed opportunities.

Tip: You can set up your system to display an alert when a patient who needs a recommended service is seen. When the alert displays, you can process the alert to see which services or tests are missing from the patient record. To specify the desired alert types to display, select them in Compliance Alerts defaults. For more information, see “Compliance Alerts Defaults” on page 87.
Overview

The performance tracker feature in the IDEXX Cornerstone* Practice Management System allows you to compare month-to-month data within your practice. For example, compare your practice’s revenue from the second quarter of 2010 with the revenue from the second quarter of 2011. Cornerstone performance tracker displays your data in dynamic graphs and includes interactive features.

Tip: You can view samples of Cornerstone performance tracker reports on the Report Search window (Reports > Find a Report) by clicking on a report in the Performance Tracker report group. The report details and a sample display in the right-side pane.

Tracking Performance

Before You Begin

- Set up the Cornerstone Performance Tracker defaults. See “Performance Tracker Defaults” on page 123.

To use Cornerstone performance tracker:

1. On the Reports menu, select Performance Tracker.

2. Select which time periods you want to compare from the Tracking Period box and the Comparison Period box. To select a quarter, press the CTRL key and click each month in the three-month period. Click Retrieve. The retrieved information displays.

3. Click the Summary tab to see the financial information compared between your selected time periods.
   - To display graphs comparing your accounts receivable information, gross sales or preset discounts, right-click within the results display area and select the applicable option.
   - To print a report showing the information on the Summary tab, right-click within the data display area and select Print Summary Tab.
4. Click the **Doctor** tab to see the amount of gross sales for each doctor compared between your selected time periods.

- To display graphs comparing gross sales by doctor, showing a doctor’s monthly sales, or showing the top 15 services or inventory items for a doctor, select a doctor’s name to highlight it and then right-click within the results display area and select the applicable option.

- To print a report showing the information on the **Doctor** tab, select a doctor’s name to highlight it and then right-click within the results display area and select **Print Doctor Tab**.
5. Click the **Reminders** tab to see your clients’ reminders compliance rate, based on what you selected on the Cornerstone performance tracker Default Reminder tab. This information is always current, even if a different time period is selected.

- To see a detailed report of missing reminders, right-click in the **Seen yet missing reminder opportunities** box or the **Total missing reminder opportunities** box and select **Patient report for species**.

- To generate a file that can be merged with a reminder card or letter, right-click on a reminder and select **Generate reminder file for selected items** or **Generate reminder file for patients without all selected items**.

- To generate a report of patients without all selected items, a patient report for all items, or a patient report for all selected items, right-click on a reminder and select the applicable option.

- To see patients over one year old who have never received services, click the **Retrieve** button next to this option in the bottom right corner of the **Reminders** tab. Because the software must sort through your entire practice database, retrieving this information could take some time.
6. Click the **Client** tab to see a summary of how many clients your practice has seen compared between your selected time periods. You can also view sales by postal code and see the geographical location of your clients.

- To print a Client Referral Report, New Clients Report, Sales by Postal Code Report or Sales Analysis Report, right-click in any results display area and select the applicable report.

7. Click the **Patient** tab to view sales comparisons by species, breed and age. You can also view a comparison of the number of patients seen. You can print reports showing the sales comparisons.

- To print a Species Report, right-click in the **Sales by species** results display area.
- To print a Breed Report, right-click in the **Sales by breed** results display area.
- To print an Age Report, right-click in the **Sales by age** results display area.
Chapter 27: Using Cornerstone Performance Tracker

Cornerstone Performance Tracker—Patient tab

8. Click the **Comparative** tab to learn about the benefits that IDEXX Practice Profile* provides your practice.

9. Click **X** to exit Cornerstone* performance tracker.
Chapter 28: Using the Backup Verification Assistant

Overview
The Backup Verification Assistant provides an extra precautionary measure to protect your data by scanning the backup log and reporting possible problems when a staff member logs into the IDEXX Cornerstone* Practice Management System.

If your practice uses compatible backup software, you can set up Cornerstone to automatically verify your backup. The following backup software is compatible: Backup4all™, Backup Exec™, BackUp MyPC™, PC Backup, TapeWare® and IDEXX VetVault* Backup Solution.

How the Backup Verification Assistant Works
The Backup Verification Assistant scans your backup log for certain keywords. If keywords are found, the Backup Verification Assistant highlights the line(s) in your backup log and displays them, color-coded, in the Summary area.

Backup Exec, TapeWare and BackUp My PC
- **Red**—indicates there was a warning or error during the backup process.
- **Blue**—indicates a Cornerstone data file with a file date older than the backup date. It is normal for the cstone.db file to display in blue if an automatic backup is scheduled to run nightly.
- **Green**—indicates a Cornerstone data file with the current file date was backed up.

Backup4all and PC Backup
- **Red**—indicates there was a warning or error during the backup process.
- **Green**—indicates a Cornerstone data file was backed up.

IDEXX VetVault Backup Solution
- **Red**—indicates there was a warning or error during the backup process.
- **Blue**—indicates a Cornerstone data file was NOT backed up.
- **Green**—indicates a Cornerstone data file was backed up.
Chapter 28: Using the Backup Verification Assistant

Enabling the Backup Verification Assistant in Cornerstone

1. On the Tools menu, select Backup Verification Assistant.
2. Select the backup software that is used by your practice.
3. Select the Use Backup Verification Assistant check box.
4. Click OK.

Viewing the Backup Verification Assistant

Cornerstone Administrators and staff with proper security permissions will see the Backup Verification Assistant the first time they log in each day. It can also be viewed manually through the Reports menu.

To manually view the Backup Verification Assistant:

1. On the Reports menu, select Backup Logs.
2. After viewing the Backup Verification Assistant, select the Verified check box.
3. Click OK.
Chapter 29: Purging Data from Cornerstone*

Overview
After you have entered many years of data into the IDEXX Cornerstone* Practice Management System, you may want to go back and clean up old files by deleting data you no longer need. There are several reasons why you would want to periodically purge (delete) data from the Cornerstone database:

- It makes Cornerstone work faster.
- It decreases the amount of history displayed in client account history and patient medical history records, as well as decreases the size of reports that include client and patient history.
- It allows you to delete old client and patient records that clutter your system.

Think of your Cornerstone database as a parking lot. When you purge data, you remove cars from the lot. The lot is still the same size, but it’s easier to find your car (with fewer cars to look at) and you can fit new cars into the empty spaces.

Options for Purging Data from Cornerstone
You can perform three different types of data purges in Cornerstone:

- Delete clients, their patients, and all associated information
- Delete patients and their associated information
- Delete specific types of client or patient information from the client and patient records (but do not delete the client or patient)

IMPORTANT: We strongly advise backing up your Cornerstone database before purging any data.

If you purge clients and patients:
Cornerstone will:

- Delete all records of the selected client(s) and any patients owned 100% by the client(s) before the selected date. (The client must have 100% ownership or the client and patient records will not be deleted.)
- Delete the selected client(s) and associated patient(s) from the Client List and Patient List.

Cornerstone will purge a client only if:

- All of the patients owned by the client can be purged.
- The client does not have a balance.
- The client does not have an open invoice.
- The client does not have any account transactions after the purge date.
- The client has 100% ownership of all of their patients.

Note: If the client has been written off, Cornerstone prompts you to keep the client.
Cornerstone will purge a patient only if:

- The patient does not have a future appointment.
- The patient does not have an open (saved) exam. ♦
- The patient is not checked in.
- The patient does not have transactions on an open invoice. ♦
- The patient does not have any account transactions after the purge date. ♦
- The patient does not have a controlled substance in its history for at least two years. ♦
- The patient’s record was not created after the purge date specified.
- The patient does not have reminders in the future nor in the past month.

If a patient is deceased, Cornerstone will only check to verify that the patient does not meet any of the conditions indicated by the ♦ symbol.

Note: If you do not want to delete the client or patient, purge specific information from the records instead. See “Purging Specific Types of Client or Patient Information” on page 452.

Purging Clients and Patients

If you purge clients and patients, Cornerstone will:

- Delete all records of the selected client(s) and any patients owned 100% by the client(s) before the selected date. (The client must have 100% ownership or the client and patient records will not be deleted.)
- Delete the selected client(s) and associated patient(s) from the Client List and Patient List.

Note: If you do not want to delete the client or patient, purge specific information from the records instead. See "Purging Specific Types of Client or Patient Information" on page 452.

Before You Begin

- Process End of Year, if necessary. End of Year must be run before the database can be purged. You must have entered one full year of data and processed at least two End of Year periods before you can purge data.
- Check with your accountant to make sure your practice is complying with state and local regulations regarding the length of time data should be kept.
- Review your Purging defaults to prevent you from purging recent client or patient information. See “Purging Defaults” on page 130.

IMPORTANT: Back up your Cornerstone database.

To purge clients and patients and their records:

1. On the Tools menu, select Purge Data. A message appears to remind you to back up your database before continuing. If you have backed up your database, click OK. The Select Type of Purge dialog box appears.
2. Specify Purge both clients and patients and click OK. The Purge Information dialog box appears.
3. If necessary, change the Last date to purge. The date that appears by default is based on the periods entered in purging defaults. You cannot purge data from a more current date than the default period allows.

Note: If the records to purge contain both client and patient account information and reminders, Cornerstone retains data using the oldest possible date from the defaults.

4. In the Options area, do the following:
   - Select the Print list of records purged check box if you want to print a list of the records purged.
   - Specify whether to select the range of clients to purge by ID or by last name.

5. In the Client selection area, type the ID or last name (or part of the ID or name) of the first and last client to delete.

Note: You can press F2 to use the Client List to choose a client.

6. Select the Status of clients to delete: Active, All or Inactive.

7. Select the Classifications of clients to delete. Select <All> to include all classifications.

8. Click OK.

9. If prescriptions for the patient exist, Cornerstone prompts you to save the refill information.

10. If the patient’s weight has not been updated after the selected date, Cornerstone prompts you to retain the patient’s most recent weight.

11. If you decided to print a list of purged records, a message appears to inform you that Cornerstone will print the purged history next. Click OK.

   Note: Cornerstone does not print records purged for all types of information.

12. A message appears to inform you that the purge is now completed. Click OK.

13. If there is a reason a client or patient was not deleted, the reason is displayed in the Purge Summary. Click Print to print the summary.
Purging Patients

If you purge patients, Cornerstone will:

- Delete all records of the selected patient before the selected date.
- Delete the selected patient(s) from the Patient List.

**Note:** If you do not want to delete the patient, purge specific information from the patient records instead. See “Purging Specific Types of Client or Patient Information” on page 452.

**Before You Begin**

- Process End of Year, if necessary. End of Year must be run before the database can be purged. You must have entered one full year of data and processed at least two End of Year periods before you can purge data.
- Check with your accountant to make sure your practice is complying with state and local regulations regarding the length of time data should be kept.
- Review your purging defaults to prevent you from purging recent client or patient information. See “Purging Defaults” on page 130.

**IMPORTANT:** Back up your Cornerstone database.

**To purge patient records and patients:**

1. On the Tools menu, select Purge Data. A message appears to remind you to back up your database before continuing. If you have backed up your database, click OK. The Select Type of Purge dialog box appears.

2. Specify Purge only patients and click OK. The Purge Information dialog box appears.

3. If necessary, change the Last date to purge. The date that appears by default is based on the periods entered in the Purging Defaults. You cannot purge data from a more current date than the default period allows.

**Note:** If the records to purge contain both patient account information and reminders, Cornerstone retains data using the oldest possible date from the defaults.
4. In the Options area, do the following:
   - Select the Print list of records purged check box if you want to print a list of the records purged. (Note: Cornerstone does not print records purged for all types of information.)
   - Specify whether to select the range of patients to purge by ID or by last name.
5. In the Patient selection area, type the ID or last name (or part of the ID or name) of the first and last patient to delete.
   Note: You can press F2 to use the Patient List to choose a patient.
   Note: You can purge a range of IDs or names or one single patient. If you want to purge a single patient’s records, enter the patient’s ID (or exact name) in both the First patient and Last patient boxes. (Use the ID if two patients have the same name.)
6. Select the Status of patients to delete: Active, All, Deceased or Inactive.
7. Select the Classifications of patients to delete. Select <All> to include all classifications.
8. Click OK.
9. If you decided to print a list of purged records, a message appears to inform you that Cornerstone will print the purged history next. Click OK.
10. A message appears to inform you that the purge is now completed. Click OK.

**Purging Specific Types of Client or Patient Information**

If you want to remove old information from a client or patient record, you can select to purge specific types of information without deleting the client or patient.

You can purge any of the following information (provided it was entered before the selected date):

**Client Information**

- Account History–all client account transactions including payments, invoices, returned checks, written off (and reinstated) amounts, account comments and transferred amounts

**Patient Information**

<table>
<thead>
<tr>
<th>Client Information</th>
<th>Patient Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing (invoiced items)</td>
<td>Lab Results</td>
</tr>
<tr>
<td>Boarding</td>
<td>Medical Notes</td>
</tr>
<tr>
<td>Census History (check-in and check-out information)</td>
<td>Patient Visit List (items on the Patient Visit List)</td>
</tr>
<tr>
<td>Correspondence Documents</td>
<td>Prescription Labels</td>
</tr>
<tr>
<td>Declined History</td>
<td>Problems</td>
</tr>
<tr>
<td>Departing Instructions</td>
<td>Rabies Tags</td>
</tr>
<tr>
<td>Diagnoses</td>
<td>Reminder Call Backs</td>
</tr>
<tr>
<td>Estimates</td>
<td>Reminder Letters</td>
</tr>
<tr>
<td>Exams (from the Patient Advisor* module)</td>
<td>Vital Signs (including weight history)</td>
</tr>
<tr>
<td>Lab Requests</td>
<td></td>
</tr>
</tbody>
</table>

**Before You Begin**

- Process End of Year, if necessary. End of Year must be run before the database can be purged. You must have entered one full year of data and processed at least two End of Year periods before you can purge data.
- Check with your accountant to make sure your practice is complying with state and local regulations regarding the length of time data should be kept.
• Review your purging defaults to prevent you from purging recent client or patient information. See “Purging Defaults” on page 130.

IMPORTANT: Back up your Cornerstone database.

To purge specific client or patient information:

1. On the Tools menu, select Purge Data. A message appears to remind you to back up your database before continuing. If you have backed up your database, click OK. The Select Type of Purge dialog box appears.

2. Specify Purge specific information, click the type(s) of information to purge, and click OK. The Purge Information dialog box appears.

3. If necessary, change the Last date to purge. The date that appears by default is based on the periods entered in the Purging Defaults. You cannot purge data from a more current date than the default period.

   Note: If the records to purge contain both client and patient account information and reminders, Cornerstone retains data using the oldest possible date from the defaults.

4. In the Options area, specify whether to select clients or patients by ID or by name.

5. Enter the appropriate ID or name of the first client or patient whose information you want to delete.

6. In the Last client or patient box, enter the ID or name of the last client or patient whose information you want to delete. (Remember, if you are purging information for a single client or patient, enter the same ID in both the First and Last boxes.)

7. Select the Status of the clients or patients to delete: Active, All, Deceased (Patient only) or Inactive.

8. Select the Classifications of the clients or patients whose information you want to delete. Select <All> to include all classifications.

9. Click OK.

   If prescriptions for the patient exist, Cornerstone prompts you to save the refill information.

   If the patient’s weight has not been updated after the selected date, Cornerstone prompts you to retain the patient’s most recent weight.

10. If you decided to print a list of purged records, a message appears to inform you that Cornerstone will print the purged history next. Click OK.

11. A message appears to inform you that the purge is now completed. Click OK.
12. If there is a reason a client or patient was not deleted, the reason is displayed in the Purge Summary. Click **Print** to print the summary.

**Purging Patient Reminders**
If you purge patient reminders, Cornerstone will delete all Call or Letter reminders (whichever you choose) for the selected patient before the selected date.

**Before You Begin**
- Process End of Year, if necessary. End of Year must be run before the database can be purged. You must have entered one full year of data and processed at least two End of Year periods before you can purge data.
- Check with your accountant to make sure your practice is complying with state and local regulations regarding the length of time data should be kept.
- Review your purging defaults to prevent you from purging recent client or patient information. See “Purging Defaults” on page 130.

**IMPORTANT:** Back up your Cornerstone database.

**To purge patient reminders:**
1. On the **Tools** menu, select **Purge Data**. A message appears to remind you to back up your database before continuing. If you have backed up your database, click **OK**. The Select Type of Purge dialog box appears.
2. Specify **Purge specific information**, click Call Backs or Reminder Letters or both and click **OK**. The Purge Information dialog box appears.
3. If necessary, change the **Last date to purge**. The date that appears by default is based on the periods entered in the Purging Defaults. You cannot purge data from a more current date than the default period allows.
   **Note:** If the records to purge contain both patient account information and reminders, Cornerstone retains data using the oldest possible date from the defaults.
4. Select the **Print list of records purged** check box if you want to print a list of the reminder records purged.
   **Note:** Cornerstone does not print records purged for all types of information.
5. Specify whether to select the range of patients by **ID** or by **name**.
6. Under **Patient selection**, type the **ID** or **name** (or part of the ID or name) of the first and last patient whose reminders you want to delete.
   **Note:** You can press F2 to use the Patient List to choose a patient.
   **Note:** You can purge for a range of patient IDs or names or one single patient. If you want to purge a single patient’s reminders, enter the patient’s ID (or exact name) in both the First patient and Last patient boxes. (Use the ID if two patients have the same name.) If you want to purge all patient records, leave these fields blank.
7. Select the **Status** of patients to delete: Active, All, Deceased or Inactive.
8. Select the **Classifications** of patients to delete. Select **<All>** to include all classifications.
9. Click **OK**.
10. If the **Print list of records purged** check box was selected, a message appears to inform you that Cornerstone will print the purged history next. Click **OK**.

11. A message appears to inform you that the purge is now completed. Click **OK**.

12. If there is a reason a client or patient was not deleted, the reason is displayed in the Purge Summary. Click **Print** to print the summary.

   For a complete list of dates when purge functions were performed at your practice, print a **Purge Report**.

**Purging Inventory Records**

Inventory history accumulates throughout the year. You can purge inventory history information at any time; however, if items are still on order or backordered, the record will not be purged. Purging records deletes all of the information associated with the internal usage, return, receipt, Quantity on Hand (QOH) adjustment, or order from the database.

**IMPORTANT:** We recommend you backup your database before purging history or making any mass changes to the database.

**To purge order history:**

1. On the **Tools** menu, select **Inventory Purge**.

2. A **Database purge** message appears to remind you to back up the database before continuing. Click **OK**. The Inventory Purge dialog box appears.

3. Specify the date to begin purging **From** and the date **To** end purging.

4. Select all applicable records to purge (Internal usage, Returns to vendors, Received orders, QOH adjustments, Placed orders, and/or Stock transfers).

5. Click **OK** to delete the records.
Chapter 30: Using the Time Clock

Overview
The Time Clock is a computerized version of a standard time clock that will keep track of staff hours. Time Clock can also:

• Record and track regular, sick, and vacation time.
• Print attendance information reports based on options you select.

Staff members can record their own hours, but only a person with appropriate security can make corrections or changes once entries are made.

Time Clock Toolbar Buttons
Time Clock provides the following toolbar buttons that allow you to easily access commonly used features.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Display the Timesheet" /></td>
<td>Display the Timesheet</td>
</tr>
<tr>
<td><img src="image" alt="Log in a different staff member using password entry" /></td>
<td>Log in a different staff member using password entry</td>
</tr>
<tr>
<td><img src="image" alt="Clock in" /></td>
<td>Clock in</td>
</tr>
<tr>
<td><img src="image" alt="Clock out" /></td>
<td>Clock out</td>
</tr>
<tr>
<td><img src="image" alt="Record sick time" /></td>
<td>Record sick time</td>
</tr>
<tr>
<td><img src="image" alt="Record vacation and holiday time" /></td>
<td>Record vacation and holiday time</td>
</tr>
<tr>
<td><img src="image" alt="Edit times in the Timesheet" /></td>
<td>Edit times in the Timesheet</td>
</tr>
<tr>
<td><img src="image" alt="Display hours entered for a specific week" /></td>
<td>Display hours entered for a specific week</td>
</tr>
<tr>
<td><img src="image" alt="Print the Staff Hours Report" /></td>
<td>Print the Staff Hours Report</td>
</tr>
</tbody>
</table>

Setting Up Security
Due to its confidential nature, specific security instructions are not provided in this manual. To set up security for each staff member, from the File menu, select Security Setup and follow the IDEXX Cornerstone* Practice Management System Staff Security instructions you received separately when you purchased your Cornerstone software.

Setting Up Staff Members
All of the staff members set up in Cornerstone are automatically set up as employees in Time Clock.

Note: You cannot delete staff members if they have punched in or out.
Chapter 30: Using the Time Clock

The Timesheet
When you enter Time Clock, the Timesheet window displays. Select your name or ID from the staff member list to display your hours in the Timesheet.

To open the Timesheet:
➤ Click the Timesheet button or on the Activities menu, select Timesheet.

To change the week displayed:
The Timesheet will display one week—from Sunday through Saturday (or beginning the first day you work after Sunday, through the following Saturday). To change the week displayed in the Timesheet window, the Timesheet must be open.

1. Click the Display Week button or on the Activities menu, select Display Week.
2. Enter any date from the week you want to view and click OK.
   The hours for the selected week will display in the Timesheet window.

To change the day the Timesheet begins:
You can change the day the Timesheet begins, for example, if you want your work week to start on Monday instead of Sunday.

1. On the Activities menu, select Data Defaults. The Data Defaults dialog box appears.
   
   ![Data Defaults dialog box](image)

   Data Defaults dialog box

2. Select the appropriate day from the drop-down list.
3. If your practice is open 24 hours and you want all employee hours for the week on one time sheet, select the Split 3rd shift at the end of the week check box to have Cornerstone automatically split employee hours into the correct work week.
4. Click OK.

Clocking In and Out
For Cornerstone Time Clock to accurately record the hours you have worked, you must clock in and out from the Timesheet.

To clock in:
1. From the staff list on the Timesheet, select your name.
2. Click the Clock In button or on the Activities menu, select Clock In. Time Clock will record your starting time.

To clock out:
1. From the staff list on the Timesheet, select your name.
2. Click the Clock Out button or on the Activities menu, select Clock Out. Time Clock will record your ending time and the total number of hours you worked for that time period.
Chapter 30: Using the Time Clock

**Note:** If the user who is currently logged in does not have appropriate security privileges, the user is the only one shown in the staff list. This user can only clock in and out and can only view his or her timesheet. If the user who is currently logged in does have appropriate security privileges, the system will automatically select that staff member’s ID in order to clock in. Users with administrator status will still be allowed to clock other employees in or out and view other employees’ timesheets. This option can be set in security to give an employee without administrator status access to other employees’ timesheets.

**Recording Absences**

Time Clock will record and track your absences from work. Specify whether it was sick time or vacation/holiday time, and enter the date(s) and amount of time you were away.

**To record sick time:**

1. Select your name from the staff list on the Timesheet.
2. **Click the** **Sick Hours** button or on the Activities menu, select **Sick Hours**. The Sick Hours dialog box appears.

   ![Sick Hours dialog box](image)

3. Click **Add**. The current date and eight hours appear. Revise the date or number of hours if necessary.
   **Note:** To add another sick day, click **Add** again and enter the date and number of hours.
4. **Click OK**.

**To record vacation time:**

1. From the staff list on the Timesheet, select your name.
2. **Click the** **Vacation Hours** button or on the Activities menu, select **Vacation Hours**. The Vacation Hours dialog box appears.

   ![Vacation Hours dialog box](image)

3. Click **Add**. The current date and eight hours appear. Revise the date or number of hours if necessary.
   **Note:** To add another vacation day, click **Add** again and enter the date and number of hours.
4. **Click OK**.
Changing Previously Recorded Times

Staff time sheets occasionally need to be revised. Only a staff member with security access to the Edit Times dialog box can add to or modify a staff member’s hours.

**To edit staff member hours:**

1. From the staff list on the Timesheet, select the staff member whose time sheet needs revision.

2. Click the **Edit Times** button or on the **Activities** menu, select **Edit Times**.

3. On the Time Clock Login dialog box, log in using your **User** name and **Password**. You must have security access to the Edit Times dialog box in order to add to or modify a staff member’s hours. The Edit Times dialog box appears.

4. Enter the **Date to edit** and click **Retrieve**. The staff member’s hours for that date appear.
   
   **Tip:** Press F2 to use the Calendar tool to select dates.
   
   **Note:** If hours have not been entered for that date, a message asks if you want to add hours for that date. Click **Yes** to add hours or **No** to enter a different date to edit.

5. To change the type of hours, click the **Regular**, **Vacation**, or **Sick** option at the bottom of the dialog box.
   
   - For regular hours, revise the **Date** and **Time In** or **Date** and **Time Out**. The hours are calculated automatically.
   
   - For vacation or sick hours, change the **Date** or number of **Hours**.

6. To delete hours, click **Delete**. You are prompted to confirm the deletion. Click **Yes**.

7. To add hours, click **Add**.

8. Enter the reason for the change in the **Note** field.

9. Click **OK**. A message asks if you are finished editing this staff member’s hours. Click **Yes** to finish or **No** to edit additional hours.

**Entering Hours Using the Edit Times Dialog Box**

When a staff member forgets to clock in or needs to be compensated for work done outside of the office, you can add hours to staff time sheets with the Edit Times dialog box.
Printing Attendance Reports

Using Cornerstone Time Clock to record and track staff hours generates data that can be used to analyze staff hours. The Staff Hours report makes it easy to collect the necessary data.

Staff Hours Report

The Staff Hours Report details your staff’s hours. For each date in the selected period, the report includes:

- Time of day each staff member clocked in and out.
- Number of hours clocked in for each period.
- Total number of hours for all dates included on the report, broken down into weekly subtotals. (Does not apply when one page per staff member is selected.)
- Type of hours (regular, sick, vacation), based on which type of hours you selected to view.

Note: Time Clock does not calculate overtime.

To print or preview the Staff Hours report:

1. Open Cornerstone Time Clock.
2. On the Reports menu, select Report Selection or click the Reports button. The Print Reports window appears.

3. In the Date range area, enter the Begin date, End of first week and End date. This is the time period that will be reflected in the report.
   Tip: Press F2 to use the Calendar tool to select dates.
4. In the Select by area, choose one of the following options:
   • Select **ID** to generate the Staff Hour Report for staff members selected by staff IDs and under Staff ID, enter a beginning ID and an ending ID.
   • Select **Last Name** to generate the Staff Hour Reports for staff members selected by staff last names and under Staff last name, enter a beginning last name and ending last name.
   • Select **Classification** and then under Classification, select the staff classification(s) to include on the time card report. Staff members with the selected classification are included in the report.
     **Tip:** Multiple classifications can be selected by holding the CTRL key down while clicking on each additional classification you want to select.

5. In the Sort by area, select **ID** to sort and print the report in staff ID order or select **Last name** to sort and print by staff last name.

6. To not include an hour type (regular, vacation or sick) on the report, under Hour types, deselect the hour type that you do not want to include. (A ✅ means the Hour Type will be included.)

7. Select the **New page per staff** check box if you want to print only one staff member per page on the report. If you choose this option, the total hours for all staff are not included on the report.

8. Choose one of the following options:
   • Click **Preview** to preview the report. From the Preview window, click **Print** to print, **Save** to save the report or **Cancel** to return to the previous window.
   • Click **Print** to print the report, select print options and click **OK**.

9. Click **Close**.
Chapter 31: Setting Up the Mobile Computing Module

Overview

The Mobile Computing module with mobile computer synchronization provides the ability to use the IDEXX Cornerstone® Practice Management System outside of the practice. A mobile computer could be a laptop or a tablet PC.

After returning to the practice, the data on a mobile computer can be downloaded to the main practice database. The database on the mobile computer is also updated to match the main database.

Some possible scenarios where the Mobile Computing module would be valuable include the following:

- Large animal or equine practices where veterinarians need to travel to see patients
- Practices that run vaccination clinics
- Doctors who want to update medical notes or correspondence from home

Note: Machines that have been designated as the End of Period workstation or the Lab workstation cannot be used as mobile computers.

Mobile Computing Functionality—Mobile Computer vs. Main System

The following information shows the mobile computing-related tasks that can be performed on the mobile computer and those that can be performed from any workstation on the main system’s network.

Tasks that can be performed on the mobile computer

- Create a mobile computer
- Assign a printer on the mobile computer
- Synchronize a mobile computer to update the laptop and main system’s database
- Undo a mobile computer to use as a workstation at the practice

Tasks that can be performed on the main system

- Set security and defaults
- View a list of created mobile computers
- View exception and End of Day reports after synchronizing a mobile computer
- Delete a mobile computer that is no longer accessible
### Setting Up the Mobile Computing Module

#### Before You Begin

Before you set up a mobile computer, review the following checklist.

- Check to ensure that you have enough disk space on the mobile computer machine. You will need approximately three times the size of your Cornerstone database. If you plan to view your images on the mobile computer, you will also need to make sure you have enough space for your images folders. See “Copying Images to a Mobile Computer” on page 465.

- Make sure the appropriate security has been set up for mobile computer users. At least one user should have permission to access all mobile computer options.

- Set the mobile computing defaults and any workstation-specific defaults. Once the mobile computer database is created, you will not be able to change any of these settings without undoing the mobile computer. See the “Setting Mobile Computing Defaults” section that follows for information on mobile computing defaults.

- Printer assignments may be set on the mobile computer. However, these assignments are temporary and will be overwritten the next time synchronization is run.

#### Setting Mobile Computing Defaults

You can set up the End of Period defaults to specify that End of Day processing automatically run before and after mobile computing synchronization. If this default is enabled, you will have separate End of Day records according to mobile computers.

**Note:** If the Run End of Day before and after mobile computer synchronization option is selected, End of Day processing will be run on the main system every time a mobile computer is synchronized.

**To set the mobile computer (End of Period) defaults:**

**Note:** Perform this task on your main system.

1. On the Controls menu, select Defaults > Practice and Workstation. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click End Of Period. The End Of Period configuration pane appears on the right side of the window.
3. To run separate End of Day processing for the mobile computers, select the **Run End of Day before and after mobile computer synchronization** check box.

If selecting this option, note the following:

- When synchronization occurs on the mobile computer, an End of Day is processed initially for the main database and then a separate End of Day is processed for the mobile computer's data.
- End of Day processing will be run on the main system every time a mobile computer is synchronized.

**Tip:** If you choose to run separate End of Day during the synchronization of the mobile computers, you can see if the End of Day was run on the mobile computer or server by clicking the **Details** button on the Daily Reports dialog box (**Reports > End of Period > End of Day**).

4. To specify that synchronization of the mobile computer(s) must be performed within a certain number of hours of End of Month processing or an alert will appear, select the **Computers must be synchronized within __ hours before End of Month** check box and specify the timeframe.

If selecting this option, note the following:

- If your practice is set up to **automatically** run End of Month and the specified time frame is exceeded, automatic End of Month processing will not run.
- If you attempt to **manually** process End of Month and the specified time frame is exceeded, an alert will display. If necessary, you can override this alert and continue your End of Month processing.

5. Click **OK**.
Copying Images to a Mobile Computer

When your practice sets up a mobile computer to be used with the Mobile Computing module, you have the option to copy your images from your main system to your mobile computers.

**Note:** If you do not have enough space on the mobile computer for your images, you may decide not to copy images to it. If you choose to not copy images to the mobile computer, images can still be created and uploaded to the main system, but images stored on the main system cannot be viewed on the mobile computer.

**To set the option to copy images to the mobile computer:**

**Note:** Perform this task on your main system.

1. On the Controls menu, select **Defaults > Practice and Workstation**. The Practice and Workstation Defaults window appears.
2. In the navigation pane, click **Imaging**. The Imaging configuration pane appears on the right side of the window.
3. Select the **Copy images to mobile computer** check box if you want images from your main system to be copied to your mobile computer(s).
4. Click **OK**.

Viewing the Mobile Computer List

The Mobile Computer List shows the mobile computers that have been created from your database and when synchronizations took place. If you want to check which mobile computers are in use or when the last data synchronization for a mobile computer occurred, view the Mobile Computer List. Also, if you need to reprint an Exception Report, this can be done from the Mobile Computer List.

**To view the Mobile Computer List:**

**Note:** Perform this task on your main system.

2. To reprint an Exception Report, select the synchronization date and click **Report**. If your practice has multiple mobile computers, select the mobile computer first, and then select the synchronization date.
Deleting a Mobile Computer

You should only use this option if you cannot access the mobile computer; for example, if the mobile computer is lost or stolen or if it’s broken.

Note: Even if a lost or stolen mobile computer is recovered, you will not be able to synchronize it with the main system once you have deleted it from the Mobile Computer List.

To delete a mobile computer:

Note: Perform this task on your main system.

2. Select the mobile computer to delete from the system and click Delete. You are prompted to confirm the deletion.
3. Click Yes to delete the mobile computer.

Generating a Mobile Computing Checkout Report

The Mobile Computing Checkout Report shows which staff members have checked out medical notes or correspondence. This report must be accessed from the main system.

To run the Mobile Computing Checkout Report:

Note: Perform this task on your main system.


![Mobile Computer Checkout Report](image-url)